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These topics refer to all English retail/final/gamma/Gold/RTM/OEM releases,
versions, editions + builds [including previews, Service Packs (SPs), updates
+ patches] 32-bit (x86) + 64-bit (x64) of these Microsoft Windows operating
systems (OSes)
- 10
http://en.wikipedia.org/wiki/Windows_10
http://en.wikipedia.org/wiki/Windows_10_editions
http://en.wikipedia.org/wiki/Windows_10_version_history
- 11
http://en.wikipedia.org/wiki/Windows_11
http://en.wikipedia.org/wiki/Windows_11_version_history
- Server 2016
http://en.wikipedia.org/wiki/Windows_Server_2016
- Server 2019
http://en.wikipedia.org/wiki/Windows_Server_2019
- Server 2022
http://en.wikipedia.org/wiki/Windows_Server_2022
unless specified otherwise:
http://www.mdgx.com/10.php
Also available as plain text/ASCII file (this file):
http://www.mdgx.com/WIN10.TXT
Also available as PDF (Portable Document Format) document:
http://www.mdgx.com/WIN10.pdf
Translate this file into your language: top right side -> click/touch down
arrow to expand drop down menu -> select desired language:
http://translate.google.com/?sl=en&tl=en&text=http%3A%2F%2Fwww.mdgx.com
%2FWIN10.TXT
TIP:
Some of these topics (clearly marked) apply also to Windows 7, 2008 R2, 8, 2012,
8.1, 2012 R2.

BONUS:
More Windows 10/11 (clearly marked) tweaks, hacks, fixes, guides, links + tools 
(all included):
- MDGx "Win10 Block Tools (10_BLOCK)" in 10_BLOCK.TXT:
http://www.mdgx.com/xptoy.htm#10BLK
http://www.mdgx.com/10BLK/10_BLOCK.php
http://www.mdgx.com/10BLK/10_BLOCK.TXT
- MDGx "Windows 8/8.1 Tweaks, Fixes, Guides, Downloads + Links" in WINDOWS8.TXT:
http://www.mdgx.com/8.php
http://www.mdgx.com/WINDOWS8.TXT
- MDGx "Windows 7/7 SP1 Tweaks, Fixes, Guides, Downloads + Links" in 
WINDOWS7.TXT:
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
- MDGx "List of Useful Windows NTx Tools [free(ware)]" in TOOLS.TXT:
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT

FYI:
Windows NTx (based on Windows NT) = Windows 
NT4/2000/XP/2003/Vista/2008/7/8/8.1/2012/10/2016/2019/11/2022/newer
http://en.wikipedia.org/wiki/Windows_NT
Windows 9x (based on Windows 95) = Windows 95/95 OSR1/95 OSR2.x/98/98 SP1/98 



SE(U)/ME
http://en.wikipedia.org/wiki/Windows_9x

    @@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@
    @@ ALWAYS BACKUP ALL YOUR OPERATING SYSTEM DRIVES TO A SAFE LOCATION @@
    @@          BEFORE ATTEMPTING TO MAKE ANY SYSTEM CHANGES !           @@
    @@     -> "Free(ware) WinDOwS Backup + Restore Tools" section in     @@
    @@                      SECRETS.TXT (included):                      @@
    @@               http://www.mdgx.com/secrets.htm#BKP                 @@
    @@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@

WARNING: * Take EXTREME CAUTION when modifying/adjusting/customizing your
 Registry/System/Startup files/configuration/settings!
 Faulty changes may result in crashes/lockups/permanent data loss, or
 might lead to having you REINSTALL your Operating System(s)!
 YOU are the ONLY one responsible for ANY changes YOU make!
 ALWAYS HAVE YOUR MOST RECENT SYSTEM BACKUP READY! ->
 "Free(ware) WinDOwS Backup + Restore Tools" in SECRETS.TXT
 (included):
 http://www.mdgx.com/secrets.htm#BKP
 * BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> "BACKUP/EXPORT +
 RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in WINDOWS7.TXT (included):
 http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE

%2FIMPORT%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
 * Some of these tricks + apps/programs/tools/scripts require
 adequate/advanced knowledge about critical computing, operating
 systems (OSes), registry, services, shared environments, networks,
 cybersecurity, and other related subjects/disciplines:
 http://en.wikipedia.org/wiki/Category:Microsoft_operating_systems
 http://en.wikipedia.org/wiki/Windows_Registry
 http://www.mdgx.com/reg.htm
 http://en.wikipedia.org/wiki/Category:Windows_services
 http://en.wikipedia.org/wiki/Real-time_computing
 http://en.wikipedia.org/wiki/Enterprise_software
 http://en.wikipedia.org/wiki/Shared_resource
 http://en.wikipedia.org/wiki/Computer_network
 http://en.wikipedia.org/wiki/Computer_security
 http://en.wikipedia.org/wiki/Network_security

NOTES: - These ©Tricks + Secrets have been tested on many computers, but 
with

  NO guarantee they should also work for you.
- Some of these tips I stumbled upon while browsing the Internet or
  while helping others with WinDOwS problems, some were kindly sent in
  by concerned readers (all authors/contributors are acknowledged and
  reliable sources given proper credit), and some I discovered on my
  own. Enjoy the ride.
- Contributed tips (clearly marked) and other web sites mentioned here
  do not necessarily reflect the opinion of the author + owner of
  these files + of this web site.

IMPORTANT:
**********
http://www.mdgx.com/importnt.php
* Some of these files are archived in ZIP
[http://en.wikipedia.org/wiki/Zip_%28file_format%29], RAR
[http://en.wikipedia.org/wiki/RAR_%28file_format%29], 7Z
[http://en.wikipedia.org/wiki/7z] or CAB
[http://en.wikipedia.org/wiki/Cabinet_%28file_format%29] format. You need a
file decompression (unZIPping/unARChiving/unRARing) tool to extract their
contents. I recommend [free(ware)]:
- Windows 9x/NTx users: File Shrinkers 32-bit + 64-bit:
http://www.mdgx.com/toy.htm#ZIP
- Windows/WfWG 3.1x users: Info-ZIP WiZ 16-bit:



http://www.info-zip.org/WiZ.html#Win16
- DOS/MS-DOS/FreeDOS/DR-DOS/OpenDOS users: DOS ZIP/unZIP 16-bit tools:
http://www.mdgx.com/dos.htm#ZIP
* STAY SAFE -> Scan for viruses *all* files downloaded from the Internet:
http://www.mdgx.com/vir.htm
and *beware* of false positives (included):
http://www.mdgx.com/fp.php
http://www.mdgx.com/FALSPOSI.TXT
* Target Operating System(s)/software/hardware REQUIRED for installing
upgrades/patches/fixes/drivers!
* Installing Windows OS components/upgrades/patches/fixes/drivers/tools may
require you to be logged on with Administrative/Power User/Sysadmin
privileges.
* Windows Vista/newer users: right-click each file and select "Run as
Administrator" (temporary fix) or disable User Account Control (UAC)
(permanent fix) in:
- Windows 10/2016/2019/11/2022:
http://www.tenforums.com/tutorials/3577-user-account-control-uac-change-
settings-windows-10-a.html
- Windows 8/2012/8.1/2012 R2:
http://www.eightforums.com/tutorials/5509-user-account-control-uac-change-
settings-windows-8-a.html
- Windows 7/2008 R2:
http://www.petri.com/disable-uac-in-windows-7/
- Windows Vista/2008:
http://www.petri.com/disable_uac_in_windows_vista/
User Account Control (UAC) tweaking tools [free(ware)]:
- UAC Pass:
http://sites.google.com/site/freeavvarea/uac-pass/uac-pass/
- TweakUAC:
http://www.winability.com/tweak-uac/
- Disable UAC:
http://www.majorgeeks.com/files/details/disable_uac.html
FYI:
MDGx Tweaked + Customized File Manager (FM) installer FMNT32.EXE (free):
http://www.mdgx.com/xptoy.htm#FMNT
also installs "Disable User Account Control (UAC)" + "Enable User Account
Control (UAC)" items to Desktop right-click shell context menu.
* NEWest at the top -> OLDest at the bottom.
* Items labeled as "discontinued!": obsolete, unmaintained +/- abandoned.
* Most all software featured here is free(ware):
- Freeware:
http://en.wikipedia.org/wiki/Freeware
- Free:
http://en.wikipedia.org/wiki/Free_software
- Open Source:
http://en.wikipedia.org/wiki/Open-source_software
* I do not recommend any crippled/demo/limited/shareware/trialware/retail
software, except the few essentials on my *MUST HAVE* list:
http://www.mdgx.com/toy.htm
and only if I could not find any free(ware) alternative.
* Most unofficial Windows OSes (Hot)Fixes, Packs + Updates created using
official Microsoft IEAK {INF [http://www.mdgx.com/add.htm#INF] + SED
[http://www.mdgx.com/INF_web/cdfinfo.htm]} installer toolkit (free):
http://www.mdgx.com/add.htm#IEA
* Check back often for NEW tools + UPDATEs.
* FYI:
Certain MDGx.com [http://www.mdgx.com/] ancient/old(er),
deprecated/discontinued/obsolete/unneeded, deleted/moved/renamed web pages,
documents, files, directories/folders are most likely to have been
archived/saved for posterity by these entities, and may still be available for
free (gratis):
- Internet Archive (WayBack Machine) [2003 - 2023]:
http://web.archive.org/web/*/http://www.mdgx.com/



- archive.today (Webpage Capture) [2014 - 2022]:
http://archive.is/http://www.mdgx.com/
* MDGx.com archived/saved directories/folders + all their files:
- /files/ -> from 2021:
http://web.archive.org/web/20210506185314/http://www.mdgx.com/files/
- /spx/ -> from 2019:
http://web.archive.org/web/20210506152359/http://www.mdgx.com/spx/list.php
- /sbdrv/ -> from 2021:
http://www.mdgx.com/sbdrv/
* Please let me know if you discover any broken links:
http://www.mdgx.com/form.htm
* Thank you for your time and patience. ;-/
* Enjoy. ;-)

Please send me feedback online:
http://www.mdgx.com/form.htm
Thanks. ;-/

Must have + useful Windows NTx Software Programs [99.99% free(ware)] from 
TOOLS.TXT (included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT
Must have + useful Software Programs [99.99% free(ware)] from SOFTWARE.TXT 
(included):
- MDGx Windows NTx Extras:
http://www.mdgx.com/xptoy.htm
- MDGx 1000+ Windows NTx Power Toys + Tweaking Tools:
http://www.mdgx.com/toy.htm
- MDGx Windows NTx Web Browsers + Internet Power Toys:
http://www.mdgx.com/nettoys.htm

WIN10.TXT Contents: [New ©tweaks added at the TOP]

Windows 11 Requirements = Personal Perspective
Turn OFF/Postpone/Block/Uninstall Windows Updates (WU)
On The Edge of A Hostile Takeover = Uninstall + Replace Edge While You Still Can
Windows Updates (WU) Catalog, Listings + Guides
Turn OFF/Remove Windows 10 Adware, Spyware, Security Flaws + Repair/Restore 
Privacy
Tweak Windows 10/11 Services
Windows Settings (WS) + Control Panel (CP) Shortcuts
Tweaks, Hacks + Fixes... UNconventional, UNdocumented, UNcensored ;-/
Essential Add-ons, Components, Fixes, Updates, Tools + Games [free(ware)]
Tweak, Customize + Repair Tools on the Internet [free(ware)]
BACKUP/EXPORT + RESTORE/IMPORT REGISTRY/REGISTRY KEY(S) -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
Whazz App? -> WINDOWS8.TXT (included):
http://www.mdgx.com/8.php
Tweaks, Hacks + Fixes... UNconventional, UNdocumented, UNcensored ;-/ -> 
WINDOWS8.TXT (included):
http://www.mdgx.com/8.php
Turn OFF/Remove Windows 7/8/8.1 Adware, Spyware, Security Flaws + Repair/Restore
Privacy -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Tweaks, Hacks + Fixes... UNconventional, UNdocumented, UNcensored ;-/ -> 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Updates/(Hot)Fixes/Patches + Windows Update (WU) -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Internet + Web Browsers Tweaks, Fixes + Tools -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Internet%20%2B%20Web%20Browsers%20Tweaks%2C



%20Fixes%20%2B%20Tools%20%5BChromium%2FChrome%2C%20Firefox
Digital + Internet/Online Privacy, Safety + Security -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Digital%20%2B%20Internet%2FOnline%20Privacy%2C
%20Safety%20%2B%20Security%20%3D%20Your%20Top%20Priority
Chromium/Chrome/X-Chromium/Thorium/Brave/Vivaldi/Supermium Automated Clean-Up ->
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Everything About The Infamous (Not So) Trusted Installer -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php
Free(ware) Burn/Copy/Write/Install CDs/DVDs/BDs/USB Tools -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php
Free(ware) Start Menu Shell Replacements -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Control Panel (CP) + Omnipotent/Master/Mega/'god mode' (OMg) Control Panel -> 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Windows (Defender) Firewall (WF) Tweaks + Tools -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Public Root DNS Servers -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Public%20Root%20DNS%20Servers%20%5B%2A%5D
Turn OFF/ON User Account Control (UAC) -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Turn OFF Action/Security Center + Notifications/Messages -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php
Tweak Windows 7/7 SP1 Services -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Logon + Password Tweaks -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Turn OFF/ON Link Layer Topology Discovery (LLTD) + Quality of Service (QoS) -> 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Desktop Background/Wallpaper Tweaks + Free(ware) Tools -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php
Turn OFF NVidia Telemetry -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Free(ware) 7/8/8.1/10/11 Aero Tools + Tweaks -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
XP -> 7/8/8.1 Easy Transfer Files + Settings -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Windows Side-by-Side (WinSxS) Folder -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Save Files List -> Text -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Maximize Your Internet/Network Traffic Speed = MTU -> WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
Windows 7/8/8.1/10/11 Wikipedia Resources + Free eBooks -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php
Free(ware), Open Source + Portable Software + Games @ MDGx.com -> WINDOWS7.TXT 
(included):
http://www.mdgx.com/7.php
Advanced Appearance (Metrics) Settings [AA(M)S] for Windows 7/newer -> 
WINDOWS8.TXT (included):
http://www.mdgx.com/8.php
TESTING... TESTING !!! -> SERVCS10.TXT (included):
http://www.mdgx.com/servcs10.php
USELESS + UNSAFE SERVICES + DRIVERS = DISABLED -> SERVCS10.TXT (included):
http://www.mdgx.com/servcs10.php
Turn ON/OFF Services + Drivers Automatically Using Scripts -> SERVCS10.TXT 
(included):



http://www.mdgx.com/servcs10.php
exFAT -> SECRETS.TXT (included):
http://www.mdgx.com/secrets.htm#XFAT

See also matching/related Windows NTx tweaks in WINDOWS8.TXT, WINDOWS7.TXT,
SERVCS10.TXT, DESKTOP.TXT, MYTIPS95.TXT, REGISTRY.TXT, TIPS2000.TXT,
TIPS95.TXT, TIPSXP.TXT (all included):
http://www.mdgx.com/newtip.htm
______________________________________________________________________________

Windows 11 Requirements = Personal Perspective

Per Microsoft guidelines these are the basic minimum computer/device hardware 
requirements necessary to install + operate
Windows 11:
http://www.microsoft.com/windows/windows-11-specifications/
Short list:
- 64-bit (x64) CPU;
- 1 GHz CPU + minimum 2 cores [those ancient CPUs are sooo slooow!];
- 4 GB RAM [questionable, sluggish, barely suitable for 
basic/required/routine/simple jobs/tasks!];
- minimum 64 GB [theoretical], average 80-120 GB [practical] free disk space 
[bloat much... that's a lot of wasted storage
space!];
- UEFI BIOS + Secure Boot [which effectively bans/blocks/rejects all OSes 
(Operating Systems) NOT approved/certified by
Microsoft, and those "secure boot keys" cost a pretty penny!]; [*]
- TPM (Trusted Platform Module) 2.0 [which effectively bans/blocks/rejects all 
OSes (Operating Systems) NOT
approved/certified by Microsoft, and those "secure boot keys" cost a pretty 
penny!]; [*]
- DX12 (DirectX 12) + WDDM (Windows Display Driver Model) 2.0 compliant video 
adapter;
- display/monitor/screen: minimum 720p [1280x720 px] resolution, minimum 9"/23cm
diagonal;
- Microsoft online account to initiate + complete the installation/setup process
[why? There is no need whatsoever for such
an annoyance, burden, hindrance + waste of time, and most importantly, it only 
increases the risk for
breach/hack/intrusion/invasion/spying/theft of personal privacy, safety + 
security, just by willingly giving Microsoft your
confidential/identifiable/personal/private/privileged 
biometrics/data/fingerprint/information/stats!]; [#]
- network/internet connection [why? The entire OS (Operating System) + all its 
components are stored locally on the setup
disk/drive/partition/volume!];
- audio system;
- keyboard;
- pointing device.
Reference @ Wikipedia:
http://en.wikipedia.org/wiki/Windows_11#System_requirements
http://en.wikipedia.org/wiki/
Comparison_of_Microsoft_Windows_versions#Hardware_requirements
[*][#] Say whaaat? Hard pass! Ergo... I don't see a Windows 11 upgrade in my 
future.
More info about Secure [a.k.a. Restricted] Boot:
- FSF (Free Software Foundation): Will your computer's "Secure Boot" turn out to
be "Restricted Boot"?:
http://www.fsf.org/campaigns/secure-boot-vs-restricted-boot/
- Matthew Garrett's Journal: Secure Boot and Restricted Boot:



http://mjg59.dreamwidth.org/23817.html
- reddit [r/]: Secure Boot Cost?:
http://www.reddit.com/r/linux/comments/14inl0c/
- Stack Exchange: How secure is Microsoft mandated UEFI Secure Boot, really?:
http://security.stackexchange.com/questions/16243/
- Microsoft Tech Community: UEFI Signing Requirements:
http://techcommunity.microsoft.com/t5/hardware-dev-center/updated-uefi-signing-
requirements/ba-p/1062916/
- Microsoft DOCs: Secure Boot:
http://learn.microsoft.com/windows-hardware/design/device-experiences/oem-
secure-boot/
[#] See "* FIX: Turn OFF/bypass Windows 10 build 22H2/newer + Windows 11 
Home/Pro 'Let's connect you to a Network' mandatory
pre-install dialog window prompt" topic -> part of "Tweaks, Hacks + Fixes... 
UNconventional, UNdocumented, UNcensored ;-/"
chapter further below in WIN10.TXT (this file):
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT
What's Wrong with This Picture:
*******************************
Some of these (forced) requirements are (among other things) questionable, allow
backdoors/flaws for, and expose
customers/owners/users to breaches, hacks, intrusions, invasion of personal 
privacy, spying, surveillance, theft, tracking,
inherent safety + security flaws/vulnerabilities, are counterproductive, 
limiting, restrictive, conducive to a waste of
money, resources + time, annoying, and (in many cases) way tooo slooow even for 
basic/necessary/required/routine/simple
every day jobs/tasks. :-(
http://arstechnica.com/gadgets/2024/02/windows-11-24h2-goes-from-unsupported-to-
unbootable-on-some-older-pcs/
Privacy, Safety + Security Concerns:
************************************
Sorry, but any computer/device/laptop/portable hardware locked [using Trusted 
Platform Module (TPM), Secure Boot, or any
other anti-competitive/exclusivist/limiting/restrictive method/technology] for 
the sole purpose of being limited/restricted
to using only Microsoft approved, certified, contracted, designed, leased, 
licensed and/or sold Operating Systems (OSes)
bundled and/or retailed for more money than they're worth, while stifling [in 
some cases illegaly, unethically, unfairly]
the competition, and it gets worse... behind your backs, dishonest, forced, 
hidden, without your
approval/consent/knowledge/permission, for profit, in certain cases, countries, 
territories and regions banned, illegal
marketing, monetizing and business tactics and strategies, unauthorized, 
disguised, hidden non-stop auditing, monitoring,
intrusive, invasive of your identifiable personal 
biometrics/data/fingerprint/information/stats, privacy, spying,
surveilling, tracking proprietary, closed source, secretive, anti-competitive, 
centered, exclusivist, deceitful,
monopolizing, crippling, limiting, restrictive, bundling, tying, take-over-style
Microsoft + their 3rd
party/affiliates/associates/branches/brands/companies/divisions/entities/
parents/partners/subsidiaries accounts, apps,
enrollments, memberships, remote (cloud, network, online) storage, services, 
subscriptions, etc is not worth a single
nanosecond of my time.
But don't take my word for it...
- gHacks: Windows 11 24H2 to enforce hardware requirement [CPUs without POPCNT 
instruction will NOT boot!]:
http://www.ghacks.net/2024/02/12/windows-11-24h2-to-enforce-hardware-
requirement/
Wikipedia: POPCNT (a subset of SSE4a instruction set):



http://en.wikipedia.org/wiki/SSE4#POPCNT_and_LZCNT
- Ars Technica: You'll need a Microsoft account to set up future versions of 
Windows 11 Pro:
http://arstechnica.com/gadgets/2022/02/new-preview-build-adds-microsoft-account-
requirement-to-windows-11-pro/
- How-To Geek: Set Up Windows 11 Without a Microsoft Account:
http://www.howtogeek.com/836157/how-to-use-windows-11-with-a-local-account/
- C|Net: Want to download Windows 11? You need to do these 2 things first:
http://www.cnet.com/tech/services-and-software/want-to-download-windows-11-you-
need-to-do-these-two-things-first/
- EnGadget: Windows 11 will add a watermark if you use unsupported hardware:
http://www.engadget.com/windows-11-watermark-unsupported-hardware-135550376.html
- The Verge: Windows 11 gets a new desktop watermark on unsupported hardware:
http://www.theverge.com/22988775/microsoft-hardware/
... and some good news for all who live in the European Union (E.U.) countries, 
nations, sovereignties, states +
territories:
- Ars Technica: On DMA (Digital Markets Act) eve Google whines, Apple sounds 
alarms, and TikTok wants out:
http://arstechnica.com/tech-policy/2024/03/on-dma-eve-google-whines-apple-
sounds-alarms-and-tiktok-wants-out/
- Microsoft Blogs: Previewing changes in Windows to comply with the Digital 
Markets Act (DMA) in the European Economic Area:
http://blogs.windows.com/windows-insider/2023/11/16/previewing-changes-in-
windows-to-comply-with-the-digital-markets-act-in-the-european-economic-area/
- Ars Technica: No Bing, no Edge, no upselling: De-crufted Windows 11 coming to 
Europe soon:
http://arstechnica.com/gadgets/2023/11/europeans-can-soon-strip-bing-edge-other-
microsoft-cruft-from-windows-11/
Ad(vertisement)s on Your Desktop:
*********************************
Microsoft's decades old dream finally happened... hard to believe, but the April
2024 Windows 11 22H2/23H2 beta channel
preview cummulative update [KB5036980] just went live, and is already filling 
your Start Menu with ads, or "recommendations"
+ "promotions" as Microsoft likes to call them, in order to make this "feature" 
more palatable for their customers:
http://www.theverge.com/2024/4/24/24138949/
http://www.bleepingcomputer.com/news/microsoft/windows-11-kb5036980-update-goes-
live-with-start-menu-ads/
http://www.techradar.com/computing/windows/bad-news-windows-11-users-ads-are-
coming-to-the-start-menu-but-theres-something-you-can-do-about-it/
Luckily at this point, you can [still!] disable them: Start Menu -> Settings -> 
Personalization -> Start -> turn OFF "Show
recommendations for tips, app promotions, and more".
Unfortunately this update will soon become mainstream, which means it will be 
distributed/pushed to all Windows 11 computers
on the planet via Windows Update [which is extremely hard to turn OFF], doesn't 
matter if you, as paying customer, want it
or not!
Interface Aesthetics, Design, Look + Feel:
******************************************
Not mentioning the fugly, flat, insipid, monotonous, uninteresting, bland, 
boring, inadequate, poorly designed user
interface (UI) with drab, dull, annoying desktop, interface colors (mostly lack 
thereof), backgrounds, icons + layout, all
inherited from the fiasco code named "Windows X" [latin cardinal numeral for 
"10" in arabic numerals]. ;-/
Conclusion:
***********
IMO... Windows 11 constitutes an unnecessary upgrade, worse than Windows 10. :-(
More info:
- Wikipedia: Windows 11:
http://en.wikipedia.org/wiki/Windows_11



- Wikipedia: List of features removed in Windows 11:
http://en.wikipedia.org/wiki/List_of_features_removed_in_Windows_11
- Windows 11 Criticism + Complaints:

- Wikipedia: Windows 11 Launch:
http://en.wikipedia.org/wiki/Windows_11#Launch
- PC Magazine: The 10 Worst Things About Windows 11:
http://www.pcmag.com/news/the-10-worst-things-about-windows-11/
- PC World: Windows 11 review: An unnecessary replacement for Windows 10:
http://www.pcworld.com/article/539183/windows-11-review-an-unnecessary-

replacement-for-windows-10.html
- TechTimes: Windows 11 Received Harsh Criticism Without Even Launching:
http://www.techtimes.com/articles/261841/20210623/windows-11-received-

harsh-criticism-without-even-launching.htm
- Ars Technica: Windows 11 has made the "clean Windows install" an 

oxymoron:
http://arstechnica.com/gadgets/2023/08/windows-11-has-made-the-clean-

windows-install-an-oxymoron/
- Digital Citizen: Windows 11 sucks: Reasons why you may not like it:
http://www.digitalcitizen.life/windows-11-sucks/
- MakeUseOf: 5 Common Complaints Users Have About Windows 11:
http://www.makeuseof.com/common-complaints-windows-11/

BEWARE:
*******
The worst is yet to come...
Microsoft is moving [slowly but surely] to cloud (network, online, remote) 
based, periodic subscription fee based operating
systems (OSes), apps, software + services, which means you as paying customers +
users are not going to be able to own or
control anything, and will be stuck in an endless loop with unfair, anti-
competitive, proprietary, unable to customize to
your needs or preferences, and you will be exposed to a world devoid of personal
privacy, safety, digital/online
choices/freedom/rights, in which you're going to be constantly audited, 
fingerprinted, monitored, profiled, spied upon,
under non-stop surveillance, tracked for marketing purposes and profit, having 
to tolerate annoying, behind-your-back,
forced, hard or (almost) impossible to disable/remove/stop/turn OFF/uninstall, 
in-your-face, time consuming, unwanted
ad(vertisement)s, commercials, promo(tion)s, unnecessary bloat, useless
apps/add-ons/banners/"experiences"/"features"/widgets/etc you never asked for, 
don't need or care about, and on top of
everything else you'll have to pay on a regular basis for their expensive
enrollment/maintenance/membership/renewal/service/subscription/support 
fees/prices in order to get all those "privileges".
More info:
http://www.theverge.com/2023/6/27/23775117/
http://www.pcworld.com/article/1969519/
http://www.techradar.com/news/could-windows-12-become-microsofts-first-cloud-
based-operating-system/
http://medium.com/@parami.vishal/microsofts-vision-a8ae10a3ddda/
______________________________________________________________________________

Turn OFF/Postpone/Block/Uninstall Windows Updates (WU)

* Turn OFF/delay/defer/pause/postpone/block/disable/stop/uninstall/delete/
rollback Windows Updates (WU) in Windows 10/11:
http://www.ghacks.net/2018/09/27/how-to-delay-feature-updates-in-windows-10/
http://admx.help/HKLM/Software/Policies/Microsoft/Windows/WindowsUpdate
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.WindowsUpdate::DeferFeatureUp



dates
http://www.askvg.com/windows-10-tip-change-maximum-days-limit-to-pause-windows-
updates-installation/
http://www.askvg.com/fixing-windows-10-automatic-updates-install-problem/
http://hashhackers.com/posts/easily-stop-windows-10-updates-for-your-desired-
time-period/
http://tipsmake.com/turn-off-the-win-10-update-stop-windows-10-from-updating-
automatically
http://www.repairwin.com/seven-methods-to-stop-windows-10-updates-that-actually-
work/
http://www.intowindows.com/how-to-pause-windows-update-download-in-windows-10/
http://www.tenforums.com/tutorials/96097-view-configured-update-policies-
windows-10-a-3.html
http://supportcommunity.zebra.com/s/article/Re-enable-windows-feature-updates/
http://troubleshooter.xyz/wiki/disable-windows-creators-update-notice-in-
windows-update/
http://forums.mydigitallife.net/threads/how-to-disable-updates-forever-windows-
10-pro.77148/page-3
http://pastebin.com/mdB7xQrs
http://syamdownloads.com/OnlineHelp/Management%20Utilities/
Windows10UpdatesControllingUpdat.html
http://www.winaero.com/defer-feature-updates-and-quality-updates-in-windows-10-
version-2004/
http://www.majorgeeks.com/content/page/
how_to_block_the_windows_10_version_1809_october_update.html
http://www.majorgeeks.com/content/page/how_to_uninstall_windows_10_updates.html
http://www.majorgeeks.com/content/page/
what_is_the_update_orchestrator_service.html
http://www.majorgeeks.com/content/page/
how_to_delete_pending_windows_updates.html
http://www.majorgeeks.com/content/page/
configure_when_and_how_windows_updates_are_delivered.html
http://www.majorgeeks.com/content/page/
how_to_change_rollback_days_for_windows_10_feature_upgrades.html
http://superuser.com/questions/1247989/
http://linustechtips.com/main/blogs/entry/1474-eleven-different-ways-to-disable-
windows-update-in-windows-10-updated-march-2019/
http://superuser.com/questions/1213206/
http://www.msfn.org/how-to-block-windows-10-upgrades-on-your-business-network-
and-at-home-too/
http://www.thewindowsclub.com/free-update-blocker-tools-to-stop-automatic-
windows-10-updates/
http://www.majorgeeks.com/content/page/
how_to_delete_pending_windows_updates.html
http://www.majorgeeks.com/content/page/
how_to_stop_windows_updates_from_downloading_drivers_on_windows_10.html
http://www.thewindowsclub.com/disable-delivery-optimization-via-group-policy-or-
registry-editor/
http://tipsmake.com/steps-to-fix-windows-computer-that-randomly-wakes-up-to-
check-for-updates
http://tipsmake.com/how-to-enable-disable-the-pause-updates-feature-for-windows-
update-in-windows-10
http://learn.microsoft.com/windows/deployment/update/waas-wu-settings/
FYI:
Show Hidden Windows Updates to be able to UNinstall them at will:
http://www.digitalcitizen.life/how-manage-installed-or-hidden-windows-updates/
http://pureinfotech.com/hide-updates-windows-10/
File:
http://download.microsoft.com/download/f/2/2/f22d5fdb-59cd-4275-8c95-
1be17bf70b21/wushowhide.diagcab
UNinstall Windows Updates:
http://www.makeuseof.com/manually-uninstall-windows-10-updates/

* BUGs, Crashes, LockUps, Loss of Data !!!



******************************************
Way too many official Microsoft Windows 10 and 11 
updates/upgrades/(hot)fixes/patches are buggy/faulty/flawed/unsafe,
generate errors, corrupt data, expose 
confidential/identifiable/personal/private/privileged protected/secure
biometrics/data/fingerprint/information/files/stats to security 
breaches/hacking/leaks/malware/spyware/tracking, crashes,
lock up many computer(s)/laptop(s)/server(s)/device(s), reboot/restart randomly,
unexpectedly in the middle of performing
critical/essential/vital/important tasks/operations/work, even cause loss of 
data/files, and here are just a few examples:
http://arstechnica.com/security/2024/03/hackers-exploited-windows-0-day-for-6-
months-after-microsoft-knew-of-it/
http://www.bleepingcomputer.com/news/microsoft/new-windows-updates-cause-
unsupported-processor-blue-screens/
http://arstechnica.com/security/2023/08/a-renegade-certificate-is-removed-from-
windows-then-it-returns-confusion-ensues/
http://arstechnica.com/security/2023/08/windows-feature-that-resets-system-
clocks-based-on-random-data-is-wreaking-havoc/
http://arstechnica.com/gadgets/2023/08/windows-11-has-made-the-clean-windows-
install-an-oxymoron/
http://arstechnica.com/security/2023/08/microsoft-cloud-security-blasted-for-
its-culture-of-toxic-obfuscation/
http://arstechnica.com/information-technology/2022/12/microsoft-digital-
certificates-have-once-again-been-abused-to-sign-malware/
http://arstechnica.com/information-technology/2022/10/how-a-microsoft-blunder-
opened-millions-of-pcs-to-potent-malware-attacks/
http://arstechnica.com/gadgets/2022/08/windows-11-and-server-2022-encryption-
bug-could-damage-data-on-newer-devices/
http://www.bleepingcomputer.com/news/microsoft/microsoft-defender-falsely-
detects-win32-hivezy-in-google-chrome-electron-apps/
http://arstechnica.com/gadgets/2018/10/microsoft-suspends-distribution-of-
latest-windows-10-update-over-data-loss-bug/
http://arstechnica.com/gadgets/2018/11/latest-windows-10-update-breaks-windows-
media-player-win32-apps-in-general/
http://arstechnica.com/information-technology/2016/08/windows-10-anniversary-
update-breaks-most-webcams/
http://www.bleepingcomputer.com/news/microsoft/microsofts-incomplete-
printnightmare-patch-fails-to-fix-vulnerability/
http://www.msfn.org/microsoft-issues-windows-10-upgrade-warning/
http://www.zdnet.com/article/microsofts-printnightmare-patch-is-now-causing-
problems-for-some-printers/
http://www.zdnet.com/article/get-updating-microsoft-delivers-printnightmare-
patch-for-more-windows-versions/
http://www.windowscentral.com/how-mitigate-printing-problems-update-kb5004945-
windows-10/
http://kotaku.com/1846864671/
http://www.techradar.com/news/new-windows-10-update-is-causing-a-whole-world-of-
pain/
http://betanews.com/2021/02/07/windows-10-updates-kb4598299-kb4598301-visual-
studio-problems/
http://www.komando.com/security-privacy/latest-windows-10-update-causing-
serious-issues-including-blue-screen-of-death/760098/
http://callnerds.com/windows-10-update-disaster-and-what-you-should-do-about-it/
http://www.pcmag.com/news/microsoft-re-releasing-windows-10-october-update-for-
all/
http://www.maketecheasier.com/latest-windows-10-update-problems/
http://www.howtogeek.com/658194/windows-10s-new-update-is-deleting-peoples-
files-again/
http://www.msfn.org/windows-latest-patches-crash-event-viewer-but-microsoft-has-
temporary-fix/
http://www.forbes.com/sites/gordonkelly/2020/05/19/microsoft-windows-10-warning-
crashes-bsod-chrome-browser-slowdown-gaming-problems-upgrade-windows-10-free/
http://www.pcmag.com/news/windows-10-update-degrades-performance-in-some-games/



http://www.forbes.com/sites/gordonkelly/2020/05/27/microsoft-issues-windows-10-
update-warning-kb4556799-free-windows-10-upgrade/
http://www.cnet.com/news/microsoft-windows-10-forced-updates-auto-restarts-are-
the-worst/
http://www.theregister.com/2022/11/17/microsoft_windows_10_fix/
... Would you like to know more? ;-/
http://www.youtube.com/watch?v=kdrjzE1SE58
http://en.wikipedia.org/wiki/Starship_Troopers_(film)#Politics_and_propaganda

* Bonus:
********
Turn OFF/block/disable/stop Windows 11 update:
http://www.easeus.com/knowledge-center/stop-windows-11-update.html
http://www.ghacks.net/2021/07/06/how-to-block-the-windows-11-update/
... These are the reasons why:
http://www.tomshardware.com/news/windows-11-sends-user-data-to-third-party-
services/
http://www.ghacks.net/2022/11/21/microsoft-is-turning-windows-11s-start-menu-
into-an-advertisement-delivery-system/

* FIXes:
********
The easy fix step-by-step:
Windows Update Blocker (WUB) [Wub.exe 32-bit + Wub_x64.exe 64-bit] for Windows 
10/11 32-bit (x86) + 64-bit (x64) allows all
users to block/disable/stop/turn OFF, and/or unblock/reenable/restart/turn back 
ON
automatic/unattended 
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission Microsoft Windows Updates (WU) service + 
interconnected/interdependent/interrelated
services [up to 25 services!] + program executables (.exe) which are very 
complicated/hard/almost impossible to
block/control/disable/manage/stop/turn OFF without performing complicated/time 
consuming operations, cumbersome registry
tweaks, or/and without dedicated 3rd party tools (like this one):
http://www.sordum.org/9470/
File [Portable ZIP]:
http://www.sordum.org/files/download/windows-update-blocker/Wub.zip
Screen shot:
http://www.sordum.org/wp-content/uploads/2020/10/
windos_update_blocker_blocked.png
Windows Update (WU) Tools:
http://www.majorgeeks.com/mg/sortdate/windows_update.html
See MDGx "On The Edge of A Hostile Takeover = Uninstall + Replace Edge While You
Still Can" chapter -> "REMEMBER:" section
in WIN10.TXT (included):
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT
1. Use an unZIPping/unARChiving/unRARing tool [free(ware)]
http://www.mdgx.com/toy.htm#ZIP
-> open "Wub.zip" archive -> extract "Wub_x64.exe" [for Windows 10/11 64-bit 
(x64)] or "Wub.exe" [for Windows 10/11 32-bit
(x86)] + "Wub.ini" into the same dedicated/empty directory/folder: I have used 
C:\TOOLS_10 in this example.
2. Open Explorer/similar/replacement -> right-click "Wub_x64.exe" [used in this 
example] -> Run as Administrator ->
(1) check "Disable Updates" box -> (2) check "Protect Services Settings" box -> 
(3) click "Apply Now" -> close/exit WUB.
http://www.sordum.org/wp-content/uploads/2020/10/
windos_update_blocker_blocked.png
3. Use WUB interface or edit WUB.ini (using a UNICODE compatible 
Notepad/similar/better plain text/ASCII editor) to



add/disable/enable Windows services [up to 25] (example):
http://www.thewindowsclub.com/windows-update-blocker/
Add these 5 Windows Update (WU) interconnected/interdependent/interrelated 
services:
- DoSvc [Delivery Optimization service]
- UsoSvc [Update Orchestrator service]
- WaaSMedicSvc [Windows Update Medic service]
- wuauserv [Windows Update (Automatic Updates) service]
- BITS [Background Intelligent Transfer service]
to your WUB.ini to make sure they will remain disabled upon every Windows 
(re)boot/(re)start (example):
-----snippity-snip-----
[Service_List]
; 2=Auto
; 3=Manual
; 4=Disabled
wuauserv=3,4
dosvc=3,4
WaaSMedicSvc=3,4
UsoSvc=3,4
BITS=3,4
-----snippity-snip-----
WUB.ini is the WUB configuration file (plain text/ASCII, UNICODE encoded), and 
contains all its settings.
WUB.ini is located in the same directory/folder as its parent executable(s): 
Wub.exe (32-bit) +/- Wub_x64.exe (64-bit).
4. Add this entry to your HKEY_LOCAL_MACHINE (HKLM) machine/system wide/all 
users registry "Run" subkey (example):
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
"WUB"="\"C:\\TOOLS_10\\Wub_x64.exe\" /D /P"
;
------End cut & paste here------
Wub_x64.exe (64-bit) = only for Windows 10/11 64-bit (x64).
If using Windows 10/11 32-bit (x86) = use Wub.exe (32-bit) instead.
In this example Wub_x64.exe is located in the C:\TOOLS_10 directory/folder.
Replace C:\\TOOLS_10 with your WUB directory/folder name (+ 
drive/partition/volume letter if other than C) = notice the
double backslash [\\] necessary in registry (.reg) files for 
drive/partition/volume letters + (sub)directory/(sub)folder
names demarcation.
See "REG Files" section under "Comprehensive Windows Registry Guide" [Intro 
Chapter] in REGISTRY.XT (included) for more
details:
http://www.mdgx.com/reg.htm#RF
5. OR:
Create a new task to run Windows Update Blocker (WUB) periodically scheduled 
(say once a day) in the background using
Task Scheduler [TaskSchd.msc] located in the %WinDir%\SYSTEM32 directory/folder 
[where %WinDir% = usually C:\WINDOWS]:
http://www.windowscentral.com/how-create-automated-task-using-task-scheduler-
windows-10/
Start -> Run... [hold WinKey + press R] -> type
TaskSchd.msc
-> press Enter -> right-click "Task Scheduler Library" directory/folder -> New 



Folder -> type directory/folder name
(Tasks_10 in this example) -> Action top menu option -> Create Basic Task -> 
Create Basic Task Wizard -> type new task name
in Name field (WUB_Run_Daily in this example) -> Next button -> check Daily box 
-> Next button -> check Start a program box
-> Program/script field -> Browse button -> go to (example used here)
C:\TOOLS_10\Wub_x64.exe
-> Add arguments (optional) box -> type
/D /P
-> press Finish button.
In this example Wub_x64.exe is located in the C:\TOOLS_10 directory/folder.
Replace C:\TOOLS_10 with your WUB directory/folder name.
Other tools similar to Windows Update Blocker (WUB) [free(ware)]:
http://www.majorgeeks.com/mg/sortdate/windows_update.html
InControl for Windows 10/11 allows all users to block/disable/stop/turn OFF or 
delay/defer/pause/postpone
automatic/unattended 
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission Microsoft Windows Updates (WU) + upgrades 
which are very complicated/hard/almost
impossible to block/control/disable/manage/stop/turn OFF without performing 
complicated/time consuming operations,
cumbersome registry tweaks, or/and without dedicated 3rd party tools (like this 
one):
http://www.grc.com/incontrol.htm
File:
http://www.grc.com/files/incontrol.exe
More details:
http://www.grc.com/incontrol/details.htm
Wu10Man for Windows 10 stops Windows Updates (WU) by tweaking Registry (Group 
Policy), disabling services + blocking URLs:
http://weredev.com/developer/wu10man/
http://github.com/WereDev/Wu10Man/
Download:
http://github.com/WereDev/Wu10Man/releases/latest/
Requires Microsoft .NET Framework Redistributable (NFR) 4.7.2/newer:
http://www.mdgx.com/add.htm#NFR
5. Restart/reboot Windows for all changes to take effect.

* TWEAKs:
*********
Control exactly if, how, when + where files from Windows Updates (WU) will be 
allowed/blocked, downloaded to + installed on
your computer(s)/laptop(s)/device(s).
Free(ware) tools:
- WindowsSpyBlocker 32-bit for Windows 10/newer blocks Microsoft
dangerous/deceptive/insecure/invasive/intrusive/subversive/unsafe IPs based on 
blocking rules [spy (spyware, surveillance,
telemetry, tracking), Windows Update (WU) + extra (Microsoft apps + services)] +
blocklists, highly customizable:
http://crazymax.dev/WindowsSpyBlocker/
Download [Portable EXE]:
http://github.com/crazy-max/WindowsSpyBlocker/releases/latest/
WindowsSpyBlocker Repository:
http://github.com/crazy-max/WindowsSpyBlocker/
Usage Guide:
http://crazymax.dev/WindowsSpyBlocker/app/
Blocking Rules Guide:
http://crazymax.dev/WindowsSpyBlocker/blocking-rules/
- Windows Update MiniTool (WUMT) 32-bit + 64-bit tweaks, downloads, 
(un)installs, deletes +/- blocks Windows Updates (WU):
http://win10.guru/toolkit-item-windows-update-minitool-wumt/
Download:



http://www.majorgeeks.com/files/details/windows_update_minitool.html
- More Windows Update (WU) Tools:
http://www.majorgeeks.com/mg/sortdate/windows_update.html
- See "Similar Windows 7/newer Anti-Spyware/Privacy Tools" chapter in 
10_BLOCK.TXT (included + part of 10_BLOCK.ZIP) for a
list of anti-spyare + privacy tools:
Brief Guide:
http://www.mdgx.com/xptoy.htm#10BLK
10_BLOCK ReadMe Guide:
http://www.mdgx.com/10BLK/10_BLOCK.php
10_BLOCK.ZIP:
http://www.mdgx.com/10BLK/10_BLOCK.ZIP

That's it, you're done, you can stop reading now. ;-/
******************************************************************************
Naaah... I'm just messin' with you. :-) And now... The Long and Winding Road,
http://andrewgodsell.wordpress.com/2016/05/17/the-beatles-in-wonderland/
for those dedicated minds who'd like to know how to overcome Microsoft obstacles
+ reclaim control over their rightfully
owned Windows computers... ;-/

* OPTIONAL Steps + Explanation:
*******************************
All steps below are optional if you wish to do this step-by-step by 
hand/manually, or/and if you'd like to learn about the
complicated process and the tremendous length Microsoft went (and is still 
going) to in order to forbid Windows 10/11 users
from disabling/stopping Windows Updates. Wow... mind blown!
http://media.tenor.com/6gEFCYhPwV0AAAAd/blown-mind-blown.gif
WUB Brief Explanation:
**********************
Windows Update Blocker (WUB) disables + protects (by changing ownership access, 
level, permissions, privileges, rights,
modifying, renaming +/- overwriting them) these Windows Updates (WU) 
interconnected/interdependent/interrelated services:
- Backup Scan = runs by default upon every (re)boot + periodically in the 
background -> %SystemRoot%\system32\usoclient.exe
- Schedule Scan = runs by default upon every (re)boot + periodically in the 
background -> %SystemRoot%\system32\usoclient.exe
- Schedule Scan Static Task = runs by default upon every (re)boot + periodically
in the background -> %SystemRoot%\system32\usoclient.exe
- UpdateModelTask = runs by default upon every (re)boot + periodically in the 
background -> %SystemRoot%\system32\usoclient.exe
- USO_UxBroker = runs by default upon every (re)boot + periodically in the 
background -> %SystemRoot%\system32\MusNotification.exe
found in this scheduled Tasks directory/folder:
%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\UpdateOrchestrator
and also turns off, disables + protects (by changing ownership access, level, 
permissions, privileges, rights, modifying,
renaming +/- overwriting them) these Windows Updates (WU) 
interconnected/interdependent/interrelated services -> see
respective Registry + BATch files below:
- DoSvc [Delivery Optimization service]
- UsoSvc [Update Orchestrator service]
- WaaSMedicSvc [Windows Update Medic service]
http://appuals.com/what-is-waasmedic-and-how-to-disable-it-and-fix-it/
- wuauserv [Windows Update (Automatic Updates) service]
WUB also stops temporarily this related service:
- BITS [Background Intelligent Transfer service]
WUB adds these REG_DWORD (DWORD) 32-bit values to the registry for all 4 Windows
Updates (WU)
interconnected/interdependent/interrelated services listed above + an entire 
list of Windows Update (WU)/Upgrade
executables, effectively disabling them, thus preventing them from running 



unoticed in the background, behind your back:
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DoSvc]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\UsoSvc]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\wuauserv]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\DoSvc]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\UsoSvc]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WaaSMedicSvc]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\wuauserv]
"WubLock"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options]
"WubBlockLists"=hex(7):57,61,61,53,4d,65,64,69,63,2e,65,78,65,00,57,61,61,73,\
  4d,65,64,69,63,41,67,65,6e,74,2e,65,78,65,00,57,69,6e,64,6f,77,73,31,30,55,\
  70,67,72,61,64,65,2e,65,78,65,00,57,69,6e,64,6f,77,73,31,30,55,70,67,72,61,\
  64,65,72,41,70,70,2e,65,78,65,00,55,70,64,61,74,65,41,73,73,69,73,74,61,6e,\
  74,2e,65,78,65,00,55,73,6f,43,6c,69,65,6e,74,2e,65,78,65,00,72,65,6d,73,68,\
  2e,65,78,65,00,45,4f,53,6e,6f,74,69,66,79,2e,65,78,65,00,53,69,68,43,6c,69,\
  65,6e,74,2e,65,78,65,00,75,70,66,63,2e,65,78,65,00,49,6e,73,74,61,6c,6c,41,\
  67,65,6e,74,2e,65,78,65,00,4d,75,73,4e,6f,74,69,66,69,63,61,74,69,6f,6e,2e,\
  65,78,65,00,4d,75,73,4e,6f,74,69,66,69,63,61,74,69,6f,6e,55,78,2e,65,78,65,\
  00,00,00
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\InstallAgent.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MusNotification.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MusNotificationUx.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\remsh.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\SihClient.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\UpdateAssistant.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\upfc.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\UsoClient.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\WaaSMedic.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\WaasMedicAgent.exe]
"Debugger"="/"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\Windows10Upgrade.exe]
"Debugger"="/"



[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\Windows10UpgraderApp.exe]
"Debugger"="/"
;
------End cut & paste here------
Original (unmodified) Windows 10 Windows Updates (WU) built-in scheduled tasks 
are found in these TrustedInstaller
(%WinDir%\servicing\TrustedInstaller.exe = %WinDir% is usually C:\WINDOWS) 
Microsoft built-in user account [special "VIP"
type user created by Microsoft as "master overseer"] protected 
directories/folders, which are
disabled/forbidden/locked/unavailable to any (other) user, even to the 
computer/device owner/main/only user, even with
Admin(istrator)/Sysadmin/SYSTEM level of access/permissions/privileges/rights:
- C:\WINDOWS\SYSTEM32\Tasks\Microsoft\Windows\UpdateOrchestrator :
Backup Scan
Maintenance Install
Reboot_AC Reboot_Battery
Schedule Scan
Schedule Scan Static Task
UpdateModelTask
USO_UxBroker
- C:\WINDOWS\SYSTEM32\Tasks\Microsoft\Windows\WaaSMedic :
PerformRemediation
- C:\WINDOWS\SYSTEM32\Tasks\Microsoft\Windows\WindowsUpdate :
Scheduled Start
sihpostreboot
To be allowed to access all these scheduled tasks one must take ownership + 
grant themselves Adminnistrator level privileges
to the respective directories/folders + files from a DOS console (command 
prompt) -> right-click CMD shortcut/CMD.EXE -> Run
as Administrator -> run these commands -> press Enter after each line:
TAKEOWN.EXE /f "%WinDir%\SYSTEM32\Tasks" /r /d y
ICACLS.EXE "%WinDir%\SYSTEM32\Tasks" /grant:r %UserName%:F /t /c /q
iCACLs [ICACLS.EXE] + TakeOwn [TAKEOWN.EXE] DOS console command line tools are 
both located in the %WinDir% directory/folder
[%WinDir% = usually C:\WINDOWS].
ICACLS.EXE:
http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/
You can also do this using a graphical user interface (GUI) tool:
NTFS Permissions Tools (NPT) 32-bit + 64-bit display/modify/add/delete NTFS ACLs
file system security options/owner:
http://www.majorgeeks.com/files/details/ntfs_permissions_tools.html
Download:
http://www.softpedia.com/get/Internet/Servers/Server-Tools/NTFS-Permissions-
Tools.shtml#download
Then rename all the Tasks subfolders listed above to anything else (example) 
from a DOS console (command prompt) ->
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
REN %WinDir%\SYSTEM32\Tasks\Microsoft\Windows\UpdateOrchestrator 
UpdateOrchestrator_OLD
REN %WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WaaSMedic WaaSMedic_OLD
REN %WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WindowsUpdate WindowsUpdate_OLD
OR run Task Scheduler MMC snap-in:
MMC.EXE /S taskschd.msc
and disable all the tasks listed above -> right-click on each one of them 1 at a



time -> click Disable each time.
FYI:
TrustedInstaller (%WinDir%\servicing\TrustedInstaller.exe = %WinDir% is usually 
C:\WINDOWS) is Windows NTx [Vista/newer]
Microsoft built-in user account [special "VIP" type user created by Microsoft as
"master overseer"] with privileged,
above-admin, system wide rights which performs automatic/unattended
behind-your-back/forced/disguised/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission operations, for example: downloads, 
updates, installs/uninstalls,
closes/executes/(re)starts/(re)schedules dynamic link libraries 
(DLLs)/executables/services/tasks/scripts, modifies the
Registry, creates/copies/renames/modifies/moves/deletes files/folders, 
modifies/takes over files/folders
ownership/permissions/attributes, reboots/restarts/shuts down Windows.
See also "Everything About The Infamous (Not So) Trusted Installer" in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
How to stop Windows Updates (WU) [wuauserv] service + TrustedInstaller 
[TrustedInstaller.exe] process:
1. Run... [hold WinKey + press R] -> type:
services.msc
-> press Enter -> double-click Windows Updates (WU) service -> Stop button -> 
wait for service to stop -> OK button ->
immediately double-click Windows Updates (WU) again -> General tab -> Startup 
type: -> select Manual -> Recovery tab ->
"First Failure:", "Second Failure:" + "Subsequent Failures:" -> select Take No 
Action for all 3 types of Failure -> OK
button.
2. Hold Ctrl + Shift + press Esc -> Task Manager (%WinDir%\SYSTEM32\TaskMgr.exe)
-> Processes tab -> right-click
TrustedInstaller.exe -> End task -> End process button -> close Task Manager.
All attempts to stop and/or disable these 
services/executables/processes/scheduled tasks manually by using:
Services MMC snap-in (%WinDir%\SYSTEM32\Services.msc)
Task Scheduler MMC snap-in (%WinDir%\SYSTEM32\TaskSchd.msc)
RegEdit (%WinDir%\REGEDIT.EXE)
built-in DOS command console tools (examples): REG.EXE, NET.EXE, SC.EXE, 
TASKKILL.EXE, etc,
are usually unsuccessful on their own/by themselves, or when performed as any 
user other than TrustedInstaller, because
Windows restarts/reschedules/restores them afterwards almost immediately, or 
after a certain amount of time preset in the
built-in scheduled tasks/services/API/registry settings/run commands, and/or 
after the next restart/reboot.
That's why multiple consecutive steps need to be performed in a certain order 
for this to succeed.
1st Things 1st:
***************
BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> See "BACKUP/EXPORT + 
RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
Step 1:
*******
Delay/defer/pause/postpone Windows Update service (WuauServ) by running BATch 
file below:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the



lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
REG.EXE ADD "HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\
WindowsUpdateSysprepInProgress" /f
WMIC.EXE service wuauserv call StopService
RUNDLL32.EXE wuaueng.dll,GeneralizeForImaging
:END
EXIT
------End cut & paste here------
WMIC [WMIC.EXE] is located in the %WinDir%\SYSTEM32\wbem directory/folder 
[%WinDir% = usually C:\WINDOWS], which is listed
on your system PATH.
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
WMIC (Windows Management Instrumentation Command):
http://learn.microsoft.com/windows/win32/wmisdk/wmic/
MS DOCs: WMIC:
http://technet.microsoft.com/library/bb742610.aspx
Dedoimedo: WMIC - The Windows secret weapon:
http://www.dedoimedo.com/computers/windows-wmic.html
ComputerHope: WMIC:
http://www.computerhope.com/wmic.htm
Rob van der Woude: WMIC:
http://www.robvanderwoude.com/wmic.php
quux: WMIC Snippets:
http://quux.wiki.zoho.com/WMIC-Snippets.html
SS64: WMIC.EXE:
http://www.ss64.com/nt/wmic.html
Wikipedia: WMI:
http://en.wikipedia.org/wiki/Windows_Management_Instrumentation
Step 2:
*******
Delay/defer/pause/postpone Windows Update (WU) by running registry (.reg) file 
below [in this example WU postpone date has
been set to > 50 years into the future: 2077-07-07 ;-/]:
http://support.microsoft.com/help/328010/
http://github.com/vFense/vFenseAgent-win/wiki/Registry-keys-for-configuring-
Automatic-Updates-&-WSUS/
http://www.smallvoid.com/article/winnt-automatic-updates-config.html
http://admx.help/HKLM/Software/Policies/Microsoft/WindowsStore
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsSelfHost\UI\Visibility]
"HideInsiderPage"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsUpdate\UX]
"IsConvergedUpdateStackEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsUpdate\UX\Settings]
"AllowAutoWindowsUpdateDownloadOverMeteredNetwork"=dword:0



"BranchReadinessLevel"=dword:10
"ConfigureDeadlineForFeatureUpdates"=dword:1e
"ConfigureDeadlineForQualityUpdates"=dword:1e
"DeferFeatureUpdates"=dword:1
"DeferFeatureUpdatesPeriodInDays"=dword:16d
"DeferQualityUpdatesPeriodInDays"=dword:16d
"DeferQualityUpdates"=dword:1
"DeferQualityUpdatesPeriodInDays"=dword:1e
"DeferUpgrade"=dword:1
"DeferUpgradePeriod"=dword:8
"DeferUpdatePeriod"=dword:4
"DisableWindowsUpdateAccess"=dword:1
"DoNotConnectToWindowsUpdateInternetLocations"=dword:1
"ExcludeWUDriversInQualityUpdate"=dword:1
"FlightCommitted"=dword:0
"FlightSettingsMaxPauseDays"=dword:99999999
"HideMCTLink"=dword:1
"InsiderProgramEnabled"=dword:0
"LastToastAction"=dword:0
"PauseDeferrals"=dword:1
"PauseFeatureUpdatesStartTime"="2015-05-05T05:05:05Z"
"PauseQualityUpdatesStartTime"="2015-05-05T05:05:05Z"
; Next 3 values delay/defer/pause/postpone WU until 2077 (example), can be 
extended to any acceptable date:
"PauseUpdatesExpiryTime"="2077-07-07T07:07:07Z"
"PauseFeatureUpdatesEndTime"="2077-07-07T07:07:07Z"
"PauseQualityUpdatesEndTime"="2077-07-07T07:07:07Z"
"RestartNotificationsAllowed"=dword:1
"SetDisableUXWUAccess"=dword:1
"UxOption"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\WindowsUpdate]
"AllowAutoWindowsUpdateDownloadOverMeteredNetwork"=dword:0
"BranchReadinessLevel"=dword:10
"ConfigureDeadlineForFeatureUpdates"=dword:1e
"ConfigureDeadlineForQualityUpdates"=dword:1e
"DeferFeatureUpdates"=dword:1
"DeferFeatureUpdatesPeriodInDays"=dword:16d
"DeferQualityUpdatesPeriodInDays"=dword:1e
"DeferQualityUpdates"=dword:1
"DeferQualityUpdatesPeriodInDays"=dword:1e
"DeferUpgrade"=dword:1
"DeferUpgradePeriod"=dword:8
"DeferUpdatePeriod"=dword:4
"DisableOSUpgrade"=dword:1
"DisableWindowsUpdateAccess"=dword:1
"DoNotConnectToWindowsUpdateInternetLocations"=dword:1
"ElevateNonAdmins"=dword:1
"ExcludeWUDriversInQualityUpdate"=dword:1
"FlightCommitted"=dword:0
; "FlightSettingsMaxPauseDays"=dword:000f4240
"FlightSettingsMaxPauseDays"=dword:99999999
"HideMCTLink"=dword:1
"InsiderProgramEnabled"=dword:0
"LastToastAction"=dword:0
"ManagePreviewBuilds"=dword:1
"ManagePreviewBuildsPolicyValue"=dword:0
"PauseDeferrals"=dword:1
"PauseFeatureUpdatesStartTime"="2015-05-05T05:05:05Z"
"PauseQualityUpdatesStartTime"="2015-05-05T05:05:05Z"
; Next 3 values delay/defer/pause/postpone WU until 2077 (example), can be 
extended to any acceptable date:
"PauseUpdatesExpiryTime"="2077-07-07T07:07:07Z"
"PauseFeatureUpdatesEndTime"="2077-07-07T07:07:07Z"
"PauseQualityUpdatesEndTime"="2077-07-07T07:07:07Z"



"RestartNotificationsAllowed"=dword:1
"SetDisableUXWUAccess"=dword:1
"TargetReleaseVersion"=dword:1
"TargetReleaseVersionInfo"="0000"
"UxOption"=dword:0
; These Windows Server Update Services (WSUS) server IPs are bogus, of 
course. ;-/
; Alternatively you can use built-in local server IPs instead: null [0.0.0.0], 
or localhost [127.0.0.1]:
"WUServer"="localserver.localdomain.wsus"
"WUStatusServer"="localserver.localdomain.wsus"
"UpdateServiceUrlAlternate"="wsus.localdomain.localserver"
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\WindowsUpdate\AU]
"AutoInstallMinorUpdates"=dword:0
"NoAutoUpdate"=dword:1
"NoAutoRebootWithLoggedOnUsers"=dword:1
"NoAUAsDefaultShutdownOption"=dword:1
"RebootRelaunchTimeout"=dword:3
"RebootRelaunchTimeoutEnabled"=dword:1
"UseWUServer"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\WindowsUpdate\Auto
Update]
"NextSqmReportTime"="0"
"NextFeaturedUpdatesNotificationTime"="0"
"EnableFeaturedSoftware"=dword:0
"FeaturedUpdatesNotificationSeqNum"=dword:0
"FeaturedUpdatesNotificationSeqNumGenTime"="0"
"SetupWizardLaunchTime"="0"
"ForcedReboot"=dword:0
"AUOptions"=dword:1
"ConfigVer"=dword:1
"BalloonTime"="0"
"ScheduledInstallDay"=dword:0
"ScheduledInstallTime"=dword:0
"IncludeRecommendedUpdates"=dword:0
"NextDetectionTime"="0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"NoWindowsUpdate"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"NoWindowsUpdate"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\WindowsUpdate\
OSUpgrade]
"AllowOSUpgrade"=dword:0
"ReservationsAllowed"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\WindowsUpdate\
OSUpgrade\State]
"OSUpgradeState"=dword:1
"OSUpgradeStateTimeStamp"="2015-05-05 05:05:05"
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\WindowsStore]
"DisableOSUpgrade"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\Setup\UpgradeNotification]
"UpgradeAvailable"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsUpdate\UpdatePolicy\Settings]
"PausedFeatureStatus"=dword:1
"PausedQualityStatus"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Notifications\
Settings]
"Windows.SystemToast.Suggested"=dword:0
;
------End cut & paste here------
Step 3:
*******
Microsoft SubInACL [SUBINACL.EXE] 32-bit command line tool for Windows 
2000/newer displays/modifies/migrates NTFS ACL file



system/registry security options/owner:
http://web.archive.org/web/20190828204406/http://www.microsoft.com/en-us/
download/details.aspx?id=23510
File [MSI Installer]:
http://web.archive.org/web/20190910062448if_/http://download.microsoft.com/
download/1/7/d/17d82b72-bc6a-4dc8-bfaa-98b37b22b367/subinacl.msi
More info:
http://www.mdgx.com/xptoy.htm#SIA
SubInACL Documentation:
http://www.mdgx.com/fmnt32/SUBINACL.HTM
Install 7-Zip unZIPping/unARChiving/unRARing tool (free GPL):
http://www.7-zip.org/
Use 7-Zip File Manager (7zFM.exe) to extract SubInACL (SUBINACL.EXE) from 
subinacl.msi (see above) to a directory/folder of
your choice, preferably one listed in your system PATH (example):
C:\WINDOWS\SYSTEM32
View your system path from a DOS console command prompt -> right-click CMD 
shortcut/CMD.EXE -> Run as Administrator -> run
this command -> press Enter:
SET PATH
Turn OFF all 4 Windows Update (WU) interconnected/interdependent/interrelated 
services (+ stop BITS service temporarily) by
running BATch file below:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
:: Make sure SUBINACL.EXE resides in a directory/folder listed in your system 
PATH -> see above.
SUBINACL.EXE /keyreg "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services" 
/setowner=%UserName% /grant=%UserName%=f
SUBINACL.EXE /keyreg "HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services" 
/setowner=%UserName% /grant=%UserName%=f
SUBINACL.EXE /keyreg "HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services" 
/setowner=%UserName% /grant=%UserName%=f
REG.EXE EXPORT "HKLM\SYSTEM\CurrentControlSet\Services\BITS" BITS.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet001\Services\BITS" BITS001.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet002\Services\BITS" BITS002.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\CurrentControlSet\Services\DoSvc" Dosvc.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet001\Services\DoSvc" Dosvc001.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet002\Services\DoSvc" Dosvc002.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\CurrentControlSet\Services\UsoSvc" UsoSvc.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet001\Services\UsoSvc" UsoSvc001.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet002\Services\UsoSvc" UsoSvc002.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc" 
WaaSMedicSvc.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet001\Services\WaaSMedicSvc" 
WaaSMedicSvc001.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet002\Services\WaaSMedicSvc" 
WaaSMedicSvc002.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\CurrentControlSet\Services\wuauserv" wuauserv.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet001\Services\wuauserv" wuauserv001.reg /y
REG.EXE EXPORT "HKLM\SYSTEM\ControlSet002\Services\wuauserv" wuauserv002.reg /y
REG.EXE DELETE "HKLM\SYSTEM\CurrentControlSet\Services\BITS\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet001\Services\BITS\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet002\Services\BITS\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\CurrentControlSet\Services\DoSvc\Security" /f



REG.EXE DELETE "HKLM\SYSTEM\ControlSet001\Services\DoSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet002\Services\DoSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\CurrentControlSet\Services\UsoSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet001\Services\UsoSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet002\Services\UsoSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet001\Services\WaaSMedicSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet002\Services\WaaSMedicSvc\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\CurrentControlSet\Services\wuauserv\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet001\Services\wuauserv\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet002\Services\wuauserv\Security" /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\BITS" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\BITS" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\BITS" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\DoSvc" /v LaunchProtected /t
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\DoSvc" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\DoSvc" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\UsoSvc" /v 
LaunchProtected /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\UsoSvc" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\UsoSvc" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc" /v 
LaunchProtected /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WaaSMedicSvc" /v LaunchProtected
/t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WaaSMedicSvc" /v LaunchProtected
/t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\wuauserv" /v LaunchProtected
/t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\wuauserv" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\wuauserv" /v LaunchProtected /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\BITS" /v UserServiceFlags /t
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\BITS" /v UserServiceFlags /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\BITS" /v UserServiceFlags /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\DoSvc" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\DoSvc" /v UserServiceFlags /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\DoSvc" /v UserServiceFlags /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\UsoSvc" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\UsoSvc" /v UserServiceFlags /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\UsoSvc" /v UserServiceFlags /t 
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WaaSMedicSvc" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WaaSMedicSvc" /v 



UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\wuauserv" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\wuauserv" /v UserServiceFlags /t
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\wuauserv" /v UserServiceFlags /t
REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\BITS" /v Start /t 
REG_DWORD /d 3 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\BITS" /v Start /t REG_DWORD /d 3
/f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\BITS" /v Start /t REG_DWORD /d 3
/f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\DoSvc" /v Start /t REG_DWORD
/d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\DoSvc" /v Start /t REG_DWORD /d 
4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\DoSvc" /v Start /t REG_DWORD /d 
4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\UsoSvc" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\UsoSvc" /v Start /t REG_DWORD /d
4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\UsoSvc" /v Start /t REG_DWORD /d
4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WaaSMedicSvc" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WaaSMedicSvc" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\wuauserv" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\wuauserv" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\wuauserv" /v Start /t 
REG_DWORD /d 4 /f
ECHO Y|NET.EXE STOP BITS
SC.EXE CONFIG BITS START= demand
ECHO Y|NET.EXE STOP DoSvc
SC.EXE CONFIG DoSvc START= disabled
ECHO Y|NET.EXE STOP UsoSvc
SC.EXE CONFIG UsoSvc START= disabled
ECHO Y|NET.EXE STOP WaaSMedicSvc
SC.EXE CONFIG WaaSMedicSvc START= disabled
ECHO Y|NET.EXE STOP wuauserv
SC.EXE CONFIG wuauserv START= disabled
:END
EXIT
------End cut & paste here------
Step 4:
*******
Turn OFF all 4 (+ 1) Windows Update (WU) 
interconnected/interdependent/interrelated services by running REG file below:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4



; Background Intelligent Transfer service (BITS):
; http://lifehacker.com/1786614642/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\BITS\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\BITS\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\BITS]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:3
; Delivery Optimization service (DoSvc):
; http://www.techwibe.com/dosvc-bandwidth-eating-windows-10-permanent-solution-
fix/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DoSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DoSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DoSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
; Update Orchestrator service (UsoSvc):
; http://www.techwibe.com/what-does-usosvc-do-and-how-to-disable-usovsc/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\UsoSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\UsoSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\UsoSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
; Windows Update Medic service (WaaSMedicSvc):
; http://www.thewindowsclub.com/windows-update-blocker/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WaaSMedicSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
; Windows Update (Automatic Updates) service (wuauserv):
; http://lifehacker.com/1786614642/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\wuauserv\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\wuauserv\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\wuauserv]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\DoSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\DoSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\DoSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\UsoSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\UsoSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\UsoSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WaaSMedicSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WaaSMedicSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WaaSMedicSvc]



"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\wuauserv\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\wuauserv\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\wuauserv]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\DoSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\DoSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\DoSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\UsoSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\UsoSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\UsoSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WaaSMedicSvc\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WaaSMedicSvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WaaSMedicSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\wuauserv\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\wuauserv\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\wuauserv]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
;
------End cut & paste here------
Step 5:
*******
Rename the %WinDir%\SoftwareDistribution [%WinDir% = usually C:\WINDOWS] 
directory/folder to something else (example) by
running BATch file below:
http://tipsmake.com/how-to-change-the-download-folder-windows-update-in-windows-
10
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
TAKEOWN.EXE /f "%WinDir%\SoftwareDistribution" /r /d y
ICACLS.EXE "%WinDir%\SoftwareDistribution" /grant:r %UserName%:F /t /c /q
REN "%WinDir%\SoftwareDistribution" SoftwareDistribution_OLD
:END
EXIT
------End cut & paste here------



OR delete the %WinDir%\SoftwareDistribution directory/folder altogether (but 
back it up first if it contains anything!) by
running BATch file below:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
TAKEOWN.EXE /f "%WinDir%\SoftwareDistribution" /r /d y
ICACLS.EXE "%WinDir%\SoftwareDistribution" /grant:r %UserName%:F /t /c /q
DEL /F /Q /S "%WinDir%\SoftwareDistribution\*.*"
RD /Q /S "%WinDir%\SoftwareDistribution"
:END
EXIT
------End cut & paste here------
ICACLS.EXE:
http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/
Step 6:
*******
Rename all Windows Updates (WU) interconnected/interdependent/interrelated 
scheduled tasks directories/folders to any other
names (example) by running BATch file below:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
TAKEOWN.EXE /f "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\UpdateOrchestrator" /r
/d y
ICACLS.EXE "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\UpdateOrchestrator" 
/grant:r %UserName%:F /t /c /q
REN "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\UpdateOrchestrator" 
UpdateOrchestrator_OLD
TAKEOWN.EXE /f "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WaaSMedic" /r /d y
ICACLS.EXE "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WaaSMedic" /grant:r 
%UserName%:F /t /c /q
REN "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WaaSMedic" WaaSMedic_OLD
TAKEOWN.EXE /f "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WindowsUpdate" /r /d y
ICACLS.EXE "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WindowsUpdate" /grant:r 
%UserName%:F /t /c /q
REN "%WinDir%\SYSTEM32\Tasks\Microsoft\Windows\WindowsUpdate" WindowsUpdate_OLD
:END
EXIT
------End cut & paste here------
ICACLS.EXE:



http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/
Step 7 [last 1]:
****************
Last but not least, restart/reboot Windows for all changes to take effect.

* SAFE INSTALL:
***************
Install by hand/manually downloaded/local/offline individual/separate CAB 
(.cab)/EXE (.exe)/MSU (.msu) Updates from
Windows Updates Catalog (WUC) in Windows 7/8/1.8/10/11:
http://woshub.com/manually-install-cab-msu-updates-windows/
This can be done even if Windows Update (WU) feature/service is 
blocked/disabled/turned OFF on your computer(s)/device(s),
and multiple such updates can be included in BATch (.bat)/CoMmanD (.cmd) files 
for automated/unattended install/upgrade
purposes.
In case you add more than 1 such commands to the same batch file [.bat or .cmd],
you should precede each command line with
"START /wait " (generic example):
START /wait WUSA.EXE "%UserProfile%\Downloads\Update_1.msu" /quiet /norestart
START /wait WUSA.EXE "%UserProfile%\Downloads\Update_2.msu" /quiet /norestart
START /wait WUSA.EXE "%UserProfile%\Downloads\Update_3.msu" /quiet /norestart
WUSA (Windows Update Standalone Installer) [WUSA.EXE] executable is located in 
the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
Alternatively you can extract the main CAB (.cab) file (with identical/similar 
name as the MSU file) from the parent MSU
(.msu) installer using an unZIPping/unARChiving/unRARing tool [free(ware)]
http://www.mdgx.com/toy.htm#ZIP
and install it from a DOS console (command prompt) -> right-click CMD 
shortcut/CMD.EXE -> Run as Administrator -> run this
command line (generic example: replace Update text string below with the actual 
CAB file name):
DISM.EXE /Online /Add-Package /PackagePath:Update.cab /Quiet /NoRestart
In case you run more than 1 such commands, or if you add more than 1 such 
commands to the same batch file [.bat or .cmd],
you should precede each command line with "START /wait " (generic example):
START /wait DISM.EXE /Online /Add-Package /PackagePath:Update_1.cab /Quiet 
/NoRestart
START /wait DISM.EXE /Online /Add-Package /PackagePath:Update_2.cab /Quiet 
/NoRestart
START /wait DISM.EXE /Online /Add-Package /PackagePath:Update_3.cab /Quiet 
/NoRestart
DISM (Deployment Image Servicing and Management) [DISM.EXE] executable is 
located in the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
NOTE:



See also "Turn OFF/Postpone/Block/Uninstall Windows Updates (WU)" further above:
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT
1. Search Windows Updates (WU) Catalog for the particular update(s) you wish to 
install (example):
http://www.catalog.update.microsoft.com/search.aspx?q=cumulative%20x64%20windows
%2010
http://www.catalog.update.microsoft.com/search.aspx?q=%22Windows%2010%22
Make sure the update(s) you select match the Windows NTx [7/newer] operating 
system(s) [OS(es)]
build/edition/release/update/version + bit strength [32-bit (x86) or 64-bit 
(x64)] you are using.
2. Download this file (example):
http://download.windowsupdate.com/c/msdownload/update/software/secu/2020/10/
windows10.0-kb4579311-x64_9cc8221b0ed1bc799278d029c4edadf785920da9.msu
to your %UserProfile%\Downloads directory/folder [default]:
%UserProfile%\Downloads\windows10.0-kb4579311-
x64_9cc8221b0ed1bc799278d029c4edadf785920da9.msu
MSKB 4579311 Info:
http://support.microsoft.com/help/4579311/
MSKB 4579311 Downloads (from MS Catalog Update):
http://www.catalog.update.microsoft.com/search.aspx?q=KB4579311
MSKB 4579311 Bugs:
http://betanews.com/2020/10/17/windows-10-kb4579311-cumulative-update-problems/
3. Install the update you selected above from a DOS console (command prompt) -> 
right-click CMD shortcut/CMD.EXE ->
Run as Administrator -> run this command -> press Enter (example):
WUSA.EXE %UserProfile%\Downloads\windows10.0-kb4579311-
x64_9cc8221b0ed1bc799278d029c4edadf785920da9.msu /quiet /norestart
WUSA (Windows Update Standalone Installer) [WUSA.EXE] executable is located in 
the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
4. Restart/reboot Windows for all changes to take effect.
Update Manager for Windows 10 (WuMgr) manages, downloads + installs Microsoft 
products updates, highly customizable:
http://github.com/DavidXanatos/wumgr/
Download:
http://github.com/DavidXanatos/wumgr/releases/latest/
WuMgr Guide:
http://www.askwoody.com/forums/topic/guide-to-using-wumgr-for-windows-10-
updates/
______________________________________________________________________________

On The Edge of A Hostile Takeover = Uninstall + Replace Edge While You Still Can

* UNinstall, remove + replace Edge (especially, and if possible, any 
build/edition/release/version prior to September 2020
Windows 10 Update) from all your computers/portables running Windows 7/newer 
OSes (if using more than 1), respectively both:
- old/legacy/obsolete/out-of-date Edge (all Edge versions up to 78) based on 
proprietary EdgeHTML + Chakra JavaScript web
browser engines installed by older/obsolete/out-of-date Windows 10 
builds/releases/updates, and
- newer/current/updated Windows 10/11 built-in/default/forced Google Chromium 
Edge (all Edge versions 79 and newer)



[proprietary, disabled/limited/locked/unavailable basic/important/optional 
features/functions/options/settings, loaded with
forced/impossible/hard-to-disable/unnecessary/unsafe/unwanted Microsoft
anti-competitive/bundling/centered/deceitful/exclusivist/limiting/monopolizing/
restrictive apps, enrollments, features,
memberships, services, software, subscriptions, trials, 
ad(ware)/spyware/surveillance/tracking] based on heavily modified
Google Chromium (Canary developer channel) web browser source code:
http://www.cloudwards.net/how-to-uninstall-microsoft-edge/
http://mspoweruser.com/how-to-uninstall-microsoft-edge-in-windows-10/
http://blog.pcrisk.com/windows/12542/
http://www.intowindows.com/how-to-uninstall-remove-edge-browser-from-windows-10/
http://www.winaero.com/blog/how-to-uninstall-and-remove-edge-browser-in-windows-
10/
http://www.winability.com/how-to-stop-microsoft-edge-from-hijacking-pdf-files/
http://superuser.com/questions/949814/
http://betanews.com/2020/07/07/uninstall-microsoft-edge/
http://thinkmobiles.com/blog/how-to-uninstall-microsoft-edge/
http://learn.microsoft.com/deployedge/edge-learnmore-neededge/
http://en.wikipedia.org/wiki/Microsoft_Edge
FULL DISCLOSURE:
****************
As paying customers you have the right to know what Microsoft is doing behind 
your backs, hidden, without your
approval/consent/knowledge/permission, and be aware of their anti-competitive, 
centered, exclusivist, deceitful,
monopolizing, crippling, limiting, restrictive, spying, tracking, unfair, 
bundling, tying, take-over-style, and in certain
countries, regions, territories banned, illegal, unauthorized marketing, 
monetizing and business tactics and strategies it
keeps employing for almost 50 years [but don't take my word for it]
http://en.wikipedia.org/wiki/United_States_v._Microsoft_Corp.
http://en.wikipedia.org/wiki/Criticism_of_Microsoft
with the purpose of limiting, restricting and suppressing paying consumers' 
options and choices, stifle competition, and to
persuade you to buy/lure/switch to/tempt/tie exclusively into and/or subscribe 
to their own and/or
3rd party/affiliates/associates/branches/brands/companies/divisions/entities/
parents/partners/subsidiaries of products and
services, even if not as qualitative/satisfactory as advertised due to anti-
competitive, deceitful, advertising/promotion,
or worse, and/or more expensive, and/or longer term binding/contract/dependent 
than competitors'/3rd parties
products/services, and/or not worth your 
choices/interests/money/needs/preferences/resources:
http://www.pcmag.com/news/microsoft-deploys-harmful-design-tricks-to-push-edge-
say-mozilla-researchers/
http://arstechnica.com/gadgets/2024/01/microsoft-edge-is-apparently-seamlessly-
usurping-chrome-on-peoples-pcs/
http://www.theverge.com/24054329/microsoft-edge-automatic-chrome-import-data-
feature/
http://www.xda-developers.com/microsoft-shooting-itself-foot-edge/
http://arstechnica.com/gadgets/2023/08/microsoft-rolls-out-then-pauses-pop-up-
that-asked-chrome-users-to-switch-to-bing/
http://www.xda-developers.com/microsoft-edge-popups-switch-bing/
http://www.windowslatest.com/2023/05/02/microsoft-targets-chrome-pushes-edge-on-
windows-11-10-and-android-ios/
http://gizmodo.com/1850392901/
http://arstechnica.com/gadgets/2023/04/on-by-default-edge-feature-seems-to-be-
sending-all-the-urls-you-visit-to-bing/
http://www.neowin.net/news/report-microsoft-edge-apparently-leaking-all-
websites-you-visit-to-bing-api/
http://arstechnica.com/gadgets/2022/11/the-sign-in-menu-is-the-latest-frontier-
for-microsoft-ads-in-windows-11/



https://www-kuketz--blog-de.translate.goog/microsoft-edge-datensendeverhalten-
desktop-version-browser-check-teil4/?_x_tr_sl=de&_x_tr_tl=en
http://www.bleepingcomputer.com/news/microsoft/windows-10-hosts-file-blocking-
telemetry-is-now-flagged-as-a-risk/
http://gizmodo.com/1848150282/
http://www.tomshardware.com/news/microsoft-confirms-windows-11-edge-default-
browser/
http://www.ctrl.blog/entry/microsoft-edge-protocol-competition.html
http://www.zdnet.com/article/microsoft-edge-is-stealing-chrome-users-data-i-
asked-microsoft-if-its-true/
http://www.zdnet.com/article/windows-10s-edge-must-stop-stealing-the-browser-
default-says-vivaldi-ceo/
http://news.softpedia.com/news/microsoft-edge-accused-of-sneakily-importing-
firefox-data-on-windows-10-530338.shtml
http://www.zdnet.com/article/microsoft-started-pestering-me-about-edge-there-
was-one-problem/
See also MDGx "Similar Windows 7/newer Anti-Spyware/Privacy Tools" + "HOSTS" 
sections in 10_BLOCK.TXT (included):
http://www.mdgx.com/xptoy.htm#10BLK
http://www.mdgx.com/10BLK/10_BLOCK.php
http://www.mdgx.com/10BLK/10_BLOCK.TXT
BEWARE:
*******
Edge web browsers collect, spy, surveil, track + send logged on/signed in 
members/subscribers/users' unique SID (Security
IDentifier) + web browser history [URLs (Uniform Resource Locator) = IPs, web 
addresses]
biometrics/data/fingerprint/information/stats, 
confidential/identifiable/personal/private/privileged preferences, user
choices/options/settings, to Microsoft + Microsoft 3rd 
party/affiliated/associated/leased/(sub)contracted/partner/subsidiary
cloud/network/internet/remote domains/servers/sites 
behind-your-back/disguised/forced/without your
approval/authorization/consent/knowledge/permission:
http://ieeexplore.ieee.org/document/9374407/
http://winbuzzer.com/2019/07/23/users-raise-privacy-concerns-as-edge-browser-
caught-sending-full-urls-and-sid-to-microsoft-xcxwbn/
http://www.scss.tcd.ie/Doug.Leith/pubs/browser_privacy.pdf
http://www.slashgear.com/7-reasons-to-stop-using-microsoft-edge-03701116/
http://www.whatismyip.com/best-browser-for-privacy/
http://www.zdnet.com/article/a-professor-says-edge-is-the-worst-for-privacy-
microsoft-isnt-happy/
http://www.laptopmag.com/news/edge-fails-browser-security-rankings-but-
microsoft-isnt-buying-it/
UPDATE:
*******
Obsolete Windows 10 Edge proprietary closed source [discontinued!] core (all 
Edge versions up to 78), web browser + APIs
(Application Programming Interfaces) are being phased out and replaced with 
free, open source Chromium (Canary) code (all
Edge versions 79 and newer) created by Google Chromium developers
http://www.chromium.org/Home/
and further modified, crippled, limited, locked, restricted extensively by Edge 
web browser [current!] developers to support
Windows 10/11 Live/Metro/Screen/Start/Tile (Store) apps, aimed to lock 
legitimate/paying customers/owners/users out of
certain built-in original Chromium/Chrome web browser 
features/functions/options/settings, and
confine/cripple/force/limit/lock/redirect/replace/restrict Windows users towards
Microsoft
anti-competitive/centered/exclusive/proprietary/restricted/specific (even 
without offering any other alternatives/choices)
and/or pay-for/membership-only/subscription-only bundled/exclusive
apps/features/functions/memberships/programs/services/subscriptions:



http://en.wikipedia.org/wiki/Microsoft_Edge
Older Live/Metro/Screen/Start/Tile (Store) apps still use obsolete Microsoft 
Internet Explorer (IE) interface and APIs
(Application Programming Interface), but those are being or have been already 
phased
out/uninstalled/locked/disabled/discontinued/replaced/unsupported.
Chromium/Chrome web browser extensions (free, open source)
http://chromewebstore.google.com/category/extensions
may or may not [?] work or be compatible with Chromium based Edge web browser, 
depending on modified code
limitations/lock-outs/restrictions/removals made by Microsoft.
WARNING:
********
Users who have allowed/tolerated/lived through the installation of the September
2020 Windows 10 Update
http://support.microsoft.com/help/4571756/
http://support.microsoft.com/help/4577266/
were being told by Microsoft that they canNOT uninstall Edge anymore, due to the
new browser core integration [!], which
recently replaced the ancient [> 25 years old!], proprietary, obsolete, flawed, 
inadequate, insecure Internet Explorer (IE)
[discontinued in April 2021 from all newer Windows 10/2016/2019 
builds/editions/releases/updates]:
http://support.microsoft.com/help/4576988/
http://techcommunity.microsoft.com/t5/microsoft-365-blog/new-microsoft-edge-to-
replace-microsoft-edge-legacy-with-april-s/ba-p/2114224/
http://www.zdnet.com/article/microsoft-heres-why-you-cant-uninstall-our-edge-
browser/
http://www.theverge.com/21310611/microsoft-edge-browser-forced-update-chromium-
editorial/
BUG + FIX: Windows 10 September 2020 Update breaks another major feature:
http://www.windowslatest.com/2020/09/07/windows-10-sleep-mode-problem/
REMEMBER:
*********
- You do NOT have to allow automatic/unattended
behind-your-back/disguised/forced/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission installation of Windows 10 cosmetic, non-
essential, security unrelated, spying,
surveillance, tracking updates/patches/fixes/builds, because you can stop, 
uninstall (and reenable/reinstall whenever you
wish) Windows Updates (WU) permanently/temporarily (+ turn it back on) using 
Windows
Update Blocker (WUB) (freeware):
Windows Update Blocker (WUB) [Wub.exe 32-bit + Wub_x64.exe 64-bit] for Windows 
10/11 32-bit (x86) + 64-bit (x64) allows all
users to block/disable/stop/turn OFF, and/or unblock/reenable/restart/turn back 
ON
automatic/unattended 
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission Microsoft Windows Updates (WU) service + 
interconnected/interdependent/interrelated
services [up to 25 services!] + program executables (.exe) which are very 
complicated/hard/almost impossible to
block/control/disable/manage/stop/turn OFF without performing complicated/time 
consuming operations, cumbersome registry
tweaks, or/and without dedicated 3rd party tools (like this one):
http://www.sordum.org/9470/
File [Portable ZIP]:
http://www.sordum.org/files/download/windows-update-blocker/Wub.zip
Screen shot:
http://www.sordum.org/wp-content/uploads/2020/10/
windos_update_blocker_blocked.png



Windows Update (WU) Tools:
http://www.majorgeeks.com/mg/sortdate/windows_update.html
See MDGx "Turn OFF/Postpone/Block/Uninstall Windows Updates (WU)" chapter -> "* 
FIXes:" section in WIN10.TXT (included):
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT
- You can always uninstall Windows 10/11 updates:
http://www.anoopcnair.com/remove-windows-11-update-patch-latest-cu-best/
http://www.pcmag.com/how-to/computer-acting-up-how-to-uninstall-a-windows-10-
update/
Extra step:
***********
Disable these 3 recently introduced automatic/unattended
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission Edge services:
- Microsoft Edge Elevation Service [MicrosoftEdgeElevationService]
http://batcmd.com/windows/10/services/microsoftedgeelevationservice/
%ProgramFiles%\Microsoft\Edge\Application\89.0.774.68\elevation_service.exe
%ProgramFiles%\Microsoft\Edge\Application\92.0.902.67\elevation_service.exe
%ProgramFiles%\Microsoft\Edge\Application\108.0.1462.46\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\89.0.774.68\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\92.0.902.67\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\108.0.1462.46\
elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\89.0.774.68\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\92.0.902.67\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\108.0.1462.46\elevation_service.exe
- Microsoft Edge Update Service (edgeupdate) [edgeupdate]
http://batcmd.com/windows/10/services/edgeupdate/
%ProgramFiles%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /svc
%ProgramFiles(x86)%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /svc
- Microsoft Edge Update Service (edgeupdatem) [edgeupdatem]
http://batcmd.com/windows/10/services/edgeupdatem/
%ProgramFiles%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /medsvc
%ProgramFiles(x86)%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /medsvc
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it -> Run
as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
ECHO Y|NET.EXE STOP MicrosoftEdgeElevationService
SC.EXE CONFIG MicrosoftEdgeElevationService START= disabled
ECHO Y|NET.EXE STOP edgeupdate
SC.EXE CONFIG edgeupdate START= disabled
ECHO Y|NET.EXE STOP edgeupdatem
SC.EXE CONFIG edgeupdatem START= disabled
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\
MicrosoftEdgeElevationService" /v Start /t REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\
MicrosoftEdgeElevationService" /v Start /t REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\
MicrosoftEdgeElevationService" /v Start /t REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\edgeupdate" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\edgeupdate" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\edgeupdate" /v Start /t 



REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\edgeupdatem" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\edgeupdatem" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\edgeupdatem" /v Start /t 
REG_DWORD /d 4 /f
:END
EXIT
------End cut & paste here------
Use WUB interface or edit WUB.ini (using a UNICODE compatible 
Notepad/similar/better plain text/ASCII editor) to
add/disable/enable Windows services [up to 25] (example):
http://www.thewindowsclub.com/windows-update-blocker/
Add these 3 newly introduced MS Edge services to your WUB.ini to make sure they 
will remain disabled upon every Windows
(re)boot/(re)start (example):
-----snippity-snip-----
[Service_List]
; 2=Auto
; 3=Manual
; 4=Disabled
MicrosoftEdgeElevationService=3,4
edgeupdate=3,4
edgeupdatem=3,4
-----snippity-snip-----
WUB.ini is the WUB configuration file (plain text/ASCII, UNICODE encoded), and 
contains all its settings.
WUB.ini is located in the same directory/folder as its parent executable(s): 
Wub.exe (32-bit) +/- Wub_x64.exe (64-bit).
Add this entry to your HKEY_LOCAL_MACHINE (HKLM) machine/system wide/all users 
registry "Run" subkey (example):
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
"WUB"="\"C:\\TOOLS_10\\Wub_x64.exe\" /D /P"
;
------End cut & paste here------
Wub_x64.exe (64-bit) = only for Windows 10/11 64-bit (x64).
If using Windows 10/11 32-bit (x86) = use Wub.exe (32-bit) instead.
In this example Wub_x64.exe is located in the C:\TOOLS_10 directory/folder.
Replace C:\\TOOLS_10 with your WUB directory/folder name (+ 
drive/partition/volume letter if other than C) = notice the
double backslash [\\] necessary in registry (.reg) files for 
drive/partition/volume letters + (sub)directory/(sub)folder
names demarcation.
See "REG Files" section under "Comprehensive Windows Registry Guide" [Intro 
Chapter] in REGISTRY.XT (included) for more
details:
http://www.mdgx.com/reg.htm#RF
Next step:
**********
Uninstall + remove (or disable) Edge web browser using DOS (CMD) console 
commands + "Uninstall Edge.cmd" batch file script:
http://www.winaero.com/how-to-uninstall-and-remove-edge-browser-in-windows-10/
Download "Uninstall Edge.cmd" [ZIP file]:



http://www.winaero.com/download.php?view.1835
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run this command 
(depending on your Windows 10
build/edition/release/update/version) -> press Enter:
C:\Program Files (x86)\Microsoft\Edge\Application\83.0.478.58\Installer\
setup.exe --uninstall --system-level --verbose-logging --force-uninstall
OR right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\
v1.0\PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
PowerShell.exe -ExecutionPolicy Unrestricted
Then from within the PowerShell console run one of these commands (depending on 
your Windows 10
build/edition/release/update/version) -> press Enter after each line:
Get-AppXPackage Microsoft.MicrosoftEdge_20.10240.16384.0_neutral__8wekyb3d8bbwe 
| Remove-AppXPackage
Get-AppXPackage *edge* | Remove-AppXPackage
Get-AppXPackage *Microsoft.MicrosoftEdge* | Remove-AppXPackage
Get-AppXPackage *Microsoft.MicrosoftEdge.Beta* | Remove-AppXPackage
Get-AppXPackage *Microsoft.MicrosoftEdge.Canary* | Remove-AppXPackage
Get-AppXPackage *Microsoft.MicrosoftEdgeDevToolsClient* | Remove-AppXPackage
More info:
http://www.tenforums.com/tutorials/4689-uninstall-apps-windows-10-a.html#option3
Rename Edge executable [MicrosoftEdge.exe] to something else (example): right-
click CMD shortcut/CMD.EXE -> Run as
Administrator -> run all these commands in this order -> press Enter after each 
line:
TASKKILL.EXE /IM elevation_service.exe /F /T
TASKKILL.EXE /IM MicrosoftEdgeUpdate.exe /F /T
TASKKILL.EXE /IM LaunchWinApp.exe /F /T
TASKKILL.EXE /IM MicrosoftEdge.exe /F /T
TASKKILL.EXE /IM MicrosoftEdgeBCHost.exe /F /T
TASKKILL.EXE /IM MicrosoftEdgeCP.exe /F /T
TASKKILL.EXE /IM MicrosoftEdgeDevTools.exe /F /T
TASKKILL.EXE /IM MicrosoftEdgeSH.exe /F /T
TASKKILL.EXE /IM msedge.exe /F /T
TAKEOWN.EXE /f "%WinDir%\SystemApps\Microsoft.MicrosoftEdge_8wekyb3d8bbwe" /r /d
y
ICACLS.EXE "%WinDir%\SystemApps\Microsoft.MicrosoftEdge_8wekyb3d8bbwe" /grant:r 
%UserName%:F /t /c /q
REN "%WinDir%\SystemApps\Microsoft.MicrosoftEdge_8wekyb3d8bbwe\
MicrosoftEdge.exe" MicrosoftEdge.OLD
ICACLS.EXE:
http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/
Choices... choices... free(ware) tools to block/disable/replace/uninstall Edge:
- Edge Blocker (EdgeBlock.exe 32-bit + EdgeBlock_x64.exe 64-bit) for Windows 
10/11:
http://www.sordum.org/9312/
File:
http://www.sordum.org/files/download/edge-blocker/EdgeBlock.zip
- MSEdgeRedirect for Windows 8.1/10/11 intercepts, redirects + switches all 
Desktop, Metro, Start, Store, Tiles apps,
feeds/RSS, gadgets, maps, news, search, widgets, weather, etc, file extensions 
(.dhtml, .htm, .html, .php, .xhtml, .xml,
etc), internet/URI schemes/protocols (ftp:, http:, https:, magnet:, mailto:, 
news:, etc) + URL/URI
addresses/items/links/schemes/shortcuts (.url, .website, etc) forced 
(built/hardwired/preset into the operating system) by



Microsoft to open in Edge + forces them to open instead in user's choice custom 
selected default web browser (if any other
than Edge) + to use any user's choice custom selected default search engine 
other than bing, works from anywhere in the
world (including outside Europe/EU/UE):
http://github.com/rcmaehl/MSEdgeRedirect/
Download:
http://github.com/rcmaehl/MSEdgeRedirect/releases/latest/
More info:
http://www.ghacks.net/2023/11/18/you-can-remove-edge-and-bing-search-on-windows-
11-even-if-you-dont-live-in-europe/
MDGx "100+ WWW (World Wide Web) Search Engines" [most have enhanced privacy, 
safety + security]:
http://www.mdgx.com/links.htm#WSE
List of URI Schemes:
http://www.w3.org/wiki/UriSchemes
- EdgeDeflector for Windows 10/11 intercepts + redirects HTTP(S), Maps, News, 
Feeds/RSS, Widgets, Weather, etc file
extensions (.dhtml, .htm, .html, .php, .xhtml, .xml, etc), internet 
schemes/protocols (ftp:, http:, https:, magnet:,
mailto:, news:, etc) + URL/URI addresses/items/links/schemes/shortcuts 
(.url, .website, etc) forced (built/hardwired/preset
into the operating system) by Microsoft to open in Edge to open instead in 
user's choice custom selected default web browser
(if any other than Edge):
http://github.com/da2x/EdgeDeflector/
Download:
http://github.com/da2x/EdgeDeflector/releases/latest/
EdgeDeflector Purpose:
http://www.ctrl.blog/entry/edgedeflector-default-browser.html
- Firewall App Blocker (FAB) 32-bit + 64-bit for Windows 7/newer allows/blocks 
inbound + outbound app(lication)s/EXEcutables
(.exe)/programs, highly customizable:
http://www.sordum.org/8125/
File:
http://www.sordum.org/files/download/firewall-app-blocker/fab.zip
MS Edge firewall block rule [Disable_EdgeRule.bat] [ZIP]:
http://www.sordum.org/files/download/firewall-app-blocker/edge_rule.zip
BEWARE:
*******
Newer Windows 10 builds/editions/releases/versions blocked EdgeDeflector + 
similar Edge browser competitors:
http://www.ctrl.blog/entry/microsoft-edge-protocol-competition.html
FIX:
****
Restore EdgeDeflector + similar Edge browser competitors functionality -> 
UNinstall Windows Update KB5007262:
Start button/icon/logo/menu/orb -> Windows Settings [gear icon] -> Update & 
Security -> Windows Update -> View update
history -> Uninstall updates -> highlight/select update KB5007262 -> right-click
-> Uninstall -> reboot/restart if
needed/prompted.
- Edge Chromium Blocker Toolkit:
http://www.windowscentral.com/how-prevent-microsoft-edge-chromium-installing-
automatically-windows-10/
File:
http://web.archive.org/web/20210812025623if_/http://
msedgeblockertoolkit.blob.core.windows.net/blockertoolkit/
MicrosoftEdgeChromiumBlockerToolkit.exe
- Enable/Unlock Chromium Edge disabled/locked features + options using Policy 
Plus for Windows 7/8/8.1/10/11 (free, open
source):
http://github.com/Fleex255/PolicyPlus/releases/latest/
http://www.itechtics.com/best-group-policy-editor-gpedit-msc-alternative-for-



windows/
http://www.majorgeeks.com/files/details/policy_plus.html
- Uninstall + remove Edge web browser from Windows 10/11 using DOS (CMD) console
commands + "Uninstall Edge.cmd" batch file
script:
http://www.winaero.com/how-to-uninstall-and-remove-edge-browser-in-windows-10/
Download "Uninstall Edge.cmd" [ZIP file]:
http://www.winaero.com/download.php?view.1835
Disable Edge Updates in the registry:
http://admx.help/?
Category=EdgeChromium&Policy=Microsoft.Policies.Update::Pol_DefaultUpdatePolicy
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\EdgeUpdate]
"UpdateDefault"=dword:0
;
------End cut & paste here------
STRONGLY RECOMMENDED:
*********************
In case you decide to keep + use Edge (for whatever reason, personal preference,
or being forced due to certain business,
contract, employer, enrollment, job, licensing, membership, partnership, 
proprietary software, services, etc constraints,
limitations, requirements, etc) the *least* you can do in order to 
enhance/improve your privacy, safety + security, and to
block/disable/minimize/reduce/stop/turn OFF the ad(vertising)/adware, auditing, 
fingerprinting, spying, surveillance,
tracking, unwanted "offers"/promo(tion)s
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission 
compromising/dangerous/dubious/harmful/insecure/malicious/unsafe environment is 
to
install uBlock Origin (uBO) [free, open source add-on/extension for all Chromium
based Edge web browsers]
http://microsoftedge.microsoft.com/addons/detail/
odfafepnkmbhccpbejgmiehpchacaeak/
-> *best* ad(ware), scripting, malware, phishing, pop-ups, spyware, tracking, 
hijacking, dialers, miners, skimmers, social
media, video sites, e-mail blocker/filter/remover:
http://www.cloudwards.net/best-pop-up-blockers/
OR uBlock Origin Lite (uBOL) [MV3 compliant: 
http://www.theverge.com/2023/11/16/23964509/]
http://microsoftedge.microsoft.com/addons/detail/
cimighlppcgcoapaliogpjjdehbnofhn/
uBlock Origin (uBO):
http://ublockorigin.com/
uBlock Origin (uBO) repository + source code:
http://github.com/gorhill/uBlock/
uBlock Origin (uBO) releases:
http://github.com/gorhill/uBlock/releases/latest/
uBlock Origin (uBO) Documentation:
http://github.com/gorhill/uBlock/?tab=readme-ov-file/#documentation
Add to uBlock Origin (uBO) -> Filters for blocking mining, pop-ups, resource 
abuse, embedded URL trackers + anti-adblock
bypass -> Install Instructions:



http://github.com/bogachenko/fuckfuckadblock/wiki/Installation-instruction/
Examples:
- Filters for blocking pop-ups + anti-adblock bypass:
https://raw.githack.com/bogachenko/fuckfuckadblock/master/fuckfuckadblock.txt
- Filters for blocking browser based miners:
https://raw.githack.com/bogachenko/fuckfuckadblock/master/fuckfuckadblock-
mining.txt
- Filters for blocking resource abuse:
https://raw.githubusercontent.com/uBlockOrigin/uAssets/master/filters/resource-
abuse.txt
- ClearURLs filter for embedded URL trackers:
https://github.com/DandelionSprout/adfilt/raw/master/ClearURLs%20for%20uBo/
clear_urls_uboified.txt
Install TamperMonkey add-on/extension:
http://microsoftedge.microsoft.com/addons/detail/
iikmkjmpaadaobahmlepeloendndfphd/
+ useful privacy/safety/security ad-blocker/anti-malware/anti-phone-home/anti-
spyware/anti-surveillance/anti-tracking user
JavaScript (JS) scripts/scriplets (examples):
- AdGuard Extra (Java)Script:
http://github.com/AdguardTeam/AdGuardExtra/
-> Install (Java)Script:
https://userscripts.adtidy.org/release/adguard-extra/1.0/adguard-extra.user.js
- Google Unlocked (Java)Script:
https://raw.githubusercontent.com/Ibit-to/google-unlocked/master/google-
unlocked.user.js
- Anti-Adblock Killer | Reek (Java)Script:
http://reek.github.io/anti-adblock-killer/
-> Install (Java)Script:
https://raw.githubusercontent.com/reek/anti-adblock-killer/master/anti-adblock-
killer.user.js
- AdsBypasser Full Edition (Java)Script:
http://adsbypasser.github.io/
-> Install (Java)Script:
https://adsbypasser.github.io/releases/adsbypasser.full.es7.user.js
Configure AdsBypasser:
http://adsbypasser.github.io/configure.html
FYI:
Custom user (Java)Scripts (JS)/Scriptlets are also supported by uBlock Origin 
(uBO) add-on/extension:
http://microsoftedge.microsoft.com/addons/detail/
odfafepnkmbhccpbejgmiehpchacaeak/
Useful privacy, safety + security Chromium based Edge Add-ons/Extensions:
- Ad(ware) Blockers:
http://microsoftedge.microsoft.com/addons/search/blocker/
- Anti-Malware:
http://microsoftedge.microsoft.com/addons/search/malware/
- Privacy:
http://microsoftedge.microsoft.com/addons/search/privacy/
- Protection:
http://microsoftedge.microsoft.com/addons/search/protection/
- Safety:
http://microsoftedge.microsoft.com/addons/search/safety/
- Security:
http://microsoftedge.microsoft.com/addons/search/security/
BEWARE:
*******
Edge web browsers collect, spy, surveil, track + send logged on/signed in 
members/subscribers/users' unique SID (Security
IDentifier) + web browser history [URLs (Uniform Resource Locator) = IPs, web 
addresses]
biometrics/data/fingerprint/information/stats, 
confidential/identifiable/personal/private/privileged preferences, user
choices/options/settings, to Microsoft + Microsoft 3rd 



party/affiliated/associated/leased/(sub)contracted/partner/subsidiary
cloud/network/internet/remote domains/servers/sites 
behind-your-back/disguised/forced/without your
approval/authorization/consent/knowledge/permission:
http://ieeexplore.ieee.org/document/9374407/
http://winbuzzer.com/2019/07/23/users-raise-privacy-concerns-as-edge-browser-
caught-sending-full-urls-and-sid-to-microsoft-xcxwbn/
http://www.scss.tcd.ie/Doug.Leith/pubs/browser_privacy.pdf
http://www.slashgear.com/7-reasons-to-stop-using-microsoft-edge-03701116/
http://www.whatismyip.com/best-browser-for-privacy/
http://www.zdnet.com/article/a-professor-says-edge-is-the-worst-for-privacy-
microsoft-isnt-happy/
http://www.laptopmag.com/news/edge-fails-browser-security-rankings-but-
microsoft-isnt-buying-it/
RECOMMENDED:
************
Recommended independent/3rd party free, open source, safe, secure, uncrippled, 
unlocked, unrestricted, modern web browsers
(examples):
http://www.mdgx.com/nettoys.htm#NET
MDGx "Free(ware) Windows 9x/NTx Web Browsers" chapter -> "Chromium + Chrome web 
browsers [free(ware)]" section ->
"Chromium + Chrome" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#CHR
RECOMMENDED:
- Chromium Precompiled EXEcutable [Installer EXE + Portable Archives ZIP/7z] 32-
bit + 64-bit for Windows XP/newer 32-bit
(x86) + 64-bit (x64):
http://chromium.woolyss.com/
Degoogled/Ungoogled/stripped of Google ad(ware)/spyware/surveillance/tracking 
code Chromium builds [clearly labeled]:
http://github.com/ungoogled-software/ungoogled-chromium/blob/master/README.md
http://ungoogled-software.github.io/ungoogled-chromium-wiki/faq
Ungoogled Chromium precompiled binaries 32-bit + 64-bit for Windows 7/newer 32-
bit (x86) + 64-bit (x64) [75-125 MB,
Installer ONLY EXE + Portable ZIP, NEWest at the top]:
http://ungoogled-software.github.io/ungoogled-chromium-binaries/
Ungoogled Chromium 64-bit for Windows 7/newer 64-bit (x64):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/64bit/
Ungoogled Chromium 32-bit for Windows 7/newer 32-bit (x86):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/32bit/
- Brave 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
improved privacy, safety + security and optimized speed:
http://brave.com/
Brave Repository:
http://github.com/brave/brave-browser/
Download [ZIP = full, Portable]:
http://github.com/brave/brave-browser/releases/latest/
- Vivaldi 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
enhanced privacy, safety + security:
http://vivaldi.com/
Download [EXE = Installer ONLY]:
http://vivaldi.com/download/
Vivaldi Portable -> run Installer EXE -> Install standalone:
http://help.vivaldi.com/desktop/install-update/standalone-version-of-vivaldi/
- Thorium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-bit
(x64) based on Chromium code [fork]
hardware 3D, rendering + video playback optimized:
http://thorium.rocks/
Download [ZIP = full, Portable]:



Thorium AVX2 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium AVX 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium SS3 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-SSE3/releases/latest/
Thorium SSE2 (Win32) 32-bit edition for Windows 7/newer 32-bit (x86) + Thorium 
SSE3, SSE4, AVX + AVX2 64-bit editions for
Windows 7/newer 64-bit (x64):
http://github.com/Alex313031/thorium-win7/releases/latest/
Thorium Requirements:
- Multicore CPU: minimum Intel Core 2nd gen or AMD FX with built-in SSE4 
(Streaming SIMD Extensions 4),
http://en.wikipedia.org/wiki/SSE4
AVX (Advanced Vector EXtensions)
http://en.wikipedia.org/wiki/Advanced_Vector_Extensions
+ AES (Advanced Encryption Standard)
http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
enhancements/multimedia extensions/instructions.
- Graphics video controller with 3D rendering + OpenGL capabilities.
Required Windows 7 64-bit (x64) Updates for Thorium 64-bit web browser enhanced 
hardware + software compatibility/support:
http://thorium.rocks/win7
- Windows 7 SP1/2008 R2 64-bit (x64) Servicing Stack Update 2019 KB4490628:
http://support.microsoft.com/help/4490628/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4490628+x64
- Windows 7 SP1/2008 R2 64-bit (x64) SHA-2 Code Signing Support Update 2019 
KB4474419:
http://support.microsoft.com/help/4474419/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4474419+x64
- Supermium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-
bit (x64) based on Chromium code [fork]
optimized for speed + performance:
http://www.win32subsystem.live/supermium.html
Download [EXE = full, Installer +/- ZIP = full, Portable]:
http://github.com/win32ss/supermium/releases/latest/
- X-Chromium (X-Launcher) Portable launcher:
http://www.winpenpack.com/en/download.php?view.1082
Download [EXE = Installer, full]:
http://sourceforge.net/projects/winpenpack/files/X-Chromium/releases/
Either install Chromium precompiled stable releases 32-bit or 64-bit:
http://chromium.woolyss.com/
or extract all files from portable archive [zip or 7z] + copy to the destination
of your choice Chromium portable stable
releases 32-bit or 64-bit to match the Windows NTx [7/newer] operating system(s)
[OS(es)]
build/edition/release/update/version + bit strength [32-bit (x86) or 64-bit 
(x64)] you are using.
All Chromium + Chrome alternatives/derivatives/forks/variants users must have 
these 3 environment variables:
GOOGLE_API_KEY=NO
GOOGLE_DEFAULT_CLIENT_ID=NO
GOOGLE_DEFAULT_CLIENT_SECRET=NO
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
SETX.EXE GOOGLE_API_KEY "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_ID "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_SECRET "NO" /M
Google API Keys:
http://chromium.woolyss.com/#google-api-keys
http://www.chromium.org/developers/how-tos/api-keys/
MDGx "@ Chromium/Chrome/Brave/X-Chromium/Thorium/Vivaldi/Supermium Privacy, 



Safety + Security Settings, Extensions, Guides +
Solutions:" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#PRV
MDGx collection of essential + useful Chromium/Chrome extensions + tweaks -> 
"CHROMIUM" section in TOOLS.TXT (included):
http://www.mdgx.com/tools.php#:~:text=CHROMIUM%20%5B%2A%5D
http://www.mdgx.com/TOOLS.TXT
Edge support:
http://microsoftedgesupport.microsoft.com/
Edge vs Chromium/Chrome:
http://www.lifewire.com/microsoft-edge-4689177/
http://beebom.com/microsoft-edge-vs-google-chrome/
http://www.laptopmag.com/news/google-chrome-vs-microsoft-edge-which-browser-is-
best/

* Turn OFF Edge + Internet Explorer (IE) web browsers Operating System (OS) 
integration level
take-over/unwanted/unnecessary/unsafe control/grip:
http://admx.help/?
Category=EdgeChromium&Policy=Microsoft.Policies.Edge::InternetExplorerIntegratio
nLevel
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge]
"InternetExplorerIntegrationLevel"=dword:0
"InternetExplorerIntegrationSiteList"=""
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Policies\Microsoft\Edge]
"InternetExplorerIntegrationLevel"=dword:0
"InternetExplorerIntegrationSiteList"=""
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Edge]
"InternetExplorerIntegrationLevel"=dword:0
"InternetExplorerIntegrationSiteList"=""
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Edge]
"InternetExplorerIntegrationLevel"=dword:0
"InternetExplorerIntegrationSiteList"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\MicrosoftEdge]
"OSIntegrationLevel"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Windows\CurrentVersion\
MicrosoftEdge]
"OSIntegrationLevel"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\MicrosoftEdge]
"OSIntegrationLevel"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\MicrosoftEdge]
"OSIntegrationLevel"=dword:0
;
------End cut & paste here------

* Turn OFF Edge web browser running hidden/invisible/unknowingly in the 
background automatic/unattended
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission Internet Explorer (IE) Edge tab, IE smiley
button + Edge Desktop shortcut creation:
http://www.howtogeek.com/397718/how-to-prevent-microsoft-edge-from-preloading-



on-windows-10/
http://www.appuals.com/how-to-disable-microsoft-edge-browser/
http://www.ghacks.net/2019/02/11/block-microsoft-edge-from-running-in-the-
background-on-windows-10/
http://admx.help/HKLM/Software/Policies/Microsoft/MicrosoftEdge/Main
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.MicrosoftEdge::AllowAddressBa
rDropdown
http://www.winaero.com/blog/edge-button-internet-explorer-windows-10/
http://www.winaero.com/blog/smiley-button-internet-explorer-windows-10/
http://eddiejackson.net/wp/?p=29198
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\MicrosoftEdge\Main]
"AllowPrelaunch"=dword:0
"PreventLiveTileDataCollection"=dword:1
"SyncFavoritesBetweenIEAndMicrosoftEdge"=dword:0
"PreventFirstRunPage"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\MicrosoftEdge\Main]
"AllowPrelaunch"=dword:0
"PreventLiveTileDataCollection"=dword:1
"SyncFavoritesBetweenIEAndMicrosoftEdge"=dword:0
"PreventFirstRunPage"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\MicrosoftEdge\Main]
"AllowPrelaunch"=dword:0
"PreventLiveTileDataCollection"=dword:1
"SyncFavoritesBetweenIEAndMicrosoftEdge"=dword:0
"PreventFirstRunPage"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main]
"HideNewEdgeButton"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main]
"HideNewEdgeButton"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Main]
"HideNewEdgeButton"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\MicrosoftEdge\TabPreloader]
"AllowTabPreloading"=dword:0
"PreventLiveTileDataCollection"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\MicrosoftEdge\TabPreloader]
"AllowTabPreloading"=dword:0
"PreventLiveTileDataCollection"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\MicrosoftEdge\TabPreloader]
"AllowTabPreloading"=dword:0
"PreventLiveTileDataCollection"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Internet Explorer\Restrictions]
"NoHelpItemSendFeedback"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet Explorer\Restrictions]
"NoHelpItemSendFeedback"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Internet Explorer\Restrictions]
"NoHelpItemSendFeedback"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer]
"DisableAppInstallsOnFirstLogon"=dword:1
"DisableResolveStoreCategories"=dword:1
"EarlyAppResolverStart"=dword:0
"DisableEdgeDesktopShortcutCreation"=dword:1
"DisplayToastAtBottom"=dword:0
"EdgeDesktopShortcutCreated"=dword:0



"ExplorerStartupTraceRecorded"=dword:0
"TelemetrySalt"=dword:0
;
------End cut & paste here------

* Turn OFF annoying + obsolete data collection, spying + tracking Microsoft 
Defender SmartScreen (Windows 8/newer) +
Phishing Filter(s) (Windows 7/newer) so-called protection "features" for built-
in/default Edge + Internet Explorer (IE) web
browsers in Windows 7/newer:
http://www.codecguide.com/smartscreen_bypass.htm
http://www.winaero.com/blog/disable-smartscreen-windows-10-creators-update/
http://winbuzzer.com/2020/11/23/how-to-disable-smartscreen-in-windows-10-xcxwbt/
http://www.tenforums.com/tutorials/5593-turn-off-smartscreen-apps-files-web-
windows-10-a-3.html
http://www.eightforums.com/threads/windows-smartscreen-turn-on-or-off-in-
windows-8.2631/
http://sourcedaddy.com/windows-7/how-configure-smart-screen-options.html
http://www.digitalcitizen.life/how-disable-or-enable-smartscreen-filter-
internet-explorer-or-windows-8/
http://www.partitionwizard.com/partitionmagic/what-is-smartscreen.html
http://en.wikipedia.org/wiki/Microsoft_SmartScreen#SmartScreen_in_Windows
BEWARE:
*******
- SmartScreen Phishing Filter collects + sends uniquely identifiable user 
biometrics/data/fingerprint/information/stats to
Microsoft servers:
http://www.wsws.org/en/articles/2005/09/micr-s17.html
"Some info is sent to Microsoft about files and apps you run on this PC."
http://www.isunshare.com/images/article/windows-10/change-windows-smartscreen-
settings-in-windows-10/choose-windows-smartscreen-setting.png
- Edge web browsers collect, spy, surveil, track + send logged on/signed in 
members/subscribers/users' unique SID (Security
IDentifier) + web browser history [URLs (Uniform Resource Locator) = IPs, web 
addresses]
biometrics/data/fingerprint/information/stats, 
confidential/identifiable/personal/private/privileged preferences, user
choices/options/settings, to Microsoft + Microsoft 3rd 
party/affiliated/associated/leased/(sub)contracted/partner/subsidiary
cloud/network/internet/remote domains/servers/sites 
behind-your-back/disguised/forced/without your
approval/authorization/consent/knowledge/permission:
http://ieeexplore.ieee.org/document/9374407/
http://winbuzzer.com/2019/07/23/users-raise-privacy-concerns-as-edge-browser-
caught-sending-full-urls-and-sid-to-microsoft-xcxwbn/
http://www.scss.tcd.ie/Doug.Leith/pubs/browser_privacy.pdf
http://www.slashgear.com/7-reasons-to-stop-using-microsoft-edge-03701116/
http://www.whatismyip.com/best-browser-for-privacy/
http://www.zdnet.com/article/a-professor-says-edge-is-the-worst-for-privacy-
microsoft-isnt-happy/
http://www.laptopmag.com/news/edge-fails-browser-security-rankings-but-
microsoft-isnt-buying-it/
RECOMMENDED:
************
Replace Edge + IE with a modern, safe, secure, unlocked, uncrippled, without so 
many security flaws/vulnerabilities,
hard-to-disable, unwanted ad(vertisement)s/"offers", spyware, surveillance, 
traking, annoyances, limitations, restrictions,
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission data collection/logging, telemetry/"phone 
home", tracking free web browser (examples)
-> see "Internet + Web Browsers Tweaks, Fixes + Tools" chapter in WINDOWS7.TXT 
(included),



http://www.mdgx.com/7.php#:~:text=Internet%20%2B%20Web%20Browsers%20Tweaks%2C
%20Fixes%20%2B%20Tools%20%5BChromium%2FChrome%2C%20Firefox
respectively these 2 sections:
- "* Chromium/Chrome:"
http://www.mdgx.com/7.php#:~:text=%2A%20Chromium%2FChrome%3A
- "* Firefox:".
http://www.mdgx.com/7.php#:~:text=%2A%20Firefox%3A
Best examples of modern, with better privacy features, more secure, highly 
customizable, free web browsers in SOFTWARE.TXT
(included):
- MDGx "Free(ware) Windows 9x/NTx Web Browsers" chapter -> "Chromium + Chrome 
web browsers [free(ware)]" section ->
"Chromium + Chrome" topic:
http://www.mdgx.com/nettoys.htm#CHR
- MDGx "Free(ware) Windows 9x/NTx Web Browsers" chapter -> "Internet Power Toys:
Firefox [free(ware)]" section -> "Firefox"
topic:
http://www.mdgx.com/nettoys.htm#MOZ
Chromium/Chrome builds/derivatives/forks/variants:
- Chromium Precompiled EXEcutable [Installer EXE + Portable Archives ZIP/7z] 32-
bit + 64-bit for Windows XP/newer 32-bit
(x86) + 64-bit (x64):
http://chromium.woolyss.com/
Degoogled/Ungoogled/stripped of Google ad(ware)/spyware/surveillance/tracking 
code Chromium builds [clearly labeled]:
http://github.com/ungoogled-software/ungoogled-chromium/blob/master/README.md
http://ungoogled-software.github.io/ungoogled-chromium-wiki/faq
Ungoogled Chromium precompiled binaries 32-bit + 64-bit for Windows 7/newer 32-
bit (x86) + 64-bit (x64) [75-125 MB,
Installer ONLY EXE + Portable ZIP, NEWest at the top]:
http://ungoogled-software.github.io/ungoogled-chromium-binaries/
Ungoogled Chromium 64-bit for Windows 7/newer 64-bit (x64):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/64bit/
Ungoogled Chromium 32-bit for Windows 7/newer 32-bit (x86):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/32bit/
- Brave 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
improved privacy, safety + security and optimized speed:
http://brave.com/
Brave Repository:
http://github.com/brave/brave-browser/
Download [ZIP = full, Portable]:
http://github.com/brave/brave-browser/releases/latest/
- Vivaldi 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
enhanced privacy, safety + security:
http://vivaldi.com/
Download [EXE = Installer ONLY]:
http://vivaldi.com/download/
Vivaldi Portable -> run Installer EXE -> Install standalone:
http://help.vivaldi.com/desktop/install-update/standalone-version-of-vivaldi/
- Thorium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-bit
(x64) based on Chromium code [fork]
hardware 3D, rendering + video playback optimized:
http://thorium.rocks/
Download [ZIP = full, Portable]:
Thorium AVX2 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium AVX 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium SS3 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-SSE3/releases/latest/



Thorium SSE2 (Win32) 32-bit edition for Windows 7/newer 32-bit (x86) + Thorium 
SSE3, SSE4, AVX + AVX2 64-bit editions for
Windows 7/newer 64-bit (x64):
http://github.com/Alex313031/thorium-win7/releases/latest/
Thorium Requirements:
- Multicore CPU: minimum Intel Core 2nd gen or AMD FX with built-in SSE4 
(Streaming SIMD Extensions 4),
http://en.wikipedia.org/wiki/SSE4
AVX (Advanced Vector EXtensions)
http://en.wikipedia.org/wiki/Advanced_Vector_Extensions
+ AES (Advanced Encryption Standard)
http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
enhancements/multimedia extensions/instructions.
- Graphics video controller with 3D rendering + OpenGL capabilities.
Required Windows 7 64-bit (x64) Updates for Thorium 64-bit web browser enhanced 
hardware + software compatibility/support:
http://thorium.rocks/win7
- Windows 7 SP1/2008 R2 64-bit (x64) Servicing Stack Update 2019 KB4490628:
http://support.microsoft.com/help/4490628/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4490628+x64
- Windows 7 SP1/2008 R2 64-bit (x64) SHA-2 Code Signing Support Update 2019 
KB4474419:
http://support.microsoft.com/help/4474419/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4474419+x64
- Supermium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-
bit (x64) based on Chromium code [fork]
optimized for speed + performance:
http://www.win32subsystem.live/supermium.html
Download [EXE = full, Installer +/- ZIP = full, Portable]:
http://github.com/win32ss/supermium/releases/latest/
- X-Chromium (X-Launcher) Portable launcher:
http://www.winpenpack.com/en/download.php?view.1082
Download [EXE = Installer, full]:
http://sourceforge.net/projects/winpenpack/files/X-Chromium/releases/
Either install Chromium precompiled stable releases 32-bit or 64-bit:
http://chromium.woolyss.com/
or extract all files from portable archive [zip or 7z] + copy to the destination
of your choice Chromium portable stable
releases 32-bit or 64-bit to match the Windows NTx [7/newer] operating system(s)
[OS(es)]
build/edition/release/update/version + bit strength [32-bit (x86) or 64-bit 
(x64)] you are using.
All Chromium + Chrome alternatives/derivatives/forks/variants users must have 
these 3 environment variables:
GOOGLE_API_KEY=NO
GOOGLE_DEFAULT_CLIENT_ID=NO
GOOGLE_DEFAULT_CLIENT_SECRET=NO
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
SETX.EXE GOOGLE_API_KEY "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_ID "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_SECRET "NO" /M
Google API Keys:
http://chromium.woolyss.com/#google-api-keys
http://www.chromium.org/developers/how-tos/api-keys/
MDGx "@ Chromium/Chrome/Brave/X-Chromium/Thorium/Vivaldi/Supermium Privacy, 
Safety + Security Settings, Extensions, Guides +
Solutions:" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#PRV
MDGx collection of essential + useful Chromium/Chrome extensions + tweaks -> 
"CHROMIUM" section in TOOLS.TXT (included):
http://www.mdgx.com/tools.php#:~:text=CHROMIUM%20%5B%2A%5D



http://www.mdgx.com/TOOLS.TXT
Firefox builds/derivatives/forks/variants:
http://www.mdgx.com/nettoys.htm#MOZ
MDGx "@ Firefox/TOR Browser/Mercury/Waterfox/Pale Moon/LibreWolf Privacy, Safety
+ Security Settings, Add-ons, Guides +
Solutions:" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#PSF
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\System]
"EnableSmartScreen"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\System]
"EnableSmartScreen"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\System]
"EnableSmartScreen"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System]
"EnableSmartScreen"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\System]
"EnableSmartScreen"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Policies\System]
"EnableSmartScreen"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer]
"SmartScreenEnabled"="Off"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\PhishingFilter]
"ShownVerifyBalloon"=dword:3
"Enabled"=dword:0
"EnabledV8"=dword:0
"EnabledV9"=dword:0
"PreventOverride"=dword:0
"PreventOverrideAppRepUnknown"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\PhishingFilter]
"ShownVerifyBalloon"=dword:3
"Enabled"=dword:0
"EnabledV8"=dword:0
"EnabledV9"=dword:0
"PreventOverride"=dword:0
"PreventOverrideAppRepUnknown"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\PhishingFilter]
"ShownVerifyBalloon"=dword:3
"Enabled"=dword:0
"EnabledV8"=dword:0
"EnabledV9"=dword:0
"PreventOverride"=dword:0
"PreventOverrideAppRepUnknown"=dword:0
[HKEY_CLASSES_ROOT\Local Settings\Software\Microsoft\Windows\CurrentVersion\
AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\MicrosoftEdge\
PhishingFilter]
"ShownVerifyBalloon"=dword:3
"Enabled"=dword:0
"EnabledV8"=dword:0
"EnabledV9"=dword:0
"PreventOverride"=dword:0
"PreventOverrideAppRepUnknown"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\AppHost]
"EnableWebContentEvaluation"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\AppHost]



"EnableWebContentEvaluation"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\AppHost]
"EnableWebContentEvaluation"=dword:0
;
------End cut & paste here------

* Turn OFF "suggested" sites in Edge + Internet Explorer (IE) web browsers, turn
OFF/disable Cortana in Edge, customize Edge
+ Internet Explorer (IE) tabs/Tabbed Browsing + replace Edge + Internet Explorer
(IE)
built-in/default/forced/hardwired/locked/preset Bing (MSN, Microsoft, Live, 
Microsoft Start) start page(s) + search engine(s)
with better, safer, enhanced privacy, more secure alternatives with less hard-
to-disable/hard-to-find/hidden, unwanted
ad(vertisement)s/"offers", spyware, annoyances, forced/behind-your-back data 
collection/logging, telemetry/"phone home",
surveillance, tracking (examples):
http://www.mdgx.com/links.htm#WSE
BEWARE:
*******
Edge web browsers collect, spy, surveil, track + send logged on/signed in 
members/subscribers/users' unique SID (Security
IDentifier) + web browser history [URLs (Uniform Resource Locator) = IPs, web 
addresses]
biometrics/data/fingerprint/information/stats, 
confidential/identifiable/personal/private/privileged preferences, user
choices/options/settings, to Microsoft + Microsoft 3rd 
party/affiliated/associated/leased/(sub)contracted/partner/subsidiary
cloud/network/internet/remote domains/servers/sites 
behind-your-back/disguised/forced/without your
approval/authorization/consent/knowledge/permission:
http://ieeexplore.ieee.org/document/9374407/
http://winbuzzer.com/2019/07/23/users-raise-privacy-concerns-as-edge-browser-
caught-sending-full-urls-and-sid-to-microsoft-xcxwbn/
http://www.scss.tcd.ie/Doug.Leith/pubs/browser_privacy.pdf
http://www.slashgear.com/7-reasons-to-stop-using-microsoft-edge-03701116/
http://www.whatismyip.com/best-browser-for-privacy/
http://www.zdnet.com/article/a-professor-says-edge-is-the-worst-for-privacy-
microsoft-isnt-happy/
http://www.laptopmag.com/news/edge-fails-browser-security-rankings-but-
microsoft-isnt-buying-it/
In this example I have selected Neocities [http://searx.neocities.org/] as 
default search engine. You can change to any
other according to your needs/preferences -> see MDGx "100+ WWW (World Wide Web)
Search Engines" [most have enhanced
privacy, safety + security]:
http://www.mdgx.com/links.htm#WSE
See also MDGx "* Turn OFF/Disable/Opt OUT of/Stop for Profit Web Sites + Social 
Media Invading Your Privacy + Enhance Safety
+ Security:" section in WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Turn%20OFF%2FDisable%2FOpt%20OUT%20of%2FStop
%20for%20Profit%20Web%20Sites%20%2B%20Social%20Media%20Invading%20Your%20Privacy
%20%2B%20Enhance%20Safety%20%2B%20Security
http://www.mdgx.com/WINDOWS7.TXT
and its privacy, safety + security topics for specific search engines:
All these WWW (World Wide Web) search engines, some of whom have by 
default/preconfigured/preinstalled/out-of-the-box
enhanced anonymity/pseudonymity, privacy, safety + security 
features/functions/properties/protocols -> see below:
- "@ Google search, (geo)location tracking, data, history, e-mail (Gmail), 
notifications + apps:"
- "@ YouTube (YT) [videos hosted by Google]:"
- "@ Bing Search, Live, Microsoft, MSN + Related/Shared Accounts, Services + 
Apps [owned by Microsoft]:"



- "@ Yahoo! (Y!) Search, Yahoo! Mail + Yahoo! News:"
- "@ DuckDuckGo (DDG) Search, Privacy Essentials + E-mail Protection:"
- "@ SearXNG Metasearch:"
- "@ SearX Metasearch:"
- "@ Startpage Search + Privacy Protection Add-on + Extension:"
- "@ Brave Search:"
- "@ Qwant Search:"
from the "Digital + Internet/Online Privacy, Safety + Security" chapter in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Digital%20%2B%20Internet%2FOnline%20Privacy%2C
%20Safety%20%2B%20Security%20%3D%20Your%20Top%20Priority
References:
http://admx.help/HKCU/Software/Policies/Microsoft/MicrosoftEdge
http://www.howtogeek.com/221709/how-to-change-your-default-search-engine-in-
microsoft-edge/
http://admx.help/HKCU/Software/Policies/Microsoft/Internet%20Explorer/
TabbedBrowsing
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.MicrosoftEdge::AllowSearchEng
ineCustomization
http://stackoverflow.com/questions/30769921/
http://renenyffenegger.ch/notes/Windows/registry/tree/HKEY_CURRENT_USER/
Software/Microsoft/Windows/CurrentVersion/Explorer/Advanced/index#reg-no-edge-
tabs
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Multitasking::BrowserAltTabBl
owout
http://www.ntkernel.com/microsoft-edge-protectedhomepages/
http://www.itstillworks.com/change-bing-google-12283088.html
http://smallbusiness.chron.com/change-bing-google-70809.html
http://www.howtogeek.com/709072/how-to-switch-to-duckduckgo-a-private-search-
engine/
http://www.howtogeek.com/710128/what-is-duckduckgo-meet-the-google-alternative-
for-privacy/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; Neocities random SearXNG Metasearch Redirector [http://searx.neocities.org/] 
used in this example:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main]
"Default_Search_URL"="http://searx.neocities.org/"
"Default_Page_URL"="http://searx.neocities.org/"
"Start Page"="http://searx.neocities.org/"
"Search Page"="http://searx.neocities.org/"
"First Home Page"="http://searx.neocities.org/"
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main]
"Default_Search_URL"="http://searx.neocities.org/"
"Default_Page_URL"="http://searx.neocities.org/"
"Start Page"="http://searx.neocities.org/"
"Search Page"="http://searx.neocities.org/"
"First Home Page"="http://searx.neocities.org/"
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Main]
"Default_Search_URL"="http://searx.neocities.org/"
"Default_Page_URL"="http://searx.neocities.org/"
"Start Page"="http://searx.neocities.org/"
"Search Page"="http://searx.neocities.org/"
"First Home Page"="http://searx.neocities.org/"



[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Suggested Sites]
"Enabled"=dword:0
"DataStreamEnabledState"=dword:0
[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Internet Explorer\Suggested Sites]
"Enabled"=dword:0
"DataStreamEnabledState"=dword:0
[HKEY_USERS\.DEFAULT\SOFTWARE\Microsoft\Internet Explorer\Suggested Sites]
"Enabled"=dword:0
"DataStreamEnabledState"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\TabbedBrowsing]
"WarnOnClose"=dword:0
"NewTabPageShow"=dword:0
[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Internet Explorer\TabbedBrowsing]
"WarnOnClose"=dword:0
"NewTabPageShow"=dword:0
[HKEY_USERS\.DEFAULT\SOFTWARE\Microsoft\Internet Explorer\TabbedBrowsing]
"WarnOnClose"=dword:0
"NewTabPageShow"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"DisableSearchBoxSuggestions"=dword:1
"MultiTaskingAltTabFilter"=dword:4
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"DisableSearchBoxSuggestions"=dword:1
"MultiTaskingAltTabFilter"=dword:4
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"DisableSearchBoxSuggestions"=dword:1
"MultiTaskingAltTabFilter"=dword:4
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\Main]
"ShowSearchSuggestionsGlobal"=dword:0
"ShowSearchSuggestionsGlobal_TIMESTAMP"=hex:00
"HomeButtonPage"="http://searx.neocities.org/"
"HomeButtonEnabled"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\OnlineHistory]
"MuidBing"=""
"MuidBingCounter"=dword:0
"MuidMsn"=""
"MuidMsnCounter"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\PhishingFilter]
"PreventOverride"=dword:0
; FYI: According to my knowledge and understanding:
; (¶) You (Microsoft corporation, and all its third parties, affiliates, 
associates, branches, brands, companies, divisions,
; entities, holders, parents, participants, partners, subsidiaries, etc) are in 
violation of the United States of America
; (U. S. A.) Department of Justice (DOJ) legal verdict, the United States 
District Court, District of Columbia (DC), Civil
; Action No. 98-1232, as of July 28, 1999, which established beyond reasonable 
doubt that web browsers are not Windows
; [quote]:
; "154. In conclusion, the preferences of consumers and the responsive behavior 
of software firms demonstrate that Web
; browsers and operating systems are separate products."
; https://www.justice.gov/atr/us-v-microsoft-courts-findings-fact/
; https://en.wikipedia.org/wiki/United_States_v._Microsoft_Corp.
; https://ec.europa.eu/commission/presscorner/detail/en/IP_09_1941/
; https://ec.europa.eu/commission/presscorner/detail/en/IP_13_196/
; https://en.wikipedia.org/wiki/Microsoft_Corp._v._Commission
; https://www.ctrl.blog/entry/microsoft-edge-protocol-competition.html



; (¶) You (Microsoft corporation, and all its third parties, affiliates, 
associates, branches, brands, companies, divisions,
; entities, holders, parents, participants, partners, subsidiaries, etc) are in 
violation of the (Free and) Open Source
; Software [(F)OSS] license and usage agreements binding contracts valid world 
wide when you attempted to cripple, limit,
; modify, restrict, bundle and/or tie said software applications with the 
purpose of limiting, restricting, suppressing your
; paying customers' choices, options and preferences, and using anti-
competitive, deceitful, monopolizing, exclusivist,
; take-over, bundling, tying, unfair, and in certain countries, 
federations/unions, territories and/or regions banned or/and
; illegal marketing, monetizing and business practices, strategies and tactics: 
Google Chromium web browser [BSD, MIT, LGPL,
; Ms-PL, MPL/GPL/LGPL licenses] source code used for all current builds of 
Microsoft Edge web browsers built-in, forced,
; locked, pre-configured, pre-installed, pre-set as default web browser and web 
browser core/engine for most local,
; networking, internet/online and remote based app(lication)s, programs, 
software, features, file types, links, protocols,
; shortcuts, enrollments, memberships, services, subscriptions, trials, 
ad(ware)/spyware/surveillance/tracking, and made
; them, on purpose, unable or very hard to replace with/switch to any 
alternative/other/similar web browser/web browser
; core/engine, designed them on purpose to be complicated and confusing, and 
(almost) impossible to remove/uninstall and/or
; disable/replace by built-in/standard methods/procedures in all current and new
releases of Microsoft Windows operating
; systems (OSes).
; https://opensource.org/faq/#commercial
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\Protected - It is a violation of Windows Policy to modify. See 
aka.ms/browserpolicy]
"ProtectedHomepages"=hex:00
"ProtectedSearchScopes"=hex:00
"ProtectedGlobalExtensionSetting"=hex:00
"UADHPNeedToVerify"=dword:0
"UADSPNeedToVerify"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ContinuousBrowsing]
"Enabled"=dword:0
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ContinuousBrowsing]
"Enabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ContinuousBrowsing]
"Enabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"NewTabPageFlightUrlKind"="http://searx.neocities.org/"
"EnableCortana"=dword:0
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"NewTabPageFlightUrlKind"="http://searx.neocities.org/"
"EnableCortana"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]



"NewTabPageFlightUrlKind"="http://searx.neocities.org/"
"EnableCortana"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\MicrosoftEdge\Protected - It is 
a violation of Windows Policy to modify. See aka.ms/browserpolicy]
"AllowSearchEngineCustomization"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\MicrosoftEdge\Protected - It is a
violation of Windows Policy to modify. See aka.ms/browserpolicy]
"AllowSearchEngineCustomization"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\MicrosoftEdge\Protected - It is
a violation of Windows Policy to modify. See aka.ms/browserpolicy]
"AllowSearchEngineCustomization"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\EUPP Protected - It is 
a violation of Windows Policy to modify. See aka.ms/browserpolicy\DHP]
"BackupHomePage"=hex:00
"ChangeNotice"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\EUPP Protected - It is a
violation of Windows Policy to modify. See aka.ms/browserpolicy\DHP]
"BackupHomePage"=hex:00
"ChangeNotice"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\EUPP Protected - It is
a violation of Windows Policy to modify. See aka.ms/browserpolicy\DHP]
"BackupHomePage"=hex:00
"ChangeNotice"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\EUPP Protected - It is 
a violation of Windows Policy to modify. See aka.ms/browserpolicy\DSP]
"BackupDefaultSearchScope"=hex:00
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\EUPP Protected - It is a
violation of Windows Policy to modify. See aka.ms/browserpolicy\DSP]
"BackupDefaultSearchScope"=hex:00
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\EUPP Protected - It is
a violation of Windows Policy to modify. See aka.ms/browserpolicy\DSP]
"BackupDefaultSearchScope"=hex:00
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Protected - It is a 
violation of Windows Policy to modify. See aka.ms/browserpolicy]
"HomepagesUpgradeVersion"=dword:0
"SearchScopesUpgradeVersion"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Protected - It is a 
violation of Windows Policy to modify. See aka.ms/browserpolicy]
"HomepagesUpgradeVersion"=dword:0
"SearchScopesUpgradeVersion"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Protected - It is a 
violation of Windows Policy to modify. See aka.ms/browserpolicy]
"HomepagesUpgradeVersion"=dword:0
"SearchScopesUpgradeVersion"=dword:0
;
------End cut & paste here------

* Replace Edge + Internet Explorer (IE) with your choice of independent/3rd 
party free, open source, better, safer, more
secure, uncrippled, unlocked, unrestricted, modern default web browser 
[Chromium, Brave, Vivaldi, Thorium, X-Chromium
(X-Launcher), Firefox, Opera, TOR Browser, etc] for HTM, HTML, DHTM, DHTML, 
XHTM, XHTML, XML, PHP, PHP4, PHP5, HTTP, HTTPS,
URL (URI), WebSite, e-mail (web mail), FTP, etc file extensions, shortcuts + 
protocols:
http://www.thewindowsclub.com/set-chrome-default-browser-windows-8/
http://newoldthing.wordpress.com/2007/03/23/how-does-your-browsers-know-that-
its-not-the-default-browser/
http://forums.tomshardware.com/threads/default-browser-in-registry.1136495/
http://community.spiceworks.com/topic/464572-how-to-set-google-chrome-as-the-
default-browser-in-group-policy/
http://stackoverflow.com/questions/32354861/
http://www.adamfowlerit.com/2020/07/set-microsoft-edge-as-default-browser-one-
time/



http://www.petenetlive.com/KB/Article/0001284/
http://tor.stackexchange.com/questions/4125/
http://www.technipages.com/ie-default-browser-prompt/
BEWARE:
*******
Edge web browsers collect, spy, surveil, track + send logged on/signed in 
members/subscribers/users' unique SID (Security
IDentifier) + web browser history [URLs (Uniform Resource Locator) = IPs, web 
addresses]
biometrics/data/fingerprint/information/stats, 
confidential/identifiable/personal/private/privileged preferences, user
choices/options/settings, to Microsoft + Microsoft 3rd 
party/affiliated/associated/leased/(sub)contracted/partner/subsidiary
cloud/network/internet/remote domains/servers/sites 
behind-your-back/disguised/forced/without your
approval/authorization/consent/knowledge/permission:
http://ieeexplore.ieee.org/document/9374407/
http://winbuzzer.com/2019/07/23/users-raise-privacy-concerns-as-edge-browser-
caught-sending-full-urls-and-sid-to-microsoft-xcxwbn/
http://www.scss.tcd.ie/Doug.Leith/pubs/browser_privacy.pdf
http://www.slashgear.com/7-reasons-to-stop-using-microsoft-edge-03701116/
http://www.whatismyip.com/best-browser-for-privacy/
http://www.zdnet.com/article/a-professor-says-edge-is-the-worst-for-privacy-
microsoft-isnt-happy/
http://www.laptopmag.com/news/edge-fails-browser-security-rankings-but-
microsoft-isnt-buying-it/
RECOMMENDED:
************
Replace Edge + IE with recommended independent/3rd party free, open source, 
better, safe, secure, uncrippled, unlocked,
unrestricted, modern web browsers (examples):
http://www.mdgx.com/nettoys.htm#NET
MDGx "Free(ware) Windows 9x/NTx Web Browsers" chapter -> "Chromium + Chrome web 
browsers [free(ware)]" section ->
"Chromium + Chrome" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#CHR
RECOMMENDED:
- Chromium Precompiled EXEcutable [Installer EXE + Portable Archives ZIP/7z] 32-
bit + 64-bit for Windows XP/newer 32-bit
(x86) + 64-bit (x64):
http://chromium.woolyss.com/
Degoogled/Ungoogled/stripped of Google ad(ware)/spyware/surveillance/tracking 
code Chromium builds [clearly labeled]:
http://github.com/ungoogled-software/ungoogled-chromium/blob/master/README.md
http://ungoogled-software.github.io/ungoogled-chromium-wiki/faq
Ungoogled Chromium precompiled binaries 32-bit + 64-bit for Windows 7/newer 32-
bit (x86) + 64-bit (x64) [75-125 MB,
Installer ONLY EXE + Portable ZIP, NEWest at the top]:
http://ungoogled-software.github.io/ungoogled-chromium-binaries/
Ungoogled Chromium 64-bit for Windows 7/newer 64-bit (x64):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/64bit/
Ungoogled Chromium 32-bit for Windows 7/newer 32-bit (x86):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/32bit/
- Brave 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
improved privacy, safety + security and optimized speed:
http://brave.com/
Brave Repository:
http://github.com/brave/brave-browser/
Download [ZIP = full, Portable]:
http://github.com/brave/brave-browser/releases/latest/
- Vivaldi 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 



(x64) based on Chromium code [fork] with
enhanced privacy, safety + security:
http://vivaldi.com/
Download [EXE = Installer ONLY]:
http://vivaldi.com/download/
Vivaldi Portable -> run Installer EXE -> Install standalone:
http://help.vivaldi.com/desktop/install-update/standalone-version-of-vivaldi/
- Thorium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-bit
(x64) based on Chromium code [fork]
hardware 3D, rendering + video playback optimized:
http://thorium.rocks/
Download [ZIP = full, Portable]:
Thorium AVX2 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium AVX 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium SS3 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-SSE3/releases/latest/
Thorium SSE2 (Win32) 32-bit edition for Windows 7/newer 32-bit (x86) + Thorium 
SSE3, SSE4, AVX + AVX2 64-bit editions for
Windows 7/newer 64-bit (x64):
http://github.com/Alex313031/thorium-win7/releases/latest/
Thorium Requirements:
- Multicore CPU: minimum Intel Core 2nd gen or AMD FX with built-in SSE4 
(Streaming SIMD Extensions 4),
http://en.wikipedia.org/wiki/SSE4
AVX (Advanced Vector EXtensions)
http://en.wikipedia.org/wiki/Advanced_Vector_Extensions
+ AES (Advanced Encryption Standard)
http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
enhancements/multimedia extensions/instructions.
- Graphics video controller with 3D rendering + OpenGL capabilities.
Required Windows 7 64-bit (x64) Updates for Thorium 64-bit web browser enhanced 
hardware + software compatibility/support:
http://thorium.rocks/win7
- Windows 7 SP1/2008 R2 64-bit (x64) Servicing Stack Update 2019 KB4490628:
http://support.microsoft.com/help/4490628/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4490628+x64
- Windows 7 SP1/2008 R2 64-bit (x64) SHA-2 Code Signing Support Update 2019 
KB4474419:
http://support.microsoft.com/help/4474419/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4474419+x64
- Supermium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-
bit (x64) based on Chromium code [fork]
optimized for speed + performance:
http://www.win32subsystem.live/supermium.html
Download [EXE = full, Installer +/- ZIP = full, Portable]:
http://github.com/win32ss/supermium/releases/latest/
- X-Chromium (X-Launcher) Portable launcher:
http://www.winpenpack.com/en/download.php?view.1082
Download [EXE = Installer, full]:
http://sourceforge.net/projects/winpenpack/files/X-Chromium/releases/
Either install Chromium precompiled stable releases 32-bit or 64-bit:
http://chromium.woolyss.com/
or extract all files from portable archive [zip or 7z] + copy to the destination
of your choice Chromium portable stable
releases 32-bit or 64-bit to match the Windows NTx [7/newer] operating system(s)
[OS(es)]
build/edition/release/update/version + bit strength [32-bit (x86) or 64-bit 
(x64)] you are using.
All Chromium + Chrome alternatives/derivatives/forks/variants users must have 
these 3 environment variables:



GOOGLE_API_KEY=NO
GOOGLE_DEFAULT_CLIENT_ID=NO
GOOGLE_DEFAULT_CLIENT_SECRET=NO
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
SETX.EXE GOOGLE_API_KEY "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_ID "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_SECRET "NO" /M
Google API Keys:
http://chromium.woolyss.com/#google-api-keys
http://www.chromium.org/developers/how-tos/api-keys/
MDGx "@ Chromium/Chrome/Brave/X-Chromium/Thorium/Vivaldi/Supermium Privacy, 
Safety + Security Settings, Extensions, Guides +
Solutions:" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#PRV
MDGx collection of essential + useful Chromium/Chrome extensions + tweaks -> 
"CHROMIUM" section in TOOLS.TXT (included):
http://www.mdgx.com/tools.php#:~:text=CHROMIUM%20%5B%2A%5D
http://www.mdgx.com/TOOLS.TXT
1st Things 1st:
***************
BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> See "BACKUP/EXPORT + 
RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
Example: I use winPenPack X-Chromium (X-Launcher) Portable launcher 64-bit 
[free, open source]:
http://www.winpenpack.com/en/download.php?view.1082
On my main home built PC and my tweaked Windows 10 gaming laptop the customized 
executables are located in these
directories/folders:
C:\PORT\CHROME\X-Chromium.exe
and respectively:
C:\PORT\CHROME\BIN\CHROME\CHROME.EXE
NOTES:
- Registry file below uses these values [example: I use winPenPack X-Chromium 
(X-Launcher) Portable launcher = see above] to
point to file names + their respective locations. You need to replace them as 
needed to match your web browser executable(s)
name(s) + location(s), depending on the specific/custom program(s) you are 
using.
- All registry plain text strings [REG_SZ] listed here need to be replaced with 
the ones matching your
existing/installed/registered web browser(s). I use winPenPack X-Chromium (X-
Launcher) Portable launcher (example) -> see
above:
Chrome
Chromium
Chromium web browser
X-Chromium
ChromeHTML
ChromiumHTML
winPenPack X-Chromium Launcher
winPenPack.X-ChromiumLauncher
winPenPack.X-ChromiumLauncher.Default
X-Chromium.File
XChromium.exe_.website
Chromium is a fast web browser for Windows.
C:\\PORT\\CHROME\\X-Chromium.exe
C:\\PORT\\CHROME\\BIN\\CHROME
I recommend to replace all instances of Edge [+ Internet Explorer (IE)] 
EXEcutables (.exe) with either:
- your preferred default web browser EXEcutable (.exe) [for example I use X-



Chromium.exe], OR with
- systray.exe [generic, silent], OR with
- / [null, silent].
In order to eliminate annoying errors when attempting to 
execute/launch/open/run/start Microsoft assigned Edge [or Internet
Explorer (IE)] built-in/default/hard-wired/pre-installed/preset file types, 
internet schemes/protocols + URL/URI
addresses/items/links/schemes/shortcuts you may want to redirect all Edge + IE 
EXEcutables (.exe) to your preferred default
web browser EXEcutable (.exe), so from now on they will 
execute/launch/open/run/start it instead. ;-/
Brace yourself... huge REG file coming up... ;-)
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; * Enable next registry key + value below by removing the semicolon and space 
[; ] in front of them to disable + replace
; Internet Explorer (IE) executable [iexplore.exe] with your favorite 
existing/installed/registered web browser.
; I use winPenPack X-Chromium (X-Launcher) Portable launcher (example) -> see 
above:
; http://www.winpenpack.com/en/download.php?view.1082
; Optional = IEXPLORE.EXE applies only to earlier/older Windows 10 
builds/editions/releases/updates/versions:
; [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\IEXPLORE.EXE]
; "Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
; * Next 9 registry keys + values below disable + replace all known Edge/Edge 
related executables (.exe) with your
; favorite/preferred existing/installed/registered web browser.
; http://www.mdgx.com/nettoys.htm#NET
; I use winPenPack X-Chromium (X-Launcher) Portable launcher (example) -> see 
above:
; http://www.winpenpack.com/en/download.php?view.1082
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\elevation_service.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MicrosoftEdgeUpdate.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\LaunchWinApp.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\msedge.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MicrosoftEdge.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MicrosoftEdgeBCHost.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MicrosoftEdgeCP.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MicrosoftEdgeDevTools.exe]



"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\MicrosoftEdgeSH.exe]
"Debugger"="C:\\PORT\\CHROME\\X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Shell\Associations\
UrlAssociations\http\UserChoice]
"ProgId"="AppXq0fevzme2pys62n3e0fbqa7peapykr8v"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Shell\Associations\
UrlAssociations\https\UserChoice]
"ProgId"="AppX90nv6nhay5n6a98fnetv7tpk64pp35es"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Shell\Associations\
UrlAssociations\microsoft-edge\UserChoice]
"ProgId"="AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y"
[HKEY_CURRENT_USER\Software\Microsoft\Windows\Shell\Associations\
UrlAssociations\http\UserChoice]
"ProgId"="AppXq0fevzme2pys62n3e0fbqa7peapykr8v"
[HKEY_CURRENT_USER\Software\Microsoft\Windows\Shell\Associations\
UrlAssociations\https\UserChoice]
"ProgId"="AppX90nv6nhay5n6a98fnetv7tpk64pp35es"
[HKEY_CURRENT_USER\Software\Microsoft\Windows\Shell\Associations\
UrlAssociations\microsoft-edge\UserChoice]
"ProgId"="AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y"
[HKEY_USERS\.DEFAULT\Microsoft\Windows\Shell\Associations\UrlAssociations\http\
UserChoice]
"ProgId"="AppXq0fevzme2pys62n3e0fbqa7peapykr8v"
[HKEY_USERS\.DEFAULT\Microsoft\Windows\Shell\Associations\UrlAssociations\https\
UserChoice]
"ProgId"="AppX90nv6nhay5n6a98fnetv7tpk64pp35es"
[HKEY_USERS\.DEFAULT\Microsoft\Windows\Shell\Associations\UrlAssociations\
microsoft-edge\UserChoice]
"ProgId"="AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y]
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
Application]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationCompany"="Chromium"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\Shell\
open]
"ActivatableClassId"=-
"PackageId"="winPenPack X-Chromium Launcher"
"ContractId"=-
"DesiredInitialViewState"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\Shell\
open\command]
"DelegateExecute"=-
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y]
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_CURRENT_USER\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
Application]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationCompany"="Chromium"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_CURRENT_USER\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
DefaultIcon]



@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_CURRENT_USER\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\Shell\
open]
"ActivatableClassId"=-
"PackageId"="winPenPack X-Chromium Launcher"
"ContractId"=-
"DesiredInitialViewState"=dword:0
[HKEY_CURRENT_USER\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\Shell\
open\command]
"DelegateExecute"=-
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_USERS\.DEFAULT\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y]
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_USERS\.DEFAULT\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
Application]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationCompany"="Chromium"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_USERS\.DEFAULT\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_USERS\.DEFAULT\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
Shell\open]
"ActivatableClassId"=-
"PackageId"="winPenPack X-Chromium Launcher"
"ContractId"=-
"DesiredInitialViewState"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\AppX7rm9drdg8sk7vqndwj3sdjw11x96jc0y\
Shell\open\command]
"DelegateExecute"=-
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v]
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
Application]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationCompany"="Chromium"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\Shell\
open]
"ActivatableClassId"=-
"PackageId"="winPenPack X-Chromium Launcher"
"ContractId"=-
"DesiredInitialViewState"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\Shell\
open\command]
"DelegateExecute"=-
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v]
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_CURRENT_USER\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
Application]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationCompany"="Chromium"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"



[HKEY_CURRENT_USER\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_CURRENT_USER\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\Shell\
open]
"ActivatableClassId"=-
"PackageId"="winPenPack X-Chromium Launcher"
"ContractId"=-
"DesiredInitialViewState"=dword:0
[HKEY_CURRENT_USER\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\Shell\
open\command]
"DelegateExecute"=-
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_USERS\.DEFAULT\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v]
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_USERS\.DEFAULT\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
Application]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationCompany"="Chromium"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_USERS\.DEFAULT\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_USERS\.DEFAULT\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
Shell\open]
"ActivatableClassId"=-
"PackageId"="winPenPack X-Chromium Launcher"
"ContractId"=-
"DesiredInitialViewState"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\AppXq0fevzme2pys62n3e0fbqa7peapykr8v\
Shell\open\command]
"DelegateExecute"=-
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main]
"Check_Associations"="No"
"IgnoreDefCheck"="Yes"
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main]
"Check_Associations"="No"
"IgnoreDefCheck"="Yes"
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Main]
"Check_Associations"="No"
"IgnoreDefCheck"="Yes"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App Paths\X-
Chromium.exe]
@="C:\\PORT\\CHROME\\X-Chromium.exe"
"Path"="C:\\PORT\\CHROME"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App Paths\
CHROME.EXE]
@="C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE"
"Path"="C:\\PORT\\CHROME\\BIN\\CHROME"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile_FullWindowEmbed]
@="HTML Plugin Document"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile_FullWindowEmbed\CLSID]
@="{25336921-03F9-11CF-8FD0-00AA00686F13}"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\CLSID]
@="{25336920-03F9-11cf-8FD0-00AA00686F13}"



[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\ScriptHostEncode]
@="{0CF774D0-F077-11D1-B1BC-00C04F86C324}"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\shell\open]
@="Open in S&ame Window"
"CommandId"="X-Chromium.File"
"MUIVerb"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
"DelegateExecute"="{17FE9752-0B5A-4665-84CD-569794602F5C}"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmfile\shell\open\ddeexec\Application]
@="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\CLSID]
@="{25336920-03F9-11cf-8FD0-00AA00686F13}"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\ScriptHostEncode]
@="{0CF774D0-F077-11D1-B1BC-00C04F86C324}"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\shell\open]
@="Open in S&ame Window"
"CommandId"="X-Chromium.File"
"MUIVerb"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
"DelegateExecute"="{17FE9752-0B5A-4665-84CD-569794602F5C}"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\htmlfile\shell\open\ddeexec\Application]
@="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\ChromiumHTML]
@="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\ChromiumHTML\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\ChromiumHTML\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\ChromiumHTML\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\ChromiumHTML]
@="winPenPack X-Chromium Launcher"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
[HKEY_CURRENT_USER\Software\Classes\ChromiumHTML\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\ChromiumHTML\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"PerceivedType"="text"
"Content Type"="text/html"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm\OpenWithList\notepad.exe]



@=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm\OpenWithProgIds]
"htmlfile"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"PerceivedType"="text"
"Content Type"="text/html"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html\OpenWithProgIds]
"htmlfile"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.htm\OpenWithProgids]
"htmlfile"=hex(0):
"ChromiumHTML"=hex(0):
"ChromeHTML"=-
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.html\OpenWithProgids]
"htmlfile"=hex(0):
"ChromiumHTML"=hex(0):
"ChromeHTML"=-
[HKEY_USERS\.DEFAULT\Software\Classes\.htm]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_USERS\.DEFAULT\Software\Classes\.html]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_CURRENT_USER\Software\Classes\.htm]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\.htm\OpenWithProgids]
"ChromiumHTML"=""
[HKEY_CURRENT_USER\Software\Classes\.htm\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\.htm\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\.html]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\.html\OpenWithProgids]
"ChromiumHTML"=""
[HKEY_CURRENT_USER\Software\Classes\.html\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\.html\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.htm\OpenWithList]
"a"="X-Chromium.exe"
"b"=-
"c"=-
"d"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.htm\OpenWithProgids]
"htmlfile"=hex(0):



"ChromiumHTML"=hex(0):
"ChromeHTML"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.htm\UserChoice]
"ProgId"="ChromiumHTML"
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.html\OpenWithList]
"a"="X-Chromium.exe"
"b"=-
"c"=-
"d"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.html\OpenWithProgids]
"htmlfile"=hex(0):
"ChromiumHTML"=hex(0):
"ChromeHTML"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.html\UserChoice]
"ProgId"="ChromiumHTML"
[HKEY_CURRENT_USER\Software\Microsoft\Windows\Roaming\OpenWith\FileExts\.htm\
UserChoice]
"ProgId"="ChromiumHTML"
[HKEY_CURRENT_USER\Software\Microsoft\Windows\Roaming\OpenWith\FileExts\.html\
UserChoice]
"ProgId"="ChromiumHTML"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\http]
"URL Protocol"=""
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\http\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\http\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\https]
"URL Protocol"=""
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\https\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\https\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.html\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.htm\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.URL]
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
@="urlfile"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.URL\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.URL\shell\open\command]



@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\urlfile]
@="URL File"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\urlfile\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\urlfile\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\urlfile]
@="URL File"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\urlfile\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\urlfile\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\InternetShortcut]
@="InternetShortcut"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"NeverShowExt"=""
"EditFlags"=dword:1
"IsShortcut"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\InternetShortcut\shell]
@="Open"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\InternetShortcut\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\InternetShortcut]
@="InternetShortcut"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"NeverShowExt"=""
"EditFlags"=dword:1
"IsShortcut"=""
[HKEY_CURRENT_USER\Software\Classes\InternetShortcut\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\InternetShortcut\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\http]
"URL Protocol"=""
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\http\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\http\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\https]
"URL Protocol"=""
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\https\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\https\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\.html]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\.html\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\.html\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\htmlfile]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"



"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\htmlfile\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\htmlfile\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\.htm]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\.htm\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\.htm\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\htmfile]
@="ChromiumHTML"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\htmfile\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\htmfile\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\.URL]
@="InternetShortcut"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"EditFlags"=dword:1
[HKEY_CURRENT_USER\Software\Classes\.URL\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\.URL\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\InternetShortcut]
@="InternetShortcut"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
"NeverShowExt"=""
"EditFlags"=dword:1
"IsShortcut"=""
[HKEY_CURRENT_USER\Software\Classes\InternetShortcut\shell]
@="Open"
[HKEY_CURRENT_USER\Software\Classes\InternetShortcut\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Applications\CHROME.EXE\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\Applications\CHROME.EXE\shell\open\command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Applications\X-Chromium.exe\shell\open\
command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\Applications\X-Chromium.exe\shell\open\
command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet]
@="CHROME.EXE"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE]
@="Chromium"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE\Capabilities]
"ApplicationDescription"="Chromium web browser"
"ApplicationIcon"="C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE,0"
"ApplicationName"="Chromium"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE\Capabilities\
FileAssociations]
".htm"="ChromiumHTML"
".html"="ChromiumHTML"
".shtml"="ChromiumHTML"
".xht"="ChromiumHTML"
".xhtml"="ChromiumHTML"



".website"="XChromium.exe_.website"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE\Capabilities\
StartMenu]
"StartMenuInternet"="CHROME.EXE"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE\Capabilities\
URLAssociations]
"ftp"="ChromiumURL"
"http"="ChromiumURL"
"https"="ChromiumURL"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE\DefaultIcon]
@="C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\CHROME.EXE\shell\open\
command]
@="\"C:\\PORT\\CHROME\\BIN\\CHROME\\CHROME.EXE\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe]
@="X-Chromium"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe\
Capabilities]
"ApplicationDescription"="X-Chromium web browser"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationName"="Chromium"
"AppUserModelID"="winPenPack.X-ChromiumLauncher.Default"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe\
Capabilities\FileAssociations]
".htm"="ChromiumHTML"
".html"="ChromiumHTML"
".shtml"="ChromiumHTML"
".xht"="ChromiumHTML"
".xhtml"="ChromiumHTML"
".website"="XChromium.exe_.website"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe\
Capabilities\StartMenu]
"StartMenuInternet"="X-Chromium.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe\
Capabilities\URLAssociations]
"ftp"="ChromiumURL"
"http"="ChromiumURL"
"https"="ChromiumURL"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe\
DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\X-Chromium.exe\shell\
open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MediaPlayer\ShimInclusionList\CHROME.EXE]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MediaPlayer\ShimInclusionList\X-
Chromium.exe]
[HKEY_LOCAL_MACHINE\SOFTWARE\RegisteredApplications]
"Chromium"="Software\\Clients\\StartMenuInternet\\CHROME.EXE\\Capabilities"
"X-Chromium"="Software\\Clients\\StartMenuInternet\\X-Chromium\\Capabilities"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\ProtocolExecute\
ChromiumHTML]
"WarnOnOpen"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\ProtocolExecute\
ChromiumHTML]
"WarnOnOpen"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\ProtocolExecute\
ChromiumURL]
"WarnOnOpen"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\ProtocolExecute\
ChromiumURL]
"WarnOnOpen"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\ProtocolExecute\
ChromeHTML]



"WarnOnOpen"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\ProtocolExecute\
ChromeHTML]
"WarnOnOpen"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\ProtocolExecute\
ChromeURL]
"WarnOnOpen"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\ProtocolExecute\
ChromeURL]
"WarnOnOpen"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\RegisteredApplications]
"winPenPack X-Chromium Launcher"="Software\\Clients\\StartMenuInternet\\
winPenPack X-Chromium Launcher\\Capabilities"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher]
@="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\Capabilities]
"ApplicationName"="winPenPack X-Chromium Launcher"
"ApplicationIcon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
"ApplicationDescription"="Chromium is a fast web browser for Windows."
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\Capabilities\FileAssociations]
".xhtml"="ChromeHTML"
".xht"="ChromeHTML"
".shtml"="ChromeHTML"
".html"="ChromeHTML"
".htm"="ChromeHTML"
".website"="XChromium.exe_.website"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\Capabilities\Startmenu]
"StartMenuInternet"="winPenPack X-Chromium Launcher"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\Capabilities\URLAssociations]
"webcal"="ChromeHTML"
"urn"="ChromeHTML"
"tel"="ChromeHTML"
"smsto"="ChromeHTML"
"sms"="ChromeHTML"
"nntp"="ChromeHTML"
"news"="ChromeHTML"
"mms"="ChromeHTML"
"mailto"="ChromeHTML"
"irc"="ChromeHTML"
"https"="ChromeHTML"
"http"="ChromeHTML"
"ftp"="ChromeHTML"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\InstallInfo]
"IconsVisible"=dword:1
"ShowIconsCommand"="\"C:\\PORT\\CHROME\\X-Chromium.exe\" --show-icons"
"HideIconsCommand"="\"C:\\PORT\\CHROME\\X-Chromium.exe\" --hide-icons"
"ReinstallCommand"="\"C:\\PORT\\CHROME\\X-Chromium.exe\" --make-default-browser"
[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\StartMenuInternet\winPenPack X-Chromium 
Launcher\shell\open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\IE.AssocFile.URL\shell\Open]
"Icon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\IE.AssocFile.URL\shell\Open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Classes\IE.AssocFile.URL\shell\Open]



"Icon"="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_CURRENT_USER\Software\Classes\IE.AssocFile.URL\shell\Open\command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Capabilities\
FileAssociations]
".website"="XChromium.exe_.website"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.website]
@="XChromium.exe_.website"
"Content Type"="application/x-mswebsite"
"PerceivedType"="System"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.website\OpenWithProgIds]
"XChromium.exe_.website"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\IE.AssocFile.WEBSITE]
@="Pinned Site Shortcut"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
"IsShortcut"=""
"NeverShowExt"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\XChromium.exe_.website\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\XChromium.exe_.website\Shell\Open\Command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\IE.AssocFile.WEBSITE\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\IE.AssocFile.WEBSITE\Shell\Open\Command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\XChromium.exe_.website]
@="Pinned Site Shortcut"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
"IsShortcut"=""
"NeverShowExt"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\XChromium.exe_.website\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\XChromium.exe_.website\Shell\Open\Command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Microsoft.Website]
@="Pinned Site Shortcut"
"EditFlags"=dword:1
"FriendlyTypeName"="winPenPack X-Chromium Launcher"
"IsShortcut"=""
"NeverShowExt"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Microsoft.Website\DefaultIcon]
@="C:\\PORT\\CHROME\\X-Chromium.exe,0"
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Microsoft.Website\Shell\Open\Command]
@="\"C:\\PORT\\CHROME\\X-Chromium.exe\" \"%1\""
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.website\OpenWithProgids]
"XChromium.exe_.website"=hex(0):
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
FileExts\.website\UserChoice]
"ProgId"="Applications\\XChromium.exe"
[HKEY_CURRENT_USER\Software\Classes\.website\OpenWithList\XChromium.exe]
[HKEY_LOCAL_MACHINE\Software\Policies\Google\Chrome]
"ChromeCleanupEnabled"=dword:0
"ChromeCleanupReportingEnabled"=dword:0
"AdsSettingForIntrusiveAdsSites"=dword:1
"AllowDeletingBrowserHistory"=dword:1
"AllowDinosaurEasterEgg"=dword:1
"AllowFileSelectionDialogs"=dword:1
"AllowOutdatedPlugins"=dword:1
"AutoFillEnabled"=dword:1
"AutofillCreditCardEnabled"=dword:1
"AutoplayAllowed"=dword:1



"BackgroundModeEnabled"=dword:0
"BlockThirdPartyCookies"=dword:0
"BookmarkBarEnabled"=dword:1
"BuiltInDnsClientEnabled"=dword:1
"ComponentUpdatesEnabled"=dword:1
"DefaultGeolocationSetting"=dword:0
"DefaultNotificationsSetting"=dword:0
"DefaultPluginsSetting"=dword:1
"DefaultSearchProviderSearchURL"="http://www.google.com/search?q={searchTerms}"
"DeveloperToolsDisabled"=dword:0
"Disable3DAPIs"=dword:0
"DownloadRestrictions"=dword:0
"EditBookmarksEnabled"=dword:1
"ForceBrowserSignin"=dword:0
"ForceGoogleSafeSearch"=dword:0
"ForceYouTubeRestrict"=dword:0
"FullscreenAllowed"=dword:1
"HardwareAccelerationModeEnabled"=dword:1
"HideWebStoreIcon"=dword:1
"HomepageIsNewTabPage"=dword:1
"HomepageLocation"="chrome://newtab"
"ImportAutofillFormData"=dword:1
"ImportBookmarks"=dword:1
"ImportHistory"=dword:0
"ImportHomepage"=dword:0
"ImportSavedPasswords"=dword:1
"ImportSearchEngine"=dword:0
"IncognitoModeAvailability"=dword:1
"MetricsReportingEnabled"=dword:0
"NetworkPredictionOptions"=dword:1
"NewTabPageLocation"="chrome://newtab"
"PasswordManagerEnabled"=dword:1
"PromptForDownloadLocation"=dword:0
"RelaunchNotification"=dword:0
"RunAllFlashInAllowMode"=dword:1
"SafeBrowsingEnabled"=dword:1
"SafeBrowsingExtendedReportingEnabled"=dword:0
"SavingBrowserHistoryDisabled"=dword:1
"SearchSuggestEnabled"=dword:1
"ShowAppsShortcutInBookmarkBar"=dword:0
"ShowCastIconInToolbar"=dword:0
"ShowHomeButton"=dword:1
"SitePerProcess"=dword:1
"SpellCheckServiceEnabled"=dword:0
"SpellCheckEnabled"=dword:0
"SuppressUnsupportedOSWarning"=dword:1
"SyncDisabled"=dword:1
"TaskManagerEndProcessEnabled"=dword:1
"ThirdPartyBlockingEnabled"=dword:0
"TranslateEnabled"=dword:1
"WPADQuickCheckEnabled"=dword:0
"WelcomePageOnOSUpgradeEnabled"=dword:0
[HKEY_LOCAL_MACHINE\Software\Policies\Google\Chrome\Recommended]
"AdsSettingForIntrusiveAdsSites"=dword:1
"AllowDeletingBrowserHistory"=dword:1
"AllowDinosaurEasterEgg"=dword:1
"AllowFileSelectionDialogs"=dword:1
"AllowOutdatedPlugins"=dword:1
"AutoFillEnabled"=dword:1
"AutofillCreditCardEnabled"=dword:1
"AutoplayAllowed"=dword:1
"BackgroundModeEnabled"=dword:0
"BlockThirdPartyCookies"=dword:0
"BookmarkBarEnabled"=dword:1



"BuiltInDnsClientEnabled"=dword:1
"ComponentUpdatesEnabled"=dword:1
"DefaultGeolocationSetting"=dword:0
"DefaultNotificationsSetting"=dword:0
"DefaultPluginsSetting"=dword:1
"DefaultSearchProviderSearchURL"="http://www.google.com/search?q={searchTerms}"
"DeveloperToolsDisabled"=dword:0
"Disable3DAPIs"=dword:0
"DownloadRestrictions"=dword:0
"EditBookmarksEnabled"=dword:1
"ForceBrowserSignin"=dword:0
"ForceGoogleSafeSearch"=dword:0
"ForceYouTubeRestrict"=dword:0
"FullscreenAllowed"=dword:1
"HardwareAccelerationModeEnabled"=dword:1
"HideWebStoreIcon"=dword:1
"HomepageIsNewTabPage"=dword:1
"HomepageLocation"="chrome://newtab"
"ImportAutofillFormData"=dword:1
"ImportBookmarks"=dword:1
"ImportHistory"=dword:0
"ImportHomepage"=dword:0
"ImportSavedPasswords"=dword:1
"ImportSearchEngine"=dword:0
"IncognitoModeAvailability"=dword:1
"MetricsReportingEnabled"=dword:0
"NetworkPredictionOptions"=dword:1
"NewTabPageLocation"="chrome://newtab"
"PasswordManagerEnabled"=dword:1
"PromptForDownloadLocation"=dword:0
"RelaunchNotification"=dword:0
"RunAllFlashInAllowMode"=dword:1
"SafeBrowsingEnabled"=dword:1
"SafeBrowsingExtendedReportingEnabled"=dword:0
"SavingBrowserHistoryDisabled"=dword:1
"SearchSuggestEnabled"=dword:1
"ShowAppsShortcutInBookmarkBar"=dword:0
"ShowCastIconInToolbar"=dword:0
"ShowHomeButton"=dword:1
"SitePerProcess"=dword:1
"SpellCheckServiceEnabled"=dword:0
"SpellCheckEnabled"=dword:0
"SuppressUnsupportedOSWarning"=dword:1
"SyncDisabled"=dword:1
"TaskManagerEndProcessEnabled"=dword:1
"ThirdPartyBlockingEnabled"=dword:0
"TranslateEnabled"=dword:1
"WPADQuickCheckEnabled"=dword:0
"WelcomePageOnOSUpgradeEnabled"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Google\Chrome]
"AdsSettingForIntrusiveAdsSites"=dword:1
"AllowDeletingBrowserHistory"=dword:1
"AllowDinosaurEasterEgg"=dword:1
"AllowFileSelectionDialogs"=dword:1
"AllowOutdatedPlugins"=dword:1
"AutoFillEnabled"=dword:1
"AutofillCreditCardEnabled"=dword:1
"AutoplayAllowed"=dword:1
"BackgroundModeEnabled"=dword:0
"BlockThirdPartyCookies"=dword:0
"BookmarkBarEnabled"=dword:1
"BuiltInDnsClientEnabled"=dword:1
"ComponentUpdatesEnabled"=dword:1
"DefaultGeolocationSetting"=dword:0



"DefaultNotificationsSetting"=dword:0
"DefaultPluginsSetting"=dword:1
"DefaultSearchProviderSearchURL"="http://www.google.com/search?q={searchTerms}"
"DeveloperToolsDisabled"=dword:0
"Disable3DAPIs"=dword:0
"DownloadRestrictions"=dword:0
"EditBookmarksEnabled"=dword:1
"ForceBrowserSignin"=dword:0
"ForceGoogleSafeSearch"=dword:0
"ForceYouTubeRestrict"=dword:0
"FullscreenAllowed"=dword:1
"HardwareAccelerationModeEnabled"=dword:1
"HideWebStoreIcon"=dword:1
"HomepageIsNewTabPage"=dword:1
"HomepageLocation"="chrome://newtab"
"ImportAutofillFormData"=dword:1
"ImportBookmarks"=dword:1
"ImportHistory"=dword:0
"ImportHomepage"=dword:0
"ImportSavedPasswords"=dword:1
"ImportSearchEngine"=dword:0
"IncognitoModeAvailability"=dword:1
"MetricsReportingEnabled"=dword:0
"NetworkPredictionOptions"=dword:1
"NewTabPageLocation"="chrome://newtab"
"PasswordManagerEnabled"=dword:1
"PromptForDownloadLocation"=dword:0
"RelaunchNotification"=dword:0
"RunAllFlashInAllowMode"=dword:1
"SafeBrowsingEnabled"=dword:1
"SafeBrowsingExtendedReportingEnabled"=dword:0
"SavingBrowserHistoryDisabled"=dword:1
"SearchSuggestEnabled"=dword:1
"ShowAppsShortcutInBookmarkBar"=dword:0
"ShowCastIconInToolbar"=dword:0
"ShowHomeButton"=dword:1
"SitePerProcess"=dword:1
"SpellCheckServiceEnabled"=dword:0
"SpellCheckEnabled"=dword:0
"SuppressUnsupportedOSWarning"=dword:1
"SyncDisabled"=dword:1
"TaskManagerEndProcessEnabled"=dword:1
"ThirdPartyBlockingEnabled"=dword:0
"TranslateEnabled"=dword:1
"WPADQuickCheckEnabled"=dword:0
"WelcomePageOnOSUpgradeEnabled"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Google\Chrome\Recommended]
"AdsSettingForIntrusiveAdsSites"=dword:1
"AllowDeletingBrowserHistory"=dword:1
"AllowDinosaurEasterEgg"=dword:1
"AllowFileSelectionDialogs"=dword:1
"AllowOutdatedPlugins"=dword:1
"AutoFillEnabled"=dword:1
"AutofillCreditCardEnabled"=dword:1
"AutoplayAllowed"=dword:1
"BackgroundModeEnabled"=dword:0
"BlockThirdPartyCookies"=dword:0
"BookmarkBarEnabled"=dword:1
"BuiltInDnsClientEnabled"=dword:1
"ComponentUpdatesEnabled"=dword:1
"DefaultGeolocationSetting"=dword:0
"DefaultNotificationsSetting"=dword:0
"DefaultPluginsSetting"=dword:1
"DefaultSearchProviderSearchURL"="http://www.google.com/search?q={searchTerms}"



"DeveloperToolsDisabled"=dword:0
"Disable3DAPIs"=dword:0
"DownloadRestrictions"=dword:0
"EditBookmarksEnabled"=dword:1
"ForceBrowserSignin"=dword:0
"ForceGoogleSafeSearch"=dword:0
"ForceYouTubeRestrict"=dword:0
"FullscreenAllowed"=dword:1
"HardwareAccelerationModeEnabled"=dword:1
"HideWebStoreIcon"=dword:1
"HomepageIsNewTabPage"=dword:1
"HomepageLocation"="chrome://newtab"
"ImportAutofillFormData"=dword:1
"ImportBookmarks"=dword:1
"ImportHistory"=dword:0
"ImportHomepage"=dword:0
"ImportSavedPasswords"=dword:1
"ImportSearchEngine"=dword:0
"IncognitoModeAvailability"=dword:1
"MetricsReportingEnabled"=dword:0
"NetworkPredictionOptions"=dword:1
"NewTabPageLocation"="chrome://newtab"
"PasswordManagerEnabled"=dword:1
"PromptForDownloadLocation"=dword:0
"RelaunchNotification"=dword:0
"RunAllFlashInAllowMode"=dword:1
"SafeBrowsingEnabled"=dword:1
"SafeBrowsingExtendedReportingEnabled"=dword:0
"SavingBrowserHistoryDisabled"=dword:1
"SearchSuggestEnabled"=dword:1
"ShowAppsShortcutInBookmarkBar"=dword:0
"ShowCastIconInToolbar"=dword:0
"ShowHomeButton"=dword:1
"SitePerProcess"=dword:1
"SpellCheckServiceEnabled"=dword:0
"SpellCheckEnabled"=dword:0
"SuppressUnsupportedOSWarning"=dword:1
"SyncDisabled"=dword:1
"TaskManagerEndProcessEnabled"=dword:1
"ThirdPartyBlockingEnabled"=dword:0
"TranslateEnabled"=dword:1
"WPADQuickCheckEnabled"=dword:0
"WelcomePageOnOSUpgradeEnabled"=dword:0
;
------End cut & paste here------
Windows 10/11 default locations of all Edge + related 
app(lication)s/launchers/processes/services EXEcutables (.exe):
%UserProfile%\AppData\Local\Microsoft\WindowsApps\MicrosoftEdge.exe
%WinDir%\SystemApps\Microsoft.MicrosoftEdge_8wekyb3d8bbwe\MicrosoftEdge.exe
%WinDir%\System32\LaunchWinApp.exe
%WinDir%\SysWOW64\LaunchWinApp.exe
%WinDir%\System32\MicrosoftEdgeBCHost.exe
%WinDir%\System32\MicrosoftEdgeCP.exe
%WinDir%\System32\MicrosoftEdgeDevTools.exe
%WinDir%\System32\MicrosoftEdgeSH.exe
%ProgramFiles%\Microsoft\Edge\Application\89.0.774.68\elevation_service.exe
%ProgramFiles%\Microsoft\Edge\Application\92.0.902.67\elevation_service.exe
%ProgramFiles%\Microsoft\Edge\Application\108.0.1462.46\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\89.0.774.68\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\92.0.902.67\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\108.0.1462.46\
elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\89.0.774.68\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\92.0.902.67\elevation_service.exe



%ProgramFiles(x86)%\Microsoft\EdgeCore\108.0.1462.46\elevation_service.exe
%ProgramFiles%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe
%ProgramFiles(x86)%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe
TIP:
****
Windows NTx built-in/default/pre-installed/preset machine/system (apply to all 
users on the same machine) + local/user
(apply only to the current/logged on user) environment variables used for target
system/user directories/folders:
http://www.ss64.com/nt/syntax-variables.html
http://pureinfotech.com/list-environment-variables-windows-10/
http://www.computerhope.com/issues/ch000549.htm
- %ProgramFiles% = usually C:\Program Files [exists in Windows 32-bit (x86) + 
Windows 64-bit (x64)].
- %ProgramFiles(x86)% = usually C:\Program Files (x86) [exists only in Windows 
64-bit (x64)].
- %UserProfile% = usually C:\Users\%UserName% .
- %WinDir% = usually C:\WINDOWS [same as %SystemRoot%].
View the list of all your Windows operating system (OS) environment variables 
from a DOS console command prompt
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD shortcut/CMD.EXE -> Run as 
Administrator -> type this command
SET
-> press Enter.
OR
Save it to a plain text/ASCII (.txt) file: from a DOS console command prompt 
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> type same command above followed by 
the name of the file (in this example it
will be saved in C:\ root)
SET>C:\Windows_Environment_Variables.txt
-> press Enter -> use Notepad/similar/better free(ware) plain text/ASCII 
editor/viewer
http://www.mdgx.com/toy.htm#TXT
to view saved text file contents.
IMPORTANT:
In some cases you may need to change the default Microsoft web browser [Edge or 
Internet Explorer (IE)] to match your
favorite/preferred existing/installed/registered web browser for (D)HTML/XML/PHP
documents [.htm, .html, .dhtm, .dhtml,
.xhtm, .xhtml, .xml, .php, .php4, .php5, etc] by hand: Explorer -> right-click 
any of your local drives/partitions/volumes
containing an .htm file (and then repeat same steps for all other formats listed
above) -> select Properties -> under Opens
with: click "Change..." button -> under Other options click "More apps |" -> in 
case your favorite web browser name is not
listed scroll all the way to the bottom -> click "Look for another app on this 
PC" -> scroll to your local
drive/partition/volume (sub)folder where your favorite web browser executable 
(.exe) is located -> double-click it -> click
Open button -> click Apply button.
Change/Set the default web browser to match your favorite/preferred 
existing/installed/registered web browser, any other
than Edge [or Internet Explorer (IE)] (examples):
http://www.androidauthority.com/how-to-change-the-default-browser-in-windows-10-
987604/
http://www.avg.com/en/signal/set-your-default-browser/
http://support.google.com/chrome/answer/95417/
http://support.mozilla.org/kb/how-change-your-default-browser-firefox-windows/
http://www.computerworld.com/article/3229068/
http://www.cloudwards.net/how-to-disable-microsoft-edge/
http://support.microsoft.com/windows/change-your-default-browser-in-windows-10-
020c58c6-7d77-797a-b74e-8f07946c5db6
______________________________________________________________________________



Windows Updates (WU) Catalog, Listings + Guides

* NOTE:
*******
Microsoft Updates/Upgrades/Service Packs (SPs)/(Hot)Fixes/Patches/Drivers/etc 
listed here are for United States (US) English
[en-US] language Windows NTx Operating Systems (OSes) 32-bit (x86) + 64-bit 
(x64) builds/editions/releases/versions.
Microsoft Windows Updates (WU) are available for all supported languages.
http://learn.microsoft.com/windows/win32/intl/national-language-support/
Microsoft Updates Catalog lists Windows Updates (WU) in all supported languages:
http://www.catalog.update.microsoft.com/search.aspx?q=Windows%207%20Update
More info:
http://www.science.co.il/language/Locale-codes.php
http://en.wikipedia.org/wiki/Internationalization_and_localization

* Must uninstall/remove Windows 10/11 Updates/Upgrades/(Hot)Fixes/Patches/etc 
which expose/render vulnerable your
computer(s)/device(s) to:
- auditing,
- data/info/stats collection/logging,
- (diagnostic) tracking,
- fingerprinting,
- (geo)location detection/tracking,
- (geo)marketing,
- intrusion/invasion of privacy,
- "customer experience",
- personalized/targeted ad(vertisement)s/adware,
- promo(tion)s,
- spoofing,
- spying/spyware,
- surveillance,
- telemetry snooping ("phone home"),
- tracking,
- unwanted "offers".
See "Turn OFF/Postpone/Block/Uninstall Windows Updates (WU)" chapter further 
above + "Turn OFF/Remove Windows 10 Adware,
Spyware, Security Flaws + Repair/Restore Privacy" chapter further below.

* Windows Updates (WU) Catalog, Listings + Guides:
- Windows 11 Updates Catalog:
http://www.catalog.update.microsoft.com/search.aspx?q=%22Windows%2011%22
- Windows 10 Updates Catalog:
http://www.catalog.update.microsoft.com/search.aspx?q=%22Windows%2010%22
- Windows 2022 Server Updates Catalog [unreleased yet!]:
http://www.catalog.update.microsoft.com/search.aspx?q=%22Windows%20Server
%202022%22
- Windows 2019 Server Updates Catalog:
http://www.catalog.update.microsoft.com/search.aspx?q=%22Windows%20Server
%202019%22
- Windows 2016 Server Updates Catalog:
http://www.catalog.update.microsoft.com/search.aspx?q=%22Windows%20Server
%202016%22
Download desired/needed Update(s)/Fix(es)/Patch(es) to your local 
disk/media/storage device -> right-click each
.CAB/.EXE/.MSI/.MSP/.MSU file -> Run as Administrator -> follow on screen 
instructions -> restart/reboot (if prompted).
- Windows 10/11/2016/2019/2022 Updates FAQ:
http://windows.microsoft.com/windows/windows-update/



- Microsoft Security Advisories + Bulletins:
http://learn.microsoft.com/security-updates/
- ComputerWorld: Windows 11: A guide to the updates:
http://www.computerworld.com/article/3636790/windows-11-a-guide-to-the-
updates.html
- ComputerWorld: Windows 10: A guide to the updates:
http://www.computerworld.com/article/3199077/windows-10-a-guide-to-the-
updates.html
- ERPMan's Windows 10 System Updates:
http://erpman1.tripod.com/win10upd.html
- THFS: List of Windows 10 Updates/(Hot)Fixes/Patches:
http://thehotfixshare.net/board/?/search/&q=%22Windows
%2010%22&type=downloads_file
- Windows 10 Cumulative Updates List:
http://www.howto-connect.com/windows-10-cumulative-updates-list/
- Windows 10 Updates Guide:
http://www.computerworld.com/article/3199077/windows-10-a-guide-to-the-
updates.html
- Windows 10 Updates News:
http://www.windowslatest.com/windows-10-news/
- ElevenForum: Windows 11 News:
http://www.elevenforum.com/news/
- TenForums: Windows 10 News:
http://www.tenforums.com/windows-10-news/
- Understand Windows 10 Update Names and Numbers:
http://www.howtogeek.com/697411/read-this-to-understand-windows-10-update-names-
and-numbers/
- Guide to managing Microsoft Patch Tuesday:
http://www.techrepublic.com/article/insiders-guide-to-managing-microsoft-patch-
tuesday/
- Every Last Thing About Windows Update (WU) for Windows 7/newer:
http://www.makeuseof.com/tag/how-to-find-out-every-last-thing-about-windows-
update/
- Install Manually Offline CAB (.cab), EXE (.exe) + MSU (.msu) Updates:
http://woshub.com/manually-install-cab-msu-updates-windows/
- Manually check for updates on Windows 10 computer and install them:
http://www.businessinsider.com/how-to-check-for-updates-on-windows-10/
- Prevent specific Windows 10 Update or Driver from installing:
http://www.repairwin.com/prevent-a-specific-windows-update-or-driver-from-
installing-in-windows-10/
- MajorGeeks: Windows Updates (WU) tools [free(ware)]:
http://www.majorgeeks.com/mg/sortname/windows_update.html

* Windows 7/8/8.1/10 32-bit + 64-bit Updates disable Intel Broadwell + Haswell 
CPUs Meltdown/Spectre Variants "Branch target
injection vulnerability" errors/reboots after Intel CPU firmware update(s):
- MSKB KB4090007 Fix 32-bit + 64-bit for Windows 10/2016 32-bit (x86) + 64-bit 
(x64):
http://support.microsoft.com/help/4090007/
Microsoft Catalog Files for KB4090007 Update:
http://www.catalog.update.microsoft.com/search.aspx?q=KB4090007
- MSKB KB4078130 Fix 32-bit + 64-bit for Windows 7/2008 R2/8/20012/8.1/2012 
R2/10/2016 32-bit (x86) + 64-bit (x64):
http://support.microsoft.com/help/4078130/
Microsoft Catalog File for KB4078130 Update:
http://www.catalog.update.microsoft.com/search.aspx?q=KB4078130
File:
http://download.windowsupdate.com/c/msdownload/update/software/crup/2018/01/
kb4078130_b86f0bf2dc0866a0e117ed2d4a5302fab0493a7b.exe
Intel CPUs Updates:
http://newsroom.intel.com/news/intel-security-issue-update-addressing-reboot-
issues/
Intel CPUs Info [PDF]:
http://newsroom.intel.com/wp-content/uploads/sites/11/2018/04/microcode-update-



guidance.pdf
InSpectre for Windows 10/11 detects operating system (OS) ability to prevent 
Meltdown + Spectre vulnerability attacks
against Intel Broadwell + Haswell CPUs + necessity of installing respective 
update(s):
http://www.grc.com/inspectre.htm
File:
http://www.grc.com/files/InSpectre.exe

* Windows 8.1/newer Windows Update (WU) logs generated by Event Tracing for 
Windows (ETW):
http://learn.microsoft.com/windows/deployment/update/windows-update-logs/
Convert Event Tracing for Windows (ETW) diagnostics file(s) [.etl] into readable
plain text/ASCII file [.log]:
right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
Get-WindowsUpdateLog
WU .etl files are generated in the %WinDir%\logs\WindowsUpdate directory/folder 
[%WinDir% = usually C:\WINDOWS].
Converted .log file will be created in the %WinDir% directory/folder by 
overriding any existing one:
%WinDir%\WindowsUpdate.log
View WindowsUpdate.log by using Notepad/similar/better free(ware) plain 
text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT

* MDGx Windows NTx Components, Add-ons, Extras, (Hot)Fixes, Patches, Upgrades, 
Updates:
- MDGx "Updates/(Hot)Fixes/Patches + Windows Update (WU)" chapter in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
- MDGx Windows Updates (WU) Tools [free(ware)] -> "TOOLS 10/11" chapter in 
TOOLS.TXT (included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT
- MDGx Windows NTx Add-ons, Components, Essentials, Extras, Patches, Power Toys,
Tools, Updates, Utilities [free(ware)] in
SOFTWARE.TXT (included):

- MDGx Java Runtime Environment (JRE):
http://www.mdgx.com/add.htm#JAVA
- MDGx .NET Framework Redistributable (NFR):
http://www.mdgx.com/add.htm#NFR
- MDGx Visual Studio (VS) + Visual C++ (VC):
http://www.mdgx.com/add.htm#VS6
- MDGx Group Policy (GP):
http://www.mdgx.com/xptoy.htm#GPO
- MDGx File Manager (FM):
http://www.mdgx.com/xptoy.htm#FMNT
- MDGx Access Control Lists (ACL) + Ownership Tools:
http://www.mdgx.com/xptoy.htm#ACL
- MDGx NTFS Alternate Data Streams (ADS):
http://www.mdgx.com/xptoy.htm#ADS
- MDGx Free(ware) Windows NTx Extras:
http://www.mdgx.com/xptoy.htm#2KXP
- MDGx "1000+ Power Toys + Tweaking Tools [99.99% Free(ware)]":
http://www.mdgx.com/toy.htm

______________________________________________________________________________

Turn OFF/Remove Windows 10 Adware, Spyware, Security Flaws + Repair/Restore 
Privacy



* Turn OFF/block/disable/remove/stop Windows 10/11 dangerous/insecure/unsafe,
undesirable/unnecessary/unneeded/unused/useless, automatic/unattended
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission, annoying/bloat/resources consuming, 
diagnostic, telemetry ("phone home"), data
collection/logging, customer "experience", unwanted "offers", 
ad(ware)/spyware/surveillance/tracking, security
flaws/vulnerabilities + repair/restore privacy:
- Windows 11: A spyware machine out of users' control:
http://www.techspot.com/news/97535-windows-control.html
- Windows 11 Sends Tremendous Amount of User Data to Third Parties:
http://www.tomshardware.com/news/windows-11-sends-user-data-to-third-party-
services/
- Windows 10: Privacy and data collection:
http://en.wikipedia.org/wiki/Windows_10#Privacy_and_data_collection
- Windows 10 Enterprise - Mother of all tweak scripts:
http://www.reboot.pro/topic/20623-windows-10-enterprise-mother-of-all-tweak-
scripts/
- Windows 10 Privacy Guide, Batch files + Scripts:
http://github.com/adolfintel/Windows10-Privacy/
- Windows 10 stop "phone home" (telemetry):
http://gist.github.com/CHEF-KOCH/ca8fbf6bb7f6fa7bab06/
- Disable Data Collection in Windows 10:
http://www.msfn.org/board/topic/174160-guide-disable-data-collection-in-windows-
10/
- Disable Telemetry and Data Collection in Windows 10:
http://www.winaero.com/blog/how-to-disable-telemetry-and-data-collection-in-
windows-10/
- Fix Windows 10 privacy + disable spyware:
http://web.archive.org/web/20180323123837/http://fix10.isleaked.com/
- Manage Windows 10 notification and upgrade options:
http://support.microsoft.com/help/3080351/
- Windows 10 telemetry secrets: where, when and why Microsoft collects your 
data:
http://www.zdnet.com/article/windows-10-telemetry-secrets/
- Windows 10: which services to disable?:
http://www.wilderssecurity.com/threads/378804
- Remove Bloat from Windows 10:
http://www.hwinfo.com/misc/RemoveW10Bloat.htm
- Disable Diagnostics Tracking (DiagTrack) service:
http://www.ghacks.net/2015/05/12/how-to-disable-the-diagnostics-tracking-
service-in-windows/
- Disable Windows 10 Diagnostics Hub Standard Collector 
[diagnosticshub.standardcollector.service] service:
http://www.hwinfo.com/misc/RemoveW10Bloat.htm
- Disable Windows 10 WAP Push Message Routing (DmWAPPush) service:
http://www.ghacks.net/2015/11/28/windows-10-new-services-list/
- Disable Windows 10 Retail Demo (RetailDemo) service:
http://www.tenforums.com/windows-10-news/8079-windows-10-has-secret-retail-demo-
mode-new-app-video-loop.html
- Disable Windows Event Collector [WECSvc] service:
http://www.computerstepbystep.com/windows_event_collector_service.html
- Rename/Disable Cortana + Stop SearchUI.exe:
http://www.tenforums.com/software-apps/14300-how-permanently-disable-cortana-
4.html
- Stop SearchUI.exe in Windows 10:
http://www.trishtech.com/2016/01/how-to-permanently-stop-searchui-exe-from-
running-in-windows-10/
- Stop Windows 10 from tracking + spying on you by using Windows (Defender) 
Firewall [W(D)F]:



http://www.winaero.com/blog/stop-windows-10-spying-on-you-using-just-windows-
firewall/
- Windows 10 Tweaks:
http://www.pastebin.com/m26z309a
- Windows 10 Tweaks:
http://www.tweakhound.com/2015/08/10/my-windows-10-tweaks/
... Would you like to know more? ;-/
http://www.youtube.com/watch?v=kdrjzE1SE58
http://en.wikipedia.org/wiki/Starship_Troopers_(film)#Politics_and_propaganda
Some of these fixes + guides + tips may also work with Windows 11.

* Turn OFF Windows 10/11 Microsoft automatically generated
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission unique for each logged in user apps, 
connected devices, store, 3rd parties, partners,
etc spying/tracking advertising ID in order to be able to 
block/disable/stop/turn OFF all
intrusive/unapproved/undesirable/without permission (not so) "relevant" ads:
http://www.makeuseof.com/what-is-advertiser-id-windows-turn-off/
http://www.tenforums.com/tutorials/76453-advertising-id-relevant-ads-enable-
disable-windows-10-a.html
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\AdvertisingInfo]
"DisabledByGroupPolicy"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\AdvertisingInfo]
"DisabledByGroupPolicy"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\AdvertisingInfo]
"DisabledByGroupPolicy"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\AdvertisingInfo]
"Enabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\AdvertisingInfo]
"Enabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\AdvertisingInfo]
"Enabled"=dword:0
;
------End cut & paste here------

* Turn OFF Windows + MS Office telemetry, adware, data collection/logging, 
"customer experience", unwanted "offers", Wi-Fi
Sense, AutoUpdate, Windows Defender, diagnostics logging/report, 
(re)install/uninstall automatic/unattended
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission, spyware/surveillance/tracking Windows 
Updates (WU):
http://www.winaero.com/blog/disable-defender-windows-10-fall-creators-update/
http://heimdalsecurity.com/en/windows-10-security-guide/privacy/
http://www.helpdeskgeek.com/windows-10/how-to-disable-windows-10-telemetry/
http://tosdr.org/#microsoft
http://tosdr.org/#microsoft-store
http://www.ss64.com/nt/syntax-reghacks.html
http://learn.microsoft.com/windows/privacy/windows-diagnostic-data/
http://privacy.microsoft.com/
Winaero Tweaker 32-bit + 64-bit for Windows 7/8/8.1/10/11 [select Portable at 



install time!]:
http://www.winaero.com/winaero-tweaker/
Download:
http://www.winaero.com/download-winaero-tweaker/
Winaero Tweaker Features:
http://www.winaero.com/the-list-of-winaero-tweaker-features/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\
DataCollection]
"Allow Telemetry"=dword:0
"AllowTelemetry"=dword:0
"DisableDeviceDelete"=-
"MaxTelemetryAllowed"=-
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\DataCollection]
"Allow Telemetry"=dword:0
"AllowTelemetry"=dword:0
"DisableDeviceDelete"=-
"MaxTelemetryAllowed"=-
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Internet Explorer\Main]
"DoNotTrack"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet Explorer\Main]
"DoNotTrack"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Internet Explorer\Main]
"DoNotTrack"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\WindowsBackup]
"DisableMonitoring"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\12.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\14.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\15.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\16.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\Common\ClientTelemetry]
"DisableTelemetry"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\12.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\14.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\15.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\16.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Office\Common\ClientTelemetry]
"DisableTelemetry"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Office\12.0\osm]



"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Office\14.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Office\15.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Office\16.0\osm]
"Enablelogging"=dword:0
"EnableUpload"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Office\Common\ClientTelemetry]
"DisableTelemetry"=dword:1
;
------End cut & paste here------

* Turn OFF/uninstall/disable Cortana, Cortana Search [SearchUI.exe], Web Search,
Bing/MSN/Live/Microsoft Start Search +
Location Detection:
http://www.addictivetips.com/windows-tips/disable-web-search-windows-10-april-
update/
http://www.winaero.com/blog/how-to-uninstall-and-remove-cortana-in-windows-10/
http://thinkmobiles.com/blog/how-to-uninstall-cortana/
http://www.tomsguide.com/news/how-to-uninstall-cortana/
http://www.techsupportalert.com/content/how-disable-searchuiexe-windows-10.htm
http://thegeekpage.com/file-explorer-is-opening-too-slow/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Windows Search]
"ConnectedSearchUseWebOverMeteredConnections"=dword:0
"AllowCortana"=dword:0
"DisableWebSearch"=dword:1
"ConnectedSearchUseWeb"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Search]
"CortanaConsent"=dword:0
"AllowSearchToUseLocation"=dword:0
"BingSearchEnabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Search]
"CortanaConsent"=dword:0
"AllowSearchToUseLocation"=dword:0
"BingSearchEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"EnableCortana"=dword:0
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"EnableCortana"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"EnableCortana"=dword:0
;
------End cut & paste here------
Uninstall + remove Cortana from Windows 10 using PowerShell console commands + 



"Uninstall Cortana.cmd" batch file script:
http://www.winaero.com/how-to-uninstall-and-remove-cortana-in-windows-10/
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run these commands -> press Enter after each 
line (depending on your Windows 10
build/edition/release/update/version):
Get-AppXPackage -AllUsers *Microsoft.549981C3F5F10* | Remove-AppXPackage
Get-AppXPackage -AllUsers 
Microsoft.Windows.Cortana_1.13.0.18362_neutral_neutral_cw5n1h2txyewy | Remove-
AppXPackage
Download "Uninstall Cortana.cmd" [ZIP file]:
http://www.winaero.com/download.php?view.1832
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these 6 commands
-> press Enter after each line:
C:
CD "%WinDir%\SystemApps\Microsoft.Windows.Cortana_cw5n1h2txyewy"
TAKEOWN.EXE /f SearchUI.exe
ICACLS.EXE SearchUI.exe /grant Administrators:F
TASKKILL.EXE /IM SearchUI.exe /F /T
REN SearchUI.exe SearchUI.OLD
ICACLS.EXE:
http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/

* Turn OFF/block/disable/stop 
ad(vertisement)s/adware/notifications/"offers"/promo(tion)s/surveillance/"sugges
tions",
spying, tracking + start using/switch to/turn ON Private (Incognito) Browsing in
Cortana, Edge, Internet Explorer (IE) + Web
Search in order to enhance/improve your internet/online privacy, safety + 
strengthen your security level in Windows 10/11:
http://www.thewindowsclub.com/opt-out-stop-personalized-windows-10/
http://www.howtogeek.com/269331/how-to-disable-all-of-windows-10s-built-in-
advertising/
http://choice.microsoft.com/opt-out/
http://account.microsoft.com/privacy/
http://support.microsoft.com/windows/browsing-history-on-the-privacy-dashboard-
550e772a-04c9-3e9a-3ec0-762519df5e11
http://support.microsoft.com/microsoft-edge/view-and-delete-browser-history-in-
microsoft-edge-00cf7943-a9e1-975a-a33d-ac10ce454ca4
http://www.top-password.com/blog/delete-microsoft-edge-ie-browsing-history-in-
windows-10/
http://www.winaero.com/disable-cortana-microsoft-edge-windows-10/
http://www.winaero.com/download-disable-cortana-in-microsoft-edge/
http://www.winaero.com/disable-ads-windows-10/
http://www.tenforums.com/tutorials/81383-turn-off-cortana-browsing-history-
permissions-windows-10-a.html
http://www.howtogeek.com/265027/how-to-disable-cortana-in-windows-10/
http://www.ghacks.net/2020/10/05/how-to-disable-bing-search-in-windows-10-
version-2004-and-newer/
http://technoresult.com/disable-edge-inprivate-browsing-mode-using-registry-
settings/
http://www.computerworld.com/article/3025709/
http://www.ubergizmo.com/how-to/disable-bing-search-windows-10/
http://www.helpdeskgeek.com/how-to/disable-turn-off-inprivate-browsing-ie-
microsoft-edge/
http://www.computerworld.com/article/3622001/



http://www.majorgeeks.com/content/page/
how_to_turn_diagnostic_data_settings_on_or_off_in_windows_10.html
http://redmondmag.com/articles/2021/03/01/reclaim-privacy-from-windows-1.aspx
http://redmondmag.com/articles/2021/03/03/reclaim-privacy-from-windows-2.aspx
http://www.bgr.com/2015/07/31/windows-10-upgrade-spying-how-to-opt-out/
http://www.theinquirer.net/inquirer/news/2430786/updategate-microsoft-is-now-
installing-windows-10-by-default-in-windows-update/
Internet Explorer (IE) web browser:
1. Go to:
http://choice.microsoft.com/opt-out/
2. Turn OFF all ads:
- Personalized ads in this browser.
- Personalized ads wherever I use my Microsoft account.
3. Go to:
http://www.aboutads.info/choices/
and then to:
http://optout.networkadvertising.org/
4. UNcheck all boxes:
- "All Participating Companies".
- "Companies Customizing Ads For Your Browser".
- "select all".
- click "Opt out of all" button.
5. Go to [only if using a Microsoft Azure/Bing/Hotmail/Live/MSN/Microsoft 
Start/Outlook/Windows Mail
e-mail/membership/subscription/enrollment/developer/tester/trial/VIP account]:
http://account.microsoft.com/privacy/
UNcheck/opt OUT of all ad(vertisement)s/promo(tion)s/suggestions boxes/options.
6. Internet Explorer (IE) 9/10/11 "Block Tracking" (Geolocation Detection) + 
"Automatic (Forced) Upgrade":
http://unlockforus.blogspot.com/2012/09/do-not-allow-websites-to-get-your.html
http://support.microsoft.com/help/2843950/
http://www.eightforums.com/tutorials/7996-internet-explorer-10-auto-update-
enable-disable.html
http://www.itninja.com/question/ie10-turn-off-auto-updates/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Geolocation]
"BlockAllWebsites"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Geolocation]
"BlockAllWebsites"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main]
"EnableAutoUpgrade"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main]
"EnableAutoUpgrade"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Main]
"EnableAutoUpgrade"=dword:0
;
------End cut & paste here------
7. Turn OFF primitive/obsolete Internet Explorer (IE) Security Check:
http://www.windows-security.org/65c2e8edd3108cdb6fc985493bb2fa38/turn-off-the-
security-settings-check-feature/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain



text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Security]
"DisableSecuritySettingsCheck"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Security]
"DisableSecuritySettingsCheck"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Internet Explorer\Security]
"DisableSecuritySettingsCheck"=dword:1
;
------End cut & paste here------
8. Manage cookies in Internet Explorer (IE):
http://www.whatismybrowser.com/guides/clear-cache-history-cookies/internet-
explorer
http://kb.wisc.edu/helpdesk/page.php?id=15141
http://support.microsoft.com/en-us/search?query=cookies%20in%20internet
%20explorer
More info @ MDGx "Internet Explorer (IE) 11.0" section in SOFTWARE.TXT 
(included):
http://www.mdgx.com/ietoy.htm#IE11
Open E10BLOK.CMD (included) in Notepad for details:
http://www.mdgx.com/10BLK/E10BLOK.CMD.TXT
9. Install AdBlock Plus (ABP) for Internet Explorer (IE) (free, open source):
http://adblockplus.org/en/internet-explorer
10. Restart your browser (if + when needed).
Cortana, Edge web browser, Internet Explorer (IE) web browser + Search:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"EnableCortana"=dword:0
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"EnableCortana"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\AppContainer\Storage\microsoft.microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\ServiceUI]
"EnableCortana"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Windows Search]
"AllowCortana"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"DisableSearchBoxSuggestions"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"DisableSearchBoxSuggestions"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"DisableSearchBoxSuggestions"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Internet Explorer\Privacy]
"EnableInPrivateBrowsing"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\MicrosoftEdge]
"AllowInPrivate"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\MicrosoftEdge\Main]
"AllowInPrivate"=dword:1



[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Search]
"BingSearchEnabled"=dword:0
"CortanaConsent"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Search]
"BingSearchEnabled"=dword:0
"CortanaConsent"=dword:0
;
------End cut & paste here------

* Turn OFF geo(graphical) (GPS) (geo)location tracking + Location Services for 
accounts, apps, connected devices, store:
http://winbuzzer.com/2020/07/14/windows-10-how-to-turn-on-or-turn-off-location-
services-xcxwbn/
http://www.tenforums.com/tutorials/13225-turn-off-location-services-windows-10-
a.html
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
CapabilityAccessManager\ConsentStore\location]
"Value"="deny"
[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\
CapabilityAccessManager\ConsentStore\location]
"Value"="deny"
[HKEY_USERS\.DEFAULT\SOFTWARE\Microsoft\Windows\CurrentVersion\
CapabilityAccessManager\ConsentStore\location]
"Value"="deny"
;
------End cut & paste here------

* Turn OFF Windows Insider Program (WIP) to block/disable/turn OFF 
automatic/unattended
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission installation of all untested, unsafe, 
buggy/flawed beta/unfinished/testing, developer
mode, interim, pre-release, preview, test Windows 10 update builds, some of whom
ask for money/paid
subscription/membership/enrollment/privileges/personal information and/or charge
your bank/cash/debit/credit/money
card/wallet/money account at the end of their time limited 
trial/deadline/expiration period, or for as long as you maintain
enrollment/membership/service/subscription:
http://www.tenforums.com/tutorials/63585-enable-disable-insider-build-settings-
windows-10-a.html
http://www.majorgeeks.com/content/page/remove_windows_insider_program.html
http://www.majorgeeks.com/files/details/remove_windows_insider_program_page.html
http://www.majorgeeks.com/content/page/
how_to_enable_or_disable_windows_insider_program_in_windows_10.html
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.



-----Begin cut & paste here-----
REGEDIT4
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\wisvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\wisvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\wisvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\wisvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\wisvc\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\wisvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsUpdate\UX]
"InsiderProgramEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\WindowsUpdate]
"InsiderProgramEnabled"=dword:0
"ManagePreviewBuilds"=dword:1
"ManagePreviewBuildsPolicyValue"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\PreviewBuilds]
"AllowBuildPreview"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsSelfHost\UI\Visibility]
"HideInsiderPage"=dword:1
;
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.
Unenroll/unregister/unsubscribe/terminate/cancel existent Windows Insider 
Program (WIP) account:
http://www.tenforums.com/tutorials/157018-how-leave-windows-insider-program-
unregister-account.html
Leave Windows Insider Program (WIP) account:
http://insider.windows.com/leave-program/
Unenroll/unregister/unsubscribe/terminate/cancel from WIP e-mail 
updates/newsletters/notifications/etc +/- turn OFF/disable
all upcoming WIP messages/notifications/newsletters/updates by adding the WIP 
account(s) e-mail address(es) to your blocked
sender list, which varies depending on your e-mail account(s) service 
provider(s) +/- e-mail client(s)/program(s)/software.

* Turn OFF Windows Hello for Business biometrics facial/fingerprint recognition 
login, Windows Hello PIN (Personal
Identification Number), Windows Hello Setup notification + Natural 
Authentication [NaturalAuthentication] service in order
to block unnecessary/unwanted biometrics notifications + Microsoft 
Azure/Bing/Hotmail/Live/MSN/Microsoft
Start/Outlook/Windows Mail 
e-mail/membership/subscription/enrollment/developer/tester/trial/VIP accounts in
Windows 10:
http://www.tenforums.com/tutorials/117987-enable-disable-windows-hello-
biometrics-windows-10-a.html
http://www.intowindows.com/how-to-disable-or-block-microsoft-accounts-in-
windows-10/
http://www.techilife.com/how-to-remove-windows-hello-pin-sign-in-options/
http://www.top-password.com/blog/disable-windows-10-face-recognition-or-
fingerprint-login/
http://www.top-password.com/blog/disable-windows-hello-pin-setup-in-windows-10/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 



delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\NaturalAuthentication\
Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\NaturalAuthentication]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:3
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\NaturalAuthentication\
Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\NaturalAuthentication]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:3
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\NaturalAuthentication\
Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\NaturalAuthentication]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:3
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\PolicyManager\current\device\Settings]
"AllowYourAccount"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\PolicyManager\default\Settings\
AllowYourAccount]
"value"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\PolicyManager\default\Settings\
AllowSignInOptions]
"value"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System]
"NoConnectedUser"=dword:3
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\System]
"NoConnectedUser"=dword:3
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Policies\System]
"NoConnectedUser"=dword:3
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\System]
"AllowDomainPINLogon"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Policies\Microsoft\Windows\System]
"AllowDomainPINLogon"=dword:0
;
------End cut & paste here------
Rename the %WinDir%\ServiceProfiles\LocalService\AppData\Local\Microsoft\NGC 
[%WinDir% = usually C:\WINDOWS]
directory/folder to something else (example) by running BATch file below:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
TAKEOWN.EXE /f "%WinDir%\ServiceProfiles\LocalService\AppData\Local\Microsoft\
NGC" /r /d y
ICACLS.EXE "%WinDir%\ServiceProfiles\LocalService\AppData\Local\Microsoft\
NGC" /grant:r %UserName%:F /t /c /q
REN "%WinDir%\ServiceProfiles\LocalService\AppData\Local\Microsoft\NGC" NGC_OLD



:END
EXIT
------End cut & paste here------
ICACLS.EXE:
http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/

* Turn OFF Windows 10/11 Push Notification Services (WNS) [WpnService + 
WpnUserService], automatic install, Action Center,
Taskbar notifications icon + notifications for apps (start, toast, tiles), calls
(voice, VoIP), badges, store, cloud
(server), ad(vertisement)s, memberships, subscriptions, enrollments, 
suggestions, experience, tips, sync, sound(s),
notifications, updates in Windows, Desktop, Start Menu, Apps, Explorer, on the 
Lock Screen:
http://www.thewindowsclub.com/how-to-disable-notification-and-action-center-in-
windows-10/
http://winbuzzer.com/2020/06/09/how-to-enable-or-disable-the-action-center-in-
windows-10-aka-notifications-center-xcxwbt/
http://www.winhelponline.com/blog/disable-explorer-search-box-suggestions-
windows-7/
http://superuser.com/questions/1246950/
http://www.howtogeek.com/344496/how-to-disable-notifications-on-windows-10/
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoQuietHours
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoCallsDuringQ
uietHours
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoCloudNotific
ation
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoTileNotifica
tion
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoToastNotific
ation
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoLockScreenTo
astNotification
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Notifications::NoNotification
Mirroring
http://winbuzzer.com/2020/07/01/windows-10-how-to-turn-off-notifications-or-
notification-sounds-xcxwbt/
http://techcult.com/enable-or-disable-app-notifications-on-lock-screen-in-
windows-10/
http://gist.github.com/carcheky/981fda4af8e5aac73d0ca8558947ffbb/
http://www.ghacks.net/2019/12/23/how-to-block-the-automatic-installation-of-
suggested-windows-10-apps/
http://www.tenforums.com/tutorials/31107-turn-off-lock-screen-reminders-voip-
calls-windows-10-a.html
http://www.tenforums.com/tutorials/76252-turn-off-windows-welcome-experience-
windows-10-a.html
http://www.tenforums.com/tutorials/24117-turn-off-app-suggestions-start-windows-
10-a.html
http://www.tenforums.com/tutorials/61017-turn-off-notification-sound-senders-
windows-10-a.html



http://www.thewindowsclub.com/disable-notifications-from-apps-and-other-senders/
http://learn.microsoft.com/windows/application-management/per-user-services-in-
windows/
http://en.wikipedia.org/wiki/Windows_Push_Notification_Service
http://www.geeksgyaan.com/2019/04/high-ram-usage.html
http://www.surfacetablethelp.com/2018/09/disable-windows-push-notifications-
user-service-with-high-cpu-in-windows-10.html
http://social.technet.microsoft.com/Forums/en-US/a8747e67-68a0-4cc8-af9f-
6bd4949761e3/
http://www.seaofthieves.com/forum/topic/34914/
http://dirteam.com/sander/2019/07/04/howto-disable-unnecessary-services-and-
scheduled-tasks-on-ad-fs-servers/
http://helpdeskgeek.com/windows-10/how-to-fix-system-tray-or-icons-missing-in-
windows-10/
http://social.technet.microsoft.com/forums/en-us/ac2b1d1c-1326-43b0-b8f0-
ae7260cba3bd/
See also "Turn OFF Action/Security Center + Notifications/Messages" chapter in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
Most of those tweaks apply to Windows 10/11.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\TrayNotify]
"IconStreams"=-
"PastIconsStream"=-
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\TrayNotify]
"IconStreams"=-
"PastIconsStream"=-
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
CurrentVersion\TrayNotify]
"IconStreams"=-
"PastIconsStream"=-
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Notifications\
Settings\Windows.SystemToast.SecurityAndMaintenance]
"Enabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Notifications\
Settings\Windows.SystemToast.SecurityAndMaintenance]
"Enabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Notifications\
Settings\Windows.SystemToast.SecurityAndMaintenance]
"Enabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsUpdate\UX\Settings]
"TrayIconVisibility"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"DisableActionCenter"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"DisableActionCenter"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"DisableActionCenter"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\CurrentVersion\
PushNotifications]
"DisallowNotificationMirroring"=dword:1
"NoToastApplicationNotification"=dword:1



"NoCloudApplicationNotification"=dword:1
"NoTileApplicationNotification"=dword:1
"NoToastApplicationNotificationOnLockScreen"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\CurrentVersion\
PushNotifications]
"DisallowNotificationMirroring"=dword:1
"NoToastApplicationNotification"=dword:1
"NoCloudApplicationNotification"=dword:1
"NoTileApplicationNotification"=dword:1
"NoToastApplicationNotificationOnLockScreen"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\CurrentVersion\
PushNotifications]
"DisallowNotificationMirroring"=dword:1
"NoToastApplicationNotification"=dword:1
"NoCloudApplicationNotification"=dword:1
"NoTileApplicationNotification"=dword:1
"NoToastApplicationNotificationOnLockScreen"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\PushNotifications]
"ToastEnabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\PushNotifications]
"ToastEnabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\
PushNotifications]
"ToastEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Notifications\
Settings]
"NOC_GLOBAL_SETTING_ALLOW_TOASTS_ABOVE_LOCK"=dword:0
"NOC_GLOBAL_SETTING_ALLOW_CRITICAL_TOASTS_ABOVE_LOCK"=dword:0
"NOC_GLOBAL_SETTING_ALLOW_NOTIFICATION_SOUND"=dword:0
"NOC_GLOBAL_SETTING_GLEAM_ENABLED"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Notifications\
Settings]
"NOC_GLOBAL_SETTING_ALLOW_TOASTS_ABOVE_LOCK"=dword:0
"NOC_GLOBAL_SETTING_ALLOW_CRITICAL_TOASTS_ABOVE_LOCK"=dword:0
"NOC_GLOBAL_SETTING_ALLOW_NOTIFICATION_SOUND"=dword:0
"NOC_GLOBAL_SETTING_GLEAM_ENABLED"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Notifications\
Settings]
"NOC_GLOBAL_SETTING_ALLOW_TOASTS_ABOVE_LOCK"=dword:0
"NOC_GLOBAL_SETTING_ALLOW_CRITICAL_TOASTS_ABOVE_LOCK"=dword:0
"NOC_GLOBAL_SETTING_ALLOW_NOTIFICATION_SOUND"=dword:0
"NOC_GLOBAL_SETTING_GLEAM_ENABLED"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager]
"ContentDeliveryAllowed"=dword:0
"FeatureManagementEnabled"=dword:0
"OemPreInstalledAppsEnabled"=dword:0
"PreInstalledAppsEnabled"=dword:0
"PreInstalledAppsEverEnabled"=dword:0
"RemediationRequired"=dword:0
"SilentInstalledAppsEnabled"=dword:0
"SoftLandingEnabled"=dword:0
"SubscribedContent-338387Enabled"=dword:0
"SubscribedContent-338388Enabled"=dword:0
"SubscribedContent-338389Enabled"=dword:0
"SubscribedContent-310093Enabled"=dword:0
"SubscribedContent-338393Enabled"=dword:0
"SubscribedContent-314563Enabled"=dword:0
"SubscribedContent-353698Enabled"=dword:0
"SubscribedContent-353694Enabled"=dword:0
"SubscribedContentEnabled"=dword:0
"SystemPaneSuggestionsEnabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager]



"ContentDeliveryAllowed"=dword:0
"FeatureManagementEnabled"=dword:0
"OemPreInstalledAppsEnabled"=dword:0
"PreInstalledAppsEnabled"=dword:0
"PreInstalledAppsEverEnabled"=dword:0
"RemediationRequired"=dword:0
"SilentInstalledAppsEnabled"=dword:0
"SoftLandingEnabled"=dword:0
"SubscribedContent-338387Enabled"=dword:0
"SubscribedContent-338388Enabled"=dword:0
"SubscribedContent-338389Enabled"=dword:0
"SubscribedContent-310093Enabled"=dword:0
"SubscribedContent-338393Enabled"=dword:0
"SubscribedContent-314563Enabled"=dword:0
"SubscribedContent-353698Enabled"=dword:0
"SubscribedContent-353694Enabled"=dword:0
"SubscribedContentEnabled"=dword:0
"SystemPaneSuggestionsEnabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager]
"ContentDeliveryAllowed"=dword:0
"FeatureManagementEnabled"=dword:0
"OemPreInstalledAppsEnabled"=dword:0
"PreInstalledAppsEnabled"=dword:0
"PreInstalledAppsEverEnabled"=dword:0
"RemediationRequired"=dword:0
"SilentInstalledAppsEnabled"=dword:0
"SoftLandingEnabled"=dword:0
"SubscribedContent-338387Enabled"=dword:0
"SubscribedContent-338388Enabled"=dword:0
"SubscribedContent-338389Enabled"=dword:0
"SubscribedContent-310093Enabled"=dword:0
"SubscribedContent-338393Enabled"=dword:0
"SubscribedContent-314563Enabled"=dword:0
"SubscribedContent-353698Enabled"=dword:0
"SubscribedContent-353694Enabled"=dword:0
"SubscribedContentEnabled"=dword:0
"SystemPaneSuggestionsEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager\SuggestedApps]
"40579FactionSoftware.Colorist_ktsqrfenxtjhw"=dword:0
"46928bounde.EclipseManager_a5h4egax66k6y"=dword:0
"ActiproSoftwareLLC.562882FEEB491_24pqs290vpjk0"=dword:0
"AdobeSystemsIncorporated.AdobePhotoshopExpress_ynb6jyjzte8ga"=dword:0
"D5EA27B7.Duolingo-LearnLanguagesforFree_yx6k7tf7xvsea"=dword:0
"Flipboard.Flipboard_3f5azkryzdbc4"=dword:0
"Microsoft.BingNews_8wekyb3d8bbwe"=dword:0
"Microsoft.BingWeather_8wekyb3d8bbwe"=dword:0
"Microsoft.FreshPaint_8wekyb3d8bbwe"=dword:0
"Microsoft.Getstarted_8wekyb3d8bbwe"=dword:0
"Microsoft.NetworkSpeedTest_8wekyb3d8bbwe"=dword:0
"Microsoft.Office.Sway_8wekyb3d8bbwe"=dword:0
"Microsoft.RemoteDesktop_8wekyb3d8bbwe"=dword:0
"Microsoft.WindowsAlarms_8wekyb3d8bbwe"=dword:0
"Microsoft.WindowsSoundRecorder_8wekyb3d8bbwe"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager\SuggestedApps]
"40579FactionSoftware.Colorist_ktsqrfenxtjhw"=dword:0
"46928bounde.EclipseManager_a5h4egax66k6y"=dword:0
"ActiproSoftwareLLC.562882FEEB491_24pqs290vpjk0"=dword:0
"AdobeSystemsIncorporated.AdobePhotoshopExpress_ynb6jyjzte8ga"=dword:0
"D5EA27B7.Duolingo-LearnLanguagesforFree_yx6k7tf7xvsea"=dword:0
"Flipboard.Flipboard_3f5azkryzdbc4"=dword:0
"Microsoft.BingNews_8wekyb3d8bbwe"=dword:0



"Microsoft.BingWeather_8wekyb3d8bbwe"=dword:0
"Microsoft.FreshPaint_8wekyb3d8bbwe"=dword:0
"Microsoft.Getstarted_8wekyb3d8bbwe"=dword:0
"Microsoft.NetworkSpeedTest_8wekyb3d8bbwe"=dword:0
"Microsoft.Office.Sway_8wekyb3d8bbwe"=dword:0
"Microsoft.RemoteDesktop_8wekyb3d8bbwe"=dword:0
"Microsoft.WindowsAlarms_8wekyb3d8bbwe"=dword:0
"Microsoft.WindowsSoundRecorder_8wekyb3d8bbwe"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager\SuggestedApps]
"40579FactionSoftware.Colorist_ktsqrfenxtjhw"=dword:0
"46928bounde.EclipseManager_a5h4egax66k6y"=dword:0
"ActiproSoftwareLLC.562882FEEB491_24pqs290vpjk0"=dword:0
"AdobeSystemsIncorporated.AdobePhotoshopExpress_ynb6jyjzte8ga"=dword:0
"D5EA27B7.Duolingo-LearnLanguagesforFree_yx6k7tf7xvsea"=dword:0
"Flipboard.Flipboard_3f5azkryzdbc4"=dword:0
"Microsoft.BingNews_8wekyb3d8bbwe"=dword:0
"Microsoft.BingWeather_8wekyb3d8bbwe"=dword:0
"Microsoft.FreshPaint_8wekyb3d8bbwe"=dword:0
"Microsoft.Getstarted_8wekyb3d8bbwe"=dword:0
"Microsoft.NetworkSpeedTest_8wekyb3d8bbwe"=dword:0
"Microsoft.Office.Sway_8wekyb3d8bbwe"=dword:0
"Microsoft.RemoteDesktop_8wekyb3d8bbwe"=dword:0
"Microsoft.WindowsAlarms_8wekyb3d8bbwe"=dword:0
"Microsoft.WindowsSoundRecorder_8wekyb3d8bbwe"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Privacy]
"TailoredExperiencesWithDiagnosticDataEnabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Privacy]
"TailoredExperiencesWithDiagnosticDataEnabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Privacy]
"TailoredExperiencesWithDiagnosticDataEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"ShowSyncProviderNotifications"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"ShowSyncProviderNotifications"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"ShowSyncProviderNotifications"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\CloudContent]
"ConfigureWindowsSpotlight"=dword:2
"IncludeEnterpriseSpotlight"=dword:0
"DisableThirdPartySuggestions"=dword:1
"DisableTailoredExperiencesWithDiagnosticData"=dword:1
"DisableWindowsConsumerFeatures"=dword:1
"DisableWindowsSpotlightFeatures"=dword:1
"DisableWindowsSpotlightWindowsWelcomeExperience"=dword:1
"DisableWindowsSpotlightOnActionCenter"=dword:1
"DisableWindowsSpotlightOnSettings"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\CloudContent]
"ConfigureWindowsSpotlight"=dword:2
"IncludeEnterpriseSpotlight"=dword:0
"DisableThirdPartySuggestions"=dword:1
"DisableTailoredExperiencesWithDiagnosticData"=dword:1
"DisableWindowsConsumerFeatures"=dword:1
"DisableWindowsSpotlightFeatures"=dword:1
"DisableWindowsSpotlightWindowsWelcomeExperience"=dword:1
"DisableWindowsSpotlightOnActionCenter"=dword:1
"DisableWindowsSpotlightOnSettings"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\CloudContent]
"ConfigureWindowsSpotlight"=dword:2
"IncludeEnterpriseSpotlight"=dword:0
"DisableThirdPartySuggestions"=dword:1
"DisableTailoredExperiencesWithDiagnosticData"=dword:1
"DisableWindowsConsumerFeatures"=dword:1



"DisableWindowsSpotlightFeatures"=dword:1
"DisableWindowsSpotlightWindowsWelcomeExperience"=dword:1
"DisableWindowsSpotlightOnActionCenter"=dword:1
"DisableWindowsSpotlightOnSettings"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\CurrentVersion\
QuietHours]
"AllowCalls"=dword:0
"Enable"=dword:0
"EntryTime"=dword:0
"ExitTime"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\CurrentVersion\
QuietHours]
"AllowCalls"=dword:0
"Enable"=dword:0
"EntryTime"=dword:0
"ExitTime"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\CurrentVersion\
QuietHours]
"AllowCalls"=dword:0
"Enable"=dword:0
"EntryTime"=dword:0
"ExitTime"=dword:0
; Windows Push Notifications System Service [WpnService]:
; http://batcmd.com/windows/10/services/wpnservice/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
; Windows Push Notifications User Service [WpnUserService]:
; http://batcmd.com/windows/10/services/wpnuserservice/
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnUserService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnUserService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnUserService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnUserService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnUserService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnUserService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnUserService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnUserService\Security]



[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnUserService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
;
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.

* Turn OFF/disable + remove/uninstall Skype Meet Now app, icon, feature, 
messages + notifications in Windows 10:
http://www.digitalcitizen.life/disable-meet-now-windows-10/
http://www.windowscentral.com/how-disable-meet-now-feature-windows-10/
http://www.thewindowsclub.com/what-is-meet-now-in-windows-10/
http://beebom.com/uninstall-meet-now-windows-10/
Turn OFF Meet Now icon + notifications:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies]
"HideSCAMeetNow"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies]
"HideSCAMeetNow"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Policies]
"HideSCAMeetNow"=dword:1
;
------End cut & paste here------
Uninstall Skype [which also uninstalls the Meet Now feature]:
From a DOS console command prompt [%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD 
shortcut/CMD.EXE -> Run as Administrator ->
run this command:
DISM.EXE /Online /Remove-ProvisionedAppxPackage 
/PackageName:Microsoft.SkypeApp_14.53.77.0_neutral_~_kzf8qxf38zg5c
-> press Enter.
DISM (Deployment Image Servicing and Management) [DISM.EXE] executable is 
located in the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.

* Turn OFF/get OUT of Windows 10/11 S mode: crippled, disabled, forced, limited,
locked, restricted, stripped down to
Microsoft store anti-competitive/centered/exclusivist/proprietary account(s), 
apps, enrollments, features, memberships,
services, subscriptions, trials + ad(ware)/spyware/surveillance/tracking + 
OneDrive cloud storage:
http://www.hellotech.com/blog/what-is-windows-10-s-mode-and-how-to-turn-it-off/
http://support.microsoft.com/windows/switching-out-of-s-mode-in-windows-
4f56d9be-99ec-6983-119f-031bfb28a307
http://www.thewindowsclub.com/switch-out-of-s-mode-in-windows-10/
http://www.microsoft.com/windows/s-mode/
http://petri.com/what-you-need-to-know-about-windows-10-s-mode/
http://www.howtogeek.com/354057/what-is-windows-10-in-s-mode/
http://www.techrepublic.com/article/windows-10-s-mode-pros-and-cons/
http://helpdesk.broward.edu/TDClient/1880/Portal/KB/ArticleDet?ID=124396



http://softwarekeep.com/help-center/6-things-to-know-about-windows-10-s-and-
windows-10-in-s-mode/
http://www.pcmag.com/news/some-users-are-stuck-in-windows-10-s-mode/
Start button/icon/logo/menu/orb -> Windows Settings [gear icon] -> Update & 
Security -> Activation -> Go to the Store ->
"Switch out of S Mode" -> Get -> Install -> wait for confirmation message:
"You're all set! You have switched out of S mode and can now install apps from 
outside the Store."
Done.

* MDGx "Turn OFF/Remove Windows 7/8/8.1 Adware, Spyware, Security Flaws + 
Repair/Restore Privacy" chapter in WINDOWS7.TXT
(included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
______________________________________________________________________________

Tweak Windows 10/11 Services

* 1st Things 1st:
*****************
BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> See "BACKUP/EXPORT + 
RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21

* Disable/(re)enable, stop/(re)start, clean/repair/restore + 
customize/optimize/tweak Windows 10/11
interconnected/interdependent/interrelated services + drivers responsible 
for/contributing to/involved in/related to
dangerous/dubious/insecure/questionable/suspicious/unsafe, 
undesirable/unnecessary/unneeded/unused/useless,
automatic/unattended 
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission, annoying/bloat/resources consuming, 
diagnostic tracking, telemetry ("phone home"),
data collection/logging, customer "experience", unwanted "offers", 
ad(ware)/spyware/surveillance/tracking,
privacy/safety/security flaws/vulnerabilities: 
View/(Re)Start/Stop/(Re)Enable/Disable, set to Disabled/Manual/Automatic
Windows Services + Drivers -> Start button/icon/logo/menu/orb -> Run... [hold 
WinKey + press R] -> type this command
services.msc
-> press Enter -> (re)enable [Boot = 0, System = 1, Automatic (triggered) = 2, 
Automatic (Delayed Start) (triggered) = 2 or
Manual (triggered) = 3], disable [Disabled = 4], customize/optimize/tweak 
Windows (User) Services + Drivers after learning
about them -> continue reading...
Services.msc is located in the %WinDir%\SYSTEM32 directory/folder [%WinDir% = 
usually C:\WINDOWS].
Management Saved Console (.msc) script files are associated by default with and 
executed by Microsoft Management Console
(MMC.EXE) snap-in control tool, and most of them are located in the %WinDir%\
SYSTEM32 directory/folder [%WinDir% = usually
C:\WINDOWS].
http://en.wikipedia.org/wiki/Microsoft_Management_Console
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:



right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
RegEdit.exe:
************
http://learn.microsoft.com/troubleshoot/windows-server/performance/windows-
registry-advanced-users/
http://www.ss64.com/nt/regedit.html
http://www.mdgx.com/reg.htm#RER
http://www.windowscentral.com/how-start-and-stop-services-windows-10/
Certain services Microsoft deems mandatory they should be enabled and running at
all times because they may either affect
proper functionality/operation [interconnected/interdependent/interrelated], or 
for their own purposes [see above for
details], but which may not (always) align/coincide with your needs/preferences 
are locked + protected, and therefore they
canNOT be stopped, disabled and/or modified/customized from within the 
services.msc interface due to Windows registry
protection lockups, no matter your user level/privileges/rights, even if logged 
in as Administrator/Owner/Sysadmin/SYSTEM.
In (most) such cases the most obvious solution is to do it by hand by using the 
Registry Editor (%WinDir%\RegEdit.exe)
[%WinDir% = usually C:\WINDOWS]:
Right-click RegEdit or its shortcut/link -> Run as Administrator -> go to this 
registry subkey:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
and then to this (backup copy) registry subkey:
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services
and then to this (backup copy) registry subkey (if present):
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services
-> click left hand pane desired driver/service name registry subkey [example: 
DNSCache (DNS Client service)] (if present) ->
double-click right hand pane "Start" DWORD [REG_DWORD] registry value -> change 
its numeric value to any integer number
between 0 and 4 [see below for details] -> press OK -> exit RegEdit.
http://mistyprojects.co.uk/documents/TinyPXEServer/files/img/regedit2.jpg
http://cdn2.windowswally.com/wp-content/uploads/2015/09/RuntimeBroker.exe-
Windows-10-regedit-TimeBroker-Windows-Wally.jpg
Repeat same steps for all 3 registry subkeys above: CurrentControlSet, 
ControlSet001 + ControlSet002 (if present).
"Start" valid registry DWORD [REG_DWORD] values:
http://smallvoid.com/article/winnt-services-regedit.html
- 0 [dword:00000000] = Boot;
- 1 [dword:00000001] = System;
- 2 [dword:00000002] = Automatic;
- 3 [dword:00000003] = Manual;
- 4 [dword:00000004] = Disabled.
MDGx: "Comprehensive Windows Registry Guide" [Intro Chapter] in REGISTRY.TXT 
(included):
http://www.mdgx.com/reg.htm#CWRG
NET.EXE, NETSH.EXE, REG.EXE, SC.EXE + WMIC.EXE:
***********************************************
Another option is to use (in combination or separately) these 5 Windows NTx DOS 
console command line tools:
- Net(work) Resources Manager [NET.EXE];
http://learn.microsoft.com/troubleshoot/windows-server/networking/net-commands-
on-operating-systems/
http://www.ss64.com/nt/net-service.html
- Net(work) Sh(ell) [NETSH.EXE];
http://learn.microsoft.com/windows-server/networking/technologies/netsh/netsh-
contexts/
http://learn.microsoft.com/windows-server/administration/windows-commands/netsh/
http://www.ss64.com/nt/netsh.html
- Reg(istry) Editor + Manager [REG.EXE];



http://learn.microsoft.com/windows-server/administration/windows-commands/reg/
http://www.ss64.com/nt/reg.html
http://www.mdgx.com/reg.htm#BNR
- S(ervice) C(ontrol) [C(onfiguration)] [SC.EXE];
http://learn.microsoft.com/windows/win32/services/controlling-a-service-using-
sc/
http://learn.microsoft.com/windows-server/administration/windows-commands/sc-
config/
http://www.ss64.com/nt/sc.html
- W(indows) M(anagement) I(nstrumentation) C(ommand) [WMIC.EXE].
http://learn.microsoft.com/windows/win32/wmisdk/wmic/
http://learn.microsoft.com/windows/win32/wmisdk/wmi-start-page/
http://www.ss64.com/nt/wmic.html
WMIC has been deprecated starting with Windows 10 21H1, correspondent Windows 
Server 2022 + all newer
builds/editions/releases/updates/versions:
http://learn.microsoft.com/windows/whats-new/deprecated-features/
NOTES:
******
All these executables (.exe) require you to be logged on, or must be 
executed/run with elevated
access/permissions/privileges/rights as Admin(istrator)/SYSTEM/Sysadmin:
http://www.ss64.com/nt/syntax-elevate.html
A. Temporary [per app(lication)/command/executable (.exe)/session] FIX:
Windows Vista/newer users -> start a DOS console command prompt session [%WinDir
%\SYSTEM32\CMD.EXE]: right-click CMD
shortcut/CMD.EXE -> Run as Administrator.
OR
Use an elevation tool separately for each individual 
app(lication)/command/executable (.exe)/session [free(ware) examples]:
- AdvancedRun [AdvancedRun.exe] 32-bit + 64-bit GUI interface + DOS console 
command line tool for Windows Vista/newer
32-bit + 64-bit runs any 
app/batch/command/executable/function/process/program/script/service/task/tool 
as
Administrator/SYSTEM/TrustedInstaller/any user with elevated/highest/protected 
privileges/rights, compatibility,
environment, ownership, permissions, priority, properties, useful for task 
automation in BATch (.BAT), CoMmanD (.CMD) +
Visual Basic Script (.VBS) files, highly customizable:
http://www.nirsoft.net/utils/advanced_run.html
AdvancedRun 64-bit:
http://www.nirsoft.net/utils/advancedrun-x64.zip
AdvancedRun 32-bit:
http://www.nirsoft.net/utils/advancedrun.zip
Run Programs as SYSTEM:
http://www.winhelponline.com/blog/run-program-as-system-localsystem-account-
windows/
Run Programs as TrustedInstaller:
http://www.winhelponline.com/blog/run-program-as-trustedinstaller-locked-
registry-keys-files/
- SetACL [SetACL.exe 32-bit + SetACL.exe 64-bit] 32-bit + 64-bit DOS console 
command line tool for Windows Vista/newer
enables/disables/changes/elevates NTFS ACL permissions + ownership for 
local/remote files/(sub)directories, registry
(sub)keys, devices/objects/services:
http://helgeklein.com/setacl/
Download:
http://helgeklein.com/download/#download-setacl
SetACL Command Line Documentation:
http://helgeklein.com/setacl/documentation/command-line-version-setacl-exe/
SetACL Examples:
http://helgeklein.com/setacl/examples/
Wikipedia: SetACL:



http://en.wikipedia.org/wiki/SetACL
- Elevate [elevate.exe 32-bit + elevate.exe 64-bit] 1.3.0 32-bit + 64-bit DOS 
console command line tool runs any
app/batch/command/executable/function/process/program/script/service/task/tool 
as Administrator with
elevated/highest/protected privileges/rights, useful for task automation in 
BATch (.BAT), CoMmanD (.CMD) +
Visual Basic Script (.VBS) files:
http://code.kliu.org/misc/elevate/
File:
http://code.kliu.org/misc/elevate/elevate-1.3.0-redist.7z
- See also "NTFS ACL + OWNER" section in TOOLS.TXT (included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT
B. Permanent (per local/network user) FIX:
Disable User Account Control (UAC) in:
- Windows 10/2016/2019/11/2022:
http://www.tenforums.com/tutorials/3577-user-account-control-uac-change-
settings-windows-10-a.html
- Windows 8/2012/8.1/2012 R2:
http://www.eightforums.com/tutorials/5509-user-account-control-uac-change-
settings-windows-8-a.html
- Windows 7/2008 R2:
http://www.petri.com/disable-uac-in-windows-7/
- Windows Vista/2008:
http://www.petri.com/disable_uac_in_windows_vista/
User Account Control (UAC) tweaking tools [free(ware)]:
- UAC Pass:
http://sites.google.com/site/freeavvarea/uac-pass/uac-pass/
- TweakUAC:
http://www.winability.com/tweak-uac/
- Disable UAC:
http://www.majorgeeks.com/files/details/disable_uac.html
NET.EXE, NETSH.EXE, REG.EXE + SC.EXE executables (.exe) are located in the 
%WinDir%\SYSTEM32 directory/folder [%WinDir% =
usually C:\WINDOWS].
WMIC.EXE executable (.exe) is located in the %WinDir%\SYSTEM32\WBEM 
directory/folder.
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
OR
Save it to a plain text/ASCII (.txt) file: from a DOS console command prompt 
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> type same command above followed by 
the name of the file (in this example it
will be saved in C:\ root)
PATH>C:\Windows_PATH_Directories.txt
-> press Enter -> use Notepad/similar/better free(ware) plain text/ASCII 
editor/viewer
http://www.mdgx.com/toy.htm#TXT
to view saved text file contents.
Example using same service above [DNSCache (DNS Client service)] -> stop + 
disable DNSCache service:
From a DOS console command prompt [%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD 
shortcut/CMD.EXE -> Run as Administrator ->
type these commands in this specific order
ECHO Y|NET.EXE STOP DNSCache
SC.EXE CONFIG DNSCache START= disabled
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\services\DNSCache" /v Start /t 
REG_DWORD /d 4 /f
-> press Enter after each line.



PowerShell.exe:
***************
http://learn.microsoft.com/powershell/module/microsoft.powershell.management/
set-service/
http://www.ss64.com/ps/powershell.html
http://www.ss64.com/ps/
http://www.ss64.com/ps/set-service.html
http://www.windowscentral.com/how-start-and-stop-services-windows-10/
PowerShell [%WinDir%\SYSTEM32\WindowsPowerShell\v1.0\PowerShell.exe] is a task 
automation + configuration manager command
line shell environment + interpreter tool capable of using text/ASCII command 
line Script/BATch files (.ps1).
http://en.wikipedia.org/wiki/PowerShell
PowerShell requires Microsoft .NET Framework core + components, which are 
preinstalled on all Windows Vista/newer releases,
and (usually) updated automatically via Windows Update (WU) service [WuauServ]:
http://www.mdgx.com/add.htm#NFR
PowerShell is a better, more advanced alternative to the standard DOS console 
CoMmanD line prompt interpreter tool
[%WinDir%\SYSTEM32\CMD.EXE].
http://en.wikipedia.org/wiki/Cmd.exe
Start + Stop Drivers + Services manually in Windows 7/newer -> "How to Manage 
Services from PowerShell" section:
http://www.windowscentral.com/how-start-and-stop-services-windows-10/#section-
how-to-manage-services-from-powershell
Windows NTx Services + Drivers Information, Reference, Guidelines, Tutorials, 
Customization, Optimization:
********************************************************************************
**************************
- Disable System Services in Windows Server 2016/2019/2022 with Desktop 
Experience:
http://learn.microsoft.com/windows-server/security/windows-services/security-
guidelines-for-disabling-system-services-in-windows-server/
- Disable Unnecessary Services in Windows 10/11:
http://www.minitool.com/news/windows-10-services-to-disable.html
- Windows 10 Services to Disable for Better Performance:
http://www.howto-connect.com/windows-10-services-to-disable-for-performance/
- Disable Unnecessary Services in Windows 7/newer:
http://www.winhelp.us/disable-unneeded-services-in-windows.html
- Which Windows Services can you safely disable in Windows 11/10?:
http://www.thewindowsclub.com/which-windows-10-services-safe-to-disable/
- Windows 10/11 Services that can be Disabled Safely:
http://www.askvg.com/beginners-guide-to-configure-windows-10-services/
- Safely stop unnecessary Windows 10/11 services:
http://searchenterprisedesktop.techtarget.com/tip/How-to-safely-stop-
unnecessary-Windows-10-services/
- Disabling Microsoft Windows 11 Services:
http://regen.hu/win11/disable-windows-services/disable-windows-services-en-
EN.html
- 20 Unnecessary Background Services to Disable in Windows 10/11:
http://www.freshtechtips.com/2019/04/disable-unnecessary-services-in-
windows.html
- 20 Services in Windows 10/11 that Can be Stopped Without Any Risk:
http://www.reginout.com/help-center/turn-off-windows-10-services-get-unfair-
speed-boost/
- 12 Windows 10 Services Safe to Disable:
http://www.groovypost.com/howto/12-windows-10-services-that-are-safe-to-disable/
- Windows 10 Services to Disable to Improve Performance:
http://technicalustad.com/windows-10-services-to-disable-to-improve-performance/
- 25 Windows 10/11 Services to Disable for Performance & Better Gaming:
http://www.pcerror-fix.com/windows-10-services-to-disable-for-gaming/
- What Windows 10/11 Services Can I Disable:
http://www.briteccomputers.co.uk/posts/what-windows-10-services-can-i-disable/
- Windows 10: which services to disable?:



http://www.wilderssecurity.com/threads/378804
- Disable Windows Event Collector (WECSvc) service:
http://www.computerstepbystep.com/windows_event_collector_service.html
- Disabling Unneeded Services:
http://sourcedaddy.com/windows-7/disabling-unneeded-services.html
- Windows 10/11 Services Configuration:
http://www.blackviper.com/service-configurations/black-vipers-windows-10-
service-configurations/
- Windows 10/11 Services:
http://batcmd.com/windows/10/services/
- Windows 11 Default Windows Services Configuration:
http://www.smartpcutilities.com/windows-11-default-services-configuration.html
- Windows 10/11 Service Defaults:
http://revertservice.com/10/
- Delete a Service in Windows using Different Methods:
http://www.winhelponline.com/blog/how-to-remove-unwanted-service/
- Restore Default Services in Windows 7/newer:
http://www.majorgeeks.com/content/page/
restore_or_verify_default_services_in_windows_7_10.html
- Optimize Windows 10/11 Services for increased performance:
http://discourse.pi64.win/t/optimizing-windows-10-services-for-increased-
performance/
- Windows services:
http://renenyffenegger.ch/notes/Windows/services/
- Windows 10 Services:
http://www.ss64.com/nt/syntax-services.html
- Restore Default Services in Windows 7/newer:
http://www.majorgeeks.com/content/page/
restore_or_verify_default_services_in_windows_7_10.html
- Windows 10/11 updates - One small step for man, one big...:
http://www.dedoimedo.com/computers/windows-10-updates-improvements-control.html
- Windows 10 Default Services Configuration:
http://www.winhelponline.com/blog/windows-10-default-services-configuration/
- Windows 11 Default Services Configuration:
http://www.winhelponline.com/blog/windows-11-default-services-configuration/
- Windows 10/11 Service Configuration:
http://www.windowsafg.com/win10services.html
- Windows 10/11 Default Services:
http://www.ss64.com/nt/syntax-services.html
- Which Windows services are safe to disable and when?:
http://www.digitalcitizen.life/which-windows-services-are-safe-disable-when/
- What Windows 11 Services to Disable Safely and How?:
http://nerdschalk.com/what-windows-11-services-to-disable-safely-and-how/
- 25 Windows 10/11 Services to Disable for Performance & Better Gaming:
http://www.pcerror-fix.com/windows-10-services-to-disable-for-gaming/
- Windows Services you can safely disable [Complete Guide]:
http://windowsreport.com/disable-windows-services/
- Use Registry Editor to change Service state:
http://smallvoid.com/article/winnt-services-regedit.html
- 10services_default.bat:
http://gist.github.com/samkatakouzinos/2d57ecf46a3f729495b1e2dbff938628/
Disable individual + interconnected/interdependent/interrelated services in 
groups +/- separately (if + where applicable):
http://en.wikipedia.org/wiki/List_of_Microsoft_Windows_components#Services
http://www.elevenforum.com/t/enable-and-disable-services-in-windows-11.3069/
http://www.tenforums.com/tutorials/4499-start-stop-disable-services-windows-10-
a.html
http://www.windowscentral.com/how-start-and-stop-services-windows-10/
http://www.winaero.com/start-stop-restart-service-windows-10/
http://win10help.info/how-to-enable-or-disable-app-readiness-service-in-windows-
10/
http://www.file.net/process/fmapp.exe.html
http://teckangaroo.com/what-is-connected-devices-platform-service/
http://www.thewindowsclub.com/what-is-connected-devices-platform-service-cdpsvc/



http://appuals.com/what-is-the-connected-devices-platform-service-and-should-it-
be-disabled/
http://learn.microsoft.com/previous-versions/windows/desktop/qos/link-layer-
topology-discovery-protocol/
http://social.technet.microsoft.com/Forums/en-US/f933e03b-e157-4a1d-9916-
8cfeb11ad2fc/
http://www.makeuseof.com/tag/wsappx-high-disk-cpu-usage-windows-10/
http://www.newnettechnologies.com/disable-windows-services.html
http://virtualfeller.com/2017/04/25/optimize-vdi-windows-10-services-original-
anniversary-and-creator-updates/
http://www.howtogeek.com/268240/what-is-runtime-broker-and-why-is-it-running-on-
my-pc/
http://www.tenforums.com/tutorials/122727-enable-disable-offline-files-
windows.html
http://www.poppelgaard.com/how-to-determine-usb-drivers-are-configured-
correctly-on-the-online-plug-in/
http://www.tenforums.com/customization/179334-project-services-can-disabled-
without-drastic-impact-12.html
See also:
- MDGx "Tweak Windows 7/7 SP1 Services" chapter in WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
- MDGx "Tweaked Windows 10/11 Services + Drivers" [Experimental!] in 
SERVCS10.TXT (included):
http://www.mdgx.com/servcs10.php
http://www.mdgx.com/SERVCS10.TXT
I am currently testing (Disabled/Enabled, Started/Stopped) for optimal 
functionality, requirements, necessities, privacy,
safety, security, proper interdependencies, allocation of resources, performance
+ preferences.
- MDGx "HOSTS Files, Guides + Tools" -> "NOTE 2: DNS Client Service" section -> 
"More info:" topic:
http://www.mdgx.com/hosts.php#N2
- MDGx Windows NTx Services tweaking tools [free(ware)] -> "SERVICES" section in
TOOLS.TXT (included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT

* Autoruns 32-bit + 64-bit GUI interface (Autoruns.exe 32-bit + Autoruns64.exe 
64-bit) + DOS console command line
(Autorunsc.exe 32-bit + Autorunsc64.exe 64-bit) registry + startup tools 
add/disable/edit/enable/rename/remove any/all
automated/built-in/default/forced/hardwired/locked/preset/unattended 
(auto)load/(auto)run entries: boot/logon/startup apps,
drivers, executables (.exe), gadgets (.gadget), loading/registered APIs/DLLs 
(.dll), programs, services, scripts (.bat,
.cmd, .reg, .vbs, etc), scheduled tasks (.job), highly customizable:
http://learn.microsoft.com/sysinternals/downloads/autoruns/
File:
http://download.sysinternals.com/files/Autoruns.zip

* ServiWin 32-bit + 64-bit displays, stops/(re)starts, pauses/continues + 
disables/(re)enables Windows services + drivers:
http://www.nirsoft.net/utils/serviwin.html
ServiWin 64-bit:
http://www.nirsoft.net/utils/serviwin-x64.zip
ServiWin 32-bit:
http://www.nirsoft.net/utils/serviwin.zip
Create complete Drivers + Services HTML Report(s):
ServiWin -> Help -> Run As Administrator [or hold Ctrl + press F11] -> View -> 
HTML Report - All Items.

* Here is the list of Disabled (+ Stopped) services on my tweaked Windows 10 
gaming laptop (used only as example):



http://www.mdgx.com/pc.htm#LAP
that in my opinion start, enable +/- are 
interconnected/interdependent/interrelated to adware, tracking, spyware, 
telemetry,
phone-home, unsafe, forced, behind-my-back, unused, unnecessary, useless, 
obsolete +/- bloat
features/functions/options/settings, and obtained by running %WinDir%\SYSTEM32\
SERVICES.MSC [%WinDir% = usually C:\WINDOWS]:
view/start/stop/disable, set to Disabled/Manual/Automatic Windows Services -> 
Start button/icon/logo/menu/orb -> Run...
[hold WinKey + press R] -> type
services.msc
-> click OK or press Enter -> test + tweak each service by hand individually or 
in pairs/batches/groups (if
interconnected/interdependent/interrelated) *only* after learning about them -> 
see links at the top of this topic.
ActiveX Installer (AxInstSV) [AxInstSV]
Agent Activation Runtime (AAR) [AarSvc]
Agent Activation Runtime (AAR) ?????? [AarSvc_??????]
AllJoyn Router Service [AJRouter]
App Readiness [AppReadiness]
Application Layer Gateway Service [ALG]
Application Management [AppMgmt]
http://batcmd.com/windows/10/services/appmgmt/
%WinDir%\SYSTEM32\appmgmts.dll
AppLocker Filter (Smartlocker Filter driver) [applockerfltr]
AppX Deployment Service (AppXSVC) [AppXSvc]
AssignedAccessManager Service [AssignedAccessManagerSvc]
http://batcmd.com/windows/10/services/assignedaccessmanagersvc/
%WinDir%\SYSTEM32\assignedaccessmanagersvc.dll
Auto Time Zone Updater [tzautoupdate]
AVCTP (Audio Video Control Transport Protocol) service [BthAvctpSvc]
Background Intelligent Transfer Service [BITS] = DISABLED by WUB -> "Turn 
OFF/Postpone/Block/Uninstall Windows Updates (WU)" [above]
BitLocker Drive Encryption Service [BDESVC]
Block Level Backup Engine Service [wbengine]
Capability Access Manager Service [camsvc]
CaptureService [CaptureService]
CaptureService_?????? [CaptureService_??????]
Cellular Time [autotimesvc]
Client License Service (ClipSVC) [ClipSVC]
Clipboard User Service [cbdhsvc]
Clipboard User Service_?????? [cbdhsvc_??????]
Connected User Experiences and Telemetry [DiagTrack]
Contact Data [PimIndexMaintenanceSvc]
Contact Data ?????? [PimIndexMaintenanceSvc_??????]
Credential Manager [VaultSvc]
http://batcmd.com/windows/10/services/vaultsvc/
%WinDir%\SYSTEM32\vaultsvc.dll
Credential Enrollment Manager User Service [CredentialEnrollmentManagerUserSvc]
http://batcmd.com/windows/10/services/credentialenrollmentmanagerusersvc/
%WinDir%\SYSTEM32\CredentialEnrollmentManager.exe
Credential Enrollment Manager User Service ?????? 
[CredentialEnrollmentManagerUserSvc_??????]
http://batcmd.com/windows/10/services/credentialenrollmentmanagerusersvc/
%WinDir%\SYSTEM32\CredentialEnrollmentManager.exe
Data Sharing Service [DsSvc]
http://batcmd.com/windows/10/services/dssvc/
%WinDir%\SYSTEM32\DsSvc.dll
Data Usage [DusmSvc]
Debug reg service [debugregsvc]
Delivery Optimization [DoSvc] = DISABLED by WUB -> "Turn 
OFF/Postpone/Block/Uninstall Windows Updates (WU)" [above]
Developer Tools Service [DeveloperToolsService]



DevQuery Background Discovery Broker [DevQueryBroker]
DeviceAssociationBroker [DeviceAssociationBrokerSvc]
http://batcmd.com/windows/10/services/deviceassociationbrokersvc/
%WinDir%\SYSTEM32\deviceaccess.dll
DeviceAssociationBroker_?????? [DeviceAssociationBrokerSvc_??????]
http://batcmd.com/windows/10/services/deviceassociationbrokersvc/
%WinDir%\SYSTEM32\deviceaccess.dll
DevicesFlow [DevicesFlowUserSvc]
DevicesFlow_?????? [DevicesFlowUserSvc_??????]
DevicePicker [DevicePickerUserSvc]
DevicePicker_?????? [DevicePickerUserSvc_??????]
Device Association Service [DeviceAssociationService]
Device Management Enrollment Service [DmEnrollmentSvc]
http://batcmd.com/windows/10/services/dmenrollmentsvc/
%WinDir%\SYSTEM32\Windows.Internal.Management.dll
DialogBlockingService [DialogBlockingService]
http://batcmd.com/windows/10/services/dialogblockingservice/
%WinDir%\SYSTEM32\DialogBlockingService.dll
Display Enhancement Service [DisplayEnhancementService]
Display Policy Service [DispBrokerDesktopSvc]
(MicroSoft) Distributed Transaction Coordinator [MSDTC]
http://batcmd.com/windows/10/services/msdtc/
%WinDir%\SYSTEM32\msdtc.exe
DNS Client [Dnscache]
Dolby DAX API Service [DolbyDAXAPI]
Downloaded Maps Manager [MapsBroker]
Enterprise App Management Service [EntAppSvc]
File History Service [fhsvc]
Fortemedia APO Control Service [FMAPOService]
Function Discovery Provider Host [fdPHost]
Function Discovery Resource Publication [FDResPub]
GameDVR and Broadcast User Service [BcastDVRUserService]
http://batcmd.com/windows/10/services/bcastdvruserservice/
%WinDir%\SYSTEM32\BcastDVRUserService.dll
GameDVR and Broadcast User Service ?????? [BcastDVRUserService_??????]
http://batcmd.com/windows/10/services/bcastdvruserservice/
%WinDir%\SYSTEM32\BcastDVRUserService.dll
Geolocation Service [lfsvc]
Graphics Performance Service [GraphicsPerfSvc]
http://batcmd.com/windows/10/services/graphicsperfsvc/
%WinDir%\SYSTEM32\GraphicsPerfSvc.dll
HV (Hypervisor/Virtual Machine) Host Service [HvHost]
http://www.smartpcutilities.com/windows-service.html?name=HvHost
%WinDir%\SYSTEM32\hvhostsvc.dll
http://learn.microsoft.com/virtualization/hyper-v-on-windows/reference/
integration-services/
http://www.nakivo.com/blog/manage-hyper-v-integration-services/
Hyper-V Data Exchange Service [vmickvpexchange]
http://batcmd.com/windows/10/services/vmickvpexchange/
%WinDir%\SYSTEM32\icsvc.dll
Hyper-V Guest Service Interface [vmicguestinterface]
http://batcmd.com/windows/10/services/vmicguestinterface/
%WinDir%\SYSTEM32\icsvc.dll
Hyper-V Guest Shutdown Service [vmicshutdown]
http://batcmd.com/windows/10/services/vmicshutdown/
%WinDir%\SYSTEM32\icsvc.dll
Hyper-V Heartbeat Service [vmicheartbeat]
http://batcmd.com/windows/10/services/vmicheartbeat/
%WinDir%\SYSTEM32\icsvc.dll
Hyper-V PowerShell Direct Service [vmicvmsession]
http://batcmd.com/windows/10/services/vmicvmsession/
%WinDir%\SYSTEM32\icsvc.dll
Hyper-V Remote Desktop Virtualization Service [vmicrdv]
http://batcmd.com/windows/10/services/vmicrdv/



%WinDir%\SYSTEM32\icsvcext.dll
Hyper-V Time Synchronization Service [vmictimesync]
http://batcmd.com/windows/10/services/vmictimesync/
%WinDir%\SYSTEM32\icsvc.dll
Hyper-V Volume Shadow Copy Requestor [vmicvss]
http://batcmd.com/windows/10/services/vmicvss/
%WinDir%\SYSTEM32\icsvcext.dll
Hypervisor/Virtual Machine Support Driver [hvservice]
http://renenyffenegger.ch/notes/Windows/dirs/Windows/System32/drivers/index/
%WinDir%\SYSTEM32\DRIVERS\hvservice.sys
Microsoft VMBus Synthetic Keyboard Driver [hyperkbd]
http://batcmd.com/windows/10/services/hyperkbd/
%WinDir%\SYSTEM32\DRIVERS\hyperkbd.sys
Microsoft VMBus Video Device Miniport Driver [hypervideo]
http://batcmd.com/windows/10/services/hypervideo/
%WinDir%\SYSTEM32\DRIVERS\HyperVideo.sys
Internet Connection Sharing (ICS) [SharedAccess]
KtmRm for Distributed Transaction Coordinator [KtmRm]
http://batcmd.com/windows/10/services/ktmrm/
%WinDir%\SYSTEM32\msdtckrm.dll
Link-Layer Topology Discovery Mapper [lltdsvc]
http://batcmd.com/windows/10/services/lltdsvc/
%WinDir%\SYSTEM32\lltdsvc.dll
http://learn.microsoft.com/windows/win32/services/services-and-redirected-
drives/
http://helpdeskgeek.com/windows-10/4-fixes-when-you-cant-map-a-network-drive-in-
windows-10/
Link-Layer Topology Discovery Mapper I/O Driver [lltdio]
http://batcmd.com/windows/10/services/lltdio/
%WinDir%\SYSTEM32\DRIVERS\lltdio.sys
http://www.windows-security.org/windows-service/link-layer-topology-discovery-
mapper/
Local Profile Assistant Service [wlpasvc]
Messaging Service [MessagingService]
Messaging Service ?????? [MessagingService_??????]
Microsoft Account Sign-in Assistant [wlidsvc]
Microsoft App-V Client [AppVClient]
http://batcmd.com/windows/10/services/appvclient/
Microsoft App-V VFS Mini-Filter Driver [AppvVfs]
http://batcmd.com/windows/10/services/appvvfs/
Microsoft App-V Virtual Environment Manager Driver [AppvVemgr]
http://batcmd.com/windows/10/services/appvvemgr/
Microsoft App-V Streaming Mini-Filter Driver [AppvStrm]
Microsoft (Windows) Defender Antivirus Network Inspection Driver [WdNisDrv]
http://batcmd.com/windows/10/services/wdnisdrv/
%WinDir%\SYSTEM32\DRIVERS\WdNisDrv.sys
Microsoft (Windows) Defender Antivirus Network Inspection Service [WdNisSvc]
http://batcmd.com/windows/10/services/wdnissvc/
%ProgramFiles%\Windows Defender\NisSrv.exe
Microsoft (Windows) Defender Antivirus Service [WinDefend]
http://batcmd.com/windows/10/services/windefend/
%ProgramFiles%\Windows Defender\MsMpEng.exe
Microsoft Edge Elevation Service [MicrosoftEdgeElevationService]
http://batcmd.com/windows/10/services/microsoftedgeelevationservice/
%ProgramFiles%\Microsoft\Edge\Application\89.0.774.68\elevation_service.exe
%ProgramFiles%\Microsoft\Edge\Application\92.0.902.67\elevation_service.exe
%ProgramFiles%\Microsoft\Edge\Application\108.0.1462.46\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\89.0.774.68\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\92.0.902.67\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\Edge\Application\108.0.1462.46\
elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\89.0.774.68\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\92.0.902.67\elevation_service.exe
%ProgramFiles(x86)%\Microsoft\EdgeCore\108.0.1462.46\elevation_service.exe



Microsoft Edge Update Service (edgeupdate) [edgeupdate]
http://batcmd.com/windows/10/services/edgeupdate/
%ProgramFiles%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /svc
%ProgramFiles(x86)%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /svc
Microsoft Edge Update Service (edgeupdatem) [edgeupdatem]
http://batcmd.com/windows/10/services/edgeupdatem/
%ProgramFiles%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /medsvc
%ProgramFiles(x86)%\Microsoft\EdgeUpdate\MicrosoftEdgeUpdate.exe /medsvc
Microsoft Passport [NgcSvc]
http://batcmd.com/windows/10/services/ngcsvc/
%WinDir%\SYSTEM32\ngcsvc.dll
Microsoft Passport Container [NgcCtnrSvc]
http://batcmd.com/windows/10/services/ngcctnrsvc/
%WinDir%\SYSTEM32\NgcCtnrSvc.dll
Microsoft (R) Diagnostics Hub Standard Collector Service 
[diagnosticshub.standardcollector.service]
http://batcmd.com/windows/10/services/diagnosticshub-standardcollector-service/
%WinDir%\SYSTEM32\DiagSvcs\DiagnosticsHub.StandardCollector.Service.exe
Microsoft Software Shadow Copy Provider [swprv]
Microsoft Storage Spaces SMP [smphost]
Microsoft Store Install Service [InstallService]
Microsoft Windows SMS Router Service [SmsRouter]
Natural Authentication [NaturalAuthentication]
Net.Tcp Port Sharing Service [NetTcpPortSharing]
Netlogon [Netlogon]
http://batcmd.com/windows/10/services/netlogon/
%WinDir%\SYSTEM32\netlogon.dll
Network Connection Broker [NcbService]
Offline Files [CscService]
Optimize drives [defragsvc]
Parental Controls [WpcMonSvc]
Payments and NFC/SE Manager [SEMgrSvc]
Peer Name Resolution Protocol [PNRPsvc]
Peer Networking Grouping [p2psvc]
Peer Networking Identity Manager [p2pimsvc]
Performance Counter DLL Host [PerfHost]
PNRP Machine Name Publication Service [PNRPAutoReg]
Printer Extensions and Notifications [PrintNotify]
PrintWorkflow [PrintWorkflowUserSvc]
PrintWorkflow ?????? [PrintWorkflowUserSvc_??????]
Problem Reports and Solutions Control Panel Support [wercplsupport]
http://batcmd.com/windows/10/services/wercplsupport/
%WinDir%\SYSTEM32\wercplsupport.dll
Quality Windows Audio Video Experience [QWAVE]
Remote Access Connection Manager [RasMan]
Remote Desktop Configuration [SessionEnv]
Remote Desktop Services [TermService]
Remote Desktop Services UserMode Port Redirector [UmRdpService]
Remote Packet Capture Protocol v.0 (experimental) [rpcapd]
Remote Procedure Call (RPC) Locator [RpcLocator]
http://batcmd.com/windows/10/services/rpclocator/
%WinDir%\SYSTEM32\locator.exe
Remote Registry [RemoteRegistry]
Retail Demo Service [RetailDemo]
Routing and Remote Access [RemoteAccess]
http://batcmd.com/windows/10/services/remoteaccess/
%WinDir%\SYSTEM32\mprdim.dll
Security Center [wscsvc]
Sensor Data Service [SensorDataService]
Sensor Monitoring Service [SensrSvc]
Sensor Service [SensorService]
Server [LanmanServer]
http://batcmd.com/windows/10/services/lanmanserver/
%WinDir%\SYSTEM32\srvsvc.dll



Shared PC Account Manager [shpamsvc]
SNMP (Simple Network Management Protocol) Trap [SNMPTRAP]
http://batcmd.com/windows/10/services/snmptrap/
http://www.manageengine.com/vulnerability-management/misconfiguration/legacy-
protocols/how-to-disable-snmp.html
http://en.wikipedia.org/wiki/Simple_Network_Management_Protocol
%WinDir%\SYSTEM32\snmptrap.exe
Spatial Data Service [SharedRealitySvc]
SSDP (Simple Service Discovery Protocol) Discovery [SSDPSRV]
http://batcmd.com/windows/10/services/ssdpsrv/
http://www.blackviper.com/windows-services/ssdp-discovery-service/
http://www.windows-security.org/windows-service/ssdp-discovery/
http://en.wikipedia.org/wiki/Simple_Service_Discovery_Protocol
%WinDir%\SYSTEM32\ssdpsrv.dll
Storage Tiers Management [TieringEngineService]
Sync Host [OneSyncSvc]
http://batcmd.com/windows/10/services/onesyncsvc/
%WinDir%\SYSTEM32\APHostService.dll
Sync Host ?????? [OneSyncSvc_??????]
http://batcmd.com/windows/10/services/onesyncsvc/
%WinDir%\SYSTEM32\APHostService.dll
TCP/IP NetBIOS Helper [lmhosts]
Time Broker [TimeBrokerSvc]
Touch Keyboard and Handwriting Panel Service [TabletInputService]
Udk User Service (User Share Process Template) [UdkUserSvc]
Udk User Service ?????? (User Share Process Template) [UdkUserSvc_??????]
http://batcmd.com/windows/10/services/udkusersvc/
%WinDir%\SYSTEM32\windowsudk.shellcommon.dll
Update Orchestrator Service [UsoSvc] = DISABLED by WUB -> "Turn 
OFF/Postpone/Block/Uninstall Windows Updates (WU)" [above]
UPnP (Universal Plug and Play) Device Host [upnphost]
http://batcmd.com/windows/10/services/upnphost/
%WinDir%\SYSTEM32\upnphost.dll
http://www.upguard.com/blog/what-is-upnp/
http://en.wikipedia.org/wiki/Universal_Plug_and_Play
User Data Access [UserDataSvc]
User Data Access ?????? [UserDataSvc_??????]
User Data Storage [UnistoreSvc]
User Data Storage ?????? [UnistoreSvc_??????]
User Experience Virtualization Service [UevAgentService]
Volume Shadow Copy [VSS]
Volumetric Audio Compositor Service [VacSvc]
Wallet Service [WalletService]
Windows Backup [SDRSVC]
Windows Biometric Service [WbioSrvc]
Windows Camera Frame Server [FrameServer]
Windows Connection Manager [Wcmsvc]
Windows Connect Now - Config Registrar [wcncsvc]
Windows Encryption Provider Host Service [WEPHOSTSVC]
Windows Event Collector [Wecsvc]
Windows Insider Program (WIP) [wisvc]
Windows License Manager Service [LicenseManager]
Windows Management Service [WManSvc]
http://batcmd.com/windows/10/services/wmansvc/
%WinDir%\SYSTEM32\Windows.Management.Service.dll
Windows Media Player Network Sharing Service [WMPNetworkSvc]
Windows Mixed Reality OpenXR Service [MixedRealityOpenXRSvc]
Windows Perception Service [spectrum]
Windows Perception Simulation Service [perceptionsimulation]
Windows Push Notifications System Service [WpnService]
http://batcmd.com/windows/10/services/wpnservice/
%WinDir%\SYSTEM32\WpnService.dll
Windows Push Notifications User Service [WpnUserService]
http://batcmd.com/windows/10/services/wpnuserservice/



%WinDir%\SYSTEM32\WpnUserService.dll
Windows Push Notifications User Service ?????? [WpnUserService_??????]
http://batcmd.com/windows/10/services/wpnuserservice/
%WinDir%\SYSTEM32\WpnUserService.dll
Windows PushToInstall Service [PushToInstall]
Windows Remote Management (WS-Management) [WinRM]
Windows Search [WSearch]
Windows Security Service [SecurityHealthService]
Windows Update [wuauserv] = DISABLED by WUB -> "Turn 
OFF/Postpone/Block/Uninstall Windows Updates (WU)" [above]
Windows Update Medic Service [WaaSMedicSvc] = DISABLED by WUB -> "Turn 
OFF/Postpone/Block/Uninstall Windows Updates (WU)" [above]
Work Folders [workfolderssvc]
Workstation [LanmanWorkstation]
http://batcmd.com/windows/10/services/lanmanworkstation/
%WinDir%\SYSTEM32\wkssvc.dll
Xbox Accessory Management Service [XboxGipSvc]
Xbox Live Auth Manager [XblAuthManager]
Xbox Live Game Save [XblGameSave]
Xbox Live Networking Service [XboxNetApiSvc]
See also MDGx "Tweaked Windows 10/11 Services + Drivers" [Experimental!] in 
SERVCS10.TXT (included):
http://www.mdgx.com/servcs10.php
http://www.mdgx.com/SERVCS10.TXT
Services that refuse to be disabled or to have their status 
(Automatic/Manual/Disabled) changed from within SERVICES.MSC can
be disabled/(re)enabled as needed using the Registry Editor (RegEdit): right-
click RegEdit (%WinDir%\REGEDIT.EXE)
[%WinDir% = usually C:\WINDOWS] or its shortcut/link -> Run as Administrator -> 
go to this registry subkey
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
-> click left hand pane desired service name registry key [example: Dnscache]
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache
-> double-click right hand pane "Start" DWORD [REG_DWORD] registry value -> 
change its numeric value to 4 [which means
Disabled] -> press OK -> exit RegEdit.
Examples:
http://mistyprojects.co.uk/documents/TinyPXEServer/files/img/regedit2.jpg
http://cdn2.windowswally.com/wp-content/uploads/2015/09/RuntimeBroker.exe-
Windows-10-regedit-TimeBroker-Windows-Wally.jpg
IMPORTANT:
**********
- Your custom/specific 
choices/features/functions/needs/options/preferences/settings and
devices/hardware/software/services/drivers for specific pairs/batches/groups of 
interconnected/interdependent/interrelated
services + drivers may be different depeding on what you do with your 
computer(s)/portable(s)/device(s), and/or what
(combination of) devices/hardware/software/services/drivers you are using.
- Make sure to review carefully each service documentation, and most importantly
each service "Dependencies" tab as shown in
SERVICES.MSC *before* disabling them (example):
http://www.thewindowsclub.com/wp-content/uploads/2018/05/Windows-10-Service-
Dependencies.png
NOTE:
*****
Windows 10 introduced a new "breed" of Windows services: Per User services, 
marked at the end of the name string with an
underscore [_] or a space [ ] followed by a 4-12 digit numeric string [Locally 
Unique IDentifier (LUID)], which is unique
for each user/user session/login/up time, depending on which Windows 10/11 
build/edition/release/update/version you are
using.
http://learn.microsoft.com/windows/application-management/per-user-services-in-



windows/
http://helgeklein.com/blog/per-user-services-in-windows-info-and-configuration/
1st Things 1st:
***************
BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> See "BACKUP/EXPORT + 
RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
Per User services can be disabled and/or prevented from being (re)created by 
changing their default "LaunchProtected",
"Security" and/or "UserServiceFlags" registry DWORD [REG_DWORD] 32-bit or Binary
[REG_BINARY] numeric values to null
[dword:0 or hex:00/hex(0):] (examples):
http://learn.microsoft.com/answers/questions/401557/
See also "Comprehensive Windows Registry Guide" chapter -> "Registry Structure" 
section in REGISTRY.TXT (included):
http://www.mdgx.com/reg.htm#RTS
CAUTION:
Disabling/changing some of these registry keys/values may impair/limit 
normal/proper Windows functionality/operation, cause
errors, or even lock you out of your Windows Operating System (OS)!
Make sure you already have a current full Windows backup copy and backups of all
main registry keys saved in binary format
[Save as type: -> Registration Files (.reg)] *before* making any changes = see 
"BACKUP/EXPORT + RESTORE/IMPORT
REGISTRY/REGISTRY KEY(S)" in WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
Only after that...
******************
Plan A
~~~~~~
Disable Per User service [WpnUserService] from a DOS console (command prompt) ->
right-click CMD shortcut/CMD.EXE ->
Run as Administrator -> run these commands -> press Enter after each line 
(example):
REG.EXE DELETE "HKLM\SYSTEM\CurrentControlSet\Services\WpnUserService\
Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet001\Services\WpnUserService\Security" /f
REG.EXE DELETE "HKLM\SYSTEM\ControlSet002\Services\WpnUserService\Security" /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WpnUserService\Security" /v 
Security /t REG_BINARY /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WpnUserService\Security" /v 
Security /t REG_BINARY /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WpnUserService\Security" /v 
Security /t REG_BINARY /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WpnUserService" /v 
LaunchProtected /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WpnUserService" /v 
LaunchProtected /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WpnUserService" /v 
LaunchProtected /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WpnUserService" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WpnUserService" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WpnUserService" /v 
UserServiceFlags /t REG_DWORD /d 0 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WpnUserService" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WpnUserService" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WpnUserService" /v Start /t 



REG_DWORD /d 4 /f
OR if method above does not work (using same example):
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnUserService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnUserService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WpnUserService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnUserService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnUserService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WpnUserService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnUserService\Security]
"Security"=hex:00
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnUserService\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WpnUserService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
;
------End cut & paste here------
Windows Push Notifications User Service [WpnUserService]:
http://batcmd.com/windows/10/services/wpnuserservice/
Plan B
~~~~~~
In case both methods above do not work due to Windows 10/11 registry protection,
you may need to do this by hand by using the
Registry Editor (%WinDir%\RegEdit.exe) [%WinDir% = usually C:\WINDOWS] (using 
same example): right-click RegEdit or its
shortcut/link -> Run as Administrator -> go to this registry subkey:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
and then to this registry subkey:
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services
and then to this registry subkey (if present):
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services
-> click left hand pane desired service name registry key [example: 
WpnUserService] (if present) -> double-click right hand
pane "Start" DWORD [REG_DWORD] registry value -> change its numeric value to 4 
[which means Disabled] -> press OK -> exit
RegEdit.
Repeat same steps for the other registry values above and set their DWORD 
[REG_DWORD] or Binary [REG_BINARY] numeric values
to null [dword:0 or hex:00 or hex(0):] (see above):
LaunchProtected [REG_DWORD] = dword:0
Security [REG_BINARY] = hex:00 [hex(0):]
UserServiceFlags [REG_DWORD] = dword:0
Plan C
~~~~~~
In case "Plan B" above does not work due to Windows 10/11 registry protection, 
you can do this by hand by running the



Registry Editor (%WinDir%\RegEdit.exe) [%WinDir% = usually C:\WINDOWS] as 
TrustedInstaller (highest available user level
privileges) using AdvancedRun.exe (example):
AdvancedRun.exe /EXEFilename "%windir%\REGEDIT.EXE" /RunAs 8 /Run
AdvancedRun [AdvancedRun.exe] 32-bit + 64-bit GUI interface + DOS console 
command line tool for Windows Vista/newer
32-bit + 64-bit runs any 
app/batch/command/executable/function/process/program/script/service/task/tool 
as
Administrator/SYSTEM/TrustedInstaller/any user with elevated/highest/protected 
privileges/rights, compatibility,
environment, ownership, permissions, priority, properties, useful for task 
automation in BATch (.BAT), CoMmanD (.CMD) +
Visual Basic Script (.VBS) files, highly customizable:
http://www.nirsoft.net/utils/advanced_run.html
AdvancedRun 64-bit:
http://www.nirsoft.net/utils/advancedrun-x64.zip
AdvancedRun 32-bit:
http://www.nirsoft.net/utils/advancedrun.zip
Run Programs as TrustedInstaller:
http://www.winhelponline.com/blog/run-program-as-trustedinstaller-locked-
registry-keys-files/
See also "Everything About The Infamous (Not So) Trusted Installer" chapter in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
As soon as the RegEdit window is open, repeat all steps above from "Plan B".
Example: Microsoft (Windows) Defender Antivirus Service [WinDefend] can be 
disabled only by using RegEdit as
TrustedInstaller, or if you're running a Windows 10 edition other than Home, it 
may still be available by running Group
Policy Editor (GPEdit.msc).
http://tipsmake.com/instructions-to-turn-off-windows-defender-completely-on-
windows-10
Final Step
~~~~~~~~~~
No matter which "Plan" you have used, you should restart/reboot Windows for all 
changes to take effect.

* ALWAYS ON: *never* Stop nor Disable these Windows 10 drivers + services, which
are either critical, essential/vital for
the integrity, proper functionality/operation and/or stability of the operating 
system (OS) and its core components, or that
cannot be stopped (unable to bypasses Windows built-in/forced/hardwired/locked 
defaults/presets), or which Windows always
restarts on its own even after they (together with their 
interconnected/interdependent/interrelated drivers/services) are
set to Disabled and Stopped (most important examples I can think of):
Background Tasks Infrastructure Service [BrokerInfrastructure]
http://batcmd.com/windows/10/services/brokerinfrastructure/
%WinDir%\SYSTEM32\psmsrv.dll
Capability Access Manager Service [camsvc]
http://batcmd.com/windows/10/services/camsvc/
CD/DVD File System Reader driver [cdfs]
http://batcmd.com/windows/10/services/cdfs/
Cloud Files Mini Filter Driver [CldFlt]
http://batcmd.com/windows/10/services/cldflt/
CNG Hardware Assist algorithm provider Driver [cnghwassist]
http://batcmd.com/windows/10/services/cnghwassist/
CoreMessaging [CoreMessagingRegistrar]
http://batcmd.com/windows/10/services/coremessagingregistrar/
%WinDir%\SYSTEM32\coremessaging.dll
Cryptographic Services [CryptSvc] = ALWAYS ON -> (re)starts even if DISABLED !
http://batcmd.com/windows/10/services/cryptsvc/



%WinDir%\SYSTEM32\cryptsvc.dll
Diagnostic Policy Service [DPS]
http://batcmd.com/windows/10/services/dps/
%WinDir%\SYSTEM32\dps.dll
Diagnostic Execution Service [diagsvc]
http://batcmd.com/windows/10/services/diagsvc/
%WinDir%\SYSTEM32\DiagSvc.dll
Diagnostic Service Host [WdiServiceHost]
http://batcmd.com/windows/10/services/wdiservicehost/
%WinDir%\SYSTEM32\wdi.dll
Diagnostic System Host [WdiSystemHost]
http://batcmd.com/windows/10/services/wdisystemhost/
%WinDir%\SYSTEM32\wdi.dll
Display Policy Service [DispBrokerDesktopSvc]
http://batcmd.com/windows/10/services/dispbrokerdesktopsvc/
%WinDir%\SYSTEM32\DispBroker.Desktop.dll
Distributed Link Tracking Client (DLTC) [TrkWks]
http://learn.microsoft.com/troubleshoot/windows-server/backup-and-storage/
distributed-link-tracking-on-domain-controller/
http://www.blackviper.com/windows-services/distributed-link-tracking-client/
http://batcmd.com/windows/10/services/trkwks/
%WinDir%\SYSTEM32\trkwks.dll
Embedded Mode [embeddedmode]
http://batcmd.com/windows/10/services/embeddedmode/
%WinDir%\SYSTEM32\embeddedmodesvc.dll
Filter Manager Driver (FltMgr) [FltMgr]
http://batcmd.com/windows/10/services/fltmgr/
Kernel Cryptography Driver [CNG]
http://batcmd.com/windows/10/services/cng/
MUP (Multiple UNC Provider) Driver [Mup]
%WinDir%\SYSTEM32\DRIVERS\mup.sys
http://learn.microsoft.com/windows-hardware/drivers/ifs/support-for-unc-naming-
and-mup/
http://batcmd.com/windows/10/services/mup/
Net.Tcp Port Sharing Service [NetTcpPortSharing]
http://batcmd.com/windows/10/services/nettcpportsharing/
http://learn.microsoft.com/dotnet/framework/wcf/feature-details/net-tcp-port-
sharing/
http://www.windows-security.org/windows-service/nettcp-port-sharing-service/
Network List Service [netprofm]
Network Location Awareness [NlaSvc]
Redirected Buffering Sub System [rdbss]
http://learn.microsoft.com/windows-hardware/drivers/ifs/the-redirected-drive-
buffering-subsystem/
http://batcmd.com/windows/10/services/rdbss/
Secondary Logon [seclogon]
http://batcmd.com/windows/10/services/seclogon/
%WinDir%\SYSTEM32\seclogon.dll
Security Accounts Manager [SamSs] = ALWAYS ON -> (re)starts even if DISABLED !
http://batcmd.com/windows/10/services/samss/
%WinDir%\SYSTEM32\lsass.exe
Spot Verifier [svsvc]
http://batcmd.com/windows/10/services/svsvc/
%WinDir%\SYSTEM32\svsvc.dll
State Repository Service [StateRepository] = ALWAYS ON -> (re)starts even if 
DISABLED !
http://batcmd.com/windows/10/services/staterepository/
%WinDir%\SYSTEM32\windows.staterepository.dll
Storage Service [StorSvc]
http://batcmd.com/windows/10/services/storsvc/
Storage Tiers Management [TieringEngineService]
System Guard Runtime Monitor Broker [sgrmbroker.exe]
http://www.winosbite.com/sgrmbroker-exe/
TCP/IP Protocol Driver [Tcpip]



http://batcmd.com/windows/10/services/tcpip/
%WinDir%\SYSTEM32\DRIVERS\tcpip.sys
Universal Disk Format File System driver [udfs]
http://batcmd.com/windows/10/services/udfs/
User Manager [UserManager]
http://batcmd.com/windows/10/services/usermanager/
%WinDir%\SYSTEM32\usermgr.dll
Web Account Manager [TokenBroker]
http://batcmd.com/windows/10/services/tokenbroker/
%WinDir%\SYSTEM32\TokenBroker.dll
Windows Socket 2.0 Non IFS Service Provider Support Environment Driver [WS2IFSL]
http://batcmd.com/windows/10/services/ws2ifsl/
%WinDir%\SYSTEM32\DRIVERS\WS2IFSL.SYS
http://www.bleepingcomputer.com/startups/
Windows_Socket_2.0_Non_IFS_Service_Provider_Support_Environment-12029.html
http://en.wikipedia.org/wiki/Layered_Service_Provider
http://flylib.com/books/en/1.397.1.105/1/
See also MDGx "Tweaked Windows 10/11 Services + Drivers" [Experimental!] in 
SERVCS10.TXT (included):
http://www.mdgx.com/servcs10.php
http://www.mdgx.com/SERVCS10.TXT

* Here is the list of Windows 10 services needed/recommended/required by/used 
for cable/dial/direct/fiber (optic)/wired, BPL
(Broadband over Power Lines)/cable/DSL (Digital Subscriber 
Line)/fiber/satellite/wireless broadband, bluetooth +
Wi-Fi/wireless remote connections/internet/networks, devices/services/software, 
all set to Manual [triggered to start/wake
up as necessary if/whenever triggered by other 
interconnected/interdependent/interrelated services, devices, drivers,
functions, apps/programs/software, residents, tasks]:
AVCTP (Audio Video Control Transport Protocol) service [BthAvctpSvc]
http://batcmd.com/windows/10/services/bthavctpsvc/
%WinDir%\SYSTEM32\BthAvctpSvc.dll
Bluetooth Audio Gateway Service [BTAGService]
http://batcmd.com/windows/10/services/btagservice/
%WinDir%\SYSTEM32\BTAGService.dll
Bluetooth Support Service [bthserv]
http://batcmd.com/windows/10/services/bthserv/
%WinDir%\SYSTEM32\bthserv.dll
Bluetooth User Support Service [BluetoothUserService]
http://batcmd.com/windows/10/services/bluetoothuserservice/
%WinDir%\SYSTEM32\Microsoft.Bluetooth.UserService.dll
Bluetooth User Support Service_?????? [BluetoothUserService_??????]
http://batcmd.com/windows/10/services/bluetoothuserservice/
%WinDir%\SYSTEM32\Microsoft.Bluetooth.UserService.dll
Cellular Time [autotimesvc]
Connected Devices Platform Service [CDPSvc]
http://batcmd.com/windows/10/services/cdpsvc/
%WinDir%\SYSTEM32\CDPSvc.dll
Connected Devices Platform User Service [CDPUserSvc]
http://batcmd.com/windows/10/services/cdpusersvc/
%WinDir%\SYSTEM32\CDPUserSvc.dll
Connected Devices Platform User Service_?????? [CDPUserSvc_??????]
http://batcmd.com/windows/10/services/cdpusersvc/
%WinDir%\SYSTEM32\CDPUserSvc.dll
ConsentUX [ConsentUxUserSvc]
ConsentUX_?????? [ConsentUxUserSvc_??????]
Credential Manager [VaultSvc]
http://batcmd.com/windows/10/services/vaultsvc/
%WinDir%\SYSTEM32\vaultsvc.dll
Credential Enrollment Manager User Service [CredentialEnrollmentManagerUserSvc]
http://batcmd.com/windows/10/services/credentialenrollmentmanagerusersvc/
%WinDir%\SYSTEM32\CredentialEnrollmentManager.exe



Credential Enrollment Manager User Service ?????? 
[CredentialEnrollmentManagerUserSvc_??????]
http://batcmd.com/windows/10/services/credentialenrollmentmanagerusersvc/
%WinDir%\SYSTEM32\CredentialEnrollmentManager.exe
Cryptographic Services [CryptSvc] = ALWAYS ON -> (re)starts even if DISABLED !
http://batcmd.com/windows/10/services/cryptsvc/
%WinDir%\SYSTEM32\cryptsvc.dll
Data Sharing Service [DsSvc]
http://batcmd.com/windows/10/services/dssvc/
%WinDir%\SYSTEM32\DsSvc.dll
Device Association Service [DeviceAssociationService]
Device Install Service [DeviceInstall]
Device Management Enrollment Service [DmEnrollmentSvc]
http://batcmd.com/windows/10/services/dmenrollmentsvc/
%WinDir%\SYSTEM32\Windows.Internal.Management.dll
Device Management Wireless Application Protocol (WAP) Push message Routing 
Service [dmwappushservice]
http://batcmd.com/windows/10/services/dmwappushservice/
%WinDir%\SYSTEM32\dmwappushsvc.dll
Device Setup Manager [DsmSvc]
DeviceAssociationBroker [DeviceAssociationBrokerSvc]
http://batcmd.com/windows/10/services/deviceassociationbrokersvc/
%WinDir%\SYSTEM32\deviceaccess.dll
DeviceAssociationBroker_?????? [DeviceAssociationBrokerSvc_??????]
http://batcmd.com/windows/10/services/deviceassociationbrokersvc/
%WinDir%\SYSTEM32\deviceaccess.dll
DevicesFlow [DevicesFlowUserSvc]
DevicesFlow_?????? [DevicesFlowUserSvc_??????]
DevQuery Background Discovery Broker [DevQueryBroker]
Embedded Mode [embeddedmode]
Extensible Authentication Protocol [Eaphost]
Intel Bluetooth Service [ibtsiva]
MessagingService [MessagingService]
MessagingService_?????? [MessagingService_??????]
Natural Authentication [NaturalAuthentication]
Network Connected Devices Auto-Setup [NcdAutoSetup]
Network List Service [netprofm]
Network Location Awareness [NlaSvc]
Network Setup Service [NetSetupSvc]
Network Store Interface Service [nsi]
OpenSSH Authentication Agent [ssh-agent]
Portable Device Enumerator Service [WPDBusEnum]
Radio Management Service [RmSvc]
Sensor Data Service [SensorDataService]
Sensor Monitoring Service [SensrSvc]
Sensor Service [SensorService]
SNMP (Simple Network Management Protocol) Trap [SNMPTRAP]
http://batcmd.com/windows/10/services/snmptrap/
http://www.manageengine.com/vulnerability-management/misconfiguration/legacy-
protocols/how-to-disable-snmp.html
http://en.wikipedia.org/wiki/Simple_Network_Management_Protocol
%WinDir%\SYSTEM32\snmptrap.exe
Wi-Fi Direct Services Connection Manager Service [WFDSConMgrSvc]
Windows Connect Now - Config Registrar [wcncsvc]
Windows Encryption Provider Host Service [WEPHOSTSVC]
Windows Management Service [WManSvc]
http://batcmd.com/windows/10/services/wmansvc/
%WinDir%\SYSTEM32\Windows.Management.Service.dll
Windows Mobile Hotspot Service [icssvc]
WWAN AutoConfig [WwanSvc]

* Here is the list of running (+ enabled: Automatic or Manual) services on my 
tweaked Windows 10 gaming laptop (used only as
example):



http://www.mdgx.com/pc.htm#LAP
that in my opinion are essential, necessary, useful, unavoidable, indispensable,
depend on
other/interconnected/interdependent/interrelated services + drivers, +/- on 
which
other/interconnected/interdependent/interrelated services + drivers depend on, 
+/- cater to the (combination of)
custom/specific choices/features/functions/needs/options/preferences/settings 
and devices/hardware/software/services/drivers
I use, and obtained by running command below from a DOS console (command prompt)
-> right-click CMD shortcut/CMD.EXE -> Run
as Administrator -> run this command -> press Enter:
NET.EXE START>SVC_STARTED.TXT
Application Management [AppMgmt]
Background Tasks Infrastructure Service [BrokerInfrastructure]
Base Filtering Engine [BFE]
COM+ Event System [EventSystem]
CoreMessaging [CoreMessagingRegistrar]
Cryptographic Services [CryptSvc]
DCOM Server Process Launcher [DcomLaunch]
DHCP Client [Dhcp]
Diagnostic Policy Service [DPS]
Diagnostic Service Host [WdiServiceHost]
Diagnostic System Host [WdiSystemHost]
Human Interface Device Service [hidserv]
Local Session Manager [LSM]
Network Connections [Netman]
Network List Service [netprofm]
Network Location Awareness [NlaSvc]
Network Store Interface Service [nsi]
NVIDIA Display Container LS [NVDisplay.ContainerLocalSystem]
Plug and Play [PlugPlay]
Power [Power]
Program Compatibility Assistant Service [PcaSvc]
Radio Management Service [RmSvc]
Realtek Audio Universal Service [RtkAudioUniversalService]
Remote Procedure Call (RPC) [RpcSs]
RPC Endpoint Mapper [RpcEptMapper]
Secondary Logon [seclogon]
http://batcmd.com/windows/10/services/seclogon/
Shell Hardware Detection [ShellHWDetection]
Software Protection [sppsvc]
State Repository Service [StateRepository] = ALWAYS ON -> (re)starts even if 
DISABLED !
http://batcmd.com/windows/10/services/staterepository/
%WinDir%\SYSTEM32\windows.staterepository.dll
Storage Service [StorSvc]
SysMain [SysMain]
System Event Notification Service [SENS]
System Events Broker [SystemEventsBroker]
System Guard Runtime Monitor Broker [SgrmBroker]
Themes [Themes]
Time Broker [TimeBrokerSvc]
User Manager [UserManager]
User Profile Service [ProfSvc]
Web Account Manager [TokenBroker]
http://batcmd.com/windows/10/services/tokenbroker/
%WinDir%\SYSTEM32\TokenBroker.dll
Windows Audio [Audiosrv]
Windows Audio Endpoint Builder [AudioEndpointBuilder]
Windows Connection Manager [Wcmsvc]
Windows Defender Firewall [mpssvc]
Windows Event Log [EventLog]
Windows Font Cache Service [FontCache]



Windows Image Acquisition (WIA) [stisvc]
Windows Management Instrumentation [Winmgmt]
See also MDGx "Tweaked Windows 10/11 Services + Drivers" [Experimental!] in 
SERVCS10.TXT (included):
http://www.mdgx.com/servcs10.php
http://www.mdgx.com/SERVCS10.TXT
______________________________________________________________________________

Windows Settings (WS) + Control Panel (CP) Shortcuts

* Create Windows 10/11 Windows Settings (WS) a.k.a. Immersive Control Panel 
(ICP) a.k.a. native Control Panel +
Live/Metro/Screen/Start/Tile (Store) UWP (Universal Windows Platform) 
apps/programs/games/tools command(s)
item(s)/shortcut(s) (.lnk, .url, .web, etc):
Desktop (empty spot) -> right-click -> New -> Shortcut -> cut & paste respective
"ms-settings:xxxx" text string listed below
[not all are available, and some may differ depending on installed Windows OS 
build/edition/release/update/version, patches
+ update(s), installed add-ons, apps, components, drivers, features, games, 
network/internet connections/devices/interfaces,
programs, services, software, tools, and/or custom configuration, options, 
preferences, settings]:
http://learn.microsoft.com/windows/uwp/launch-resume/launch-settings-app/
FYI:
Universal Windows Platform (UWP) apps:
http://en.wikipedia.org/wiki/Universal_Windows_Platform_apps
http://learn.microsoft.com/windows/uwp/
http://en.wikipedia.org/wiki/Universal_Windows_Platform
See also my Windows 10/11 Settings Uniform Resource Identifier (URI) commands 
links/shortcuts listed in WIN10SET.HTM
(included):
http://www.mdgx.com/WIN10SET.HTM
Similar Windows 10/11 resources:
http://www.majorgeeks.com/content/page/
how_to_create_a_shortcut_to_any_windows_settings.html
http://tenop.com/windows-10-settings-links-launch-list-guide/
http://www.winaero.com/blog/ms-settings-commands-in-windows-10/
http://www.winaero.com/windows-11-ms-settings-commands-settings-uri-shortcuts/
http://4sysops.com/wiki/list-of-ms-settings-uri-commands-to-open-specific-
settings-in-windows-10/history/?revision=1558411
http://www.tenforums.com/tutorials/78214-settings-pages-list-uri-shortcuts-
windows-10-a.html
http://www.ss64.com/nt/syntax-settings.html
http://woshub.com/ms-settings-uri-commands-windows-11/
http://mywindowshub.com/a-complete-list-of-uri-commands-in-windows-11/
http://pureinfotech.com/windows-11-mssettings-uri-commands/
http://shortcutworld.com/Windows/win/Windows-Run-Commands_-Settings_-and-Start-
Menu-Shortcuts
http://www.benecke.cloud/windows-10-modify-settings-page/
http://appuals.com/customize-settings-page-visibility-in-windows-10/
http://www.elevenforum.com/t/list-of-uri-commands-to-open-microsoft-store-apps-
in-windows-11.2683/
http://www.msftnext.com/ms-settings-commands-in-windows-11-the-full-list-of-uri-
shortcuts/
http://en.wikipedia.org/wiki/Settings_(Windows)
To access any of these Uniform Resource Identifier (URI) links/shortcuts: make 
sure you are logged in with
Administrator/Sysadmin/SYSTEM access + privileges -> Run... [hold WinKey + press
R] -> type this command:



ms-settings:
-> press Enter.
OR this command:
EXPLORER.EXE ms-settings:
-> press Enter.
See also "Control Panel (CP) + Omnipotent/Master/Mega/'god mode' (OMg) Control 
Panel" chapter in WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
List of Windows 10/11 Settings URI (Uniform Resource Identifier) commands 
shortcuts:

* Main window:
Windows Settings (front page) = ms-settings:

* Accounts:
Access Work/School = ms-settings:workplace
E-mail + App Accounts = ms-settings:emailandaccounts
Family + Other People = ms-settings:otherusers
Set up Kiosk = ms-settings:assignedaccess
Sign-in options = ms-settings:signinoptions | ms-settings:signinoptions-
dynamiclock
Sync Your Settings = ms-settings:sync
Windows Hello setup = ms-settings:signinoptions-launchfaceenrollment | ms-
settings:signinoptions-launchfingerprintenrollment
Your Info = ms-settings:yourinfo
Provisioning = ms-settings:workplace-provisioning
Provisioning = ms-settings:provisioning
Windows Anywhere = ms-settings:windowsanywhere

* Apps:
Apps + Features = ms-settings:appsfeatures
App Features = ms-settings:appsfeatures-app (reset, manage add-ons, downloadable
content)
Apps for Websites = ms-settings:appsforwebsites
Default Apps = ms-settings:defaultapps
Manage Optional Features = ms-settings:optionalfeatures
Offline Maps = ms-settings:maps | ms-settings:maps-downloadmaps
Startup Apps = ms-settings:startupapps
Video Playback = ms-settings:videoplayback

* Devices:
Audio + Speech = ms-settings:holographic-audio
AutoPlay = ms-settings:autoplay
Bluetooth = ms-settings:bluetooth
Connected Devices = ms-settings:connecteddevices
Mouse + Touchpad = ms-settings:mousetouchpad
Pen + Ink = ms-settings:pen
Printers + Scanners = ms-settings:printers
Touchpad = ms-settings:devices-touchpad
Typing = ms-settings:typing
USB = ms-settings:usb
Wheel = ms-settings:wheel (available if Dial paired)
Mobile Device/Phone = ms-settings:mobile-devices

* Ease of Access:
Audio = ms-settings:easeofaccess-audio
Closed Captions = ms-settings:easeofaccess-closedcaptioning
Color Filters = ms-settings:easeofaccess-colorfilter
Cursor + Pointer Size = ms-settings:easeofaccess-cursorandpointersize
Display = ms-settings:easeofaccess-display
Eye Control = ms-settings:easeofaccess-eyecontrol
Fonts = ms-settings:fonts
High Contrast = ms-settings:easeofaccess-highcontrast



Holographic headset = ms-settings:holographic-headset
Keyboard = ms-settings:easeofaccess-keyboard
Magnifier = ms-settings:easeofaccess-magnifier
Mouse = ms-settings:easeofaccess-mouse
Mouse Pointer = ms-settings:easeofaccess-mousepointer
Narrator = ms-settings:easeofaccess-narrator
Speech = ms-settings:easeofaccess-speechrecognition

* Extras:
Extras = ms-settings:extras (available if extra/other MS/3rd party apps 
installed)

* Gaming:
Broadcasting = ms-settings:gaming-broadcasting
Game bar = ms-settings:gaming-gamebar
Game DVR = ms-settings:gaming-gamedvr
Game Mode = ms-settings:gaming-gamemode
Play Game Full Screen = ms-settings:quietmomentsgame [available if compatible 
game(s) installed]
TruePlay = ms-settings:gaming-trueplay (available if TruePlay enabled)
Xbox Networking = ms-settings:gaming-xboxnetworking

* Network + Internet:
Airplane mode = ms-settings:network-airplanemode | ms-settings:proximity
Cellular + SIM = ms-settings:network-cellular
Data Usage = ms-settings:datausage (available if using metered internet 
connection/network)
Dial-up = ms-settings:network-dialup
DirectAccess = ms-settings:network-directaccess (available if DirectAccess 
enabled)
Ethernet = ms-settings:network-ethernet
Manage Known Networks = ms-settings:network-wifisettings
Mobile Hotspot = ms-settings:network-mobilehotspot
NFC = ms-settings:nfctransactions
Proxy = ms-settings:network-proxy
Status = ms-settings:network-status | ms-settings:network
VPN = ms-settings:network-vpn
Wi-Fi = ms-settings:network-wifi (available if device has Wi-Fi adapter)
Wi-Fi Calling = ms-settings:network-wificalling (available if Wi-Fi calling 
enabled)

* Personalization:
Background = ms-settings:personalization-background
Choose which folders appear on Start = ms-settings:personalization-start-places
Colors = ms-settings:personalization-colors | ms-settings:colors
Lock Screen = ms-settings:lockscreen
Personalization (category) = ms-settings:personalization
Start = ms-settings:personalization-start
Taskbar = ms-settings:taskbar
Themes = ms-settings:themes

* Privacy:
Account Info = ms-settings:privacy-accountinfo
Activity History = ms-settings:privacy-activityhistory
App Diagnostics = ms-settings:privacy-appdiagnostics
Automatic File Downloads = ms-settings:privacy-automaticfiledownloads
Background Apps = ms-settings:privacy-backgroundapps
Calendar = ms-settings:privacy-calendar
Call History = ms-settings:privacy-callhistory
Camera = ms-settings:privacy-webcam
Contacts = ms-settings:privacy-contacts
Documents = ms-settings:privacy-documents
E-mail = ms-settings:privacy-email
Eye Tracker = ms-settings:privacy-eyetracker



Feedback + Diagnostics = ms-settings:privacy-feedback
File System = ms-settings:privacy-broadfilesystemaccess
General = ms-settings:privacy-general
Location = ms-settings:privacy-location
Messaging = ms-settings:privacy-messaging
Microphone = ms-settings:privacy-microphone
Motion = ms-settings:privacy-motion
Notifications = ms-settings:privacy-notifications
Other Devices = ms-settings:privacy-customdevices
Pictures = ms-settings:privacy-pictures
Radios = ms-settings:privacy-radios
Speech, Inking + Typing = ms-settings:privacy-speechtyping
Tasks = ms-settings:privacy-tasks
Videos = ms-settings:privacy-videos

* System:
About = ms-settings:about
Advanced display settings = ms-settings:display-advanced
Battery Saver = ms-settings:batterysaver
Battery Saver settings = ms-settings:batterysaver-settings
Battery Use = ms-settings:batterysaver-usagedetails
Clipboard = ms-settings:clipboard
Display = ms-settings:display
Default Save Locations = ms-settings:savelocations
Display = ms-settings:screenrotation
Duplicating My Display = ms-settings:quietmomentspresentation
During these Hours = ms-settings:quietmomentsscheduled
Encryption = ms-settings:deviceencryption
Focus Assist = ms-settings:quiethours | ms-settings:quietmomentshome
Graphics settings = ms-settings:display-advancedgraphics
Messaging = ms-settings:messaging
Multitasking = ms-settings:multitasking
Night Light settings = ms-settings:nightlight
Mobile Device/Phone = ms-settings:phone-defaultapps
Projecting to This PC = ms-settings:project
Shared Experiences = ms-settings:crossdevice
Tablet mode = ms-settings:tabletmode
Taskbar = ms-settings:taskbar
Notifications + Actions = ms-settings:notifications
Remote Desktop = ms-settings:remotedesktop
Power + Sleep = ms-settings:powersleep
Sounds = ms-settings:sounds
App Volume + Device preferences = ms-settings:apps-volume
Storage = ms-settings:storagesense
Storage Sense = ms-settings:storagepolicies

* Time + Language:
Date + Time = ms-settings:dateandtime
Japan IME settings = ms-settings:regionlanguage-jpnime
Language = ms-settings:keyboard
Pinyin IME settings = ms-settings:regionlanguage-chsime-pinyin
Speech = ms-settings:speech
Wubi IME settings = ms-settings:regionlanguage-chsime-wubi (available if MS Wubi
input editor installed)

* Update + Security:
Activation = ms-settings:activation
Backup = ms-settings:backup
Delivery Optimization = ms-settings:delivery-optimization
Find My Device = ms-settings:findmydevice
For Developers = ms-settings:developers
Recovery = ms-settings:recovery
Troubleshoot = ms-settings:troubleshoot
Windows Security = ms-settings:windowsdefender



Windows Insider Program = ms-settings:windowsinsider | ms-
settings:windowsinsider-optin
Windows Update = ms-settings:windowsupdate
Check for Updates = ms-settings:windowsupdate-action
Windows Update Advanced options = ms-settings:windowsupdate-options
Windows Update Restart options = ms-settings:windowsupdate-restartoptions
Windows Update View update history = ms-settings:windowsupdate-history
______________________________________________________________________________

Tweaks, Hacks + Fixes... UNconventional, UNdocumented, UNcensored ;-/

* Windows 10/11 Tweaks + Fixes web sites:
http://www.thewindowsclub.com/category/windows/
http://www.winaero.com/category/windows-11/
http://www.winaero.com/windows-11-tutorials/
http://www.winaero.com/category/windows-10/
http://www.winaero.com/
http://www.howtogeek.com/
http://www.wintips.org/
http://www.tweaks.com/windows-11/
http://www.tweaks.com/windows-10/
http://www.tweakhound.com/tag/this-site+windows-10/
http://www.tweakhound.com/2021/05/19/tweaking-windows-10-version-21h1/
http://pureinfotech.com/tag/how-to/
http://pureinfotech.com/tag/windows-11/
http://pureinfotech.com/tag/windows-10/
http://www.boredgamer.co.uk/2018/03/20/windows-10-ultimate-gaming-tweak-guide/
http://www.minitool.com/backup-tips/optimize-windows-10-for-gaming.html
http://sourcedaddy.com/windows-10/
http://www.techspot.com/
http://www.smallvoid.com/
http://www.intowindows.com/?s=windows+11
http://www.intowindows.com/?s=windows+10
http://www.askvg.com/category/windows-11/
http://www.askvg.com/category/windows-10/
http://www.ghacks.net/category/windows/
http://www.elevenforum.com/tutorials/
http://www.tenforums.com/tutorials/
http://www.elevenforum.com/
http://www.winhelponline.com/
http://www.laptopmag.com/articles/how-to-use-windows-10/
http://www.softwareok.com/?page=Windows/11/Quick-Tip
http://www.softwareok.com/?page=Windows/10/Quick-Tip

* FIX: Turn OFF/disable/repair/restore Windows 11 annoyances, errors, problems, 
worst features + improve performance +
reliability:
http://www.tomshardware.com/how-to/worst-windows-11-features-fix-them/
http://www.makeuseof.com/common-windows-11-problems/
http://www.elevenforum.com/t/windows-11-tweaks-leader-board.1842/
http://www.guidingtech.com/fix-low-volume-on-windows-11/
http://www.theverge.com/22715331/how-to-regedit/
http://beebom.com/how-speed-up-windows-11/
http://windowsreport.com/how-to-make-windows-11-faster/
http://www.itpro.co.uk/operating-systems/microsoft-windows/361485/how-to-speed-
up-windows-11/
http://www.askvg.com/how-to-bypass-this-pc-cant-run-windows-11-error-and-
disable-hardware-check-on-unsupported-devices/

* FIX: Turn OFF/bypass/disable Windows 10 build 22H2/newer + Windows 11 Home/Pro



'Let's connect you to a Network' mandatory
pre-install dialog window prompt which wants you [withOUT presenting ANY other 
alternatives/options!] to open a new (or log
into/sign in with an existing, if any) Microsoft internet/online/remote e-mail, 
enrollment, membership, service,
subscription account in order to successfully complete the installation/setup 
process:
http://4sysops.com/archives/install-windows-10-11-22h2-without-microsoft-
account/
http://www.askvg.com/tip-how-to-complete-windows-11-setup-without-internet-
connection/
http://www.elevenforum.com/t/microsoft-blocks-all-options-to-bypass-ms-account-
on-new-installs.19342/
http://www.howtogeek.com/836157/how-to-use-windows-11-with-a-local-account/
http://www.winaero.com/how-to-install-windows-11-with-local-account/
http://arstechnica.com/gadgets/2024/02/what-i-do-to-clean-up-a-clean-install-of-
windows-11-23h2-and-edge/
http://www.tomshardware.com/how-to/install-windows-11-without-microsoft-account/
http://www.laptopmag.com/laptops/windows-laptops/how-to-install-windows-11-
without-a-microsoft-account/
SOLUTIONS:
**********
Method #1:
**********
1. 1st things 1st: make sure you disconnect your computer/device/laptop/portable
from the internet/network by unplugging the
cable(s) [if using Ethernet, a (hybrid) network, (W)LAN, (W)MAN, (W)PAN, (W)WAN,
etc], and also make sure to unplug/turn off
your cable box, modem, modem/router combo, router and/or satellite box 
(especially if using any kind of wireless/Wi-Fi
connection).
That's because in case Windows 10/11 setup detects any kind of internet/network 
connection it will insist on trying to force
you to log on/sign in (if you already have a Microsoft account), or to prompt 
you to create a new Microsoft account (if you
don't have one).
2. During Windows 10/11 setup when you see the 'Let's connect you to a Network' 
forced/inescapable/mandatory dialog window
prompt:
press + hold Shift + F10 -> DOS console command prompt window [%WinDir%\
SYSTEM32\CMD.EXE] will appear -> type this command
[case insensitive]
%SystemRoot%\SYSTEM32\OOBE\BypassNRO.cmd
-> press Enter -> your computer/device/laptop/portable will restart 
automatically -> upon next reboot when prompted again to
connect to a network -> click "I don't have internet" button/link -> click 
"Continue with limited setup" button/link -> in
the "Who's going to use this device?" dialog window type your 
name/nickname/handle/moniker/etc under the "Enter your name"
prompt -> click Next button/link -> etc... -> complete the installation/setup 
process.
This allows using [same as before in case you have already installed and/or used
any other previous Windows OS
build(s)/edition(s)/release(s)/version(s)] your preferred local/owner/personal 
user account other than the
internet/network/online account name forced down your throat by Microsoft, which
by design exposes your
computer(s)/device(s) behind your back, unauthorized, without your 
knowledge/permission to dangerous, deceptive, unsafe,
unwanted ad(vertisement)s/adware, auditing, fingerprinting, intrusions, 
invasions of privacy, "offers", promo(tion)s,
spoofing, surveillance, spying, tracking.
BypassNRO.cmd plain text CoMmanD (.cmd) script file is located in the %WinDir%\
SYSTEM32\OOBE directory/folder [%WinDir% =



usually C:\WINDOWS].
3. In case procedure above does NOT work: press + hold Shift + F10 -> DOS 
console command prompt window
[%WinDir%\SYSTEM32\CMD.EXE] will appear -> type this command [case insensitive]
taskmgr
-> press Enter -> click "More details" button -> find + highlight/select 
"Network Connection Flow" process -> right-click on
it -> click "End task" button -> click "I don't have internet" button/link -> 
click "Continue with limited setup"
button/link -> in the "Who's going to use this device?" dialog window type your 
name/nickname/handle/moniker/etc under the
"Enter your name" prompt -> click Next button/link -> etc... -> complete the 
installation/setup process.
4. Alternatively (in case the above does NOT work): press + hold Shift + F10 -> 
DOS console command prompt window
[%WinDir%\SYSTEM32\CMD.EXE] will appear -> type this command [case insensitive]
taskkill /F /IM oobenetworkconnectionflow.exe
-> press Enter -> etc... -> complete the installation/setup process.
TaskKill.exe + TaskMgr.exe executables (.exe) are both located in the %WinDir%\
SYSTEM32 directory/folder [%WinDir% = usually
C:\WINDOWS].
OOBENetworkConnectionFlow.exe executable (.exe) is located in 1 of these 
directories/folders, depending on your Windows
10/11 build/edition/release/update/version:
- %WinDir%\SYSTEM32\OOBE [%WinDir% = usually C:\WINDOWS];
- "%ProgramFiles%\Microsoft\Windows 10(11) ????(-??)" [????(-??) = 
build/edition/release/update/version number]
[%ProgramFiles% = usually "C:\Program Files"];
- %WinDir%\SystemApps\Microsoft.Windows.OOBENetworkConnectionFlow_????????????? 
[????????????? =
build/edition/release/update/version number] [%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
OR
Save it to a plain text/ASCII (.txt) file: from a DOS console command prompt 
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> type same command above followed by 
the name of the file (in this example it
will be saved in C:\ root)
PATH>C:\Windows_PATH_Directories.txt
-> press Enter -> use Notepad/similar/better free(ware) plain text/ASCII 
editor/viewer
http://www.mdgx.com/toy.htm#TXT
to view saved text file contents.
Method #2:
**********
Make this system change permanent, just in case you may ever need it again in 
the future:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
REG.EXE ADD "HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\OOBE" /v 
BypassNRO /t REG_DWORD /d 1 /f
shutdown.exe /r /t 0



------End cut & paste here------
This will also restart Windows so the change will take effect, and you can 
continue with the installation/setup process.
REG.EXE + ShutDown.exe executables (.exe) are both located in the %WinDir%\
SYSTEM32 directory/folder [%WinDir% = usually
C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
OR
Save it to a plain text/ASCII (.txt) file: from a DOS console command prompt 
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> type same command above followed by 
the name of the file (in this example it
will be saved in C:\ root)
PATH>C:\Windows_PATH_Directories.txt
-> press Enter -> use Notepad/similar/better free(ware) plain text/ASCII 
editor/viewer
http://www.mdgx.com/toy.htm#TXT
to view saved text file contents.
Method #3:
**********
Follow the step-by-step guidelines detailed in the "Using an answer file to 
install Windows 11 without a Microsoft Account"
section of this WinAero web page:
http://www.winaero.com/how-to-install-windows-11-with-local-account/
#Using_an_answer_file_to_install_Windows_11_without_a_Microsoft_Account
in order to create, edit/modify or download,
http://www.winaero.com/blog/wp-content/uploads/2021/06/autounattend.zip
and use this already customized "autounattend.xml" text file with your Windows 
10/11 installation/setup process.
FYI:
File above is customized "out of the box" for Windows 11 installations with 
United States English (en-US) language
pre-selected as preferred locale.
In case you have a different Windows OS build/edition/release/update/version 
and/or need/prefer a different language you
must edit autounattend.xml file above using Notepad [%WinDir%\notepad.exe]: 
right-click Notepad(.exe) located in the
%WinDir% directory/folder [%WinDir% = usually C:\WINDOWS] -> select Run as 
Administrator -> File -> Open... -> browse or
search for the location of autounattend.xml -> Open -> add/modify any 
options/parameters necessary to match your
needs/requirements + preferences -> File -> Save [press Ctrl + hold S] -> 
exit/close Notepad.
Microsoft Windows supported languages:
http://learn.microsoft.com/windows/win32/intl/national-language-support/
More info:
http://www.science.co.il/language/Locale-codes.php
http://en.wikipedia.org/wiki/Internationalization_and_localization
After that you may need to copy [right-click autounattend.xml -> Copy] your 
customized autounattend.xml file to the same
directory/folder [right-click respective directory/folder name -> Paste] where 
Windows Setup EXEcutable [setup(.exe)] is
located, for example the root or the main directory/folder of the Windows 10/11 
installation disk/drive/partition/volume.
Method #4:
**********
Use Rufus (Portable) [free(ware)]
http://rufus.ie/downloads/
to create a bootable USB drive/media [make sure capacity is at least 8 GB!] 
containing your Windows 10 22H2/newer or Windows



11 Home/Pro ISO image installation Setup [see "Using the Rufus tool" section for
details]
http://arstechnica.com/gadgets/2024/02/what-i-do-to-clean-up-a-clean-install-of-
windows-11-23h2-and-edge/
-> leave your bootable USB drive/media [the 1 containing Windows 10/11 ISO 
image] plugged in into the fastest USB port
available -> reboot -> enter BIOS Setup [key(s) shortcut combo to access BIOS 
settings differ depending on your
computer/device/laptop/motherboard/portable brand + model -> see their 
respective support web site for details] -> configure
USB as your primary boot drive -> save newly changed BIOS 
configuration/settings, exit BIOS + reboot -> proceed with your
Windows 10/11 installation.
Rufus (Portable) 32-bit + 64-bit formats + creates bootable USB drive/media from
bootable ISO image:
http://rufus.ie/
Rufus Portable:
http://rufus.ie/downloads/
Rufus repository:
http://github.com/pbatard/rufus/
Download [Portable EXE]:
http://github.com/pbatard/rufus/releases/latest/
Choices... choices...
A. In case you have acquired/purchased/etc your computer/device/laptop/portable 
with Windows 7/8/8.1/10/11
built-in/pre-installed/pre-loaded you can download [for free] provided/supported
Windows 10/11 ISO image installation Setup
from the manufacturer/OEM/retailer/service/vendor downloads/service/support web 
site or from Microsoft.
http://tb.rg-adguard.net/
Guide:
http://superuser.com/questions/1108085/
B. In case you wish to install Windows 10/11 new from scratch or as upgrade from
an older Windows
build/edition/release/version you can download [for free] desired Windows 10/11 
ISO image [installation Setup] from
Microsoft.
- Windows 10:
http://www.microsoft.com/en-us/software-download/windows10/
Guide:
http://www.howtogeek.com/427223/how-to-download-a-windows-10-iso-without-the-
media-creation-tool/
http://answers.microsoft.com/en-us/windows/forum/windows_10-windows_install-
winpc/how-to-download-official-windows-10-iso-files/35cde7ec-5b6f-481c-a02d-
dadf465df326
http://www.isumsoft.com/windows-10/how-to-download-windows-10-iso-from-
microsoft.html
- Windows 11:
http://www.microsoft.com/software-download/windows11/
Guide:
http://techcommunity.microsoft.com/t5/windows-11/how-to-download-windows-11-
iso/m-p/3062471/

* Disable/Uninstall +/- reenable/reinstall 
built-in/preinstalled/provisioned/hidden/uninstallable built-in/store Windows 10
UWP (Universal Windows Platform)/modern/native/tile apps:
http://learn.microsoft.com/windows/application-management/remove-provisioned-
apps-during-update/
http://learn.microsoft.com/windows/application-management/remove-provisioned-
apps-during-update/#registry-keys-for-provisioned-apps
http://4sysops.com/archives/remove-provisioned-built-in-apps-in-windows-10/
http://www.howtogeek.com/224798/how-to-uninstall-windows-10s-built-in-apps-and-
how-to-reinstall-them/
http://www.askvg.com/guide-how-to-remove-all-built-in-apps-in-windows-10/



http://www.tenforums.com/tutorials/4689-uninstall-apps-windows-10-a.html#option3
http://www.laptopmag.com/articles/uninstall-restore-windows-10-builtin-apps/
http://www.majorgeeks.com/content/page/
remove_windows_10_apps_using_powershell.html
http://www.makeuseof.com/tag/easily-remove-bloatware-windows-10/
http://appuals.com/how-to-remove-bloatware-on-windows-10/
http://appuals.com/how-to-uninstall-programs-on-windows-10-that-wont-uninstall/
http://mbplace.net/hacks.html
http://github.com/adolfintel/Windows10-Privacy/
Use 1 of these tools [free(ware)]:
- O&O AppBuster uninstalls/reinstalls preinstalled/built-in/hidden Windows 10 
Store Apps:
http://www.oo-software.com/en/ooappbuster/
File:
http://dl5.oo-software.com/files/ooappbuster/OOAPB.exe
- 10AppsManager uninstalls/reinstalls preinstalled/built-in/hidden Windows 10 
Store Apps:
http://www.thewindowsclub.com/10appsmanager-windows-10/
File:
http://www.thewindowsclub.com/downloads/10amW10.zip
- Windows10Debloater using PowerShell script files (.ps1):
http://github.com/Sycnex/Windows10Debloater/
Files [right-click each 1 -> Save as...]:
http://raw.githubusercontent.com/Sycnex/Windows10Debloater/master/
Windows10Debloater.ps1
http://raw.githubusercontent.com/Sycnex/Windows10Debloater/master/
Windows10DebloaterGUI.ps1
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run one of these commands [using default 
Downloads directory/folder] -> press Enter:
%UserProfile%\Downloads\Windows10DebloaterGUI.ps1
[and click desired selection boxes] or:
%UserProfile%\Downloads\Windows10Debloater.ps1
- Windows 10 Decrapifier + Optimization for 18xx/19xx/2xxx:
http://community.spiceworks.com/scripts/show/4378-windows-10-decrapifier-18xx-
19xx-2xxx/
File:
http://gist.github.com/BenNottelling/9c43d168e8344ac7c971c701c5f5e455#file-
w10onarm_setup_batch-bat
Optimize Windows 10/11 Services for increased performance:
http://discourse.pi64.win/t/optimizing-windows-10-services-for-increased-
performance/
Follow this comprehensive guide:
http://github.com/adolfintel/Windows10-Privacy/
Example:
Uninstall Game DVR + Xbox apps: right-click PowerShell shortcut or C:\WINDOWS\
SYSTEM32\WindowsPowerShell\v1.0\PowerShell.exe
[default location in Windows 10/11] -> Run as Administrator -> run this command 
-> press Enter:
Get-AppxPackage -AllUsers *xbox* | Remove-AppxPackage
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.BingWeather_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\



AppxAllUserStore\Deprovisioned\Microsoft.DesktopAppInstaller_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.GetHelp_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Getstarted_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Microsoft3DViewer_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.MicrosoftOfficeHub_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\
Microsoft.MicrosoftSolitaireCollection_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.MicrosoftStickyNotes_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.MSPaint_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Office.OneNote_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.OneConnect_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.People_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Print3D_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.SkypeApp_kzf8qxf38zg5c]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.StorePurchaseApp_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Wallet_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Windows.Photos_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsAlarms_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsCalculator_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsCamera_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\
microsoft.windowscommunicationsapps_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsFeedbackHub_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsMaps_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsSoundRecorder_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.WindowsStore_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Xbox.TCUI_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.XboxApp_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.XboxGameOverlay_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.XboxIdentityProvider_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.XboxSpeechToTextOverlay_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.ZuneMusic_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.ZuneVideo_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\



AppxAllUserStore\Deprovisioned\Microsoft.3DBuilder_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.HEVCVideoExtension_8wekyb3d8bbwe]
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Appx\
AppxAllUserStore\Deprovisioned\Microsoft.Messaging_8wekyb3d8bbwe]
;
------End cut & paste here------
Uninstall/Remove Quick Assist app:
http://walkersam.blogspot.com/2017/10/how-to-uninstall-quick-assist-within.html
http://github.com/adolfintel/Windows10-Privacy/issues/37/
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
PowerShell.exe -ExecutionPolicy Unrestricted
Then from within the PowerShell console run this command -> press Enter:
Remove-WindowsCapability -online -name App.Support.QuickAssist~~~~0.0.1.0
OR this command -> press Enter:
Get-WindowsPackage -Online | Where PackageName -like *QuickAssist* | Remove-
WindowsPackage -Online -NoRestart
Uninstall/Remove Microsoft Hello Face + Hello for Business apps:
http://dirteam.com/sander/2020/07/02/howto-delete-your-windows-hello-for-
business-registration/
http://github.com/adolfintel/Windows10-Privacy/issues/37/
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run this command -> 
press Enter:
certutil.exe -DeleteHelloContainer
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
PowerShell.exe -ExecutionPolicy Unrestricted
Then from within the PowerShell console run this command -> press Enter:
Get-WindowsPackage -Online | Where PackageName -like *Hello-Face* | Remove-
WindowsPackage -Online -NoRestart
Uninstall/Remove Contact Support + Feedback (Hub) apps:
http://www.winaero.com/how-to-uninstall-and-remove-contact-support-in-windows-
10/
http://www.majorgeeks.com/content/page/how_to_uninstall_the_feedback_hub.html
File:
http://www.winaero.com/downloads/Uninstall_Contact_Support.zip
Use an unZIPping/unARChiving/unRARing tool [free(ware)]
http://www.mdgx.com/toy.htm#ZIP
to open "Uninstall_Contact_Support.zip" archive and extract "Uninstall Contact 
Support.cmd" + "install_wim_tweak.exe" into a
dedicated/empty directory/folder -> right-click "Uninstall Contact Support.cmd" 
-> Run as Administrator -> restart/reboot.
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
PowerShell.exe -ExecutionPolicy Unrestricted
Then from within the PowerShell console run this command -> press Enter:
Get-AppXPackage *feedback* | Remove-AppXPackage

* FIX: Install Windows 10/11 *without* the need for a Microsoft 
account/enrollment/membership/sign-up/subscription, even if
their deceptive/misleading instruction guidelines state otherwise:
http://www.filecatchers.com/setting-up-windows-without-a-microsoft-account/
http://windowsreport.com/install-windows-10-without-microsoft-account/
http://helpdeskgeek.com/windows-10/how-to-setup-windows-10-without-a-microsoft-
account/

* Turn ON/enable Hardware Accelerated GPU Scheduling in Windows 10/11 in order 
to improve speed + performance and reduce
latency with graphics/processing/rendering intensive app(lication)s, programs, 
games, tools, web browsers by



offloading/transferring power + time consuming computing tasks from the CPU 
(Central Processing Unit) onto the GPU (Graphics
Processing Unit):
http://www.majorgeeks.com/content/page/hardware_accelerated_gpu_scheduling.html
http://www.makeuseof.com/windows-10-gpu-hardware-scheduling-worth-turning-on/
http://pureinfotech.com/enable-hardware-accelerated-gpu-scheduling-windows-10/
http://pureinfotech.com/enable-hardware-accelerated-gpu-scheduling-windows-11/
Start button/icon/logo/menu/orb -> Windows Settings [gear icon] -> System -> 
Display -> Graphics (settings) [-> Change
default graphics settings] -> Hardware-accelerated GPU scheduling -> turn 
ON/slide right -> Restart Windows.
OR Run... [hold WinKey + press R] -> type this command:
EXPLORER.EXE ms-settings:display-advancedgraphics
-> press Enter [-> Change default graphics settings] -> Hardware-accelerated GPU
scheduling -> turn ON/slide right ->
Restart Windows.
NOTES:
******
- Requires capable/compatible/modern/supported GPU/graphics/video card hardware 
controller.
- It also reduces CPU heat, therefore prolonging its lifespan.
- Modern GPUs are more efficient, faster + more powerful at processing 
multitasking, multithreading, parallellizable
computer program code.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\GraphicsDrivers]
"HwSchMode"=dword:2
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\GraphicsDrivers]
"HwSchMode"=dword:2
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\GraphicsDrivers]
"HwSchMode"=dword:2
;
------End cut & paste here------

* Turn ON/enable Prefetch + SuperFetch [SysMain] service + 
interconnected/interdependent/interrelated Remote Procedure Call
(RPC) [RpcSs] service + File Information FS MiniFilter [FileInfo] driver (set 
them all to Automatic startup) in order to
speed up loading of frequently used executables (.exe) in Windows 7/newer:
http://www.tenforums.com/tutorials/99821-enable-disable-superfetch-windows.html
http://www.technipages.com/windows-enable-disable-superfetch/
http://www.thewindowsclub.com/disable-superfetch-prefetch-ssd/
http://batcmd.com/windows/10/services/fileinfo/
http://batcmd.com/windows/10/services/rpcss/
http://batcmd.com/windows/10/services/sysmain/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4



[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\FileInfo\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\FileInfo]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RpcSs\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RpcSs]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SysMain\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SysMain]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
"SvcMemHardLimitInMB"=dword:002dc6c0
"SvcMemMidLimitInMB"=dword:0000012c
"SvcMemSoftLimitInMB"=dword:0000001e
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management\PrefetchParameters]
"EnableSuperfetch"=dword:3
"EnablePrefetcher"=dword:3
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\FileInfo\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\FileInfo]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\RpcSs\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\RpcSs]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\SysMain\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\SysMain]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
"SvcMemHardLimitInMB"=dword:002dc6c0
"SvcMemMidLimitInMB"=dword:0000012c
"SvcMemSoftLimitInMB"=dword:0000001e
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\Session Manager\Memory 
Management\PrefetchParameters]
"EnableSuperfetch"=dword:3
"EnablePrefetcher"=dword:3
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\FileInfo\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\FileInfo]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\RpcSs\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\RpcSs]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\SysMain\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\SysMain]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:2
"SvcMemHardLimitInMB"=dword:002dc6c0
"SvcMemMidLimitInMB"=dword:0000012c
"SvcMemSoftLimitInMB"=dword:0000001e
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\Session Manager\Memory 
Management\PrefetchParameters]



"EnableSuperfetch"=dword:3
"EnablePrefetcher"=dword:3
;
------End cut & paste here------

* Windows 10/11 Custom Installs: Guides + Downloads:
- MS DOCs: Build + deploy Windows 10/11 images:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/system-builder-
deployment/
- MS DOCs: Add Custom Scripts to Windows Setup:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/add-a-custom-
script-to-windows-setup/
- MS DOCs: Configuration + Settings:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/configuration-
and-settings/
- MS DOCs: Microsoft Windows Assessment + Deployment Kit (WADK):
http://learn.microsoft.com/windows-hardware/get-started/adk-install/
WADK -> see "Essential Add-ons, Components, Fixes, Updates, Tools + Games 
[free(ware)]" section further below:
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT
- The IT Bros: Sysprep Windows 10 + 11 Machine Guide:
http://theitbros.com/sysprep-windows-machine/
- Win10XPE + Win10PESE packages:
http://win10se.cwcodes.net/Compressed/
- Windows 10 Lite (Better Privacy) Setup Helper customization scripts:
http://sourceforge.net/projects/windows-10-lite/
http://www.majorgeeks.com/files/details/windows_10_lite.html
- gHacks: Run Windows 10 Setup Scripts after installation to customize the OS:
http://www.ghacks.net/2020/08/19/run-windows-10-setup-script-after-installation-
to-customize-the-os/
- Sophia Script PowerShell Module for Windows 10/11:
http://github.com/farag2/Sophia-Script-for-Windows/
Download:
http://github.com/farag2/Sophia-Script-for-Windows/releases/latest/

* Turn OFF/disable Network Location Awareness (NLA) service [NlaSvc] Active 
Probing + Network Connectivity Status Indicator
(NCSI) Taskbar icon in Windows 8/newer:
http://support.microsoft.com/help/4494446/
http://newsignature.com/articles/network-location-awareness-service-can-ruin-
day-fix/
http://learn.microsoft.com/windows/win32/winsock/network-location-awareness-
service-provider-nla--2/
These 2 interconnected/interdependent/interrelated services [+ other services 
they depend on -> see below] provide this
functionality:
- Network Location Awareness [NlaSvc] = Collects and stores configuration 
information for the network and notifies programs
when this information is modified. If this service is stopped, configuration 
information might be unavailable. If this
service is disabled, any services that explicitly depend on it will fail to 
start.
Dependencies:
http://batcmd.com/windows/10/services/nlasvc/
%WinDir%\SYSTEM32\nlasvc.dll
- Network List Service [netprofm] = Identifies the networks to which the 
computer has connected, collects and stores
properties for these networks, and notifies applications when these properties 
change.
Dependencies:
http://batcmd.com/windows/10/services/netprofm/
%WinDir%\SYSTEM32\netprofmsvc.dll
TIP:



Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\NlaSvc\Parameters\
Internet]
"EnableActiveProbing"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\NlaSvc\Parameters\Internet]
"EnableActiveProbing"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\NlaSvc\Parameters\Internet]
"EnableActiveProbing"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\
NetworkConnectivityStatusIndicator]
"DisablePassivePolling"=dword:1
"NoActiveProbe"=dword:1
;
------End cut & paste here------
BUG:
****
Your active/current/installed internet/network/LAN/WAN/Wi-Fi/wireless connection
might report this false error (NCSI Taskbar
icon):
"No Internet"
even if/when it works properly.
http://superuser.com/questions/1400187/
FIX:
****
In such cases you can (re)enable these 2 registry values:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\
NetworkConnectivityStatusIndicator]
"DisablePassivePolling"=dword:0
"NoActiveProbe"=dword:0
;
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.

* Turn ON/repair NTFS (New Technology File System) Long Paths (> 260 characters)
in Windows 10 with installed versions of
Microsoft .NET Framework Redistributable (NFR) OLDer than 4.6.2:
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.FileSys::LongPathsEnabled
http://superuser.com/questions/1119883/
http://www.howtogeek.com/266621/how-to-make-windows-10-accept-file-paths-over-
260-characters/
http://www.winaero.com/blog/how-to-enable-ntfs-long-paths-in-windows-10/
NFR 4.6.2 + NTFS Long Paths in Windows 10:
http://blogs.msdn.microsoft.com/jeremykuhne/2016/07/30/net-4-6-2-and-long-paths-
on-windows-10/
RECOMMENDED:



Install NEWest available update/version (if you haven't already) of 
Microsoft .NET Framework Redistributable (NFR):
http://www.mdgx.com/add.htm#NFR
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Policies]
"LongPathsEnabled"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem]
"LongPathsEnabled"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Policies]
"LongPathsEnabled"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\FileSystem]
"LongPathsEnabled"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Policies]
"LongPathsEnabled"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\FileSystem]
"LongPathsEnabled"=dword:1
[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Group Policy 
Objects\{48981759-12F2-42A6-A048-028B3973495F}Machine\System\CurrentControlSet\
Policies]
"LongPathsEnabled"=dword:1
[HKEY_USERS\.DEFAULT\SOFTWARE\Microsoft\Windows\CurrentVersion\Group Policy 
Objects\{48981759-12F2-42A6-A048-028B3973495F}Machine\System\CurrentControlSet\
Policies]
"LongPathsEnabled"=dword:1
;
------End cut & paste here------

* Turn ON/repair/restore original Windows 10 style (classic) Taskbar tray [+ 
Start Menu] in Windows 11:
http://www.winaero.com/how-to-restore-classic-start-menu-in-windows-11-and-get-
back-live-tiles/
http://ramensoftware.com/7-taskbar-tweaker-on-windows-11-with-windows-10s-
taskbar/
http://www.winaero.com/winaero-tweaker-1-20-1-get-back-windows-10-start-menu-
and-taskbar-in-windows-11/
Method 1:
*********
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Shell\Update\
Packages]
"UndockingDisabled"=dword:1
;
------End cut & paste here------
After you register/merge/import .reg file above -> click Start 
button/icon/logo/menu/orb -> log off/sign out -> log on/sign
in back into Windows 11 under same user name so the change above can take 



effect.
Method 2:
*********
A. Restore Windows 10 Taskbar in Windows 11 by using Winaero Tweaker:
http://www.winaero.com/winaero-tweaker-1-20-1-get-back-windows-10-start-menu-
and-taskbar-in-windows-11/
1. Install Winaero Tweaker:
http://www.winaero.com/winaero-tweaker/
2. Open/run/start Winaero Tweaker.
3. Go to: Windows 11 -> Classic Start Menu and Taskbar -> check "Enable Classic 
Taskbar and Start menu" box -> click
"Sign out now" button.
4. Log on/sign in back into Windows 11 under same user name.
5. Open/run/start 7+ Taskbar Tweaker (7TT) -> customize/tweak settings according
to your needs/preferences -> done.
BONUS:
Windhawk customizes/tweaks Windows 10/11 app(lication)s/programs with mods:
http://windhawk.net/
Windhawk Repository:
http://github.com/ramensoftware/windhawk/
Windhawk Mods:
http://windhawk.net/mods/
Windhawk Mods Repository:
http://github.com/ramensoftware/windhawk-mods/
Windhawk Wiki Documentation:
http://github.com/ramensoftware/windhawk/wiki/
B. Tweak Windows 10 Taskbar in Windows 11 by using 7+ Taskbar Tweaker (7TT):
7+ Taskbar Tweaker (7TT) 32-bit + 64-bit (Portable) for Windows 7/newer adds 
hidden + unavailable Taskbar tray settings
beyond Windows capabilities, highly customizable [select Portable at install 
time]:
http://ramensoftware.com/7-taskbar-tweaker/
http://tweaker.ramensoftware.com/
File [Install -> select Portable]:
http://ramensoftware.com/downloads/7tt_setup.exe
7+ Taskbar Tweaker (7TT) Portable:
http://www.portableapps.com/apps/utilitues/7plus-taskbar-tweaker-portable/
7+ Taskbar Tweaker (7TT) Guide:
http://www.winaero.com/get-a-classic-taskbar-in-windows-8-and-windows-7-that-
works-like-xp/
7+ Taskbar Tweaker (7TT) Advanced Settings:
http://tweaker.ramensoftware.com/images/7-taskbar-tweaker.png
7+ Taskbar Tweaker (7TT) Repository:
http://github.com/m417z/7-Taskbar-Tweaker/
7+ Taskbar Tweaker (7TT) Windhawk tweak mods for Windows 11 Taskbar:
http://ramensoftware.com/windhawk-mods-for-the-windows-11-taskbar/
Method 3:
*********
Restore Windows 10 Taskbar, Start Menu + customize Start button/icon/logo/orb in
Windows 11 by using Open-Shell Menu -> see
"How to Change The Start Menu Icon in Open Shell" section:
http://www.winaero.com/how-to-restore-classic-start-menu-in-windows-11-and-get-
back-live-tiles/
Open-Shell [Classic Shell fork] 32-bit + 64-bit Start Menu + 
button/icon/logo/orb, Explorer + IE enhancer, replacer,
supports custom skins, buttons/logos, highly customizable:
http://open-shell.github.io/Open-Shell-Menu/
ReadMe:
http://github.com/Open-Shell/Open-Shell-Menu/
Download:
http://github.com/Open-Shell/Open-Shell-Menu/releases/
Open-Shell Guides:
http://askleo.com/open-shell-regain-your-start-menu-in-windows-and-much-more/
http://www.techrepublic.com/article/how-to-use-open-shell-as-your-windows-10-



start-menu/
Custom Start button/icon/logo/orb Tutorial:
http://coddec.github.io/Classic-Shell/www.classicshell.net/tutorials/
buttontutorial.html
Custom Skin Tutorial:
http://coddec.github.io/Classic-Shell/www.classicshell.net/tutorials/
skintutorial.html

* Turn ON/repair/restore original Windows 7/8/8.1 (classic) style audio/sound 
Volume Control in Windows 10/11:
http://www.winaero.com/blog/enable-old-volume-control-in-windows-10/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\MTCUVC]
"EnableMtcUvc"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows NT\CurrentVersion\MTCUVC]
"EnableMtcUvc"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows NT\CurrentVersion\MTCUVC]
"EnableMtcUvc"=dword:0
;
------End cut & paste here------

* Turn ON/repair/restore Pin to Taskbar/Pin to Start Menu right-click shell 
context menu items/links/shortcuts for
addresses/apps/files/folders/documents/items/links/schemes/shortcuts:
http://www.sevenforums.com/tutorials/5547-taskbar-pinned-programs-enable-
disable.html
http://www.helpdeskgeek.com/windows-7/pin-to-taskbar-missing-in-windows-7/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"NoPinningToTaskbar"=-
"TaskbarNoPinnedList"=-
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"NoPinningToTaskbar"=-
"TaskbarNoPinnedList"=-
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"NoPinningToTaskbar"=-
"TaskbarNoPinnedList"=-
;
------End cut & paste here------

* Turn OFF Open, Print + Edit right-click shell context menu limited to 16 items
or less with 15 or more files/items
selected in Windows 10 (example: limit increased to 1000000000 = one billion):
http://support.microsoft.com/help/2022295/
http://learn.microsoft.com/troubleshoot/windows-client/shell-experience/context-
menus-shortened-select-over-15-files/



http://www.nextofwindows.com/how-to-open-more-than-15-files-at-once-from-
context-menu-in-windows/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer]
"MultipleInvokePromptMinimum"=dword:3b9aca00
;
------End cut & paste here------

* Turn OFF File History:
http://www.eightforums.com/threads/file-history-enable-or-disable-in-windows-
8.7706/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\FileHistory]
"Disabled"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\FileHistory]
"Disabled"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\FileHistory]
"Disabled"=dword:1
;
------End cut & paste here------

* Turn OFF User Account Control (UAC), Limited User Account (LUA) service 
(LUAfv) + Modern UAC [+ Credentials UI] prompt
dialog annoyances + restore classic UAC graphical user interface (GUI) in 
Windows Vista/newer:
http://www.eightforums.com/tutorials/5509-user-account-control-uac-change-
settings-windows-8-a.html
http://www.askvg.com/tip-disable-modern-uac-prompt-and-credential-ui-in-windows-
10/
http://www.winaero.com/microsoft-has-removed-the-classic-uac-prompt-from-
windows-10/
http://batcmd.com/windows/10/services/luafv/
http://parsons-technology.com/what-is-luafv/
http://learn.microsoft.com/windows-hardware/customize/desktop/unattend/
microsoft-windows-lua-settings/
1st Things 1st:
***************
BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> See "BACKUP/EXPORT + 
RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
WARNING:
********
If LUAfv service [provided by the %WinDir%\SYSTEM32\DRIVERS\luafv.sys driver] is
disabled [see "Start"=dword:4 in .reg file



below] certain Windows components/features/functions will not work, and Windows 
Server users may experience errors in
multiuser/networked/shared/enterprise/server environments:
http://developpaper.com/windows-ad-error-message-resolution-uac-file-
virtualization-service-failed-to-start-this-driver-is-blocked-from-loading/
http://www.wincert.net/windows-server/event-id-7000-uac-file-virtualization-
error/
http://www.microsoftpressstore.com/articles/article.aspx?p=2228450&seqNum=9
http://www.programmersought.com/article/27216104324/
http://www.askvg.com/tip-disable-modern-uac-prompt-and-credential-ui-in-windows-
10/
Examples:
- Internet Explorer (IE) [discontinued!] sandbox mode = DISABLED;
- Live/Metro/Screen/Start/Tile (Store) UWP (Universal Windows Platform) apps = 
DISABLED;
- certain Windows Server components + functions [unnecessary + wasteful of 
computing resources for Windows 7/newer
Basic/Core/Desktop/Education/Home/Premium/Pro(fessional)/Starter/Ultimate 
editions] = DISABLED.
CAUTION:
********
This requires adequate/advanced knowledge about critical computing, operating 
systems, shared environments, networks,
cybersecurity.
http://www.mdgx.com/importnt.php
Recommended for single user environments without any 
add-ons/components/extensions/extras/features/services which may
require specific configurations/items/properties/settings for proper operation.
Not recommended for multiuser/networked/shared/enterprise/server environments 
processing/storing/delivering
encrypted/protected/secure critical/private/sensitive/vital 
analysis/data/information.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; MUST restart/reboot Windows after turning UAC ON or OFF !
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System]
"EnableLUA"=dword:0
; Restore classic UAC graphical user interface (GUI) from Windows Vista/7:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Authentication\
LogonUI\TestHooks]
"XamlCredUIAvailable"=dword:0
; Disable User Account Control file virtualization (LUAfv) Service:
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\luafv\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\luafv]
"LaunchProtected"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\luafv\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\luafv]
"LaunchProtected"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\luafv\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\luafv]
"LaunchProtected"=dword:0
"Start"=dword:4
;
------End cut & paste here------



TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
:: MUST restart/reboot Windows after turning UAC ON or OFF !
:: Disable User Account Control file virtualization (LUAfv) Service:
ECHO Y|NET.EXE STOP luafv
SC.EXE CONFIG luafv START= disabled
:: Disable UAC:
REG.EXE ADD "HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System" /v 
EnableLUA /t REG_DWORD /d 0 /f
:END
EXIT
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.
FIX:
****
Fix UAC prompt greyed out or missing Yes button in Windows 10:
http://www.tenforums.com/tutorials/108280-fix-uac-prompt-has-grayed-out-missing-
yes-button-windows-10-a.html

* Turn OFF Microsoft text input application memory resident process executable 
(.exe) used by portable device, touch,
software + virtual keyboards, and which load after every Windows 
(re)boot/(re)start/login, and consume hardware (processing:
CPU, GPU) + software (operating system: memory, timers) resources:
http://computerverge.com/microsoft-text-input-application-how-to-disable-or-fix-
high-cpu-consumption/
http://itectec.com/superuser/windows-10-how-to-prevent-microsoft-text-input-
application-from-starting/
http://www.reddit.com/r/Windows10/comments/abx8ct/
This executable might bear a different name and/or be located in a different 
directory/folder depending on your installed
Windows 10/11 build/edition/release/update/version (examples):
InputApp.exe
TextInputHost.exe
WindowsInternal.ComposableShell.Experiences.TextInput.InputApp.exe
These executables (.exe) can be located in 1 of these directories/folders 
[%WinDir% = usually C:\WINDOWS] (examples):
%WinDir%\SystemApps\InputApp_cw5n1h2txyewy
%WinDir%\SystemApps\MicrosoftWindows.Client.CBS_cw5n1h2txyewy
Do this from a DOS console (command prompt) -> right-click CMD shortcut/CMD.EXE 
-> Run as Administrator -> run commands
below -> press Enter after each line:
TASKKILL.EXE /IM InputApp.exe /F /T
TASKKILL.EXE /IM TextInputHost.exe /F /T
TASKKILL.EXE /IM 
"WindowsInternal.ComposableShell.Experiences.TextInput.InputApp.exe" /F /T
TAKEOWN.EXE /f "%WinDir%\SystemApps\InputApp_cw5n1h2txyewy" /r /d y
ICACLS.EXE "%WinDir%\SystemApps\InputApp_cw5n1h2txyewy" /grant:r %UserName%:F /t
/c /q
REN "%WinDir%\SystemApps\InputApp_cw5n1h2txyewy" "InputApp_cw5n1h2txyewy_OLD"
TAKEOWN.EXE /f "%WinDir%\SystemApps\
MicrosoftWindows.Client.CBS_cw5n1h2txyewy" /r /d y
ICACLS.EXE "%WinDir%\SystemApps\MicrosoftWindows.Client.CBS_cw5n1h2txyewy" 
/grant:r %UserName%:F /t /c /q
REN "%WinDir%\SystemApps\MicrosoftWindows.Client.CBS_cw5n1h2txyewy" 



"MicrosoftWindows.Client.CBS_cw5n1h2txyewy_OLD"
ICACLS.EXE:
http://www.ss64.com/nt/icacls.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
icacls/
http://adamtheautomator.com/icacls/
TAKEOWN.EXE:
http://www.ss64.com/nt/takeown.html
http://learn.microsoft.com/windows-server/administration/windows-commands/
takeown/
Alternative method: use the registry to redirect these executables (.exe) to 
execute/run/start another app/program
executable instead, for example 1 that is an intrinsic part of Windows 
[systray.exe]:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\InputApp.exe]
"Debugger"="systray.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\TextInputHost.exe]
"Debugger"="systray.exe"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\
WindowsInternal.ComposableShell.Experiences.TextInput.InputApp.exe]
"Debugger"="systray.exe"
;
------End cut & paste here------
BEWARE:
*******
Repair DCOM (Distributed Component Object Model) errors in DCOMcnfg.exe + 
comexp.msc:
http://www.makeuseof.com/tag/fix-distributedcom-error-10016-windows/
http://social.technet.microsoft.com/wiki/contents/articles/50926.windows-
component-services-troubleshooting-unable-to-edit-dcom-security-permissions.aspx
DCOMcnfg.exe + comexp.msc:
http://learn.microsoft.com/cpp/atl/dcomcnfg/
http://learn.microsoft.com/windows/win32/com/enabling-com-security-using-
dcomcnfg/
http://learn.microsoft.com/windows/win32/com/setting-processwide-security-using-
dcomcnfg/
http://webconnection.west-wind.com/docs/_4kg0z4g3p.htm
DCOM:
http://en.wikipedia.org/wiki/Distributed_Component_Object_Model

* Add frequently used/must-have/favorite/useful apps/programs/tools, Control 
Panel (CP), Windows Settings (WS) a.k.a.
Immersive Control Panel (ICP) a.k.a. native Control Panel items/links/shortcuts 
to Desktop right-click menu (examples): ->
see "Control Panel (CP) + Omnipotent/Master/Mega/'god mode' (OMg) Control Panel"
chapter ->
"* Control Panel (CP) CLSID (GUID) keys, commands, shortcuts + folders in 
Windows 7/newer (examples):" topic -> WINDOWS7.TXT
(included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT



See also Windows 10/11 Settings Uniform Resource Identifier (URI) commands 
listed in WIN10SET.HTM (included):
http://www.mdgx.com/WIN10SET.HTM
List of my all-time favorite + must-have tools [free(ware)]:
I use all these free(ware) programs + tools on all my computers + laptops 
(almost) every day for (too) many years: ;-/
- Thorium AVX2 (Chromium fork) 64-bit web browser:
http://www.mdgx.com/nettoys.htm#CHR
- Supermium (Chromium fork) 64-bit web browser:
http://www.mdgx.com/nettoys.htm#CHR
- X-Chromium (X-Launcher) Portable launcher:
http://www.winpenpack.com/en/download.php?view.1082
- Chromium/Chrome/X-Chromium/Thorium/Supermium Privacy, Safety + Security 
Extensions + (Java)Scripts:
http://www.mdgx.com/nettoys.htm#PRV
- Mercury AVX (Firefox fork) 64-bit web browser:
http://www.mdgx.com/nettoys.htm#MOZ
- Firefox Privacy, Safety + Security Add-ons + (Java)Scripts:
http://www.mdgx.com/nettoys.htm#PSF
- MDGx custom HOSTS file [frequently updated]:
http://www.mdgx.com/hosts.php
- 7-Zip 64-bit:
http://www.7-zip.org/
- Universal Extractor 2 (UniExtract2) 64-bit:
http://bioruebe.com/dev/uniextract/
- AutoRuns 64-bit:
http://learn.microsoft.com/sysinternals/downloads/autoruns/
- ServiWin 64-bit:
http://www.nirsoft.net/utils/serviwin.html
- NTFS Permissions Tools (NPT):
http://www.majorgeeks.com/files/details/ntfs_permissions_tools.html
- Default Programs Editor (DPE):
http://www.defaultprogramseditor.com/
- Classic Task Manager (TM) 64-bit:
http://www.winaero.com/how-to-restore-the-good-old-task-manager-in-windows-8/
- Open-Shell 64-bit:
http://open-shell.github.io/Open-Shell-Menu/
- 7+ Taskbar Tweaker (7TT) 64-bit:
http://ramensoftware.com/7-taskbar-tweaker/
- Winaero Tweaker 64-bit:
http://www.winaero.com/winaero-tweaker/
- Win10 All Settings (WAS):
http://www.wintools.info/index.php/win10-all-settings/
- Windows Update Blocker (WUB) 64-bit:
http://www.sordum.org/9470/
- Programmer's File Editor 32-bit (PFE32):
http://www.lancs.ac.uk/people/steveb/cpaap/pfe/
- IObit Unlocker:
http://www.iobit.com/iobit-unlocker.php
- grepWin 64-bit:
http://tools.stefankueng.com/grepWin.html
- T-Clock Redux 64-bit:
http://github.com/White-Tiger/T-Clock/
- TransparentMenu (TM):
http://www.moo0.com/software/TransparentMenu/
- TrayIcon:
http://www.mdgx.com/files/TI25.ZIP
- ClickOff:
http://johanneshuebner.com/quickcms/index.html%3Fde_downloads,2.html
- Wallpaper SlideShow LT:
http://www.gphotoshow.com/wallpaperss.htm
- MDGx File Manager (FM) 32-bit:
http://www.mdgx.com/xptoy.htm#FMNT
- Microsoft File Manager (FM) 64-bit:



http://www.mdgx.com/xptoy.htm#FMMS
- FreeCommander (FC) XE 32-bit:
http://www.freecommander.com/
- NexusFile:
http://www.xiles.app/
- NetMeter:
http://www.metal-machine.de/readerror/
- CurrPorts 64-bit:
http://www.nirsoft.net/utils/cports.html
- Network Activity Indicator (NAI) 64-bit:
http://www.itsamples.com/network-activity-indicator.html
- JPEGView 64-bit:
http://sourceforge.net/projects/jpegview/
- IrfanView 64-bit:
http://www.irfanview.com/
- Darktable 64-bit:
http://www.darktable.org/
- GIMP Portable 64-bit:
http://www.portableapps.com/apps/graphics_pictures/gimp_portable/
- XnView MP Portable 64-bit:
http://www.xnview.com/en/xnviewmp/#downloads
- IcoFX Portable:
http://www.portableapps.com/apps/graphics_pictures/icofx_portable/
- K-Lite Codec Pack (KLCP) Mega + Media Player Classic Home Cinema (MPC-HC) Lite
64-bit:
http://www.codecguide.com/download_k-lite_codec_pack_mega.htm
- MKVToolNix 64-bit:
http://www.mkvtoolnix.download/
- gMKVExtractGUI:
http://forum.doom9.org/showthread.php?t=170249
- HandBrake Portable 64-bit:
http://handbrake.fr/downloads.php
- Pazera Free Audio + Video Conversion Pack Portable 64-bit:
http://www.pazera-software.com/products/free-audio-video-pack/
- MKV Cutter:
http://www.videohelp.com/software/MKV-Cutter
- FFmpeg 64-bit:
http://www.ffmpeg.org/download.html#build-windows
- foobar2000 64-bit:
http://www.foobar2000.org/
- ReNamer 5.60:
http://files.fyxm.net/121/121773/renamer.zip
- Desktop Background Tuner (DBT) [from "Windows 8" folder]:
http://www.winaero.com/desktop-background-tuner/
- Swiss File Knife (SFK):
http://www.stahlworks.com/dev/swiss-file-knife.html
- NirCmd 64-bit:
http://www.nirsoft.net/utils/nircmd.html
- AdvancedRun 64-bit:
http://www.nirsoft.net/utils/advanced_run.html
- Calibre Portable 64-bit:
http://www.calibre-ebook.com/download_portable/
- Libre Office Portable:
http://www.portableapps.com/apps/office/libreoffice_portable/
- JDownloader2 (JD2):
http://www.jdownloader.org/
- Tixati Portable 64-bit:
http://www.tixati.com/download/portable.html
- FileZilla 64-bit:
http://www.filezilla-project.org/
Here is my Windows 10 Desktop right-click menu [JPEG screen capture]:
http://www.mdgx.com/Desktop_right-click_extended_Win10_3840x2160.jpg
More like these [all text (.txt) files included]:
- MDGx "List of Useful Windows NTx Tools" in TOOLS.TXT:



http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT
- MDGx "1000+ Windows NTx Power Toys + Tweaking Tools" in SOFTWARE.TXT:
http://www.mdgx.com/toy.htm
- MDGx "Windows NTx Internet Power Toys" in SOFTWARE.TXT:
http://www.mdgx.com/nettoys.htm
- MDGx "Free(ware) Windows NTx Extras" in SOFTWARE.TXT:
http://www.mdgx.com/xptoy.htm
- MDGx "List of Digital Photography, Imaging + Video Tools for Windows NTx" in 
PHOTO.TXT:
http://www.mdgx.com/photo.php
http://www.mdgx.com/PHOTO.TXT
LIMITATION:
Desktop/Explorer/icon/item/link/shortcut right-click shell context submenus 
(subfolders) allow a maximum of 16 items each in
all Windows NTx builds/editions/releases/versions -> example: see "||���� 
Windows Settings (WS) = NATIVE ����>" item from
JPEG above.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_CLASSES_ROOT\DesktopBackground\shell\addprogs]
@="Add/Uninstall Programs + Features = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="appwiz.cpl,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\addprogs\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL appwiz.cpl,,0"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\assocfext]
@="Associate File Extension With... (Default Program)"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,60"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\assocfext\command]
@="CONTROL.EXE /name Microsoft.DefaultPrograms /page pageFileAssoc"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\audio]
@="Audio Volume Mixer = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="SNDVOL.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\audio\command]
@="SNDVOL.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\blutooth_CLS]
@="Bluetooth Settings = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="bthprops.cpl,2"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\blutooth_CLS\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL bthprops.cpl,,1"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\clrtype]
@="ClearType Text Tuner = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="CTTUNE.EXE,0"



"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\clrtype\command]
@="CTTUNE.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\colors_transp]
@="Colors, Appearance + Transparency = Aero = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,18"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\colors_transp\command]
@="EXPLORER.EXE SHELL:::{26EE0668-A00A-44D7-9371-BEB064C98683}\\1\\::{ED834ED6-
4B5A-4bfe-8F11-A626DCB6A921}\\pageColorization"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\ctrlpanel_CLS]
@="Control Panel (CP) = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="CONTROL.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\ctrlpanel_CLS\command]
@="EXPLORER.EXE SHELL:::{21EC2020-3AEA-1069-A2DD-08002B30309D}"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\ctrlpanel_WS]
@="Windows Settings = a.k.a. Control Panel (CP) (Native)"
"SuppressionPolicy"=dword:0
"Icon"="CONTROL.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\ctrlpanel_WS\command]
@="EXPLORER.EXE ms-settings:"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\desktopicons]
@="Desktop Icons Settings = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="DESK.CPL,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\desktopicons\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL DESK.CPL,,0"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\DevMgr]
@="Device Manager (DevMgmt.msc)"
"SuppressionPolicy"=dword:0
"Icon"="hdwwiz.cpl,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\DevMgr\command]
@="MMC.EXE /S DEVMGMT.MSC"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\dev_+_prn]
@="Devices + Printers"
"SuppressionPolicy"=dword:0
"Icon"="CONTROL.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\dev_+_prn\command]
@="CONTROL.EXE Printers"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\diskman]
@="Disk Manager (DiskMgmt.msc)"
"SuppressionPolicy"=dword:0
"Icon"="MMC.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\diskman\command]
@="MMC.EXE /S DISKMGMT.MSC"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\DOS_CMD]
@="DOS Console (CMD) = Administrator"
"SuppressionPolicy"=dword:0



"Icon"="CMD.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\DOS_CMD\command]
@="CMD.EXE /K CD /D COLOR 07 && TITLE \"Administrator DOS Console\""
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\easyaccess]
@="Ease of Access Center (Native)"
"SuppressionPolicy"=dword:0
"Icon"="UTILMAN.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\easyaccess\command]
@="UTILMAN.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\firewall_adv]
@="Firewall + Advanced Security (WF.msc)"
"SuppressionPolicy"=dword:0
"Icon"="FirewallControlPanel.dll,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\firewall_adv\command]
@="MMC.EXE /S WF.MSC"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\foldopt]
@="Files, Folders + Explorer Options = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="fde.dll,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\foldopt\command]
@="RUNDLL32.EXE SHELL32.DLL,Options_RunDLL 7"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\MasterMode]
@="Omnipotent/Master/Mega/�god mode� (OMg) Control Panel"
"SuppressionPolicy"=dword:0
"Icon"="WSCUI.CPL,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\MasterMode\command]
@="EXPLORER.EXE SHELL:::{ED7BA470-8E54-465E-825C-99712043E01C}"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\msconfig]
@="System Configuration (MSConfig)"
"SuppressionPolicy"=dword:0
"Icon"="MSCONFIG.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\msconfig\command]
@="MSCONFIG.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\netcenter]
@="Network + Internet Center = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="ncpa.cpl,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\netcenter\command]
@="CONTROL.EXE /name Microsoft.NetworkAndSharingCenter"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\optcomp]
@="Optional Features + Components = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="OptionalFeatures.exe,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\optcomp\command]
@="OptionalFeatures.exe"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Powershell]
@="PowerShell Console (CMD) = Administrator"
"Icon"="powershell.exe,0"



"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Powershell\command]
@="powershell.exe -noExit -ExecutionPolicy Unrestricted -ImportSystemModules -
command Set-Location -literalPath '%V'"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\regedit]
@="Registry Editor (RegEdit)"
"SuppressionPolicy"=dword:0
"Icon"="C:\\WINDOWS\\SYSTEM32\\REGEDIT.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\regedit\command]
@="C:\\WINDOWS\\REGEDIT.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\services]
@="Services (Services.msc)"
"SuppressionPolicy"=dword:0
"Icon"="MMC.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\services\command]
@="MMC.EXE /S SERVICES.MSC"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sounds]
@="Sounds = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="mmsys.cpl,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sounds\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL mmsys.cpl,,0"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sysinfo]
@="System Info (MSInfo)"
"SuppressionPolicy"=dword:0
"Icon"="MSINFO32.EXE,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sysinfo\command]
@="MSINFO32.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sysprop]
@="System Properties + OS Info = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="sysdm.cpl,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sysprop\command]
@="EXPLORER.EXE SHELL:::{BB06C0E4-D293-4f75-8A90-CB05B6477EEE}"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\syspropadv]
@="System Properties Advanced = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,81"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\syspropadv\command]
@="SystemPropertiesAdvanced.exe"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\taskbarstart]
@="Taskbar + Start Button/Icon/Logo/Menu/Orb Properties (Native)"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,75"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\taskbarstart\command]
@="RUNDLL32.EXE SHELL32.DLL,Options_RunDLL 1"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\taskschd]
@="Task Scheduler (TaskSchd.msc)"
"SuppressionPolicy"=dword:0



"Icon"="SETUPAPI.DLL,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\taskschd\command]
@="MMC.EXE /S taskschd.msc"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\themes_CLS]
"MUIVerb"="Themes = CLASSIC"
"SuppressionPolicy"=dword:0
"ControlPanelName"="Microsoft.Personalization"
"Icon"="themecpl.dll,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\themes_CLS\command]
@="EXPLORER.EXE SHELL:::{ED834ED6-4B5A-4bfe-8F11-A626DCB6A921}"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\wallpaper_CLS]
@="Wallpaper = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,-110"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\wallpaper_CLS\command]
@="EXPLORER.EXE SHELL:::{ED834ED6-4B5A-4bfe-8F11-A626DCB6A921} -
Microsoft.Personalization\\pageWallpaper"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\defprog]
@="Default Programs (Associate with...) = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,19"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\defprog\command]
@="CONTROL.EXE /name Microsoft.DefaultPrograms"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\power]
@="Power = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="powercfg.cpl,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\power\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL powercfg.cpl"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\inetprop]
@="Internet Explorer (IE) Properties = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="inetcpl.cpl,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\inetprop\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL inetcpl.cpl,,0"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\instupdt]
@="Installed Updates = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="wuapi.dll,1"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\instupdt\command]
@="EXPLORER.EXE SHELL:::{d450a8a1-9568-45c7-9c0e-b4f9fb4537bd}"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\mouse]
@="Mouse Pointers = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="main.cpl,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\mouse\command]
@="CONTROL.EXE MAIN.CPL,,1"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\network]
@="Network Connections = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="ncpa.cpl,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\network\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL ncpa.cpl,,0"



"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\taskman]
@="Task Manager (TaskMgr)"
"SuppressionPolicy"=dword:0
"Icon"="TASKMGR.EXE,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\taskman\command]
@="TASKMGR.EXE"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\useraccounts]
@="User Accounts = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="netplwiz.exe,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\useraccounts\command]
@="netplwiz.exe"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\plugunplug]
@="Plug/Unplug Removable Devices/Storage Media = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="HotPlug.dll,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\plugunplug\command]
@="RUNDLL32.EXE SHELL32.DLL,Control_RunDLL HotPlug.dll"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\dpiscale]
@="Display + HD Color (Native)"
"SuppressionPolicy"=dword:0
"Icon"="DpiScaling.exe,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\dpiscale\command]
@="DpiScaling.exe"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\useraccountctrl]
@="User Account Control (UAC) = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="UserAccountControlSettings.exe,0"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\useraccountctrl\command]
@="UserAccountControlSettings.exe"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\notif_ico_CLS]
@="Notification Area Icons = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="taskbarcpl.dll,-1"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\notif_ico_CLS\command]
@="EXPLORER.EXE SHELL:::{05d7b0f4-2121-4eff-bf6b-ed3f69b894d9}"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sys_ico_CLS]
@="System Icons = CLASSIC"
"SuppressionPolicy"=dword:0
"Icon"="taskbarcpl.dll,-1"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\sys_ico_CLS\command]
@="EXPLORER.EXE SHELL:::{05d7b0f4-2121-4eff-bf6b-ed3f69b894d9} \\SystemIcons,,0"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\KILL_UNResp]
@="KILL UNresponsive Task(s) !"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,-98"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\KILL_UNResp\command]
@="CMD.EXE /C TASKKILL.EXE /F /FI \"status eq NOT RESPONDING\" && COLOR B3 && 
EXIT"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Win_Modes]
@=""
"MUIVerb"="Windows Mode: DARK �Side� || LIGHT �Force� �������>"



"SuppressionPolicy"=dword:0
"Icon"="themecpl.dll,-1"
"SubCommands"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Win_Modes\shell\DARK_Side]
@=""
"MUIVerb"="DARK �Side� Mode"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,-5412"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Win_Modes\shell\DARK_Side\command]
@="REG.EXE ADD HKCU\\SOFTWARE\\Microsoft\\Windows\\CurrentVersion\\Themes\\
Personalize /v SystemUsesLightTheme /t REG_DWORD /d 0 /f && REG.EXE ADD HKCU\\
SOFTWARE\\Microsoft\\Windows\\CurrentVersion\\Themes\\Personalize /v 
AppsUseLightTheme /t REG_DWORD /d 0 /f && EXIT"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Win_Modes\shell\LITE_Force]
@=""
"MUIVerb"="LIGHT �Force� Mode"
"SuppressionPolicy"=dword:0
"Icon"="imageres.dll,-5411"
[HKEY_CLASSES_ROOT\DesktopBackground\shell\Win_Modes\shell\LITE_Force\command]
@="REG.EXE ADD HKCU\\SOFTWARE\\Microsoft\\Windows\\CurrentVersion\\Themes\\
Personalize /v SystemUsesLightTheme /t REG_DWORD /d 1 /f && REG.EXE ADD HKCU\\
SOFTWARE\\Microsoft\\Windows\\CurrentVersion\\Themes\\Personalize /v 
AppsUseLightTheme /t REG_DWORD /d 1 /f && EXIT"
"IsolatedCommand"=-
[HKEY_CLASSES_ROOT\DesktopBackground\shell\REBOOT_Adv_Opt]
@="ReBOOT/ReSTART with Advanced BOOT Options"
"SuppressionPolicy"=dword:0
"Icon"="diagperf.dll,0"
"NoWorkingDirectory"=""
[HKEY_CLASSES_ROOT\DesktopBackground\shell\REBOOT_Adv_Opt\command]
@="SHUTDOWN.EXE /R /O /F /T 1"
"IsolatedCommand"=-
;
------End cut & paste here------

* Switch between Windows 10/11 Dark/Night ["The Dark Side" ;-/] + Light/Day 
["The Light Force" ;-/] GUI (Graphical User
Interface) Modes everywhere on your Desktop, in Explorer, Start/Tiles, Windows 
Settings (WS), compatible/compliant/supported
apps, programs, tools, utilities, games, web browsers + web pages/sites, etc:
http://www.windowscentral.com/how-switch-between-light-and-dark-colors-schedule-
automatically-windows-10/
http://www.askvg.com/windows-10-tip-enjoy-dark-theme-in-all-websites-and-
software-programs/
http://www.laptopmag.com/articles/windows-10-dark-theme/
http://www.laptopmag.com/articles/enable-light-mode-windows-10/
http://www.digitalcitizen.life/how-enable-disable-dark-mode-windows-10/
http://www.pcmag.com/how-to/how-to-enable-dark-mode-in-windows-10/
http://www.ionos.com/digitalguide/server/configuration/windows-10-dark-mode/
http://www.guidingtech.com/disable-dark-mode-windows-10-macos-android-ios/
http://silicophilic.com/dark-mode-guide-for-windows-10/
http://windowsreport.com/dark-mode-chrome-turn-off/
Start button/icon/logo/menu/orb -> Settings -> Personalization [Background, Lock
Screen, Colors] -> left hand Colors menu,
or type
EXPLORER.EXE ms-settings:personalization-colors
-> Choose your color drop down menu -> Dark (example).
Chromium/Chrome + Chromium alternative/derivative/fork/variant web browsers 
extensions (free):
http://chromewebstore.google.com/collection/dark_themes
http://chromewebstore.google.com/search/dark+mode?_category=extensions
http://chromewebstore.google.com/search/dark%20theme%20chrome
Firefox + Firefox alternative/derivative/fork/variant web browsers add-ons 



(free):
http://addons.mozilla.org/firefox/search/?q=dark+mode
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
;@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@
;@@                           Dark "Side" Mode                              @@
;@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Themes\
Personalize]
"SystemUsesLightTheme"=dword:0
"AppsUseLightTheme"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Themes\Personalize]
"SystemUsesLightTheme"=dword:0
"AppsUseLightTheme"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize]
"SystemUsesLightTheme"=dword:0
"AppsUseLightTheme"=dword:0
;
------End cut & paste here------
Save registration (.reg) file above as DARK_MODE_10.REG (example) -> Explorer ->
right-click on it -> Run as Administrator
-> Yes -> OK.
-----Begin cut & paste here-----
REGEDIT4
;@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@
;@@                          Light "Force" Mode                             @@
;@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@@
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Themes\
Personalize]
"SystemUsesLightTheme"=dword:1
"AppsUseLightTheme"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Themes\Personalize]
"SystemUsesLightTheme"=dword:1
"AppsUseLightTheme"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize]
"SystemUsesLightTheme"=dword:1
"AppsUseLightTheme"=dword:1
;
------End cut & paste here------
Save registration (.reg) file above as LIGHT_MODE_10.REG (example) -> Explorer -
> right-click on it -> Run as Administrator
-> Yes -> OK.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
Turn ON The Dark "Side" Mode batch file:
"If you only knew the power of the Dark Side." ;-/
http://www.youtube.com/watch?v=esEcwAWi6dk
-----Begin cut & paste here-----



@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
:: Turn ON The Dark "Side" Mode:
REG.EXE ADD "HKCU\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v SystemUsesLightTheme /t REG_DWORD /d 0 /f
REG.EXE ADD "HKCU\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v AppsUseLightTheme /t REG_DWORD /d 0 /f
REG.EXE ADD "HKU\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v SystemUsesLightTheme /t REG_DWORD /d 0 /f
REG.EXE ADD "HKU\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v AppsUseLightTheme /t REG_DWORD /d 0 /f
:END
EXIT
------End cut & paste here------
Turn ON The Light "Force" Mode batch file:
"The Force will be with you. Always." ;-/
http://www.youtube.com/watch?v=ycCAHYvAUl4
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
:: Turn ON The Light "Force" Mode:
REG.EXE ADD "HKCU\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v SystemUsesLightTheme /t REG_DWORD /d 1 /f
REG.EXE ADD "HKCU\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v AppsUseLightTheme /t REG_DWORD /d 1 /f
REG.EXE ADD "HKU\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v SystemUsesLightTheme /t REG_DWORD /d 1 /f
REG.EXE ADD "HKU\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Themes\
Personalize" /v AppsUseLightTheme /t REG_DWORD /d 1 /f
:END
EXIT
------End cut & paste here------

* FIX: Turn OFF annoying/nagging "Let's make Windows even better..." full screen
pop-up in Windows 10/11 with certain
Microsoft Updates [example: April 2022 Cumulative Update: KB5012653, KB5012596, 
KB5012647, KB5012591 + KB5012599] installed:
http://www.windowslatest.com/2022/04/25/windows-10s-full-screen-setup-nag-
screen-returns-heres-how-to-disable-it/
http://www.tenforums.com/tutorials/76252-turn-off-windows-welcome-experience-
windows-10-a.html
http://www.majorgeeks.com/content/page/
turn_windows_welcome_experience_page_on_or_off_in_windows_10.html
Start -> Windows Settings (WS) or -> Run... [hold WinKey + press R] -> type
ms-settings
-> press Enter -> System -> Notifications & Actions -> "Show me the Windows 
welcome experience after updates..." -> turn
OFF.
http://www.tenforums.com/attachments/tutorials/284489d1592760462-turn-off-
windows-welcome-experience-windows-10-a-windows_welcome_experience_settings.jpg
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager]
"SubscribedContent-310093Enabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\



ContentDeliveryManager]
"SubscribedContent-310093Enabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\
ContentDeliveryManager]
"SubscribedContent-310093Enabled"=dword:0
;
------End cut & paste here------

* FIX: Repair Start Menu, Pin to Taskbar any file 
type/shortcut/document/link/website/icon/item/object/folder from
right-click shell context menu, and Date + Time popups NOT working properly:
http://superuser.com/questions/1452901/
http://techcult.com/fix-pin-to-taskbar-missing-in-windows-10/
http://learn.microsoft.com/answers/questions/87376/powershell-command-to-pin-
apps-to-windows-taskbar.html
http://stackoverflow.com/questions/31720595/
http://windowsreport.com/taskbar-not-working-windows-10/
http://thegeekpage.com/fix-right-click-not-working-on-start-menu-taskbar-in-
windows-10/
http://www.winaero.com/enable-secret-hidden-continuum-ui-new-start-screen-in-
windows-10-tp3/
http://www.winaero.com/pin-file-taskbar-windows-10/
http://www.digitalcitizen.life/how-pin-special-windows-shortcuts-taskbar/
http://www.tenforums.com/tutorials/96525-pin-file-taskbar-windows-10-a.html
http://www.tenforums.com/tutorials/3449-pin-taskbar-unpin-taskbar-apps-windows-
10-a.html
http://thewindowscentral.com/windows-10-start-menu-not-working/
http://www.thewindowsclub.com/cant-pin-apps-to-taskbar-in-windows-10/
http://windowsreport.com/cant-pin-tiles-start-windows-10/
http://www.digitaltrends.com/computing/how-to-pin-a-website-to-the-taskbar/
Pin to... tool for Windows NTx 64-bit (x64) editions:
Pin to Taskbar Command Prompt Utility [syspin.exe] DOS console command line tool
64-bit for Windows 7/newer 64-bit:
http://www.technosys.net/products/utils/pintotaskbar
File:
http://www.technosys.net/download.aspx?file=syspin.exe
syspin.exe command line options, switches + parameters:
http://www.technosys.net/images/products/syspin1.jpg
----------snippity-snip----------
Usage:
syspin.exe ["letter:\filepath\filename.extension"] #####
or
syspin.exe ["letter:\filepath\filename.extension"] "command string"
#####s (numbers) and corresponding command strings:
5386 : Pin to Taskbar:
"%UserProfile%\AppData\Roaming\Microsoft\Internet Explorer\Quick Launch\User 
Pinned\TaskBar"
5387 : Unpin from Taskbar
51201 : Pin to Start:
"%UserProfile%\AppData\Roaming\Microsoft\Windows\Start Menu\Programs"
51394 : Unpin from Start
Samples:
syspin.exe "%ProgramFiles%\Internet Explorer\iexplore.exe" 5386
syspin.exe "C:\WINDOWS\notepad.exe" "Pin to Taskbar"
syspin.exe "%WinDir%\SYSTEM32\notepad.exe" "Pin to Start"
syspin.exe "%WinDir%\SYSTEM32\notepad.exe" "Unpin from Taskbar"
syspin.exe "C:\WINDOWS\SYSTEM32\notepad.exe" 51201
NOTE:
You canNOT pin any live/metro/screen/start/tile UWP (Universal Windows Platform)
app/gadget/widget or batch/script
file/item. :-(
----------snippity-snip----------
Add "Pin File/Item to Taskbar = SysPin [syspin.exe] 64-bit" item to the right-
click shell context menu for all file types



[*] (I have used C:\TOOLS_10 directory/folder as syspin.exe file location in 
this example):
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\*\shell\Pin_syspin64]
@="Pin File/Item to Taskbar = SysPin [syspin.exe] 64-bit"
"SuppressionPolicy"=dword:0
"Icon"="\"C:\\TOOLS_10\\syspin.exe\",0"
"NoWorkingDirectory"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\*\shell\Pin_syspin64\command]
@="\"C:\\TOOLS_10\\syspin.exe\" \"%1\" 5386"
"IsolatedCommand"=-
;
------End cut & paste here------
Pin to... tool for Windows NTx 32-bit (x86) editions:
PinOnTen [pinonten.exe] Pin to Taskbar DOS console command line tool 32-bit for 
Windows 10/11:
http://apps.codigobit.info/2016/07/pinonten-pin-or-unpin-to-taskbar-on.html
Download:
http://www.softpedia.com/get/System/OS-Enhancements/PinOnTen.shtml
NOTE:
You canNOT pin any live/metro/screen/start/tile UWP (Universal Windows Platform)
app/gadget/widget or batch/script
file/item. :-(
Date + Time Popup Does Not Work: Fix 3 - Restore [default] Registry Settings:
http://www.technipages.com/windows-10-date-popup-does-not-work/
File:
http://www.technipages.com/wp-content/uploads/2016/07/TimeZoneRestore.zip
Extract TimeZoneRestore.reg from ZIP archive above -> right-click 
TimeZoneRestore.reg -> Run as Administrator -> answer
Yes/OK to all prompts to register/merge/import its information into your 
registry.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\ImmersiveShell\
Launcher]
"UseExperience"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"HideClock"=-
"HideSCAVolume"=-
"HideSCANetwork"=-
"LockTaskbar"=-
"NoAutoTrayNotify"=-
"NoCloseDragDropBands"=-
"NoTaskGrouping"=-
"NoToolbarsOnTaskbar"=-
"NoTrayContextMenu"=-
"NoTrayItemsDisplay"=-



"TaskbarLockAll"=-
"TaskbarNoAddRemoveToolbar"=-
"TaskbarNoRedock"=-
"TaskbarNoResize"=-
"TaskbarNoNotification"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"HideClock"=-
"HideSCAVolume"=-
"HideSCANetwork"=-
"LockTaskbar"=-
"NoAutoTrayNotify"=-
"NoCloseDragDropBands"=-
"NoTaskGrouping"=-
"NoToolbarsOnTaskbar"=-
"NoTrayContextMenu"=-
"NoTrayItemsDisplay"=-
"TaskbarLockAll"=-
"TaskbarNoAddRemoveToolbar"=-
"TaskbarNoRedock"=-
"TaskbarNoResize"=-
"TaskbarNoNotification"=-
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Policies\
Explorer]
"HideClock"=-
"HideSCAVolume"=-
"HideSCANetwork"=-
"LockTaskbar"=-
"NoAutoTrayNotify"=-
"NoCloseDragDropBands"=-
"NoTaskGrouping"=-
"NoToolbarsOnTaskbar"=-
"NoTrayContextMenu"=-
"NoTrayItemsDisplay"=-
"TaskbarLockAll"=-
"TaskbarNoAddRemoveToolbar"=-
"TaskbarNoRedock"=-
"TaskbarNoResize"=-
"TaskbarNoNotification"=-
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"DisableNotificationCenter"=-
"EnableLegacyBalloonNotifications"=-
"NoPinningStoreToTaskbar"=-
"NoSystraySystemPromotion"=-
"NoPinningToDestinations"=-
"TaskbarNoPinnedList"=-
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"DisableNotificationCenter"=-
"EnableLegacyBalloonNotifications"=-
"NoPinningStoreToTaskbar"=-
"NoSystraySystemPromotion"=-
"NoPinningToDestinations"=-
"TaskbarNoPinnedList"=-
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"DisableNotificationCenter"=-
"EnableLegacyBalloonNotifications"=-
"NoPinningStoreToTaskbar"=-
"NoSystraySystemPromotion"=-
"NoPinningToDestinations"=-
"TaskbarNoPinnedList"=-
;
------End cut & paste here------
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:



PowerShell.exe -ExecutionPolicy Unrestricted
After PowerShell console comes up -> run this command -> press Enter:
Get-AppXPackage -AllUsers | Foreach {Add-AppXPackage -DisableDevelopmentMode -
Register "$($_.InstallLocation)\AppXManifest.xml"}
-> exit PowerShell.
Restart/reboot Windows for all changes to take effect.

* Turn ON Always show all Taskbar (Notification area) icons + 
messages/notifications for all users in Desktop mode + Tablet
mode in Windows 10/11:
http://www.tenforums.com/tutorials/5313-notification-area-icons-hide-show-
windows-10-a.html
http://www.tenforums.com/tutorials/5313-hide-show-notification-area-icons-
taskbar-windows-10-a.html
http://www.tenforums.com/general-support/15582-windows-10-tray-icons-hide-
automatically-how-do-i-disable.html
http://www.howtogeek.com/225568/how-to-configure-and-customize-the-taskbar-in-
windows-10/
http://www.online-tech-tips.com/windows-7/customize-notifications-action-center-
windows-10/
Run... [hold WinKey + press R] -> type this command:
ms-settings:taskbar
-> press Enter OR right-click on an empty Taskbar spot -> Taskbar settings -> 
Notification area -> Select which icons
appear on the Taskbar -> turn ON/OFF individual icon(s) OR -> turn ON Always 
show all icons in the notification area.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"NoAutoTrayNotify"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"NoAutoTrayNotify"=-
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Policies\
Explorer]
"NoAutoTrayNotify"=-
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer]
"EnableAutoTray"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer]
"EnableAutoTray"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer]
"EnableAutoTray"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"UseTabletModeNotificationIcons"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"UseTabletModeNotificationIcons"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"UseTabletModeNotificationIcons"=dword:0
;
------End cut & paste here------
Log off -> log back on into your same user account for these changes to take 
effect.

* Turn ON/enable system wide, per user + per process Dots Per Inch (DPI) display
scaling [DpiScaling.exe], improve ClearType
[CTTune.exe] text font clarity/readability + fix/UNblur blurry/fuzzy/unclear 



apps in Windows 10/11:
http://windowsreport.com/microsoft-apps-blurry/
http://thegeekpage.com/fix-apps-might-be-blurry-problem-in-windows-10/
http://www.tenforums.com/tutorials/100793-turn-off-fix-scaling-apps-blurry-
windows-10-a.html
http://wpvkp.com/fix-blurry-text-windows-10/
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Display::DisplayPerProcessSys
temDpiSettings
http://www.eightforums.com/threads/global-dpi-scaling-disable-for-win8-1-for-
all-files-users.42452/
http://pureinfotech.com/fix-windows-10-dpi-scaling-virtual-machine-high-
definition-displays/
http://superuser.com/questions/1244934/
http://stackoverflow.com/questions/20516428/
CTTune [CTTUNE.EXE] + DpiScaling [DPISCALING.EXE] Control Panel (CP) tools are 
both located in the %WinDir%\SYSTEM32
directory/folder [%WinDir% = usually C:\WINDOWS], listed in your system PATH.
Run ClearType Text Tuner: Run... [hold WinKey + press R] -> type this command:
CTTUNE.EXE
-> press Enter -> tweak text clarity/readability to match your visual 
preferences -> press Finish.
Access Advanced Scaling settings: Run... [hold WinKey + press R] -> type this 
command:
ms-settings:display-advanced
-> press Enter -> turn ON Fix Scaling for apps/programs/games/tools/etc that are
blurry, or if Reg Green Blue (RGB) colors
do not overlay (superimpose) properly.
Windows 10 DPI Fix:
http://windows10-dpi-fix.xpexplorer.com/
File:
http://www.xpexplorer.com/installers/2.1/Windows10_DPI_FIX.exe
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_CURRENT_USER\Control Panel\Desktop]
"EnablePerProcessSystemDPI"=dword:1
[HKEY_USERS\.DEFAULT\Control Panel\Desktop]
"EnablePerProcessSystemDPI"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Control Panel\Desktop]
"EnablePerProcessSystemDPI"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Control Panel\Desktop]
"EnablePerProcessSystemDPI"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Control Panel\Desktop]
"EnablePerProcessSystemDPI"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Display]
"EnablePerProcessSystemDPIForProcesses"=dword:1
"DisablePerProcessSystemDPIForProcesses"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Display]
"EnablePerProcessSystemDPIForProcesses"=dword:1
"DisablePerProcessSystemDPIForProcesses"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Display]
"EnablePerProcessSystemDPIForProcesses"=dword:1
"DisablePerProcessSystemDPIForProcesses"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\DWM]
"UseDpiScaling"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\DWM]



"UseDpiScaling"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\DWM]
"UseDpiScaling"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
VisualEffects]
"VisualFXSetting"=dword:3
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
VisualEffects]
"VisualFXSetting"=dword:3
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
VisualEffects\FontSmoothing]
"DefaultValue"=dword:1
"DefaultApplied"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
VisualEffects\FontSmoothing]
"DefaultValue"=dword:1
"DefaultApplied"=dword:1
[HKEY_CURRENT_USER\Control Panel\Desktop]
"FontSmoothing"="2"
; "FontSmoothingType"=dword:2
[HKEY_USERS\.DEFAULT\Control Panel\Desktop]
"FontSmoothing"="2"
; "FontSmoothingType"=dword:2
;
------End cut & paste here------
Try also:
GDIPP (Graphics Device Interface ++) 32-bit + 64-bit [unmaintained!] for Windows
Vista/newer improves
anti-aliasing/rasterizing/smoothing rendering + clarity/readability of all 
Windows desktop/display/monitor/screen/system
fonts:
http://code.google.com/archive/p/gdipp/
http://github.com/CoolOppo/GDIPP/
- GDIPP 32-bit for Windows Vista/newer 32-bit (x86) [MSI Installer]:
http://storage.googleapis.com/google-code-archive-downloads/v2/code.google.com/
gdipp/gdipp_x86_0.9.1.msi
- GDIPP 64-bit for Windows Vista/newer 64-bit (x64) [MSI Installer]:
http://storage.googleapis.com/google-code-archive-downloads/v2/code.google.com/
gdipp/gdipp_x64_0.9.1.msi
GDIPP Guide:
http://www.makeuseof.com/tag/make-windows-fonts-look-like-mac-fonts/

* Turn ON/enable + tweak Night (Blue) Light display/monitor/screen custom gamma 
(color space) correction/dimming/reduction
filter/mode in Windows 10/11 (example):
http://win10faq.com/windows-10-night-light-not-working/
http://community.windows.com/stories/the-night-light-rises/
http://www.digitalcitizen.life/simple-questions-what-night-light-windows-10-and-
how-use-it/
http://techtipvault.com/windows/enable-night-light-windows-10/
http://www.alphr.com/change-gamma-windows-10/
Wikipedia: Gamma Correction:
http://en.wikipedia.org/wiki/Gamma_correction
Start button/icon/logo/menu/orb -> Windows Settings [gear icon] -> System -> 
Display -> Color -> Night Light -> turn
ON/slide right -> Night Light settings -> Turn ON now -> Strength -> drag slider
right or left until satisfied with gamma
color space mode -> Schedule -> turn ON/slide right -> Set hours -> select 
preferred time table.
OR Run... [hold WinKey + press R] -> type this command:
EXPLORER.EXE ms-settings:nightlight
-> press Enter -> Night Light settings -> Turn ON now -> Strength -> drag slider
right or left until satisfied with gamma
color space mode -> Schedule -> turn ON/slide right -> Set hours -> select 



preferred time table.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
; Night (Blue) Light = custom preset settings (example):
REGEDIT4
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\CloudStore\Store\
Cache\DefaultAccount\$$windows.data.bluelightreduction.bluelightreductionstate\
Current]
"Data"=hex:02,00,00,00,54,83,08,4a,03,ba,d2,01,00,00,00,00,43,42,01,00,10,00,\
  d0,0a,02,c6,14,b8,8e,9d,d0,b4,c0,ae,e9,01,00
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\CloudStore\Store\
Cache\DefaultAccount\$$windows.data.bluelightreduction.bluelightreductionstate\
Current]
"Data"=hex:02,00,00,00,54,83,08,4a,03,ba,d2,01,00,00,00,00,43,42,01,00,10,00,\
  d0,0a,02,c6,14,b8,8e,9d,d0,b4,c0,ae,e9,01,00
;
------End cut & paste here------
10 Best Free(ware) Blue Light Filter tools:
http://www.winosbite.com/best-free-blue-light-filter/
Examples:
- f.lux 32-bit for Windows 10/11 adjusts/dims/brightens display/monitor 
brightness/color temperature (hue) depending on
time of day (warm: sun light) or night (cold: blue light), highly customizable:
http://justgetflux.com/
File:
http://justgetflux.com/dlwin.html
f.lux FAQ:
http://justgetflux.com/faq.html
f.lux Reviews:
http://www.ghacks.net/2009/04/06/computer-monitor-lighting-software-flux/
http://www.ghacks.net/2013/06/01/warm-light-app-f-lux-3-beta-introduces-movie-
mode/
http://www.ghacks.net/2017/04/05/f-lux-4-brings-presets-and-program-whitelist-2/
- LightBulb 32-bit for Windows 10/11 adjusts/dims/brightens display/monitor 
brightness/color temperature (hue) continuously
depending on environment light, highly customizable:
http://github.com/Tyrrrz/LightBulb/
Download:
http://github.com/Tyrrrz/LightBulb/releases/latest/
LightBulb Review:
http://www.ghacks.net/2017/04/23/lightbulb-open-source-f-lux-alternative-for-
windows/
- Gammy 32-bit for Windows 10/11 adjusts/dims/brightens display/monitor 
brightness/color temperature (hue) automatically or
manually, highly customizable:
http://github.com/Fushko/gammy/
Download:
http://github.com/Fushko/gammy/releases/latest/
Gammy Review:
http://www.ghacks.net/2020/03/16/gammy-is-an-adaptive-brightness-application-
for-windows-and-linux/

* Turn OFF/block/disable/stop/uninstall/remove + 
repair/customize/improve/upgrade Microsoft (Windows) Defender (WD)
background monitors, services, drivers, Windows Security (WS) + Security Center 
(SC) in Windows 10/11:
http://technet.microsoft.com/itpro/powershell/windows/defender/set-mppreference/



http://www.howtogeek.com/15788/how-to-uninstall-disable-and-remove-windows-
defender.-also-how-turn-it-off/
http://www.windowscentral.com/how-permanently-disable-windows-defender-windows-
10/
http://gist.github.com/pe3zx/7c5e0080c3b0869ccba1f1dc2ea0c5e0/
http://www.askvg.com/tip-disable-or-remove-windows-defender-security-center-app-
in-windows-10/
http://admx.help/HKLM/Software/Policies/Microsoft/Windows%20Defender
http://admx.help/HKLM/Software/Policies/Microsoft/Windows%20Defender/Real-Time
%20Protection
http://www.tenforums.com/tutorials/5918-how-turn-off-microsoft-defender-
antivirus-windows-10-a.html
... And then replace these basic/crippled/generic/limited built-in/pre-installed
tools with better/professional grade
independent/3rd party anti-malware/anti-virus tools [free(ware)]:
http://www.safetydetectives.com/blog/windows-defender-vs-antiviruses-is-
defender-enough-for-you/
http://www.safetydetectives.com/blog/best-really-free-antivirus-for-windows/
http://www.mdgx.com/vir.htm#AVS
Examples:
- TotalAV:
http://www.totalav.com/free-download
- BitDefender:
http://www.bitdefender.com/solutions/free.html
- MalwareBytes:
http://www.malwarebytes.com/mwb-download/
- ClamWin:
http://clamwin.com/content/view/18/46/
Turn OFF/block/disable/customize/repair Microsoft (Windows) Defender (WD) tools 
[free(ware)]:
Defender Control [dControl.exe] for Windows Vista/newer blocks/unblocks 
Microsoft (Windows) Defender (WD):
http://www.sordum.org/9480/
File:
http://www.sordum.org/files/download/d-control/dControl.zip
Screen shot:
http://www.sordum.org/wp-content/uploads/2021/01/defender_control_menu.png
Defender Exclusion Tool (DET) [ExcTool.exe] removes/adds file(s)/folder(s) 
from/to Microsoft (Windows) Defender lists of
scanned/exceptions apps/executables/programs/residents/services/tasks/tools to 
avoid critical errors/slow performance/false
positives/erratic behavior:
http://www.sordum.org/10636/
File:
http://www.sordum.org/files/download/defender-exclusion-tool/ExcTool.zip
1st Things 1st:
***************
BACKUP YOUR REGISTRY BEFORE MAKING ANY CHANGES! -> See "BACKUP/EXPORT + 
RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows Defender]
"DisableAntiSpyware"=dword:1



"DisableAntiVirus"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows Defender\MpEngine]
"MpEnablePus"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows Defender\Real-Time 
Protection]
"DisableScanOnRealtimeEnable"=dword:1
"DisableRealtimeMonitoring"=dword:1
"DisableRawWriteNotification"=dword:1
"DisableOnAccessProtection"=dword:1
"DisableIOAVProtection"=dword:1
"DisableBehaviorMonitoring"=dword:1
"LocalSettingOverrideDisableIntrusionPreventionSystem"=dword:1
"DisableIntrusionPreventionSystem"=dword:1
"DisableInformationProtectionControl"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows Defender\Reporting]
"DisableEnhancedNotifications"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows Defender\SpyNet]
"DisableBlockAtFirstSeen"=dword:1
"SpynetReporting"=dword:0
"SubmitSamplesConsent"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows Defender Security 
Center\Notifications]
"DisableEnhancedNotifications"=dword:1
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\WMI\Autologger\
DefenderApiLogger]
"Start"=dword:0
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\WMI\Autologger\
DefenderAuditLogger]
"Start"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
StartupApproved\Run]
"Windows Defender"=-
"WindowsDefender"=-
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
"Windows Defender"=-
"WindowsDefender"=-
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Run]
"Windows Defender"=-
"WindowsDefender"=-
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\wscsvc\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\wscsvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdBoot\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdBoot]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdFilter\
Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdFilter]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdNisDrv\
Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdNisDrv]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdNisSvc\
Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WdNisSvc]



"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WinDefend\
Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\WinDefend]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\
SecurityHealthService\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\CurrentControlSet\Services\
SecurityHealthService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\wscsvc\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\wscsvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdBoot\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdBoot]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdFilter\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdFilter]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdNisDrv\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdNisDrv]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdNisSvc\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WdNisSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WinDefend\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\WinDefend]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\
SecurityHealthService\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Services\
SecurityHealthService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\wscsvc\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\wscsvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdBoot\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdBoot]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdFilter\Security]



[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdFilter]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdNisDrv\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdNisDrv]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdNisSvc\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WdNisSvc]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WinDefend\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\WinDefend]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\
SecurityHealthService\Security]
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Services\
SecurityHealthService]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
;
------End cut & paste here------

* Turn OFF/disable Narrator [Narrator.exe], prevent it from starting 
before/after sign-in/log in, quick start, keyboard
shortcuts + online services in Windows 7/newer:
http://www.tenforums.com/tutorials/88188-turn-off-narrator-windows-10-a.html
http://www.tenforums.com/tutorials/113745-turn-off-start-narrator-after-sign-
windows-10-a.html
http://www.tenforums.com/tutorials/120822-turn-off-narrator-caps-lock-warnings-
while-typing-windows-10-a.html
http://www.winaero.com/disable-narrator-home-in-windows-10/
http://www.winaero.com/download-start-narrator-before-sign-in/
http://www.winaero.com/disable-narrator-keyboard-shortcut-windows-10/
http://www.winaero.com/disable-narrator-quickstart-guide-windows-10/
http://www.winaero.com/start-narrator-before-sign-windows-10/
http://www.howtoedge.com/disable-online-services-for-narrator-in-windows-10/
http://www.pcerror-fix.com/complete-steps-to-disable-and-enable-narrator-in-
windows-10/
http://www.techjunkie.com/turn-off-narrator/
Narrator [NARRATOR.EXE] is located in the %WinDir%\SYSTEM32 directory/folder 
[where %WinDir% = usually C:\WINDOWS].
- Windows 10/11 users: Run... [hold WinKey + press R] -> type this command:
ms-settings:easeofaccess-narrator
-> press Enter -> Narrator settings -> turn OFF/ON or tweak the ones you want:
http://support.microsoft.com/help/22798/
- Windows 7/8/8.1 users:
http://www.thewindowsclub.com/narrator-in-windows-8-7/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4



[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Narrator\NoRoam]
"CapsLockAlert"=dword:2
"OnlineServicesEnabled"=dword:0
"WinEnterLaunchEnabled"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Narrator\NoRoam]
"CapsLockAlert"=dword:2
"OnlineServicesEnabled"=dword:0
"WinEnterLaunchEnabled"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Narrator\NoRoam]
"CapsLockAlert"=dword:2
"WinEnterLaunchEnabled"=dword:0
"OnlineServicesEnabled"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Accessibility]
"Configuration"=""
[HKEY_CURRENT_USER\Software\Microsoft\Windows NT\CurrentVersion\Accessibility]
"Configuration"=""
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows NT\CurrentVersion\Accessibility]
"Configuration"=""
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Narrator\NarratorHome]
"AutoStart"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Narrator\NarratorHome]
"AutoStart"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Narrator\NarratorHome]
"AutoStart"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Narrator\QuickStart]
"SkipQuickStart"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Narrator\QuickStart]
"SkipQuickStart"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Narrator\QuickStart]
"SkipQuickStart"=dword:1
; * Turn OFF Narrator -> remove semicolon + space [; ] in front of next 2 lines:
; [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\Narrator.exe]
; "Debugger"="systray.exe"
; * Turn ON Narrator -> remove semicolon + space [; ] in front of next line:
; [-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Image File 
Execution Options\Narrator.exe]
;
------End cut & paste here------

* Turn OFF + uninstall Miracast Connect Receiver (Connect app) + Project to this
PC in Windows 10/11:
http://www.tenforums.com/tutorials/49088-change-when-ask-project-pc-windows-10-
a.html
http://www.tenforums.com/tutorials/49466-enable-disable-projecting-pc-windows-
10-a.html
http://www.tenforums.com/tutorials/157692-install-uninstall-connect-wireless-
display-feature-windows-10-a.html
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MiracastReceiver]
"ConsentToast"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Connect]
"AllowProjectionToPC"=dword:0
;
------End cut & paste here------



Uninstall Miracast Connect Receiver (Connect app) from a DOS console (command 
prompt) -> right-click CMD shortcut/CMD.EXE ->
Run as Administrator -> run this command -> press Enter:
DISM.EXE /Online /Remove-Capability 
/CapabilityName:App.WirelessDisplay.Connect~~~~0.0.1.0
DISM (Deployment Image Servicing and Management) [DISM.EXE] executable is 
located in the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.

* Turn OFF annoying, undesirable, unnecessary, useless, unwanted Windows 10/11 
built-in system/user/"special"
directories/folders from Desktop, Explorer, This PC + independent/3rd party 
similar tools:
http://www.techspot.com/guides/1703-remove-3d-objects-shortcut-windows-file-
explorer/
http://superuser.com/questions/1506090/
http://learn.microsoft.com/windows/win32/shell/knownfolderid/
List of system, user + special directories/folders registry values [some are 
unique to specific Windows NTx editions]:
http://en.wikipedia.org/wiki/Special_folder
Desktop         {B4BFCC3A-DB2C-424C-B029-7FE99A87C641}
This PC         {0AC0837C-BBF8-452A-850D-79D08E667CA7}
Downloads       {374DE290-123F-4565-9164-39C4925E467B}
Documents       {FDD39AD0-238F-46AF-ADB4-6C85480369C7}
Local Downloads {7d83ee9b-2244-4e70-b1f5-5393042af1e4}
3D Objects      {31C0DD25-9439-4F12-BF41-7FF4EDA38722}
My Music        {4BD8D571-6D19-48D3-BE97-422220080E43}
Local Pictures  {0ddd015d-b06c-45d5-8c4c-f59713854639}
My Pictures     {33E28130-4E1E-4676-835A-98395C3BC3BB}
Local Music     {a0c69a99-21c8-4671-8703-7934162fcf1d}
My Video        {18989B1D-99B5-455B-841C-AB7C74E4DDFC}
Personal        {FDD39AD0-238F-46AF-ADB4-6C85480369C7}
Local Documents {f42ee2d3-909f-4907-8871-4c22fc0bf756}
Local Videos    {35286a68-3c57-41a1-bbb1-0eae73d76c95}
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; 3D Objects:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
; Documents:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\



MyComputer\NameSpace\{d3162b92-9365-467a-956b-92703aca08af}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{d3162b92-9365-467a-956b-92703aca08af}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{d3162b92-9365-467a-956b-92703aca08af}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{d3162b92-9365-467a-956b-92703aca08af}]
; Downloads:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{088e3905-0323-4b02-9826-5d99428e115f}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{088e3905-0323-4b02-9826-5d99428e115f}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{088e3905-0323-4b02-9826-5d99428e115f}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{088e3905-0323-4b02-9826-5d99428e115f}]
; Libraries:
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\WOW6432Node\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
"System.IsPinnedToNameSpaceTree"=dword:0
[HKEY_CURRENT_USER\Software\Classes\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
"System.IsPinnedToNameSpaceTree"=dword:0
[HKEY_USERS\.DEFAULT\Software\Classes\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Classes\WOW6432Node\CLSID\{031E4825-7B94-4dc3-
B131-E946B44C8DD5}]
[-HKEY_CURRENT_USER\Software\Classes\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
[-HKEY_USERS\.DEFAULT\Software\Classes\CLSID\{031E4825-7B94-4dc3-B131-
E946B44C8DD5}]
; Music:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{3dfdf296-dbec-4fb4-81d1-6a3438bcf4de}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{3dfdf296-dbec-4fb4-81d1-6a3438bcf4de}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{3dfdf296-dbec-4fb4-81d1-6a3438bcf4de}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{3dfdf296-dbec-4fb4-81d1-6a3438bcf4de}]
; OneDrive:
[HKEY_CLASSES_ROOT\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):



[HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_CLASSES_ROOT\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
; Pictures:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{24ad3ad4-a569-4530-98e1-ab02f9417aa8}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{24ad3ad4-a569-4530-98e1-ab02f9417aa8}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{24ad3ad4-a569-4530-98e1-ab02f9417aa8}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{24ad3ad4-a569-4530-98e1-ab02f9417aa8}]
; Videos:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{f86fa3ab-70d2-4fc7-9c99-fcbf05467f3a}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{f86fa3ab-70d2-4fc7-9c99-fcbf05467f3a}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{f86fa3ab-70d2-4fc7-9c99-fcbf05467f3a}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{f86fa3ab-70d2-4fc7-9c99-fcbf05467f3a}]
; 0 / 1 Enumeration:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
AllowedEnumeration]
"{0AC0837C-BBF8-452A-850D-79D08E667CA7}"=dword:1
"{B4BFCC3A-DB2C-424C-B029-7FE99A87C641}"=dword:1
"{374DE290-123F-4565-9164-39C4925E467B}"=dword:1
"{FDD39AD0-238F-46AF-ADB4-6C85480369C7}"=dword:0
"{7d83ee9b-2244-4e70-b1f5-5393042af1e4}"=dword:0
"{31C0DD25-9439-4F12-BF41-7FF4EDA38722}"=dword:0
"{4BD8D571-6D19-48D3-BE97-422220080E43}"=dword:0
"{0ddd015d-b06c-45d5-8c4c-f59713854639}"=dword:0
"{33E28130-4E1E-4676-835A-98395C3BC3BB}"=dword:0
"{a0c69a99-21c8-4671-8703-7934162fcf1d}"=dword:0
"{18989B1D-99B5-455B-841C-AB7C74E4DDFC}"=dword:0
"{FDD39AD0-238F-46AF-ADB4-6C85480369C7}"=dword:0
"{f42ee2d3-909f-4907-8871-4c22fc0bf756}"=dword:0
"{35286a68-3c57-41a1-bbb1-0eae73d76c95}"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\
AllowedEnumeration]
"{0AC0837C-BBF8-452A-850D-79D08E667CA7}"=dword:1
"{B4BFCC3A-DB2C-424C-B029-7FE99A87C641}"=dword:1
"{374DE290-123F-4565-9164-39C4925E467B}"=dword:1
"{FDD39AD0-238F-46AF-ADB4-6C85480369C7}"=dword:0
"{7d83ee9b-2244-4e70-b1f5-5393042af1e4}"=dword:0
"{31C0DD25-9439-4F12-BF41-7FF4EDA38722}"=dword:0
"{4BD8D571-6D19-48D3-BE97-422220080E43}"=dword:0
"{0ddd015d-b06c-45d5-8c4c-f59713854639}"=dword:0
"{33E28130-4E1E-4676-835A-98395C3BC3BB}"=dword:0
"{a0c69a99-21c8-4671-8703-7934162fcf1d}"=dword:0
"{18989B1D-99B5-455B-841C-AB7C74E4DDFC}"=dword:0
"{FDD39AD0-238F-46AF-ADB4-6C85480369C7}"=dword:0
"{f42ee2d3-909f-4907-8871-4c22fc0bf756}"=dword:0
"{35286a68-3c57-41a1-bbb1-0eae73d76c95}"=dword:0



[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
AllowedEnumeration]
"{0AC0837C-BBF8-452A-850D-79D08E667CA7}"=dword:1
"{B4BFCC3A-DB2C-424C-B029-7FE99A87C641}"=dword:1
"{374DE290-123F-4565-9164-39C4925E467B}"=dword:1
"{FDD39AD0-238F-46AF-ADB4-6C85480369C7}"=dword:0
"{7d83ee9b-2244-4e70-b1f5-5393042af1e4}"=dword:0
"{31C0DD25-9439-4F12-BF41-7FF4EDA38722}"=dword:0
"{4BD8D571-6D19-48D3-BE97-422220080E43}"=dword:0
"{0ddd015d-b06c-45d5-8c4c-f59713854639}"=dword:0
"{33E28130-4E1E-4676-835A-98395C3BC3BB}"=dword:0
"{a0c69a99-21c8-4671-8703-7934162fcf1d}"=dword:0
"{18989B1D-99B5-455B-841C-AB7C74E4DDFC}"=dword:0
"{FDD39AD0-238F-46AF-ADB4-6C85480369C7}"=dword:0
"{f42ee2d3-909f-4907-8871-4c22fc0bf756}"=dword:0
"{35286a68-3c57-41a1-bbb1-0eae73d76c95}"=dword:0
; Hide / Show Policy:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{B4BFCC3A-DB2C-424C-B029-7FE99A87C641}\PropertyBag]
"ThisPCPolicy"="Show"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{0AC0837C-BBF8-452A-850D-79D08E667CA7}\PropertyBag]
"ThisPCPolicy"="Show"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{374DE290-123F-4565-9164-39C4925E467B}\PropertyBag]
"ThisPCPolicy"="Show"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{FDD39AD0-238F-46AF-ADB4-6C85480369C7}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{7d83ee9b-2244-4e70-b1f5-5393042af1e4}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{31C0DD25-9439-4F12-BF41-7FF4EDA38722}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{4BD8D571-6D19-48D3-BE97-422220080E43}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{0ddd015d-b06c-45d5-8c4c-f59713854639}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{33E28130-4E1E-4676-835A-98395C3BC3BB}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{a0c69a99-21c8-4671-8703-7934162fcf1d}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{18989B1D-99B5-455B-841C-AB7C74E4DDFC}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{FDD39AD0-238F-46AF-ADB4-6C85480369C7}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{f42ee2d3-909f-4907-8871-4c22fc0bf756}\PropertyBag]
"ThisPCPolicy"="Hide"
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
FolderDescriptions\{35286a68-3c57-41a1-bbb1-0eae73d76c95}\PropertyBag]
"ThisPCPolicy"="Hide"
;
------End cut & paste here------

* Turn OFF Sync (Synchronization) settings if not using a Microsoft 
Azure/Bing/Hotmail/Live/MSN/Microsoft



Start/Outlook/Windows Mail/WIP account, OneDrive/SkyDrive/similar network/remote
cloud storage
account/app/membership/service/subscription, connected/linked/networked/shared 
computer(s)/device(s) and/or
interconnected/interdependent 
accounts/apps/enrollments/memberships/services/subscriptions:
http://www.tenforums.com/tutorials/4077-turn-off-sync-settings-microsoft-
account-windows-10-a.html
http://www.tenforums.com/tutorials/117903-enable-disable-syncing-theme-windows-
10-sync-your-settings.html
Run... [hold WinKey + press R] -> type this command:
ms-settings:sync
-> press Enter -> Sync settings -> turn OFF all individual Sync settings -> turn
OFF all global Sync settings.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\SettingSync]
"DisablePersonalizationSettingSync"=dword:2
"DisablePersonalizationSettingSyncUserOverride"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync]
"EnableQuotaFailureDialog"=dword:0
"ReducePrivileges"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\Accessibility]
"EnableOnUpgrade"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\AppSync]
"EnableOnUpgrade"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\Credentials]
"EnableOnUpgrade"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\Language]
"EnableOnUpgrade"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\PackageState]
"EnableOnUpgrade"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\Personalization]
"EnableOnUpgrade"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SettingSync\
Groups\Windows]
"EnableOnUpgrade"=dword:0
;
------End cut & paste here------

* Turn OFF/disable/uninstall OneDrive/SkyDrive in Windows 10/11, unless you are 
actually using it:
http://account.cloud.ppi.net/knowledgebase/109/Turn-off-disable-or-uninstall-
OneDrive.html
http://thegeekpage.com/disable-onedrive/
http://www.howtogeek.com/224798/how-to-uninstall-windows-10s-built-in-apps-and-
how-to-reinstall-them/
http://www.reddit.com/r/windows/comments/3f6gsl/
http://web.archive.org/web/20190420050553/http://gist.github.com/CHEF-KOCH/
ca8fbf6bb7f6fa7bab06/



IMPORTANT:
1st backup all files, directories/folders + registry settings below if you plan 
to use OneDrive/SkyDrive in the future.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
SET x86="%SystemRoot%\SYSTEM32\OneDriveSetup.exe"
SET x64="%SystemRoot%\SysWOW64\OneDriveSetup.exe"
TASKKILL.EXE /IM OneDrive.exe /T /F
PING.EXE 127.0.0.1 -n 5
IF EXIST %x64% (
%x64% /uninstall
) else (
%x86% /uninstall
)
PING.EXE 127.0.0.1 -n 5
RD "%UserProfile%\OneDrive" /Q /S
RD "C:\OneDriveTemp" /Q /S
RD "%LocalAppData%\Microsoft\OneDrive" /Q /S
RD "%ProgramData%\Microsoft OneDrive" /Q /S
:END
EXIT
------End cut & paste here------
TIP:
****
Windows NTx built-in/default/pre-installed/preset machine/system (apply to all 
users on the same machine) + local/user
(apply only to the current/logged on user) environment variables used for target
system/user directories/folders:
http://www.ss64.com/nt/syntax-variables.html
http://pureinfotech.com/list-environment-variables-windows-10/
http://www.computerhope.com/issues/ch000549.htm
- %LocalAppData% = usually %UserProfile%\AppData\Local [same as C:\Users\
%UserName%\AppData\Local] OR
%WinDir%\SYSTEM32\Config\SystemProfile\AppData\Local .
- %ProgramData% = usually C:\ProgramData .
- %ProgramFiles% = usually C:\Program Files [exists in Windows 32-bit (x86) + 
Windows 64-bit (x64)].
- %ProgramFiles(x86)% = usually C:\Program Files (x86) [exists only in Windows 
64-bit (x64)].
- %SystemDrive% = usually C:\ root.
- %SystemRoot% = usually C:\WINDOWS [same as %WinDir%].
- %UserName% = your user name.
- %UserProfile% = usually C:\Users\%UserName% .
- %WinDir% = usually C:\WINDOWS [same as %SystemRoot%].
CAUTION:
********
Windows operating system (OS) integrity, proper functionality + correct 
operation *depend* on the *validity* of *all* these
variables!
INvalid/wrong parameters can render Windows INoperable or/and UNbootable, and 
you may have to reinstall from scratch or
repair your operating system (OS), eventually using the original storage media 
containing Windows Setup files!
Some of these variables can be added/customized/deleted/modified by using a 
Control Panel (CP)/Windows Settings (WS) tool:



Run... [hold WinKey + press R] -> type this command
SystemPropertiesAdvanced.exe
-> press Enter -> Advanced tab -> Environment Variables... button -> edit 
variables -> highlight respective line -> Edit
button -> change parameters -> OK -> OK.
View the list of all your Windows operating system (OS) environment variables 
from a DOS console command prompt
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD shortcut/CMD.EXE -> Run as 
Administrator -> type this command
SET
-> press Enter.
OR
Save it to a plain text/ASCII (.txt) file: from a DOS console command prompt 
[%WinDir%\SYSTEM32\CMD.EXE]: right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> type same command above followed by 
the name of the file (in this example it
will be saved in C:\ root)
SET>C:\Windows_Environment_Variables.txt
-> press Enter -> use Notepad/similar/better free(ware) plain text/ASCII 
editor/viewer
http://www.mdgx.com/toy.htm#TXT
to view saved text file contents.
Example of Windows Vista/newer list of relevant environment variables [replace 
all User_Name instances with your actual user
name]:
----------snippity-snip----------
ALLUSERSPROFILE=C:\ProgramData
APPDATA=C:\Users\PC\AppData\Roaming [OR: APPDATA=C:\Windows\system32\config\
systemprofile\AppData\Roaming]
CommonProgramFiles=C:\Program Files\Common Files
CommonProgramFiles(x86)=C:\Program Files (x86)\Common Files [exists only in 
Windows 64-bit (x64)]
CommonProgramW6432=C:\Program Files\Common Files
ComSpec=C:\Windows\system32\cmd.exe
DriverData=C:\Windows\System32\Drivers\DriverData
HOMEDRIVE=C:
HOMEPATH=\WINDOWS\SYSTEM32 [OR: HOMEPATH=\Users\User_Name]
LOCALAPPDATA=C:\Users\PC\AppData\Local [OR: LOCALAPPDATA=C:\Windows\system32\
config\systemprofile\AppData\Local]
OS=Windows_NT
ProgramData=C:\ProgramData
ProgramFiles=C:\Program Files
ProgramFiles(x86)=C:\Program Files (x86) [exists only in Windows 64-bit (x64)]
ProgramW6432=C:\Program Files
PSModulePath=%ProgramFiles%\WindowsPowerShell\Modules;C:\Windows\system32\
WindowsPowerShell\v1.0\Modules
PUBLIC=C:\Users\Public
SystemDrive=C:
SystemRoot=C:\Windows
TEMP=C:\Users\PC\AppData\Local\Temp [OR: TEMP=C:\Windows\TEMP]
TMP=C:\Users\PC\AppData\Local\Temp [OR: TMP=C:\Windows\TEMP]
USERNAME=User_Name
USERPROFILE=C:\Users\User_Name [OR: USERPROFILE=C:\Windows\system32\config\
systemprofile]
windir=C:\Windows
----------snippity-snip----------
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.



-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\OneDrive]
"DisableFileSync"=dword:1
"DisableFileSyncNGSC"=dword:1
; 3D Objects:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\
MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\
Explorer\MyComputer\NameSpace\{0DB7E03F-FC29-4DC6-9020-FF41B59E513A}]
; OneDrive:
[HKEY_CLASSES_ROOT\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
"System.IsPinnedToNameSpaceTree"=dword:0
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
"System.IsPinnedToNameSpaceTree"=dword:0
[-HKEY_CLASSES_ROOT\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
; WOW6432Node registry subkey exists only in Windows NTx 64-bit (x64):
[-HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{018D5C66-4533-4307-9B53-224DE2ED1FE6}]
;
------End cut & paste here------

* Turn ON/enable Check Boxes item selection in Explorer to be able to select 
all/highlighted/multiple files + (sub)folders
in Windows 8/newer:
http://www.tenforums.com/tutorials/20616-turn-off-select-items-using-check-
boxes-windows-10-a.html
http://www.dummies.com/computers/operating-systems/windows-10/how-to-use-check-
boxes-to-select-files-in-windows-10/
http://www.thewindowsclub.com/windows-explorer-disable-checkbox/
Explorer -> upper right hand corner down arrow -> Expand the Ribbon [hold Ctrl +
press F1] -> View tab -> Select Tiles ->
check "Item check boxes" box.
OR:
Run... [hold WinKey + press R] -> type this command:
RUNDLL32.EXE SHELL32.DLL,Options_RunDLL 7
OR:
Start button/icon/logo/menu/orb -> Control Panel (CP);
OR:
Run... [hold WinKey + press R] -> type this command:
CONTROL.EXE folders
-> press Enter -> File Explorer Options -> View tab -> Advanced settings: -> 
check "Use check boxes to select items" box.
Control Panel executable [CONTROL.EXE] is located in the %WinDir%\SYSTEM32 
directory/folder [%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
OR:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain



text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"AutoCheckSelect"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"AutoCheckSelect"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"AutoCheckSelect"=dword:1
;
------End cut & paste here------

* Turn OFF/uninstall/remove/disable Windows Store app/automatic updates if not 
using/planning to use UWP (Universal Windows
Platform) apps that depend on them:
http://www.tenforums.com/tutorials/127437-enable-disable-microsoft-store-apps-
windows-10-a.html
http://blog.techinline.com/2019/03/19/how-to-disable-or-uninstall-windows-store-
in-windows-10/
http://www.urtech.ca/2015/09/solved-how-to-disable-the-store-app-in-windows-10/
http://www.thewindowsclub.com/disable-automatic-microsoft-store-updates/
http://en.wikipedia.org/wiki/Universal_Windows_Platform_apps
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
Get-AppXPackage *windowsstore* | Remove-AppXPackage
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\WindowsStore]
"DisableStoreApps"=dword:1
"RemoveWindowsStore"=dword:1
"AutoDownload"=dword:2
;
------End cut & paste here------

* Turn OFF/disable Remote Assistance, Remote (Auto) Connection Manager, Remote 
Registry, Remote Management (WinRM) +
uninstall Quick Assist in Windows 10/11:
http://www.windowscentral.com/how-disable-remote-assistance-windows-10/
http://www.curatrix.co.uk/windows-quick-assist/
http://www.tenforums.com/tutorials/116749-enable-disable-remote-assistance-
connections-windows.html
http://www.winaero.com/disable-remote-assistance-windows-10/
http://4sysops.com/archives/remote-control-windows-10-with-quick-assist/
http://en.wikipedia.org/wiki/Quick_Assist
Quick Assist [quickassist.exe]is located in the %WinDir%\SYSTEM32 
directory/folder [%WinDir% = usually C:\WINDOWS].
Run Quick Assist: hold Ctrl + WinKey + press Q keyboard shortcut combo.
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
NETSH.EXE advfirewall firewall set rule group="Remote Assistance" new enable=no
NETSH.EXE advfirewall firewall set rule group="Remote Administration" new 
enable=no



NETSH.EXE advfirewall firewall set rule group="Remote Desktop" new enable=no
NETSH.EXE advfirewall firewall set rule group="Remote Management" new enable=no
NETSH.EXE advfirewall set allprofiles settings remotemanagement disable
DISM.EXE /Online /Remove-Capability 
/CapabilityName:App.Support.QuickAssist~~~~0.0.1.0
DISM (Deployment Image Servicing and Management) [DISM.EXE] executable is 
located in the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.
2nd command above can be performed using PowerShell: right-click PowerShell 
shortcut or
C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\PowerShell.exe [default location in 
Windows 10/11] -> Run as Administrator ->
run this command -> press Enter:
Remove-WindowsCapability -online -name App.Support.QuickAssist~~~~0.0.1.0
See also "Windows (Defender) Firewall (WF) Tweaks + Tools" chapter -> "* 
Control/optimize/secure advanced Windows Firewall
(WF) behavior using Network Shell (NetSh) [NETSH.EXE] DOS console command line 
tool in Windows 7/newer:" section in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
To completely turn OFF/disable all Windows Remote Assistance, Administration, 
Desktop + Management services:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
ECHO Y|NET.EXE STOP RasAuto
SC.EXE CONFIG RasAuto START= disabled
ECHO Y|NET.EXE STOP RasMan
SC.EXE CONFIG RasMan START= disabled
ECHO Y|NET.EXE STOP RemoteRegistry
SC.EXE CONFIG RemoteRegistry START= disabled
ECHO Y|NET.EXE STOP RemoteAccess
SC.EXE CONFIG RemoteAccess START= disabled
ECHO Y|NET.EXE STOP WinRM
SC.EXE CONFIG WinRM START= disabled
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\RasAuto" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\RasAuto" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\RasAuto" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\RasMan" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\RasMan" /v Start /t REG_DWORD /d
4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\RasMan" /v Start /t REG_DWORD /d
4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\RemoteRegistry" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\RemoteRegistry" /v Start /t 



REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\RemoteRegistry" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\RemoteAccess" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\RemoteAccess" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\RemoteAccess" /v Start /t 
REG_DWORD /d 4 /f
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\WinRM" /v Start /t REG_DWORD
/d 4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\WinRM" /v Start /t REG_DWORD /d 
4 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\WinRM" /v Start /t REG_DWORD /d 
4 /f
:END
EXIT
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.
To completely disable all Windows Remote Assistance, Administration, Desktop + 
Management registry settings:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; * Turn OFF remote administration/assistance/desktop/management:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Remote Assistance]
"CreateEncryptedOnlyTickets"=dword:1
"fAllowFullControl"=dword:0
"fAllowToGetHelp"=dword:0
"fEnableChatControl"=dword:0
"MaxTicketExpiry"=dword:0
"MaxTicketExpiryUnits"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Control\Remote Assistance]
"CreateEncryptedOnlyTickets"=dword:1
"fAllowFullControl"=dword:0
"fAllowToGetHelp"=dword:0
"fEnableChatControl"=dword:0
"MaxTicketExpiry"=dword:0
"MaxTicketExpiryUnits"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Control\Remote Assistance]
"CreateEncryptedOnlyTickets"=dword:1
"fAllowFullControl"=dword:0
"fAllowToGetHelp"=dword:0
"fEnableChatControl"=dword:0
"MaxTicketExpiry"=dword:0
"MaxTicketExpiryUnits"=dword:0
; * Turn OFF remote administration/assistance/desktop/management services:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RasAuto]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\RasAuto]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\RasAuto]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RasMan]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\RasMan]
"Start"=dword:4



[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\RasMan]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RemoteRegistry]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\RemoteRegistry]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\RemoteRegistry]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\RemoteAccess]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\RemoteAccess]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\RemoteAccess]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WinRM]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\WinRM]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\WinRM]
"Start"=dword:4
;
------End cut & paste here------

* Turn OFF Internet Connection Sharing (ICS) [SharedAccess] service + 
internet/network connection shared control with
other/remote entities/user(s) in order to enhance/improve digital/online 
privacy, safety + security, and reduce risks +
vulnerabilities:
http://www.its.hku.hk/faq/network/remote/disable-ics-win/
http://www.windowscentral.com/how-turn-your-windows-10-pc-wireless-hotspot/
http://getalltech.com/how-to-enable-disable-internet-connection-sharing-windows/
http://www.tenable.com/audits/items/
CIS_MS_Windows_7_v3.2.0_Level_1_Bitlocker.audit:40eaa83195178488179b237f745526e6
/
http://www.techtarget.com/searchcontentmanagement/tip/7-common-file-sharing-
security-risks/
Start menu -> Control Panel (CP) -> Network and Sharing Center -> View your 
active networks -> Connections: ->
(double-)click your active connection name link -> Properties button -> Sharing 
tab -> uncheck these 2 boxes: "Allow other
network users to connect through this computer's Internet connection" + "Allow 
other network users to control or disable the
shared Internet connection" -> click OK or press Enter.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SharedAccess\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SharedAccess]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\SharedAccess\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\SharedAccess]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\SharedAccess\Security]



[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\SharedAccess]
"LaunchProtected"=dword:0
"UserServiceFlags"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Network\
SharedAccessConnection]
"EnableControl"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\Network\SharedAccessConnection]
"EnableControl"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\Network\SharedAccessConnection]
"EnableControl"=dword:0
;
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.

* Save/export + restore/import custom/personal Power plan/scheme settings in 
Windows 10/11:
http://www.winaero.com/save-power-plan-settings-text-file-windows-10/
http://www.winaero.com/export-import-power-plan-windows-10/
http://learn.microsoft.com/windows-hardware/design/device-experiences/powercfg-
command-line-options/
http://technet.microsoft.com/library/cc748940.aspx
http://en.wikipedia.org/wiki/Powercfg
http://www.ss64.com/nt/powercfg.html
http://web.archive.org/web/20080212041212/http://xpregistry.uw.hu/xpr0035.html
Perform all these operations from a DOS console (command prompt) -> right-click 
CMD shortcut/CMD.EXE -> Run as Administrator
-> run these commands -> press Enter after each line (examples):
Save/export active Power scheme custom settings details to text file (example):
POWERCFG.EXE /QH>C:\POWER_10\POWER_10.TXT
Save/export active Power Scheme Global Unique ID (GUID) number to text file 
(example):
POWERCFG.EXE /L>C:\POWER_10\POWER_10_GUID.TXT
Export/save active Power scheme custom settings to binary file [replace GUID_# 
below with your actual GUID_# number from
POWER_10_GUID.TXT text file above] (example):
POWERCFG.EXE /EXPORT "C:\POWER_10\POWER_10.POW" GUID_#
Import/restore Power scheme custom settings from POWER_10.POW binary file above:
POWERCFG.EXE /IMPORT "C:\POWER_10\POWER_10.POW"
Power Configuration (PowerCfg) [POWERCFG.EXE] is located in the %WinDir% 
directory/folder [%WinDir% = usually C:\WINDOWS].

* Turn ON large Taskbar buttons/icons, Network Taskbar icon, Network Taskbar 
icon Network flyout + Turn OFF Network Taskbar
icon yellow exclamation sign warnings in Windows 10/11:
http://www.tenforums.com/tutorials/25233-use-large-small-taskbar-buttons-
windows-10-a.html
http://www.winaero.com/enable-small-taskbar-buttons-windows-10/
http://www.quora.com/How-can-I-use-regedit-to-make-the-taskbar-icons-small-Im-
using-unactivated-Windows-10/
http://windowsreport.com/windows-10-taskbar-button-width/
http://superuser.com/questions/1201848/
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.TaskBar2::HideSCANetwork
http://www.winaero.com/disable-the-yellow-warning-sign-from-the-network-icon-in-
windows-10/
http://www.winaero.com/change-network-icon-click-action-in-windows-10/
http://www.onmsft.com/how-to/how-fix-network-selector-and-bring-back-flyout-
windows-10-build-9869/
"ReplaceVan" DWORD [REG_DWORD] numeric values (see below):
0 = Network flyout [default];
1 = Network settings [classic = Windows 8 style];
2 = Network drop down [sidebar].
TIP:



Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"TaskbarSmallIcons"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"TaskbarSmallIcons"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"TaskbarSmallIcons"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\SideBySide]
"PreferExternalManifest"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"HideSCANetwork"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"HideSCANetwork"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Policies\
Explorer]
"HideSCANetwork"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Network Connections]
"NC_DoNotShowLocalOnlyIcon"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Control Panel\
Settings\Network]
"ReplaceVan"=dword:0
;
------End cut & paste here------

* FIX: Repair Storage service [StorSvc] in Windows 10/11:
http://answers.microsoft.com/en-us/windows/forum/all/storage-service-in-
services-is-always-set-to/a8d9fdeb-75f5-45bf-92e6-45729db08193/
http://batcmd.com/windows/10/services/storsvc/
Reinstall preinstalled/default Store apps by using 1 of these methods, or all 3 
if needed:
1. Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\
v1.0\PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
Get-AppXPackage -AllUsers | Foreach {Add-AppXPackage -DisableDevelopmentMode -
Register "$($_.InstallLocation)\AppXManifest.xml"}
2. Download reinstall-preinstalledApps.zip archive ZIP (.zip) file
http://download.microsoft.com/download/5/F/0/5F04003A-035E-4A0F-9662-
43E32C546F6C/reinstall-preinstalledApps.zip
-> install 7-Zip unZIPping/unARChiving/unRARing tool (free GPL):
http://www.7-zip.org/
-> Explorer -> right-click reinstall-preinstalledApps.zip -> select 7-Zip -> 
select Open archive -> extract
reinstall-preinstalledApps.ps1 PowerShell PS1 (.ps1) script file -> right-click 
on reinstall-preinstalledApps.ps1 ->
Run as Administrator -> restart/reboot if prompted.
3. Download Appsdiagnostic10.diagcab CAB (.cab) archive file
http://web.archive.org/web/20201111182535if_/https://download.microsoft.com/
download/F/2/4/F24D0C03-4181-4E5B-A23B-5C3A6B5974E3/Appsdiagnostic10.diagcab
-> right-click on Appsdiagnostic10.diagcab -> Run as Administrator -> follow 
steps to repair/reinstall apps ->
restart/reboot if prompted.
Set Storage service [StorSvc] to Manual (on demand: will be started by an 
app/program/service when needed):
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer



http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
REG.EXE ADD "HKLM\SYSTEM\CurrentControlSet\Services\StorSvc" /v Start /t 
REG_DWORD /d 3 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet001\Services\StorSvc" /v Start /t 
REG_DWORD /d 3 /f
REG.EXE ADD "HKLM\SYSTEM\ControlSet002\Services\StorSvc" /v Start /t 
REG_DWORD /d 3 /f
:END
EXIT
------End cut & paste here------
OR:
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
ECHO Y|NET.EXE START StorSvc
SC.EXE CONFIG StorSvc START= demand
:END
EXIT
------End cut & paste here------
OR:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\StorSvc]
"Start"=dword:3
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\StorSvc]
"Start"=dword:3
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\StorSvc]
"Start"=dword:3
;
------End cut & paste here------

* FIX: Repair/customize/force Windows 7/newer to remember (cache) + store up to 
20000 (maximum allowed for all Windows
Vista/newer builds/editions/releases/versions) Folders View instances on 
Desktop, in Explorer, Start Menu + everywhere in
the Shell GUI (Graphical User Interface):
http://www.kapilarya.com/fix-windows-10-wont-remember-folder-view-settings/
http://www.tenforums.com/windows-10-news/170119-how-increase-folder-view-
settings-cache-memory-size-windows.html
http://www.thewindowsclub.com/windows-7-forgets-folder-view-settings/
http://mspx.kapilarya.com/FIX-Windows-10-Wont-Remember-Folder-View-Settings.png
Windows 10/11 users:
Explorer -> go to any directory/folder located on 1 of your 
drives/partitions/volumes (if more than 1) -> select desired
option:
Extra Large Icons
Large Icons
Medium Icons



Small Icons
List
Details
Tiles
Content
-> View -> Options -> Change directory/folder and search options -> View tab -> 
click "Apply to Folders" button -> Apply/OK
-> repeat steps above for all your drives/partitions/volumes (if more than 1).
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; "BagMRU Size" DWORD [REG_DWORD] hexadecimal (binary) value corresponds to 
20000 (decimal) cached Folder View instances:
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
Shell]
"BagMRU Size"=dword:00004e20
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
Shell]
"BagMRU Size"=dword:00004e20
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
Shell]
"BagMRU Size"=dword:00004e20
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Local Settings\Software\Microsoft\Windows\
Shell\BagMRU]
"BagMRU Size"=dword:00004e20
[HKEY_CURRENT_USER\Software\Classes\Local Settings\Software\Microsoft\Windows\
Shell\BagMRU]
"BagMRU Size"=dword:00004e20
[HKEY_USERS\.DEFAULT\Software\Classes\Local Settings\Software\Microsoft\Windows\
Shell\BagMRU]
"BagMRU Size"=dword:00004e20
;
------End cut & paste here------

* FIX: Restore corrupted registry + system settings in Windows 10/11:
http://thegeekpage.com/fix-corrupted-registry-in-windows-10-solved/
http://windowsreport.com/windows-10-registry-permissions/
http://www.winhelponline.com/blog/edit-registry-offline-windows-re/
CAUTION:
********
Use this method ONLY if Windows exhibits major/serious errors, and ONLY if ALL 
other methods did not work!
Restore the registry to default values from a DOS console (command prompt) -> 
right-click CMD shortcut/CMD.EXE ->
Run as Administrator -> run this command -> press Enter:
DISM.EXE /Online /Cleanup-Image /ScanHealth
DISM (Deployment Image Servicing and Management) [DISM.EXE] executable is 
located in the %WinDir%\SYSTEM32 directory/folder
[%WinDir% = usually C:\WINDOWS].
View all directories/folders listed in your system PATH from a DOS console 
command prompt [%WinDir%\SYSTEM32\CMD.EXE]:
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> type this command
PATH
-> press Enter.

* FIX: (Re)Set/(re)install/repair Windows 10/11 from the blue (pre-)Login 
Screen, before logging in into Windows:



http://support.microsoft.com/windows/reset-or-reinstall-windows-10-cd352bd8-
4cb6-411a-f2f5-1814bd8d453c
http://www.theverge.com/21264104/windows-10-reset-os-reboot-troubleshoot-
microsoft/
http://www.support.com/how-to/how-to-fix-a-windows-pc-that-keeps-rebooting-
12992/
http://www.addictivetips.com/windows-tips/how-to-reset-windows-10-from-the-
login-screen/
http://www.thewindowsclub.com/reset-windows-10/
http://www.helpdeskgeek.com/windows-10/how-to-factory-reset-windows-10-without-
the-admin-password/
http://www.top-password.com/blog/how-to-reset-windows-10-without-logging-in/
http://www.winhelp.us/repair-your-computer-in-windows-10.html
http://www.yourwindowsguide.com/2016/06/how-to-do-repair-install-using-
windows.html
http://www.laptopmag.com/articles/repair-windows-10/
http://answers.microsoft.com/windows/forum/windows_10/how-to-perform-a-clean-
install-using-reset-this-pc/6f6335fc-8d15-4598-af16-033d1d8c16bf/
http://devblogs.microsoft.com/oldnewthing/20161206-00/?p=94865
http://www.asus.com/support/FAQ/1013064/
http://www.asus.com/support/FAQ/1044563/
http://www.makeuseof.com/tag/3-ways-to-reset-the-forgotten-windows-
administrator-password/
http://www.mydigitallife.net/install-windows-10-windows-8-1-local-account-
bypass-microsoft-account-sign/
PCs/laptops/netbooks/notebooks/portables/tablets/devices with pre-installed 
Windows 10/11 OEM (Original Equipment
Manufacturer) editions can be reset to factory defaults from the 
manufacturer/vendor hidden partition which contains a
pre-installed Windows OS image [refer to your specific vendor 
documentation/guidelines for details]: login screen -> Power
button -> hold Shift + click Restart button -> Troubleshoot button -> Reset this
PC button -> Keep my files button -> this
reinstalls Windows 10/11, resets all system settings to their defaults, and 
keeps all your files/folders + some user
settings, desktop icons, and some of your custom system/software settings +/- 
changes -> restart/reboot normal.
In case this doesn't work, or if you have been locked out of your computer -> 
Power button -> press repeatedly F9 or F12
(depending on your computer/device/portable brand + model) -> BIOS Setup -> Boot
tab/screen -> Windows Boot Manager
button/item -> Enter -> Recovery -> See advanced repair options button -> 
Troubleshoot button -> Reset this PC button ->
Keep my files button -> reinstall Windows 10/11 (see above) -> restart/reboot 
normal.
OR Power button -> press repeateadly F3 (depending on your 
computer/device/portable brand + model) -> See advanced repair
options button -> Troubleshoot button -> Reset this PC button -> Keep my files 
button -> reinstall Windows 10/11 (see above)
-> restart/reboot normal.
Afterwards you may need to customize (some of) your 
hardware/interface/system/user/apps/software settings, and reinstall
your 3rd party/custom/favorite app(lication)s/programs/drivers/items, and 
eventually customize (some of) them again.
But in the end these are minor inconveniences compared to having to reinstall 
and reconfigure your Windows OS (Operating
System) and all your software apps, drivers, programs, games, tools, updates, 
etc from scratch. ;-/

* FIX: Repair Windows Settings (WS) a.k.a. Immersive Control Panel (ICP) a.k.a. 
native Control Panel (CP) errors:
http://windowsreport.com/problems-settings-feature-windows-10/
http://www.windowsphoneinfo.com/threads/immersive-control-panel-error.288207/
http://forums.mydigitallife.net/threads/discussion-windows-10-enterprise-n-ltsc-
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* FIX: Perform Windows 10 in-place upgrade:
http://www.thewindowsclub.com/perform-windows-10-in-place-upgrade/

* FIX: Explorer (explorer.exe) blank message with Yellow Exclamation Mark on 
Startup:
http://www.thewindowsclub.com/explorer-exe-blank-message-with-yellow-
exclamation-mark/

* FIX: Fix Slow File Copy Speed in Windows 10:
http://thegeekpage.com/fix-slow-file-copy-speed-in-windows-10/

* FIX: Fix Most Common Windows 10 Problems:
http://www.securedyou.com/top-common-windows-10-problems-and-solutions/

* FIX: Repair 7 Windows 10 annoyances:
http://www.zdnet.com/article/seven-windows-10-annoyances-and-how-to-fix-them/

* FIX: Block/stop Microsoft from tracking + spying on you behind your back using
Windows (Defender) Firewall [W(D)F] custom
firewall rules in Windows 7/newer:
http://www.winaero.com/blog/stop-windows-10-spying-on-you-using-just-windows-
firewall/
File:
http://www.winaero.com/download.php?view.1839
http://www.winaero.com/downloads/block_telemetry.zip
1. Use an unZIPping/unARChiving/unRARing tool [free(ware)]
http://www.mdgx.com/toy.htm#ZIP
to open "block_telemetry.zip" archive and extract "add rules.cmd" + "rules.ps1" 
into the same dedicated/empty
directory/folder.
2. Open Explorer/similar/replacement -> right-click "add rules.cmd" -> Run as 
Administrator -> wait for all W(D)F rules to
be created -> exit BATch CoMmanD script file.
3. Done.

* FIX: MDGx customized/tweaked list of all Windows Defender Firewall (WDF) 
Inbound + Outbound Core Networking rules [Allowed
+ Blocked connections] for improved efficiency, performance, and most 
importantly, increased privacy, safety + security on
my customized/tweaked Windows 10 gaming laptop (examples):
http://voyager.deanza.edu/~hso/cis170f/lecture/ch08/win08/advanced.html
http://www.digitalcitizen.life/manage-rules-windows-firewall-advanced-security/
1. Start button/icon/logo/menu/orb -> Windows Administrative Tools -> Windows 
Defender Firewall with Advanced Security ->
Inbound Rules -> Outbound Rules.
2. Control Panel (CP) OR Start button/icon/logo/menu/orb -> Run... [hold WinKey 
+ press R] -> type:
control.exe
-> OK/Enter -> System and Security -> Windows Defender Firewall (WDF) -> 
Advanced settings -> Inbound Rules -> Outbound
Rules.
3. Start button/icon/logo/menu/orb -> Run... [hold WinKey + press R] -> type:
wf.msc
-> OK/Enter -> Windows Defender Firewall (WDF) with Advanced Security -> Inbound
Rules -> Outbound Rules.
ALLOW CONNECTION:
*****************
Here are my WDF Core Networking rules set to "Allow the connection", both 
Inbound + Outbound:
- Inbound Rules [set to "Allow the connection"]:
http://www.mdgx.com/Win10_FW_Inbound_rules.jpg
Core Networking - IPv6 (IPv6-In)



Core Networking - IPHTTPS (TCP-In)
Core Networking - Teredo (UDP-In)
Core Networking - Dynamic Host Configuration Protocol for IPv6(DHCPV6-In)
Core Networking - Dynamic Host Configuration Protocol (DHCP-In)
Core Networking - Destination Unreachable Fragmentation Needed (ICMPv4-In)
Core Networking - Parameter Problem (ICMPv6-In)
Core Networking - Time Exceeded (ICMPv6-In)
Core Networking - Packet Too Big (ICMPv6-In)
Core Networking - Destination Unreachable (ICMPv6-In)
- Outbound Rules [set to "Allow the connection"]:
http://www.mdgx.com/Win10_FW_Outbound_rules.jpg
Core Networking - DNS (UDP-Out)
Core Networking - Group Policy (TCP-Out)
Core Networking - Group Policy (NP-Out)
Core Networking - IPv6 (IPv6-Out)
Core Networking - IPHTTPS (TCP-Out)
Core Networking - Teredo (UDP-Out)
Core Networking - Dynamic Host Configuration Protocol for IPv6(DHCPV6-Out)
Core Networking - Dynamic Host Configuration Protocol (DHCP-Out)
Core Networking - Parameter Problem (ICMPv6-Out)
Core Networking - Time Exceeded (ICMPv6-Out)
Core Networking - Packet Too Big (ICMPv6-Out)
BLOCK CONNECTION:
*****************
I have set all other WDF Core Networking rules to "Block the connection", both 
Inbound + Outbound (examples):
- Inbound Rules [set to "Block the connection"]:
Core Networking - Internet Group Management Protocol (IGMP-In)
Core Networking - Multicast Listener Done (ICMPv6-In)
Core Networking - Multicast Listener Report v2 (ICMPv6-In)
Core Networking - Multicast Listener Report (ICMPv6-In)
Core Networking - Multicast Listener Query (ICMPv6-In)
Core Networking - Router Advertisement (ICMPv6-In)
Core Networking - Router Solicitation (ICMPv6-In)
Core Networking - Neighbor Discovery Advertisement (ICMPv6-In)
Core Networking - Neighbor Discovery Solicitation (ICMPv6-In)
- Outbound Rules [set to "Block the connection"]:
Core Networking - Group Policy (LSASS-Out)
Core Networking - Group Policy (TCP-Out)
Core Networking - Group Policy (NP-Out)
Core Networking - Internet Group Management Protocol (IGMP-Out)
Core Networking - Multicast Listener Done (ICMPv6-Out)
Core Networking - Multicast Listener Report v2 (ICMPv6-Out)
Core Networking - Multicast Listener Report (ICMPv6-Out)
Core Networking - Multicast Listener Query (ICMPv6-Out)
Core Networking - Router Advertisement (ICMPv6-Out)
Core Networking - Router Solicitation (ICMPv6-Out)
Core Networking - Neighbor Discovery Advertisement (ICMPv6-Out)
Core Networking - Neighbor Discovery Solicitation (ICMPv6-Out)
MDGx tweaked Windows 10 gaming laptop specs:
http://www.mdgx.com/pc.htm#LAP
NOTE:
All these examples apply strictly to my customized/tweaked computers, devices, 
operating systems, hardware, software,
services + subscriptions requirements, needs + preferences.
You can create a list with all "Core Networking" rules in a plain text/ASCII 
file: from a DOS console command prompt ->
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run this command 
(example):
NETSH.EXE advfirewall firewall show rule name=all | FIND.EXE /I "Core Networking
-">%TEMP%\Win10_FW_Core_Networking_rules.txt
-> press Enter.
In this example Win10_FW_Core_Networking_rules.txt is saved in your Temp(orary) 
[%TEMP%] directory/folder, usually



%UserProfile%\AppData\Local\Temp
OR:
%AppData%\Local\Temp
in Windows Vista/newer, where %UserProfile% = your actual user name.
View your default/preset (unless you changed it) system Temp(orary) [%TEMP%] 
directory/folder location: from a DOS console
command prompt [%WinDir%\SYSTEM32\CMD.EXE] right-click CMD shortcut/CMD.EXE -> 
Run as Administrator -> run this command ->
press Enter:
PATH
Scroll down to these 2 environment variables (generic example):
TEMP=C:\Users\User_Name\AppData\Local\Temp
TMP=C:\Users\User_Name\AppData\Local\Temp
User_Name is replaced with your actual user name.
Network Shell (NetSh) [NETSH.EXE] + FIND.EXE are both located in the %WinDir%\
SYSTEM32 directory/folder [%WinDir% = usually
C:\WINDOWS].
See also MDGx "Windows (Defender) Firewall (WF) Tweaks + Tools" chapter in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT

* FIX: Replace Explorer Breadcrumbs Bar with Full Path Address Bar in Windows 
10:
http://www.winaero.com/show-full-path-address-bar-windows-10-file-explorer/

* FIX: Backup/repair/reinstall/restart/reset/reregister Start Menu (Layout) + 
Taskbar,
interconnected/interdependent/interrelated apps + critical errors in Windows 10:
Start Menu Experience Host [StartMenuExperienceHost.exe] + Shell Experience Host
[ShellExperienceHost.exe]:
http://superuser.com/questions/955139/
http://superuser.com/questions/1106996/
http://answers.microsoft.com/en-us/windows/forum/windows_10-performance-winpc/
howto-reinstall-shellexperiencehost-and/da04d448-bb46-40b1-85db-0fee8cdc915c/
http://www.winhelponline.com/blog/start-and-taskbar-stuck-windows-10-fix-
shellexperiencehost/
http://www.kapilarya.com/re-register-start-menu-windows-10/
http://davejsteele.wordpress.com/2016/06/27/windows-10-start-menu-tool/
http://www.apeswithcomputers.com/article/start-menu-or-applications-wont-launch/
http://www.winhelponline.com/blog/start-and-taskbar-stuck-windows-10-fix-
shellexperiencehost/
http://www.winosbite.com/what-is-startmenuexperiencehost-exe/
http://thewindowscentral.com/windows-shell-experience-host-high-cpu-usage/
http://www.winaero.com/backup-restore-start-menu-layout-windows-10/
http://www.majorgeeks.com/content/page/
how_to_backup_and_restore_the_start_menu_in_windows_10.html
http://www.winhelponline.com/blog/backup-start-menu-layout-windows-10/
http://www.top-password.com/blog/tag/restore-start-menu-windows-10/
http://www.thewindowsclub.com/system-tray-icons-do-not-work-in-windows-10/
Winaero Tweaker 32-bit + 64-bit for Windows 7/8/8.1/10/11 [select Portable at 
install time!]:
http://www.winaero.com/winaero-tweaker/
Download:
http://www.winaero.com/download-winaero-tweaker/
Winaero Tweaker Features:
http://www.winaero.com/the-list-of-winaero-tweaker-features/
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run these commands -> press Enter after each 
line:
Get-AppXPackage Microsoft.Windows.StartMenuExperienceHost | Foreach {Add-
AppXPackage -DisableDevelopmentMode -Register "$($_.InstallLocation)\
AppXManifest.xml"}



Get-AppXPackage Microsoft.Windows.ShellExperienceHost | Foreach {Add-AppXPackage
-DisableDevelopmentMode -Register "$($_.InstallLocation)\AppXManifest.xml"}
Get-AppXPackage -all *shellexperience* -packagetype bundle |% {add-AppXPackage -
register -DisableDevelopmentMode ($_.installlocation + "\appxmetadata\
appxbundlemanifest.xml")}
Get-AppXPackage -AllUsers | Foreach {Add-AppXPackage -DisableDevelopmentMode -
Register "$($_.InstallLocation)\AppXManifest.xml"}
Download reinstall-preinstalledApps.zip archive ZIP (.zip) file
http://download.microsoft.com/download/5/F/0/5F04003A-035E-4A0F-9662-
43E32C546F6C/reinstall-preinstalledApps.zip
-> install 7-Zip unZIPping/unARChiving/unRARing tool (free GPL):
http://www.7-zip.org/
-> Explorer -> right-click reinstall-preinstalledApps.zip -> select 7-Zip -> 
select Open archive -> extract
reinstall-preinstalledApps.ps1 PowerShell PS1 (.ps1) script file -> right-click 
on reinstall-preinstalledApps.ps1 ->
Run as Administrator -> restart/reboot if prompted.
Download Appsdiagnostic10.diagcab CAB (.cab) archive file
http://web.archive.org/web/20201111182535if_/https://download.microsoft.com/
download/F/2/4/F24D0C03-4181-4E5B-A23B-5C3A6B5974E3/Appsdiagnostic10.diagcab
-> right-click on Appsdiagnostic10.diagcab -> Run as Administrator -> follow 
steps to repair/reinstall apps ->
restart/reboot if prompted.
Run... [hold WinKey + press R] -> type:
%WinDir%\SystemApps\Microsoft.Windows.StartMenuExperienceHost_cw5n1h2txyewy\
StartMenuExperienceHost.exe
%WinDir%\SystemApps\ShellExperienceHost_cw5n1h2txyewy\ShellExperienceHost.exe
-> press Enter after each line.
Backup + Restore TileDataLayer database (.edb) using a BATch file:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text BATch (.bat) or CoMmanD (.cmd) script file containing the
lines between Cut & Paste delimiters below
-> save it as plain text/ASCII file (Encode: -> ANSI) with the BAT (.bat) or CMD
(.cmd) extension -> right-click it ->
Run as Administrator -> wait for completion.
I. Backup TileDataLayer database (.edb):
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
TASKKILL.EXE /IM explorer.exe /F /T
C:
CD "C:\Users\%UserName%\AppData\Local\TileDataLayer\Database"
SC.EXE STOP tiledatamodelsvc
MD "%UserProfile%\Desktop\StartMenuBAK"
COPY /Y *.* "%UserProfile%\Desktop\StartMenuBAK"
DEL /F /Q *.*
SC.EXE START tiledatamodelsvc
explorer.exe
:END
EXIT
------End cut & paste here------
II. Restore TileDataLayer database (.edb):
-----Begin cut & paste here-----
@ECHO OFF
IF NOT "%OS%"=="Windows_NT" GOTO END
TASKKILL.EXE /IM explorer.exe /F /T
C:
CD "C:\Users\%UserName%\AppData\Local\TileDataLayer\Database"
SC.EXE STOP tiledatamodelsvc
COPY /Y "%UserProfile%\Desktop\StartMenuBAK\*.*"
SC.EXE START tiledatamodelsvc
explorer.exe



:END
EXIT
------End cut & paste here------
Backup TileDataLayer database (.edb) + related files + directories/folders:
http://www.exefiles.com/en/edb/vedatamodel-edb/
http://superuser.com/questions/1194556/
List of files + directories/folders:
%UserProfile%\AppData\Local\TileDataLayer\Database\vedatamodel.edb
%WinDir%\ImmersiveControlPanel\Application.manifest
%UserProfile%\AppData\Local\Microsoft\Windows\CloudStore
%UserProfile%\AppData\Local\Microsoft\Windows\Caches
%UserProfile%\AppData\Local\Microsoft\Windows\Explorer
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run these commands -> press Enter after each 
line:
MD "C:\StartLayoutBAK"
Export-StartLayout -Path C:\StartLayoutBAK\start.xml
Import-StartLayout -LayoutPath .\start.xml -MountPath C:\StartLayoutBAK
http://www.winhelponline.com/blog/backup-start-menu-layout-windows-10/
Backup Start Menu Layout (BackupSML) 32-bit + 64-bit:
http://www.sordum.org/10997/
File:
http://www.sordum.org/files/downloads.php?backup-start-menu-layout
http://www.sordum.org/files/download/backup-start-menu-layout/BackupSML.zip
StartTileBackup [Backup.bat + Restore.bat]:
http://github.com/TurboLabIt/StartTileBackup/
File:
http://github.com/TurboLabIt/StartTileBackup/releases/latest/
Troubleshoot Start Menu errors:
http://learn.microsoft.com/windows/configuration/start-layout-troubleshoot/
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
get-AppXPackage -Name Microsoft.Windows.ShellExperienceHost
Start Menu issues with Tile Data Layer corruption:
http://learn.microsoft.com/windows/configuration/start-layout-troubleshoot/
Download tdlrecover.exe build that matches the Windows NTx operating system(s) 
[OS(es)] build/edition/release/update/version
+ bit strength [32-bit (x86) +/- 64-bit (x64)] you are using:
http://www.pconlife.com/viewfileinfo/tdlrecover-exe/
Copy tdlrecover.exe to %WinDir%\SYSTEM32 (only if not present; do NOT overwrite 
it if present!) from a DOS console (command
prompt) -> right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run this 
command -> press Enter (using default
directory/folder names):
COPY "%UserProfile%\Downloads\tdlrecover.exe" %WinDir%\SYSTEM32
Run... [hold WinKey + press R] -> type:
%WinDir%\SYSTEM32\tdlrecover.exe -reregister -resetlayout -resetcache
-> press Enter.

* FIX: Get back/repair/restore Windows Help Viewer (WinHlp32), Windows Help 
(HLP) + Compiled HTML Help (CHM) functionality
in Windows 10/11 -> see MDGx "Restore/Update HTML Help (.CHM) + Windows Help 
(.HLP) Guides, Fixes + Tools" section in
SOFTWARE.TXT (included):
http://www.mdgx.com/add.htm#HHU
BUG:
****
In all Windows Vista/newer builds/editions/releases/versions you canNOT use 
Windows Help files (*.CNT, *.HLP) because
Microsoft removed Windows Help 32-bit (WinHlp32.exe) from these OSes. :-(
FIX:
****



Windows Help Viewer (WinHlp32) for Windows 10/11 restores Windows Help (HLP) + 
Compiled HTML Help (CHM) functionality:
http://raxsoft.com/raxccm/software_app.php?progid=13
File:
http://assets.raxsoft.com/bin/winhlp32/winhlp32.msi
FYI:
Windows 10/2016/2019/11/2022 MS Help (local) + Get Help (online/remote) canNOT 
function without Edge web browser! :-(
Registry fixes necessary to enable WinHlp32.exe macros, Intranet access + CHM 
(Compiled HTML Help) XML, XSL, CSS, JPG + PNG
functionality:
http://www.vistax64.com/tutorials/87497-help-support-vista.html
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; WinHelp32 Macro FIX for Windows Vista/2008/7/8/8.1 32-bit (x86):
[HKEY_LOCAL_MACHINE\Software\Microsoft\WinHelp]
"AllowProgrammaticMacros"=dword:1
"AllowIntranetAccess"=dword:1
; WinHelp32 Macro FIX for Windows Vista/2008/7/8/8.1 64-bit (x64):
[HKEY_LOCAL_MACHINE\Software\Wow6432Node\Microsoft\WinHelp]
"AllowProgrammaticMacros"=dword:1
"AllowIntranetAccess"=dword:1
; HTML Help (CHM) FIX: XML, XSL, CSS, JPG + PNG for Windows Vista/2008/7/8/8.1:
[HKEY_LOCAL_MACHINE\Software\Classes\.xml]
@="xmlfile"
"Content Type"="text/xml"
"PerceivedType"="text"
[HKEY_LOCAL_MACHINE\Software\Classes\.xml\PersistentHandler]
@="{7E9D8D44-6926-426F-AA2B-217A819A5CCE}"
[HKEY_LOCAL_MACHINE\Software\Classes\.xsl]
@="xslfile"
"Content Type"="text/xml"
"PerceivedType"="text"
[HKEY_LOCAL_MACHINE\Software\Classes\.xsl\PersistentHandler]
@="{7E9D8D44-6926-426F-AA2B-217A819A5CCE}"
[HKEY_LOCAL_MACHINE\Software\Classes\.css]
@="CSSfile"
"Content Type"="text/css"
"PerceivedType"="text"
[HKEY_LOCAL_MACHINE\Software\Classes\.css\PersistentHandler]
@="{eec97550-47a9-11cf-b952-00aa0051fe20}"
[HKEY_LOCAL_MACHINE\Software\Classes\.png]
@="pngfile"
"PerceivedType"="image"
"Content Type"="image/png"
[HKEY_LOCAL_MACHINE\Software\Classes\.png\PersistentHandler]
@="{098f2470-bae0-11cd-b579-08002b30bfeb}"
[HKEY_LOCAL_MACHINE\Software\Classes\.jpg]
@="jpegfile"
"Content Type"="image/jpeg"
"PerceivedType"="image"
[HKEY_LOCAL_MACHINE\Software\Classes\.jpg\OpenWithProgids]
"jpegfile"=""
[HKEY_LOCAL_MACHINE\Software\Classes\.jpg\PersistentHandler]
@="{098f2470-bae0-11cd-b579-08002b30bfeb}"
;



------End cut & paste here------
Microsoft FixIt! WinHlp32.exe tools (English, right-click to save!):
- Enable macros FixIt! after installing WinHlp32.exe [964 KB]:
http://web.archive.org/web/20160314054228if_/http://download.microsoft.com/
download/7/9/5/7955FD19-CE75-477A-A2BE-3B3E8BD20A04/MicrosoftFixit50105.msi
- Unblock .HLP FixIt! after installing WinHlp32.exe [964 KB]:
http://web.archive.org/web/20170610234444if_/http://download.microsoft.com/
download/6/9/F/69FB8CEB-90AA-49EC-ADA5-09EF2A1ACB12/MicrosoftFixit50237.msi
- Windows Update (WU) Error 80070422 .HLP FixIt! after installing WinHlp32.exe 
[1 MB]:
http://web.archive.org/web/20170503080905if_/http://download.microsoft.com/
download/3/5/0/35062C9F-980C-455D-9652-82A4B30888D2/MicrosoftFixit50776.msi

* FIX: Customize Windows 10/11 Taskbar, a.k.a. (system) tray, a.k.a. 
notification area, transparency/translucency/opacity,
appearance, arrangement, dimensions, skin, colors, icons, etc:
http://appuals.com/how-to-make-taskbar-translucent-or-fully-transparent-in-
windows-10/
http://softwarekeep.com/help-center/how-to-make-the-taskbar-transparent-in-
windows-10/
http://www.makeuseof.com/tag/windows-10-taskbar-customization/
http://www.makeuseof.com/customize-your-taskbar-with-taskbarx/
Taskbar tweakers (free, open source):
- 7+ Taskbar Tweaker (7TT) 32-bit + 64-bit (Portable) for Windows 7/newer adds 
hidden + unavailable Taskbar tray settings
beyond Windows capabilities, highly customizable [select Portable at install 
time]:
http://ramensoftware.com/7-taskbar-tweaker/
http://tweaker.ramensoftware.com/
File [Install -> select Portable]:
http://ramensoftware.com/downloads/7tt_setup.exe
7+ Taskbar Tweaker (7TT) Portable:
http://www.portableapps.com/apps/utilitues/7plus-taskbar-tweaker-portable/
7+ Taskbar Tweaker (7TT) Guide:
http://www.winaero.com/get-a-classic-taskbar-in-windows-8-and-windows-7-that-
works-like-xp/
7+ Taskbar Tweaker (7TT) Advanced Settings:
http://tweaker.ramensoftware.com/images/7-taskbar-tweaker.png
7+ Taskbar Tweaker (7TT) Repository:
http://github.com/m417z/7-Taskbar-Tweaker/
7+ Taskbar Tweaker (7TT) Windhawk tweak mods for Windows 11 Taskbar:
http://ramensoftware.com/windhawk-mods-for-the-windows-11-taskbar/
BUG:
7+ Taskbar Tweaker (7TT) does NOT (yet) support NEWer Windows 11 Taskbar:
http://ramensoftware.com/7-taskbar-tweaker-and-a-first-look-at-windows-11/
FIX:
Restore classic Taskbar tray in Windows 11:
http://ramensoftware.com/7-taskbar-tweaker-on-windows-11-with-windows-10s-
taskbar/
http://www.winaero.com/winaero-tweaker-1-20-1-get-back-windows-10-start-menu-
and-taskbar-in-windows-11/
1. Install Winaero Tweaker:
http://www.winaero.com/winaero-tweaker/
2. Open/run/start Winaero Tweaker.
3. Go to: Windows 11 -> Classic Start Menu and Taskbar -> check "Enable Classic 
Taskbar and Start menu" box -> click
"Sign out now" button.
4. Log on/sign in back into Windows 11 under same user name.
5. Open/run/start 7+ Taskbar Tweaker (7TT) -> customize/tweak settings according
to your needs/preferences -> done.
BONUS:
Windhawk customizes/tweaks Windows 10/11 app(lication)s/programs with mods:
http://windhawk.net/
Windhawk Repository:



http://github.com/ramensoftware/windhawk/
Windhawk Mods:
http://windhawk.net/mods/
Windhawk Mods Repository:
http://github.com/ramensoftware/windhawk-mods/
Windhawk Wiki Documentation:
http://github.com/ramensoftware/windhawk/wiki/
- TranslucentTB for Windows 10 makes Taskbar/toolbar tray 100% transparent or 
translucent, highly cutomizable:
http://github.com/TranslucentTB/TranslucentTB/releases/latest/
Requires Microsoft .NET Framework Redistributable (NFR) 4.5/newer:
http://www.mdgx.com/add.htm#NFR
Taskbar Transparency Guide:
http://appuals.com/how-to-make-taskbar-translucent-or-fully-transparent-in-
windows-10/
http://softwarekeep.com/help-center/how-to-make-the-taskbar-transparent-in-
windows-10/
- TaskbarTools for Windows 10 tweaks Taskbar/toolbar tray on all 
desktops/monitors to any color + transparency level:
http://github.com/Elestriel/TaskbarTools/releases/latest/
Requires Microsoft .NET Framework Redistributable (NFR) 4.5/newer:
http://www.mdgx.com/add.htm#NFR
Taskbar Transparency Guide:
http://appuals.com/how-to-make-taskbar-translucent-or-fully-transparent-in-
windows-10/
http://softwarekeep.com/help-center/how-to-make-the-taskbar-transparent-in-
windows-10/
- TaskbarX 32-bit + 64-bit customizes Windows 10 Taskbar/toolbar tray:
http://chrisandriessen.nl/taskbarx
Download:
http://github.com/ChrisAnd1998/TaskbarX/releases/latest/
TaskbarX ReadMe:
http://github.com/ChrisAnd1998/TaskbarX/
TaskbarX Guide:
http://www.makeuseof.com/customize-your-taskbar-with-taskbarx/
Windows 10 Taskbar Customization:
http://www.makeuseof.com/tag/windows-10-taskbar-customization/
- TaskbarCustomizer customizes Windows 10 Taskbar/toolbar tray:
http://github.com/JustIntroverted/TaskbarCustomizer/
Download:
http://github.com/JustIntroverted/TaskbarCustomizer/releases/latest/
Windows 10 Taskbar Customization:
http://www.makeuseof.com/tag/windows-10-taskbar-customization/
- Open-Shell [Classic Shell fork] 32-bit + 64-bit Start Menu + 
button/icon/logo/orb, Explorer + IE enhancer, replacer,
supports custom skins, buttons/logos, highly customizable:
http://open-shell.github.io/Open-Shell-Menu/
ReadMe:
http://github.com/Open-Shell/Open-Shell-Menu/
Download:
http://github.com/Open-Shell/Open-Shell-Menu/releases/
Open-Shell Guides:
http://askleo.com/open-shell-regain-your-start-menu-in-windows-and-much-more/
http://www.techrepublic.com/article/how-to-use-open-shell-as-your-windows-10-
start-menu/

* FIX: NVidia Control Panel Client Missing in Windows 10/11:
http://www.securedyou.com/fix-nvidia-control-panel-missing-client-windows-
solved/
http://thegeekpage.com/nvidia-control-panel-not-showing-in-windows-10/

* FIX: Windows 7/newer NVidia Control Panel optimal settings for 
laptops/notebooks/portables with dual GPUs (most likely DCH
in Windows 10/11) [example: Intel (primary) + NVidia (secondary)] to avoid 



annoying apps/programs/games/savers/etc
(especially web browsers, multimedia 3D/audio/video players/editors/managers, 
image viewers/editors/managers, games, screen
savers) that sometimes (by default) select the wrong, built-in/integrated, least
powerful (Power Saving) graphics processor
(for example Intel) for software hungry for hardware resources, and sometimes 
reset/switch (between) different GPUs/video
modes and reset the active display/monitor unexpectedly, blanking out/flickering
the screen for a few seconds, especially in
the middle of performing critical/essential/vital/important work:
http://i.imgur.com/SZRQoe2.jpg
http://www.howtogeek.com/351522/how-to-choose-which-gpu-a-game-uses-on-windows-
10/
http://www.dell.com/support/kbdoc/en-us/000178995/
http://support.lenovo.com/us/en/solutions/ht071102/
http://www.thewindowsclub.com/optimize-nvidia-control-panel-best-settings-for-
gaming-performance/
NVidia Declarative Componentized Hardware (DCH) [say that 10 times fast! ;-/] 
Graphic Drivers for Windows 10/11:
http://nvidia.custhelp.com/app/answers/detail/a_id/4777/
Windows 10/11 users only:
Right-click an empty spot on your Desktop -> select NVidia Control Panel (most 
likely DCH) or run Windows Settings (WS)
http://www.mdgx.com/WIN10SET.HTM
-> Display -> Run... [hold WinKey + press R] -> type this command:
ms-settings:display
-> press Enter.
All Windows 7/newer users -> go to:
- 3D Settings -> Configure Surround, PhysX -> PhysX settings -> Processor: -> 
GeForce/Quadro/Titan GTX/RTX xxxx/Xyyyy ->
Apply/OK.
- 3D Settings -> Global Settings -> Preferred graphics processor: -> High-
performance NVidia processor -> Apply/OK.
- 3D Settings -> Program settings -> (1) Select a program to customize: -> 
browse to select a program/app/game/tool ->
(2) Select the preferred graphics processor for this program: -> High-
performance NVidia processor (if available or
possible) -> Apply/OK.
- Display -> Adjust Desktop Color Settings -> Content type reported to the 
display: -> Auto-select (recommended) ->
Apply/OK.
- Display -> Adjust Desktop Size and Position -> Size -> Select the desktop 
resize mode reported to the display: ->
Auto-select (recommended) -> Apply/OK.
- Display -> Change Resolution -> (3) Apply the following settings. -> check Use
NVidia color settings box -> Desktop color
depth: -> Highest (32-bit) -> Output color depth: -> 10 bpc (or highest 
avaiable) -> Output color format: -> RGB -> Output
dynamic range: -> Full (0-255) -> Apply/OK.
Run NVidia Control Panel (most likely DCH in Windows 10) app/executable/shortcut
-> Multiple Displays -> press Detect button
-> your monitor name + model/type should appear -> Advanced Display Settings -> 
Choose display -> Select a display to view
or change the settings for it -> Display adapter properties for Display #1 [#2, 
etc, if more than 1] -> Monitor tab ->
Monitor Settings -> Screen refresh rate: -> select highest refresh rate 
available for your monitor from the drop down list
-> Apply/OK.
1st Things 1st:
***************
Make sure you have already upgraded to the current/newest version available of 
the certified/official [not beta!] NVidia
Graphics Driver supported by your NVidia graphics/video card/controller/GPU 
model/(sub)type and your installed Windows NTx



operating system(s) [OS(es)] build/edition/release/update/version + bit strength
[32-bit (x86) +/- 64-bit (x64)]:
http://www.nvidia.com/download/find.aspx
http://www.nvidia.com/download/index.aspx
Only after that...
Windows 10/11 users only:
NVidia Control Panel (DCH) app for Windows 10/11 [free]:
http://www.microsoft.com/p/nvidia-control-panel/9nf8h0h7wmlt/
ms-windows-store://pdp?productId=9nf8h0h7wmlt
http://www.majorgeeks.com/files/details/nvidia_control_panel.html
Intel Graphics Driver (DCH) for Windows 10 [free]:
http://www.intel.com/content/www/us/en/support/articles/000031572/programs/
intel-corporation.html
http://www.intel.com/content/www/us/en/support/articles/000031275/graphics.html
Intel Driver & Support Assistant (DSA):
http://www.intel.com/content/www/us/en/support/detect.html
All Windows 7/newer users:
NVidia Profile Inspector (NPI) forces use of High performance NVidia processor 
on dual GPU laptops/notebooks/portables for
apps/games by modifying NVidia internal driver database profiles and accesses 
hidden/undocumented NVidia driver settings:
http://www.guru3d.com/files-details/nvidia-profile-inspector-download.html
http://github.com/Orbmu2k/nvidiaProfileInspector/
Download:
http://github.com/Orbmu2k/nvidiaProfileInspector/releases/latest/
NVidia Profile Inspector (NPI) Wiki:
http://www.pcgamingwiki.com/wiki/Nvidia_Profile_Inspector

* FIX: NVidia graphics/video (DCH) Drivers install failed + 
(re)install/update/upgrade NVidia graphics/video Drivers in
Windows 10/11:
http://www.ghacks.net/2017/06/30/install-only-the-driver-for-nvidia-graphics-
cards/
http://community.spiceworks.com/topic/2164760-driver-not-compatible-with-
windows-10/
http://www.extremetech.com/gaming/309487-how-to-download-the-nvidia-control-
panel-without-the-microsoft-store/
http://www.iobit.com/en/knowledge-how-to-fix-nvidia-driver-install-failed-and-
update-nvidia-drivers-on-windows-10-152.php
http://in.answers.acer.com/app/answers/detail/a_id/38288/~/windows-10%3A-
disable-signed-driver-enforcement/
NVidia Declarative Componentized Hardware (DCH) Graphic Drivers for Windows 
10/11:
http://nvidia.custhelp.com/app/answers/detail/a_id/4777/
To be able to install NVidia (Standard) Driver [*not* DCH] on most Windows 10/11
installations [may or may not work]:
http://www.reddit.com/r/nvidia/comments/by2k6i/
1. 1st you must UNinstall NVidia (DCH) Driver using 1 of these tools [freeware]:
- Display Driver Uninstaller (DDU):
http://www.guru3d.com/files-details/display-driver-uninstaller-download.html
File:
http://www.guru3d.com/files-get/display-driver-uninstaller-download,19.html
OR:
- NVCleanstall 32-bit + 64-bit:
http://www.techpowerup.com/download/techpowerup-nvcleanstall/
2. Make sure you have already upgraded to the current/newest version available 
of the certified/official [not beta] NVidia
(Standard) Graphics Driver [*not* DCH!] supported by your NVidia graphics/video 
card/controller/GPU model/(sub)type and your
installed Windows NTx operating system(s) [OS(es)] 
build/edition/release/update/version + bit strength [32-bit (x86) +/-
64-bit (x64)]:
http://www.nvidia.com/download/find.aspx
http://www.nvidia.com/download/index.aspx



3. Restart/reboot Windows for all changes to take effect.
4. Run NVidia Control Panel (Standard) executable/shortcut [included with NVidia
(Standard) Driver] -> customize your
graphics/desktop/3D/video/PhysX/program(s)/games/tools/etc settings.
NOTE:
If you wish to install NVidia (DCH) Driver...
NVidia Control Panel (DCH) app for Windows 10/11 [free]:
http://www.microsoft.com/p/nvidia-control-panel/9nf8h0h7wmlt/
ms-windows-store://pdp?productId=9nf8h0h7wmlt
http://www.majorgeeks.com/files/details/nvidia_control_panel.html
Make sure you have already upgraded to the current/newest version available of 
the certified/official [not beta!] NVidia
Graphics Driver supported by your NVidia graphics/video card/controller/GPU 
model/(sub)type and your installed Windows NTx
operating system(s) [OS(es)] build/edition/release/update/version + bit strength
[32-bit (x86) +/- 64-bit (x64)]:
http://www.nvidia.com/download/find.aspx
http://www.nvidia.com/download/index.aspx
Windows 10/11 (DCH) Drivers:
http://www.majorgeeks.com/content/page/what_are_windows_dch_drivers.html
MS DOCs: Windows 10 (DCH) Drivers:
http://learn.microsoft.com/windows-hardware/drivers/develop/dch-principles-best-
practices/

* FIX: Force apps/programs/games/tools to use high performance NVidia GPU 
(Graphics Processing Unit) processor and
play/render video/movie/CD/DVD/BD/UHD/etc multimedia file types properly on 
laptops/notebooks/portables with 2 GPUs [Intel +
NVidia] in Windows 10/11.
Example using Media Player Classic Home Cinema (MPC-HC) multimedia player [MPC-
HC.exe 32-bit or MPC-HC64.exe 64-bit]
installed by K-Lite Codec Pack (KLCP) Mega 32-bit or 64-bit:
http://www.codecguide.com/faq_mpc.htm#item44
http://www.tenforums.com/tutorials/103965-set-preferred-gpu-apps-windows-10-
a.html
K-Lite Codec Pack (KLCP) Mega [free(ware)]:
http://www.codecguide.com/download_k-lite_codec_pack_mega.htm
1. MPC-HC(64) -> pause file playback (if any) -> right-click -> Options (O) -> 
Playback -> Output -> DirectShow Video [H/W]
-> Enhanced Video Renderer (EVR) -> Apply/OK.
http://learn.microsoft.com/windows/win32/directshow/video-mixing-renderer-
filter-9/
2. MPC-HC(64) -> pause file playback (if any) -> click red LAV Video Decoder 
Taskbar icon -> Hardware Acceleration [H/W] ->
Hardware Decoder to use: -> DXVA2 (DirectX Video Acceleration 2) (copy-back) -> 
Hardware Device to use: -> NVidia GeForce
(GTX) xxxx (example) [*only* if your laptop/netbook/notebook/portable is using 
an external connected
display/monitor/screen/TV as *primary* display!] -> check *all* Resolutions + 
Codecs boxes *except* DVD, MPEG-2 + VC-1 ->
Apply/OK.
http://anime.my/tutorials/watching-h264-videos-using-compute-unified-device-
architecture-cuda/
madVR Tutorial:
http://anime.my/tutorials/madvr/
Use NVIDIA Profile Inspector (NPI) -> modify Media Player Classic Home Cinema 
[MPC-HC(64).exe] profile:
http://www.guru3d.com/files-details/nvidia-profile-inspector-download.html
Enable application for Optimus = SHIM_RENDERING_MODE_ENABLE (0x00000001)
1. Copy under a different name or rename your default multimedia video/movie 
player associated with
video/movie/CD/DVD/BD/UHD/etc file types, in this case Media Player Classic Home
Cinema [MPC-HC] executable [MPC-HC.exe
32-bit or MPC-HC64.exe 64-bit] installed by K-Lite Codec Pack (KLCP) Mega 32-bit



or 64-bit,
http://www.codecguide.com/download_k-lite_codec_pack_mega.htm
to something else (example using default KLCP install directories/folders) from 
a DOS console (command prompt) ->
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run 1 of the 
commands below depending on your Windows NTx
edition: 64-bit (x64) or 32-bit (x86) -> press Enter (example):
- Windows NTx 64-bit (x64):
COPY /Y "C:\Program Files (x86)\K-Lite Codec Pack\MPC-HC64\mpc-hc64.exe" "C:\
Program Files (x86)\K-Lite Codec Pack\MPC-HC64\MPC-HC64_NV.exe"
- Windows NTx 32-bit (x86):
COPY /Y "C:\Program Files\K-Lite Codec Pack\MPC-HC\mpc-hc.exe" "C:\Program 
Files\K-Lite Codec Pack\MPC-HC\MPC-HC_NV.exe"
2. Right-click an empty spot on your Desktop -> click NVidia Control Panel -> 
Manage 3D Settings -> Program Settings tab ->
Add button -> Browse... button -> depending on your Windows NTx edition: 64-bit 
(x64) or 32-bit (x86) go to:
- Windows NTx 64-bit (x64):
C:\Program Files (x86)\K-Lite Codec Pack\MPC-HC64\MPC-HC64_NV.exe
- Windows NTx 32-bit (x86):
C:\Program Files\K-Lite Codec Pack\MPC-HC\MPC-HC_NV.exe
-> double-click it -> under Select the preferred graphics processor for this 
program: -> select High-performance NVidia
processor -> Apply/OK button.
3. Make this new MPC-HC(64) executable your new default multimedia player: 
associate it with your
video/movie/CD/DVD/BD/UHD/etc file types from within MPC-HC(64) interface: pause
file playback (if any) -> press O ->
Options -> Player -> Formats -> File extensions -> check/uncheck the boxes 
corresponding to desired audio/video format(s) ->
Apply/OK.

* Customize/Tweak Timeout Detection and Recovery (TDR) registry parameters in 
case NVidia Graphics Driver crashes or freezes
unexpectedly:
http://learn.microsoft.com/windows-hardware/drivers/display/tdr-registry-keys/
http://www.reddit.com/r/battlefield_4/comments/1xzzn4/
http://answers.microsoft.com/en-us/windows/forum/all/registry-fix-for-
videotimeoutdetectionandrecovery/deea25d5-d94a-47f8-a09f-be7ce56d5084/
http://www.pugetsystems.com/labs/hpc/Working-around-TDR-in-Windows-for-a-better-
GPU-computing-experience-777/
http://github.com/MicrosoftDocs/windows-driver-docs/issues/1382/
http://developer.download.nvidia.com/NsightVisualStudio/2.2/Documentation/
UserGuide/HTML/Content/Timeout_Detection_Recovery.htm
http://forum.giga-byte.co.uk/index.php?topic=4547.0
http://www.windowsphoneinfo.com/threads/i-modified-some-registry-keys-to-make-
graphics-card-optimization-without-hanging-on.153714/
1st Things 1st:
***************
1. Make sure you have already upgraded to the current/newest stable version 
available of the certified/official [not beta!]
NVidia Graphics Driver supported by your NVidia graphics/video 
card/controller/GPU model/(sub)type and your installed
Windows NTx operating system(s) [OS(es)] build/edition/release/update/version + 
bit strength [32-bit (x86) +/- 64-bit
(x64)]:
http://www.nvidia.com/download/find.aspx
http://www.nvidia.com/download/index.aspx
2. Backup registry key + its subkeys below:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\GraphicsDrivers
-> see "BACKUP/EXPORT + RESTORE/IMPORT REGISTRY/REGISTRY KEY(S)" chapter
http://www.mdgx.com/7.php#:~:text=BACKUP%2FEXPORT%20%2B%20RESTORE%2FIMPORT
%20REGISTRY%2FREGISTRY%20KEY%28S%29%20%21
in WINDOWS7.TXT (included):



http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
Only after that...
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\GraphicsDrivers]
"TdrLevel"=dword:0
"TdrDdiDelay"=dword:3c
"TdrDebugMode"=dword:3
"TdrDelay"=dword:3c
"TdrLimitTime"=dword:3c
"TdrLimitCount"=dword:3c
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\GraphicsDrivers\
BasicDisplay]
"BasicDisplayUserNotified"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\GraphicsDrivers\DCI]
"Timeout"=dword:3c
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\GraphicsDrivers\TdrWatch]
"TDR_RECOVERY"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\GraphicsDrivers]
"TdrLevel"=dword:0
"TdrDdiDelay"=dword:3c
"TdrDebugMode"=dword:3
"TdrDelay"=dword:3c
"TdrLimitTime"=dword:3c
"TdrLimitCount"=dword:3c
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\GraphicsDrivers\BasicDisplay]
"BasicDisplayUserNotified"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\GraphicsDrivers\DCI]
"Timeout"=dword:3c
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\GraphicsDrivers\TdrWatch]
"TDR_RECOVERY"=dword:1
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\GraphicsDrivers]
"TdrLevel"=dword:0
"TdrDdiDelay"=dword:3c
"TdrDebugMode"=dword:3
"TdrDelay"=dword:3c
"TdrLimitTime"=dword:3c
"TdrLimitCount"=dword:3c
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\GraphicsDrivers\BasicDisplay]
"BasicDisplayUserNotified"=dword:0
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\GraphicsDrivers\DCI]
"Timeout"=dword:3c
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\GraphicsDrivers\TdrWatch]
"TDR_RECOVERY"=dword:1
;
------End cut & paste here------

* FIX: Repair JPEG files (.jpe, .jpeg, .jpg) downloading as JFIF files 
(.jfi, .jfif, .jif) error in Windows 10/newer:
http://www.thinkmutoh.com/fix-for-windows-10-jpg-files-download-as-jfif/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain



text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\MIME\Database\Content Type\image/jpeg]
"Extension"=".jpg"
[HKEY_CURRENT_USER\Software\Classes\MIME\Database\Content Type\image/jpeg]
"Extension"=".jpg"
[HKEY_USERS\.DEFAULT\Software\Classes\MIME\Database\Content Type\image/jpeg]
"Extension"=".jpg"
;
------End cut & paste here------
Wikipedia: JPEG Files:
http://en.wikipedia.org/wiki/JPEG#JPEG_files
Wikipedia: JFIF Files:
http://en.wikipedia.org/wiki/JPEG_File_Interchange_Format

* FIX: Repair/Restore original (classic) Windows 7/8/8.1/10 Folder (File 
Explorer) Options (General) View tab settings
(registry values) in Windows 11:
http://www.winaero.com/how-to-change-file-explorer-options-in-the-registry/
File [PowerShell (.ps1) BATch scripts]:
http://www.winaero.com/downloads/2023/06/restore-classic-folder-options.zip
1. Use an unZIPping/unARChiving/unRARing tool [free(ware)]
http://www.mdgx.com/toy.htm#ZIP
to open "restore-classic-folder-options.zip" archive and extract "restore-
checkboxes.ps1" into a dedicated/empty
directory/folder.
2. Open Explorer/similar/replacement -> right-click "restore-checkboxes.ps1" -> 
Run as Administrator -> wait for PowerShell
BATch script file completion -> exit/quit PowerShell command line console.
3. Done.
Execute/launch/open/run/start Folder (File Explorer) Options (General) View tab 
to verify original settings have been
restored: from a DOS console command prompt [%WinDir%\SYSTEM32\CMD.EXE]: right-
click CMD shortcut/CMD.EXE -> Run as
Administrator -> run this command CONTROL.EXE folders
OR this command
RUNDLL32.EXE SHELL32.DLL,Options_RunDLL 0
-> press Enter.

* Change/Replace Windows 10/11 Start button/icon/logo/orb using Open-Shell 
[Classic Shell fork] (free, open source):
http://askleo.com/open-shell-regain-your-start-menu-in-windows-and-much-more/
Download:
http://github.com/Open-Shell/Open-Shell-Menu/releases/
Custom Start button/icon/logo/orb Tutorial:
http://coddec.github.io/Classic-Shell/www.classicshell.net/tutorials/
buttontutorial.html
Start Buttons/Orbs:
http://www.classicshell.net/forum/viewforum.php?f=18
http://www.deviantart.com/w1ck3dmatt/art/Mega-Orb-Pack-150-start-orbs-259940654/
http://www.door2windows.com/customization/start-buttons/

* Turn OFF Aero Snap [align (all) open window(s) with screen margins] + Aero 
Shake [minimize (all) open window(s)] Desktop
features in Windows 7/newer:
http://www.winaero.com/enable-or-disable-aero-shake-in-windows-10-with-these-
methods/
http://www.winaero.com/disable-aero-snap-windows-10/
http://www.winaero.com/disable-snapping-in-windows-10-but-keep-other-extended-
window-management-options/
http://www.askvg.com/how-to-disable-aerosnap-in-windows-7/



TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"DisallowShaking"=dword:1
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"DisallowShaking"=dword:1
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"DisallowShaking"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"NoWindowMinimizingShortcuts"=dword:1
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"NoWindowMinimizingShortcuts"=dword:1
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"NoWindowMinimizingShortcuts"=dword:1
[HKEY_CURRENT_USER\Control Panel\Desktop]
"DockMoving"="0"
"WindowArrangementActive"="0"
[HKEY_USERS\.DEFAULT\Control Panel\Desktop]
"DockMoving"="0"
"WindowArrangementActive"="0"
;
------End cut & paste here------

* Turn ON Aero Snap [align (all) open window(s) with screen margins] + Aero 
Shake [minimize (all) open window(s)] Desktop
features in Windows 7/newer:
http://www.winaero.com/enable-or-disable-aero-shake-in-windows-10-with-these-
methods/
http://www.winaero.com/disable-aero-snap-windows-10/
http://www.winaero.com/disable-snapping-in-windows-10-but-keep-other-extended-
window-management-options/
http://www.askvg.com/how-to-disable-aerosnap-in-windows-7/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"DisallowShaking"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"DisallowShaking"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"DisallowShaking"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Explorer]
"NoWindowMinimizingShortcuts"=dword:0
[HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer]
"NoWindowMinimizingShortcuts"=dword:0
[HKEY_USERS\.DEFAULT\Software\Policies\Microsoft\Windows\Explorer]
"NoWindowMinimizingShortcuts"=dword:0



[HKEY_CURRENT_USER\Control Panel\Desktop]
"DockMoving"="1"
"WindowArrangementActive"="1"
[HKEY_USERS\.DEFAULT\Control Panel\Desktop]
"DockMoving"="1"
"WindowArrangementActive"="1"
;
------End cut & paste here------

* Turn OFF Online Tips and Help for Windows Settings (WS) a.k.a. Immersive 
Control Panel (ICP) a.k.a. native Control Panel
in Windows 10/11:
http://www.tenforums.com/tutorials/99351-enable-disable-online-tips-help-
settings-app-windows-10-a.html
http://www.ghacks.net/2018/01/22/disable-online-tips-and-videos-in-the-windows-
10-settings-app/
http://appuals.com/disable-online-tips-in-windows-settings-app/
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.ControlPanel::AllowOnlineTips
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\PolicyManager\default\Settings\
AllowOnlineTips]
"value"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"AllowOnlineTips"=dword:0
;
------End cut & paste here------

* Turn ON Balloon/Info/Popup Tips, Taskbar Badges for buttons/icons, Taskbar 
Large Icons, Taskbar Animations, Hidden + Super
Hidden files/folders + Show All Folders in Explorer/similar tools, Hidden File 
Extensions (*.ext) + turn OFF Aero Shake +
Aero Snap to prevent annoying 
behind-your-back/out-of-the-blue/unexpected/unwanted aligning + minimizing of 
(all) open
window(s) in Windows 7/newer:
http://www.tenforums.com/tutorials/48186-taskbar-buttons-hide-show-badges-
windows-10-a.html
http://www.groovypost.com/howto/windows-8-7-disable-notification-balloons-
taskbar/
http://www.howtogeek.com/howto/windows-vista/disable-all-notification-balloons-
in-windows-vista/
http://www.heelpbook.net/2019/windows-10-disable-notifications-and-
notifications-balloons/
http://www.technorms.com/24581/
http://www.tenforums.com/tutorials/4417-how-enable-disable-aero-shake-windows-
10-a.html
http://www.winaero.com/enable-or-disable-aero-shake-in-windows-10-with-these-
methods/
http://www.tenforums.com/tutorials/62842-hide-show-file-name-extensions-windows-
10-a.html
http://www.howtogeek.com/howto/windows-7/disable-aero-shake-in-windows-7/
http://www.tenforums.com/tutorials/7078-turn-off-show-all-folders-windows-10-
navigation-pane.html
http://www.winaero.com/navigation-pane-show-folders-windows-10/



http://www.thewindowsclub.com/turn-on-off-show-all-folders-explorer-navigation-
pane/
http://www.ss64.com/nt/syntax-reghacks.html
Start -> Control Panel (CP) or Run... [hold WinKey + press R] -> type:
control.exe
-> press Enter -> File (Win10/11)/Windows (Win7/8/8.1) Explorer Options -> View 
tab -> check/uncheck the boxes corresponding
to desired settings -> Apply/OK.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"DisallowShaking"=dword:1
"EnableBalloonTips"=dword:1
"IconsOnly"=dword:0
"ShowSuperHidden"=dword:1
"Hidden"=dword:1
"HideFileExt"=dword:0
"NavPaneShowAllFolders"=dword:1
"ShowInfoTip"=dword:1
"SuperHidden"=dword:1
"StartButtonBalloonTip"=dword:2
"TaskbarAnimations"=dword:1
"TaskbarBadges"=dword:1
"TaskbarSmallIcons"=dword:0
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]
"DisallowShaking"=dword:1
"EnableBalloonTips"=dword:1
"IconsOnly"=dword:0
"ShowSuperHidden"=dword:1
"Hidden"=dword:1
"HideFileExt"=dword:0
"NavPaneShowAllFolders"=dword:1
"ShowInfoTip"=dword:1
"SuperHidden"=dword:1
"StartButtonBalloonTip"=dword:2
"TaskbarAnimations"=dword:1
"TaskbarBadges"=dword:1
"TaskbarSmallIcons"=dword:0
[HKEY_USERS\.DEFAULT\Software\Microsoft\Windows\CurrentVersion\Explorer\
Advanced]
"DisallowShaking"=dword:1
"EnableBalloonTips"=dword:1
"IconsOnly"=dword:0
"ShowSuperHidden"=dword:1
"Hidden"=dword:1
"HideFileExt"=dword:0
"NavPaneShowAllFolders"=dword:1
"ShowInfoTip"=dword:1
"SuperHidden"=dword:1
"StartButtonBalloonTip"=dword:2
"TaskbarAnimations"=dword:1
"TaskbarBadges"=dword:1
"TaskbarSmallIcons"=dword:0
;
------End cut & paste here------



* Turn OFF Clipboard Experience, Sync + annoying Clipboard Warnings in Windows 
10/11:
http://www.tenforums.com/tutorials/110048-enable-disable-clipboard-sync-across-
devices-windows-10-a.html
http://pureinfotech.com/disable-clipboard-windows-10/
http://pureinfotech.com/sync-clipboard-across-devices-windows-10/
http://www.winaero.com/enable-disable-clipboard-history-windows-10/
Access Clipboard settings: Run... [hold WinKey + press R] -> type this command:
ms-settings:clipboard
-> press Enter -> Sync across devices [must be logged/signed in with Microsoft 
Azure/Bing/Hotmail/Live/MSN/Microsoft
Start/Outlook/Windows Mail/WIP 
e-mail/membership/subscription/enrollment/developer/tester/trial/VIP account!] -
> check
"Never automatically sync text that I copy" box -> turn OFF "Sync across 
devices" ON/OFF toggle switch.
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\System]
"AllowCrossDeviceClipboard"=dword:0
;
------End cut & paste here------
NOTE:
These settings do NOT apply to Microsoft/3rd party Office/Excel/Outlook/other 
apps/programs!

* Turn OFF Mobile Hotspot activation [disable Turn on remotely] + Remote 
Assistance from another/remote computer/device in
Windows 10:
http://www.tenforums.com/tutorials/128415-enable-disable-turn-mobile-hotspot-
remotely-windows-10-a.html
http://www.winaero.com/enable-or-disable-turn-on-mobile-hotspot-remotely-in-
windows-10/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
; * Turn OFF remote assistance:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Remote Assistance]
"CreateEncryptedOnlyTickets"=dword:1
"fAllowFullControl"=dword:0
"fAllowToGetHelp"=dword:0
"fEnableChatControl"=dword:0
"MaxTicketExpiry"=dword:0
"MaxTicketExpiryUnits"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet001\Control\Remote Assistance]
"CreateEncryptedOnlyTickets"=dword:1
"fAllowFullControl"=dword:0
"fAllowToGetHelp"=dword:0
"fEnableChatControl"=dword:0



"MaxTicketExpiry"=dword:0
"MaxTicketExpiryUnits"=dword:0
[HKEY_LOCAL_MACHINE\SOFTWARE\System\ControlSet002\Control\Remote Assistance]
"CreateEncryptedOnlyTickets"=dword:1
"fAllowFullControl"=dword:0
"fAllowToGetHelp"=dword:0
"fEnableChatControl"=dword:0
"MaxTicketExpiry"=dword:0
"MaxTicketExpiryUnits"=dword:0
; * Turn OFF remote mobile hotspot activation:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WcmSvc\Tethering]
"RemoteStartupDisabled"=dword:1
;
------End cut & paste here------
See also "Tweaks, Hacks + Fixes... UNconventional, UNdocumented, UNcensored ;-/"
section -> "* Turn OFF/disable Remote
Assistance, Remote (Auto) Connection Manager, Remote Registry, Remote Management
(WinRM) + uninstall Quick Assist in Windows
10/11:" topic further above:
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT

* Turn ON Windows 10/11 Developer Mode to allow to install/use all safe/signed 
UWP (Universal Windows Platform) apps from
all sources, including those located on local/removable/remote media/storage, 
not exclusively restricted to the ones from
Microsoft store:
http://www.tenforums.com/tutorials/30136-turn-off-developer-mode-windows-10-
a.html
http://techcult.com/enable-or-disable-developer-mode-in-windows-10/
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Appx::AppxDeploymentAllowAllT
rustedApps
http://admx.help/?
Category=Windows_10_2016&Policy=Microsoft.Policies.Appx::AllowDevelopmentWithout
DevLicense
http://learn.microsoft.com/windows/apps/get-started/developer-mode-features-and-
debugging/
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Appx]
"AllowAllTrustedApps"=dword:1
"AllowDevelopmentWithoutDevLicense"=dword:1
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\AppModelUnlock]
"AllowAllTrustedApps"=dword:1
"AllowDevelopmentWithoutDevLicense"=dword:1
;
------End cut & paste here------

* Turn OFF Background Activity Moderator (BAM) [%WinDir%\SYSTEM32\Drivers\
bam.sys] + Desktop Activity Moderator (DAM)
[%WinDir%\SYSTEM32\Drivers\dam.sys] monitor drivers, especially if not using a 
laptop/netbook/notebook/portable, and don't
need to save battery power in Windows 10/11:
http://www.cellebrite.com/en/analyzing-program-execution-windows-artifacts/
http://www.andreafortuna.org/2018/05/23/forensic-artifacts-evidences-of-program-



execution-on-windows-systems/
http://batcmd.com/windows/10/services/bam/
http://www.crowdstrike.com/blog/how-to-employ-featureusage-for-windows-10-
taskbar-forensics/
http://learn.microsoft.com/windows/compatibility/desktop-activity-moderator/
http://batcmd.com/windows/10/services/dam/
Disable these 2 drivers (running as services) from a DOS console (command 
prompt) -> right-click CMD shortcut/CMD.EXE ->
Run as Administrator -> run these commands -> press Enter after each line:
ECHO Y|NET.EXE STOP bam
SC.EXE CONFIG bam START= disabled
ECHO Y|NET.EXE STOP dam
SC.EXE CONFIG dam START= disabled
OR:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\bam]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\bam]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\bam]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\dam]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\dam]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\dam]
"Start"=dword:4
;
------End cut & paste here------
Restart/reboot Windows for all changes to take effect.

* Turn OFF Windows 10 Live/Metro/Screen/Start/Tile (Store) UWP (Universal 
Windows Platform) battery info fly-out (pop-up) +
restore Windows 8/8.1 (classic) battery info interface for 
laptops/notebooks/portables/tablets/devices:
http://www.askvg.com/collection-of-windows-10-hidden-secret-registry-tweaks/
#8_disable_new_battery_fly-out_and_restore_previous_ui
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\ImmersiveShell]
"UseWin32BatteryFlyout"=dword:1
;
------End cut & paste here------

* Turn OFF Microsoft Application Virtualization [App-V] services + drivers
- Microsoft App-V Client [AppVClient]
http://batcmd.com/windows/10/services/appvclient/



- Microsoft App-V VFS Mini-Filter Driver [AppvVfs]
http://batcmd.com/windows/10/services/appvvfs/
- Microsoft App-V Virtual Environment Manager Driver [AppvVemgr]
http://batcmd.com/windows/10/services/appvvemgr/
- Microsoft App-V Streaming Mini-Filter Driver [AppvStrm]
http://batcmd.com/windows/10/services/appvstrm/
in Windows 10/11 if not using any virtual(ly) deployed/streaming client 
apps/games/tools +/- cloud/server apps/games/tools
in connected/linked/networked/shared environments:
http://learn.microsoft.com/windows/application-management/app-v/appv-for-
windows/
http://learn.microsoft.com/powershell/module/appvclient/
http://learn.microsoft.com/microsoft-desktop-optimization-pack/
http://en.wikipedia.org/wiki/Microsoft_App-V
Disable AppVClient service and these 3 App-V drivers (running as services) from 
a DOS console (command prompt) ->
right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
ECHO Y|NET.EXE STOP AppVClient
SC.EXE CONFIG AppVClient START= disabled
ECHO Y|NET.EXE STOP AppvStrm
SC.EXE CONFIG AppvStrm START= disabled
ECHO Y|NET.EXE STOP AppvVemgr
SC.EXE CONFIG AppvVemgr START= disabled
ECHO Y|NET.EXE STOP AppvVfs
SC.EXE CONFIG AppvVfs START= disabled
OR:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[-HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\AppVClient\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\AppVClient]
"LaunchProtected"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\AppVClient\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\AppVClient]
"LaunchProtected"=dword:0
"Start"=dword:4
[-HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\AppVClient\Security]
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\AppVClient]
"LaunchProtected"=dword:0
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\AppvStrm]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\AppvStrm]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\AppvStrm]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\AppvVemgr]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\AppvVemgr]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\AppvVemgr]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\AppvVfs]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\AppvVfs]



"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\AppvVfs]
"Start"=dword:4
;
------End cut & paste here------

* Turn OFF BranchCache [PeerDistSvc] service present and enabled (Manual) only 
in Windows 10 Enterprise + Windows
2016/2019/2022 Server editions, unnecessary and not used by home/personal/stand-
alone computers/devices/portables/terminals
not connected to or using Wide Area Network (WAN)/data center/cloud/enterprise 
server(s):
http://learn.microsoft.com/windows-server/networking/branchcache/branchcache/
http://searchenterprisedesktop.techtarget.com/definition/Microsoft-Windows-
BranchCache/
Disable BranchCache [PeerDistSvc] service from a DOS console (command prompt) ->
right-click CMD shortcut/CMD.EXE ->
Run as Administrator -> run these commands -> press Enter after each line:
ECHO Y|NET.EXE STOP PeerDistSvc
SC.EXE CONFIG PeerDistSvc START= disabled
OR:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
REGEDIT4
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\PeerDistSvc]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\PeerDistSvc]
"Start"=dword:4
[HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\PeerDistSvc]
"Start"=dword:4
;
------End cut & paste here------

* Remove/uninstall Windows 10/11 built-in/store UWP (Universal Windows Platform)
apps:
http://www.addictivetips.com/windows-tips/remove-default-windows-10-apps-using-
powershell/
Uninstall all UWP apps for all users (example): right-click PowerShell shortcut 
or
C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\PowerShell.exe [default location in 
Windows 10/11] -> Run as Administrator ->
run this command -> press Enter:
Get-AppXPackage -AllUsers | Remove-AppXPackage

* Download/install free UWP (Universal Windows Platform) apps + games from 
Windows Store without the need for a Microsoft
Azure/Bing/Hotmail/Live/MSN/Microsoft Start/Outlook/Windows Mail/WIP
e-mail/membership/subscription/enrollment/developer/tester/trial/VIP account(s),
and instead using better/local/3rd party/no
ads/no tracking/no phone-home/no spam/safe/secure account(s):
http://www.digitalcitizen.life/microsoft-store-without-microsoft-account/
http://www.ghacks.net/2016/11/27/windows-10-pro-store-apps-installation-without-
account/
http://www.ghacks.net/2015/06/13/how-to-enable-developer-mode-in-windows-10-to-
sideload-apps/

* Restore/reinstall manually Windows Store app + Windows 10/11 built-in UWP 



(Universal Windows Platform) apps:
http://www.winhelponline.com/blog/restore-windows-store-windows-10-uninstall-
with-powershell/
Right-click PowerShell shortcut or C:\WINDOWS\SYSTEM32\WindowsPowerShell\v1.0\
PowerShell.exe [default location in Windows
10/11] -> Run as Administrator -> run this command -> press Enter:
Get-AppXPackage -AllUsers Microsoft.WindowsStore | Foreach {Add-AppXPackage -
DisableDevelopmentMode -Register "$($_.InstallLocation)\AppXManifest.xml"}
Windows Store app Uniform Resource Identifier (URI):
http://www.microsoft.com/p/microsoft-store/9wzdncrfjbmp/
Windows Store app product identification (ID) URI:
ms-windows-store://pdp?productId=9wzdncrfjbmp
Paste Windows Store app URI and/or desired UWP app URI
http://www.microsoft.com/p/microsoft-store/xxxxxxxxxxxxxx
or product identification ID URI
ms-windows-store://pdp?productId=xxxxxxxxxxxxxx
in the search box at this web site:
http://store.rg-adguard.net/
to download all required app components listed for your specific Windows 10/11 
build/edition/release/update/version + bit
strength -> (double-)click *.appx and/or *.appxbundle file(s) to (re)install 
desired Windows Store/UWP app(s) -> log back
into or restart Windows if prompted to do so. You can also extract the entire 
contents of any downloaded *.appx/*.appxbundle
archive using an unZIPping/unARChiving/unRARing tool [free(ware)]
http://www.mdgx.com/toy.htm#ZIP
anywhere on your local storage drives/partitions/volumes, and copy file(s) 
necessary for proper function of selected app(s)
to desired location(s).

* Turn OFF/disable/remove [or turn (back) ON/(re)enable/restore] 
unnecessary/useless "Cast to Device >" item/option from the
Desktop, Explorer, Start Menu + user interface (UI) right-click shell context 
menus in Windows 10/11:
http://www.tenforums.com/tutorials/61525-how-add-remove-cast-device-context-
menu-windows-10-a.html
- Turn OFF "Cast to Device >" right-click item:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 
delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
; Turn OFF "Cast to Device >" right-click item:
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Shell Extensions\
Blocked]
"{7AD84985-87B4-4a16-BE58-8B72A5B390F7}"="Play to Menu"
;
------End cut & paste here------
OR do this from a DOS console (command prompt) -> right-click CMD 
shortcut/CMD.EXE -> Run as Administrator -> run this
command -> press Enter:
REG.EXE ADD "HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Shell Extensions\
Blocked" /V {7AD84985-87B4-4a16-BE58-8B72A5B390F7} /T REG_SZ /D "Play to 
Menu" /F
- Turn ON "Cast to Device >" right-click item:
TIP:
Use Notepad/similar/better free(ware) plain text/ASCII editor/viewer
http://www.mdgx.com/toy.htm#TXT
to create a plain text Registry file containing the lines between Cut & Paste 



delimiters below -> save it as plain
text/ASCII file (Encode: -> ANSI) with the REG extension (.reg) -> right-click 
it -> Run as Administrator -> answer Yes/OK
to all prompts to register/merge/import its information into your registry.
-----Begin cut & paste here-----
; Turn ON "Cast to Device >" right-click item:
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Shell Extensions\
Blocked]
"{7AD84985-87B4-4a16-BE58-8B72A5B390F7}"=-
;
------End cut & paste here------
OR do this from a DOS console (command prompt) -> right-click CMD 
shortcut/CMD.EXE -> Run as Administrator -> run this
command -> press Enter:
REG.EXE DELETE "HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Shell Extensions\
Blocked" /V {7AD84985-87B4-4a16-BE58-8B72A5B390F7} /F
In order to take effect all these changes require to either:
- (1) Log off + (2) Log back in as the same user;
- OR (1) exit/kill + (2) restart Explorer [EXPLORER.EXE]: from a DOS console 
(command prompt) -> right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> run these commands -> press Enter 
after each line:
TASKKILL.EXE /IM explorer.exe /F /T
explorer.exe
Reg [REG.EXE] + TaskKill [TASKKILL.EXE] are both located in the %WinDir%\
SYSTEM32 directory/folder [%WinDir% = usually
C:\WINDOWS].
TASKKILL.EXE:
http://www.ss64.com/nt/taskkill.html
REG.EXE:
http://www.ss64.com/nt/reg.html
Explorer [explorer.exe] is located in the %WinDir% directory/folder [%WinDir% = 
usually C:\WINDOWS].

* Windows 10/11 ScriptRunner [ScriptRunner.exe] built-in DOS console command 
line tool can be used to run multiple BATch
(.bat), CoMmanD (.cmd), PowerShell (.ps1), VBScript (.vbs), etc plain text/ASCII
based scripts for automated/unattended
operations:
http://www.ss64.com/nt/scriptrunner.html
ScriptRunner [ScriptRunner.exe] is located in the %WinDir%\SYSTEM32 
directory/folder [where %WinDir% = usually C:\WINDOWS].
View its command line options, switches + parameters: from a DOS console 
(command prompt) -> right-click CMD
shortcut/CMD.EXE -> Run as Administrator -> run this command -> press Enter:
ScriptRunner.exe

* Useful, little known, hidden, undocumented, unknown registry + system hacks + 
tweaks to fix, improve + customize
Windows 10/11 + Windows Server 2016/2019/2022:
http://cloudblogs.microsoft.com/industry-blog/en-gb/technetuk/2016/07/15/13-
epic-registry-hacks/
http://www.howtogeek.com/669971/the-top-10-best-registry-hacks-for-windows-10/
http://www.maketecheasier.com/windows-10-registry-hacks/
http://www.bleepingcomputer.com/news/microsoft/useful-registry-hacks-to-
optimize-your-windows-10-experience/
http://supertechman.com.au/12-awesome-windows-10-registry-hacks/
http://technicalustad.com/a-complete-guide-to-windows-10-registry-tweaks/
http://www.askvg.com/collection-of-windows-10-hidden-secret-registry-tweaks/
AskVG Windows 10 registry (.reg) tweaks [ZIP]:
http://media.askvg.com/downloads/2015/01/Windows-10-Hidden-Secret-Registry-
Tweaks.zip
http://www.ss64.com/nt/syntax-reghacks.html



http://techwiser.com/windows-registry-hacks/
http://www.majorgeeks.com/files/details/majorgeeks_registry_tweaks.html
http://github.com/MajorGeek/MajorGeeks-Windows-Tweaks/
http://www.majorgeeks.com/mg/sortdate/majorgeeks_registry_batch_file_tweaks.html
http://www.online-tech-tips.com/windows-10/10-awesome-windows-8-registry-hacks-
you-might-not-know/
http://www.iolosystem.com/resources/registry-hacks.html
http://www.minitool.com/backup-tips/windows-10-registry-hacks.html
http://gist.github.com/JohannesMP/6a273e96054f47b8501acf99138c792b/
http://windows101tricks.com/windows-10-registry-tweaks-enable-hidden-features/
http://www.winaero.com/category/windows-11/
http://www.winaero.com/category/windows-10/
http://www.itpro.com/microsoft-windows/31970/the-best-registry-hacks-for-fixing-
annoying-windows-features/
http://www.intowindows.com/category/windows-11/
http://www.intowindows.com/category/windows-10/
http://www.webnots.com/10-registry-hacks-for-windows-10/
http://www.shareus.com/windows/five-useful-registry-tweaks-for-gaming-
performance-windows-10.html
http://blogs.systweak.com/best-windows-10-registry-hacks-to-optimize-your-pc/
http://www.techradar.com/news/software/operating-systems/20-registry-hacks-to-
make-your-pc-more-awesome-590803/
http://www.windowschimp.com/best-registry-hacks/
http://lifehacker.com/tag/registry-tweak/
http://github.com/brianfgonzalez/Scripts/blob/master/windows_10_tweaks.bat
http://www.howto-connect.com/registry-hacks-for-start-menu-and-taskbar-in-
windows-10/
http://www.wikitechy.com/tutorials/ethical-hacking/registry-hacking/
http://www.makeuseof.com/tag/5-windows-10-registry-tweaks-improve-unlock-
features/
http://www.techrepublic.com/article/how-to-hack-the-windows-registry-to-insert-
control-panel-into-the-desktop-right-click-menu/
http://spyboy.blog/2020/03/27/windows-10-registry-hacks-to-optimize-your-pc-
experience/
http://www.techrepublic.com/blog/10-things/10-common-issues-you-can-fix-with-a-
registry-hack/
http://www.der-windows-papst.de/en/2019/01/08/datenschutz-fuer-windows-10-
registry-hacks/
http://appuals.com/how-to-change-or-customize-system-tray-icons-on-windows-10/
http://www.windowscentral.com/how-hide-entire-drive-prying-eyes-windows-10/
http://woshub.com/windows11/
http://woshub.com/windows-10/
MDGx "Comprehensive Windows Registry Guide" chapter in REGISTRY.TXT (included):
http://www.mdgx.com/reg.htm
MDGx "200+ Ways To Hack Your Windows 9x/NTx Registry" chapter in REGISTRY.TXT 
(included):
http://www.mdgx.com/reg.htm#RHC
MDGx "Tweaked Windows 10/11 Services + Drivers" [Experimental!] in SERVCS10.TXT 
(included):
http://www.mdgx.com/servcs10.php
http://www.mdgx.com/SERVCS10.TXT
MDGx "Windows 8/8.1 Tweaks, Fixes, Guides, Downloads + Links" chapter in 
WINDOWS8.TXT (included):
http://www.mdgx.com/8.php
http://www.mdgx.com/WINDOWS8.TXT
MDGx "Windows 7/7 SP1 Tweaks, Fixes, Guides, Downloads + Links" chapter in 
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php
http://www.mdgx.com/WINDOWS7.TXT
NOTE:
Some of these hacks + tweaks apply also to Windows 7, 8, 8.1.

* Transform Windows 10/11 interface to look + act like Windows 7, 8, or 8.1:
http://www.howtogeek.com/277448/how-to-make-windows-10-look-and-act-more-like-



windows-7/
http://www.pcmag.com/how-to/how-to-make-windows-10-feel-more-like-windows-7/
http://www.digitaltrends.com/computing/how-to-make-windows-10-look-like-windows-
7/
http://www.winaero.com/blog/how-to-restore-the-good-old-task-manager-in-windows-
8/
See also WINDOWS8.TXT (included):
http://www.mdgx.com/8.php
http://www.mdgx.com/WINDOWS8.TXT
See also: "AERO 7/8/8.1/10/11", "APPS 7", "TASK" + "GAMES" sections in TOOLS.TXT
(included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT

* Windows 10/11 native System (machine wide, all users) + User (only 
current/logged on user) icons are contained in these
applets (.cpl)/libraries (.dll)/executables (.exe)/files 
(.bmp, .gif, .icl, .ico, .jpg, .png + other icon/image formats):
http://www.digitalcitizen.life/where-find-most-windows-10s-native-icons/
http://www.tenforums.com/tutorials/8879-change-library-icon-windows-10-a.html
Extract them using IconsExtract 32-bit CPL, DLL + EXE icon grabber/extractor 
front end GUI + console command line tool:
http://www.nirsoft.net/utils/iconsext.html
File:
http://www.nirsoft.net/utils/iconsext.zip
MDGx Free(ware) GIF, JPEG, PNG Shrinkers/Converters/Editors:
http://www.mdgx.com/html.htm#GIF
MDGx Free(ware) Icon Tools:
http://www.mdgx.com/toy.htm#ICO
MDGx 223 Windows 9x/NTx Icons (.DLL, .ICL + .ICO formats, 32x32, 16 colors) -> 
MYICONS.TXT (included):
MYICONS.ZIP [ZIP]:
http://www.mdgx.com/files/MYICONS.ZIP
Convert Icon (.ico) file format to Portable Network Graphics (PNG) (.png) file 
format:
http://cloudconvert.com/ico-to-png/
Convert Portable Network Graphics (PNG) (.png) file format to Icon (.ico) file 
format:
http://png2icojs.com/

* Coulda... Shoulda... Woulda...
Operating system (OS) core/system features, functionality, operations, processes
+/- programs/tools/games/etc
abandoned/banned/cancelled/changed/deprecated/discontinued/limited//obsolete/
reduced/removed/restricted by Microsoft
in/from/out of Windows 10/11, and how to adapt/fix/port/repair/restore/upgrade, 
use better/similar, and/or work around/bring
back/restore (some of) them:
- Wikipedia: List of features removed in Windows 11:
http://en.wikipedia.org/wiki/List_of_features_removed_in_Windows_11
- Windows 11 Criticism:

- Wikipedia: Windows 11 Launch:
http://en.wikipedia.org/wiki/Windows_11#Launch
- PC Magazine: The 10 Worst Things About Windows 11:
http://www.pcmag.com/news/the-10-worst-things-about-windows-11/
- PC World: Windows 11 review: An unnecessary replacement for Windows 10:
http://www.pcworld.com/article/539183/windows-11-review-an-unnecessary-

replacement-for-windows-10.html
- TechTimes: Windows 11 Received Harsh Criticism Without Even Launching:
http://www.techtimes.com/articles/261841/20210623/windows-11-received-

harsh-criticism-without-even-launching.htm
- Ars Technica: Windows 11 has made the "clean Windows install" an 

oxymoron:
http://arstechnica.com/gadgets/2023/08/windows-11-has-made-the-clean-



windows-install-an-oxymoron/
- MS Docs: Features and functionality removed in Windows client:
http://learn.microsoft.com/windows/whats-new/removed-features/
- MS Docs: Deprecated features for Windows client:
http://learn.microsoft.com/windows/whats-new/deprecated-features/
- Wikipedia: List of features removed/missing in Windows 10:
http://en.wikipedia.org/wiki/List_of_features_removed_in_Windows_10
- How-To Geek: All the Useless Windows 10 Features Microsoft Should Remove:
http://www.howtogeek.com/437942/all-the-useless-windows-10-features-microsoft-
should-remove/
- TheWindowsClub: List of features removed or deprecated in Windows 10:
http://www.thewindowsclub.com/features-removed-in-windows-10/
- TheWindowsClub: Windows 10 Problems, Issues with Solutions and Fixes:
http://www.thewindowsclub.com/windows-10-known-issues/
- gHacks: Windows 10 Creators Update: new and removed features:
http://www.ghacks.net/2017/03/28/windows-10-creators-update-new-and-removed-
features/
- Wikipedia: Criticism of Windows 10:
http://en.wikipedia.org/wiki/Criticism_of_Windows_10
- PC Magazine: Fix the Most Annoying Things in Windows 10:
http://www.pcmag.com/how-to/how-to-fix-the-most-annoying-things-in-windows-10/
- MDGx Free(ware) "Win10/11 Block Tools (10_BLOCK)" -> 10_BLOCK.TXT (included):
http://www.mdgx.com/xptoy.htm#10BLK
http://www.mdgx.com/10BLK/10_BLOCK.php
http://www.mdgx.com/10BLK/10_BLOCK.TXT
- MDGx Free(ware) "List of Useful Windows NTx Tools" [apps/programs, games, 
screen savers, tools/utilities] -> TOOLS.TXT
(included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT
- MDGx Free(ware) "1000+ Windows 9x/NTx Power Toys + Tweaking Tools" -> 
SOFTWARE.TXT (included):
http://www.mdgx.com/toy.htm
- MDGx "Free(ware) Windows NTx Extras" -> SOFTWARE.TXT (included):
http://www.mdgx.com/xptoy.htm
______________________________________________________________________________

Essential Add-ons, Components, Fixes, Updates, Tools + Games [free(ware)]

* MDGx "Similar Windows 7/newer Anti-Spyware/Privacy Tools" section in 
10_BLOCK.TXT (included):
http://www.mdgx.com/xptoy.htm#10BLK
http://www.mdgx.com/10BLK/10_BLOCK.php
http://www.mdgx.com/10BLK/10_BLOCK.TXT
* MDGx "List of Useful Windows NTx Tools [99.9% free(ware)]" in TOOLS.TXT 
(included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT
* MDGx "1000+ Windows NTx Power Toys + Tweaking Tools [99.9% free(ware)]" 
section in SOFTWARE.TXT (included):
http://www.mdgx.com/toy.htm
* MDGx "Windows 3.1x/9x/NTx Internet Power Toys" section in SOFTWARE.TXT 
(included):
http://www.mdgx.com/nettoys.htm
* MDGx "Free(ware) Windows 9x/NTx Firewalls, Anti-Spyware + Internet Monitors" 
section in SOFTWARE.TXT (included):
http://www.mdgx.com/fw.htm
* MDGx "Free(ware) Windows NTx Extras" section in SOFTWARE.TXT (included):
http://www.mdgx.com/xptoy.htm



* Original Updated Microsoft File Manager (FM) (WINFILE.EXE) 32-bit + 64-bit 
contains cumulative up-to-date fixes/patches +
enhancements for all Microsoft supported 
[http://support.microsoft.com/help/13853/] Windows NTx 32-bit (x86) + 64-bit 
(x64)
editions (free MIT, open source):
http://github.com/microsoft/winfile/
FM master + cumulative enhancements:
http://github.com/microsoft/winfile/releases/
FM latest release:
http://github.com/microsoft/winfile/releases/latest/
Windows 10 FM App:
http://www.microsoft.com/store/apps/9p7vbbbc49rb/
FM WINFILE.CHM [right-click to save]:
http://github.com/microsoft/winfile/raw/master/help/WINFILE.CHM
Place Windows Compiled (Compressed) HTML Help (WINFILE.CHM) file into the 
directory(ies)/folder(s) where WINFILE.EXE
reside(s), both 32-bit + 64-bit.
WINFILE.CHM is identical for all FM editions 32-bit + 64-bit.
FM @ /. News:
http://news.slashdot.org/story/18/04/09/1952237/
WinHlp32 for Windows 10/2016/2019/11/2022:
http://raxsoft.com/raxccm/software_app.php?progid=13
Direct download [735 KB, freeware]:
http://assets.raxsoft.com/bin/winhlp32/winhlp32.msi
MDGx Restore/Update Windows Help (.HLP) Guide:
http://www.mdgx.com/add.htm#HHU
More info:
http://www.askvg.com/how-to-open-help-files-hlp-in-windows-7-that-require-
windows-help-program-winhlp32-exe/
Required:
FM (WINFILE.EXE) 32-bit + 64-bit require Microsoft Visual C++ 2017 (VC2017) 
Runtime Redistributables 32-bit + 64-bit for
Visual Studio 2017 (VS2017) for Windows 7 SP1/newer 32-bit (x86) + 64-bit (x64) 
(English):
http://support.microsoft.com/help/2977003/
MDGx Microsoft Visual Studio (VS) + Visual C++ (VC):
http://www.mdgx.com/add.htm#VS6
- VC2017 64-bit for Windows NTx 64-bit (x64) [15 MB]:
http://aka.ms/vs/16/release/vc_redist.x64.exe
http://download.visualstudio.microsoft.com/download/pr/12328699/
a80e967515b2a4faf37bf15387f1c5c3/VC_redist.x64.exe
- VC2017 32-bit for Windows NTx 32-bit (x86) [14 MB]:
http://aka.ms/vs/16/release/vc_redist.x86.exe
http://download.visualstudio.microsoft.com/download/pr/12319034/
ccd261eb0e095411af3b306273231b68/VC_redist.x86.exe
FM (WINFILE.EXE) 32-bit + 64-bit also work with Microsoft Visual C++ 2015 
(VC2015) Runtime Redistributables 32-bit + 64-bit
for Visual Studio 2015 (VS2015) for Windows XP SP3/2003 SP2/Vista SP2/2008 SP2/7
SP1/newer 32-bit (x86) + 64-bit (x64)
(English):
http://support.microsoft.com/help/2999226/
More info:
http://www.microsoft.com/download/details.aspx?id=53840
- VC2015 64-bit for Windows NTx 64-bit (x64) [14 MB]:
http://download.microsoft.com/download/6/A/A/6AA4EDFF-645B-48C5-81CC-
ED5963AEAD48/vc_redist.x64.exe
- VC2015 32-bit for Windows NTx 32-bit (x86) [13 MB]:
http://download.microsoft.com/download/6/A/A/6AA4EDFF-645B-48C5-81CC-
ED5963AEAD48/vc_redist.x86.exe
You actually need these 2 files:
msvcp140.dll 14.10.25008.0
vcruntime140.dll 14.10.25008.0
which do not require installation or registration. Download and copy both files 



to the directory/folder where your FM
executable(s) reside(s): 32-bit DLLs for WINFILE.EXE 32-bit or 64-bit DLLs for 
WINFILE.EXE 64-bit:
http://www.dll4free.com/msvcp140.dll.html
http://www.dll4free.com/vcruntime140.dll.html
See FM_NEW.TXT (included) for more details:
http://www.mdgx.com/fmnt32/FM_NEW.TXT

* MDGx File Manager (FM) 32-bit for Windows NTx 32-bit (x86) + 64-bit (x64) + 
support files + add-ons, modded +
customized (free):
http://www.mdgx.com/xptoy.htm#FMNT
MDGx FM Guide -> FMNT32.TXT (included):
http://www.mdgx.com/fmnt32/fmnt32.php
http://www.mdgx.com/fmnt32/FMNT32.TXT
MDGx FM Installer:
http://www.mdgx.com/fmnt32/FMNT32.EXE
I have compiled FMNT32.EXE installer using Microsoft Internet Explorer 
Administration Kit (IEAK):
http://www.mdgx.com/add.htm#IEA
+ INF/SED Guides:
http://www.mdgx.com/add.htm#INF
http://www.mdgx.com/INF_web/

* Windows Update Blocker (WUB) [Wub.exe 32-bit + Wub_x64.exe 64-bit] for Windows
10/11 32-bit (x86) + 64-bit (x64) allows
all users to block/disable/stop/turn OFF, and/or unblock/reenable/restart/turn 
back ON
automatic/unattended 
behind-your-back/disguised/forced/harmful/hidden/intrusive/invasive/subversive/
unwanted/without your
approval/consent/knowledge/permission Microsoft Windows Updates (WU) service + 
interconnected/interdependent/interrelated
services [up to 25 services!] + program executables (.exe) which are very 
complicated/hard/almost impossible to
block/control/disable/manage/stop/turn OFF without performing complicated/time 
consuming operations, cumbersome registry
tweaks, or/and without dedicated 3rd party tools (like this one):
http://www.sordum.org/9470/
File [Portable ZIP]:
http://www.sordum.org/files/download/windows-update-blocker/Wub.zip
Screen shot:
http://www.sordum.org/wp-content/uploads/2020/10/
windos_update_blocker_blocked.png
Windows Update (WU) Tools:
http://www.majorgeeks.com/mg/sortdate/windows_update.html
See MDGx "Turn OFF/Postpone/Block/Uninstall Windows Updates (WU)" chapter -> "* 
FIXes:" section in WIN10.TXT (included):
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT
See MDGx "On The Edge of A Hostile Takeover = Uninstall + Replace Edge While You
Still Can" chapter -> "REMEMBER:" section
in WIN10.TXT (included):
http://www.mdgx.com/10.php
http://www.mdgx.com/WIN10.TXT

* simplewall 32-bit + 64-bit GUI interface + DOS console command line tool for 
Windows 8.1/newer 32-bit (x86) + 64-bit (x64)
configures Windows Filtering Platform (WFP) to allow/block incoming + outgoing 
traffic, creates, edits, enables/disables +
(un)installs firewall rules + blocks Microsoft 
dangerous/deceptive/insecure/invasive/intrusive/subversive/unsafe IPs based
on blocklists [spying (spyware, surveillance, telemetry, tracking), Windows 
Update (WU) + applications (apps + services)],



highly customizable:
http://www.henrypp.org/product/simplewall/
http://github.com/henrypp/simplewall/
Download [Portable ZIP]:
http://github.com/henrypp/simplewall/releases/latest/
simplewall Portable:
Place portable.dat in the program's main directory/folder and use 
Notepad/similar plain text editor
http://www.mdgx.com/toy.htm#TXT
to create (if absent) simplewall.ini in the program's [simplewall.exe] main 
directory/folder.

* WindowsSpyBlocker 32-bit for Windows 10/newer blocks Microsoft
dangerous/deceptive/insecure/invasive/intrusive/subversive/unsafe IPs based on 
blocking rules [spy (spyware, surveillance,
telemetry, tracking), Windows Update (WU) + extra (Microsoft apps + services)] +
blocklists, highly customizable:
http://crazymax.dev/WindowsSpyBlocker/
Download [Portable EXE]:
http://github.com/crazy-max/WindowsSpyBlocker/releases/latest/
WindowsSpyBlocker Repository:
http://github.com/crazy-max/WindowsSpyBlocker/
Usage Guide:
http://crazymax.dev/WindowsSpyBlocker/app/
Blocking Rules Guide:
http://crazymax.dev/WindowsSpyBlocker/blocking-rules/

* Edge Blocker (EdgeBlock.exe 32-bit + EdgeBlock_x64.exe 64-bit) for Windows 
10/11:
http://www.sordum.org/9312/
File:
http://www.sordum.org/files/download/edge-blocker/EdgeBlock.zip

* MSEdgeRedirect for Windows 8.1/10/11 intercepts, redirects + switches all 
Desktop, Metro, Start, Store, Tiles apps,
feeds/RSS, gadgets, maps, news, search, widgets, weather, etc, file extensions 
(.dhtml, .htm, .html, .php, .xhtml, .xml,
etc), internet/URI schemes/protocols (ftp:, http:, https:, magnet:, mailto:, 
news:, etc) + URL/URI
addresses/items/links/schemes/shortcuts (.url, .website, etc) forced 
(built/hardwired/preset into the operating system) by
Microsoft to open in Edge + forces them to open instead in user's choice custom 
selected default web browser (if any other
than Edge) + to use any user's choice custom selected default search engine 
other than bing, works from anywhere in the
world (including outside Europe/EU/UE):
http://github.com/rcmaehl/MSEdgeRedirect/
Download:
http://github.com/rcmaehl/MSEdgeRedirect/releases/latest/
More info:
http://www.ghacks.net/2023/11/18/you-can-remove-edge-and-bing-search-on-windows-
11-even-if-you-dont-live-in-europe/
MDGx "100+ WWW (World Wide Web) Search Engines" [most have enhanced privacy, 
safety + security]:
http://www.mdgx.com/links.htm#WSE
List of URI Schemes:
http://www.w3.org/wiki/UriSchemes

* EdgeDeflector for Windows 10/11 intercepts + redirects HTTP(S), Maps, News, 
Feeds/RSS, Widgets, Weather, etc file
extensions (.dhtml, .htm, .html, .php, .xhtml, .xml, etc), internet 
schemes/protocols (ftp:, http:, https:, magnet:,
mailto:, news:, etc) + URL/URI addresses/items/links/schemes/shortcuts 
(.url, .website, etc) forced (built/hardwired/preset



into the operating system) by Microsoft to open in Edge to open instead in 
user's choice custom selected default web browser
(if any other than Edge):
http://github.com/da2x/EdgeDeflector/
Download:
http://github.com/da2x/EdgeDeflector/releases/latest/
EdgeDeflector Purpose:
http://www.ctrl.blog/entry/edgedeflector-default-browser.html
BEWARE:
*******
Newer Windows 10 builds/editions/releases/versions blocked EdgeDeflector + 
similar Edge browser competitors:
http://www.ctrl.blog/entry/microsoft-edge-protocol-competition.html
FIX:
****
Restore EdgeDeflector + similar Edge browser competitors functionality -> 
UNinstall Windows Update KB5007262:
Start button/icon/logo/menu/orb -> Windows Settings [gear icon] -> Update & 
Security -> Windows Update -> View update
history -> Uninstall updates -> highlight/select update KB5007262 -> right-click
-> Uninstall -> reboot/restart if
needed/prompted.
List of URI Schemes:
http://www.w3.org/wiki/UriSchemes

* Firewall App Blocker (FAB) 32-bit + 64-bit for Windows 7/newer allows/blocks 
inbound + outbound app(lication)s/EXEcutables
(.exe)/programs, highly customizable:
http://www.sordum.org/8125/
File:
http://www.sordum.org/files/download/firewall-app-blocker/fab.zip
MS Edge firewall block rule [Disable_EdgeRule.bat] [ZIP]:
http://www.sordum.org/files/download/firewall-app-blocker/edge_rule.zip

* Edge Chromium Blocker Toolkit:
http://www.windowscentral.com/how-prevent-microsoft-edge-chromium-installing-
automatically-windows-10/
File:
http://web.archive.org/web/20210812025623if_/http://
msedgeblockertoolkit.blob.core.windows.net/blockertoolkit/
MicrosoftEdgeChromiumBlockerToolkit.exe

* Enable/Unlock Chromium Edge disabled/locked features + options using Policy 
Plus for Windows 7/newer (free, open source):
http://github.com/Fleex255/PolicyPlus/releases/latest/
http://www.itechtics.com/best-group-policy-editor-gpedit-msc-alternative-for-
windows/
http://www.majorgeeks.com/files/details/policy_plus.html

* Uninstall + remove Edge web browser from Windows 10/11 using DOS (CMD) console
commands + "Uninstall Edge.cmd" batch file
script:
http://www.winaero.com/how-to-uninstall-and-remove-edge-browser-in-windows-10/
Download "Uninstall Edge.cmd" [ZIP file]:
http://www.winaero.com/download.php?view.1835
Disable Edge Updates in the registry:
http://admx.help/?
Category=EdgeChromium&Policy=Microsoft.Policies.Update::Pol_DefaultUpdatePolicy

* Recommended independent/3rd party free, open source, safe, secure, uncrippled,
unlocked, unrestricted, modern web browsers
(examples):
http://www.mdgx.com/nettoys.htm#NET
MDGx "Free(ware) Windows 9x/NTx Web Browsers" chapter -> "Chromium + Chrome web 



browsers [free(ware)]" section ->
"Chromium + Chrome" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#CHR
RECOMMENDED:
- Chromium Precompiled EXEcutable [Installer EXE + Portable Archives ZIP/7z] 32-
bit + 64-bit for Windows XP/newer 32-bit
(x86) + 64-bit (x64):
http://chromium.woolyss.com/
Degoogled/Ungoogled/stripped of Google ad(ware)/spyware/surveillance/tracking 
code Chromium builds [clearly labeled]:
http://github.com/ungoogled-software/ungoogled-chromium/blob/master/README.md
http://ungoogled-software.github.io/ungoogled-chromium-wiki/faq
Ungoogled Chromium precompiled binaries 32-bit + 64-bit for Windows 7/newer 32-
bit (x86) + 64-bit (x64) [75-125 MB,
Installer ONLY EXE + Portable ZIP, NEWest at the top]:
http://ungoogled-software.github.io/ungoogled-chromium-binaries/
Ungoogled Chromium 64-bit for Windows 7/newer 64-bit (x64):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/64bit/
Ungoogled Chromium 32-bit for Windows 7/newer 32-bit (x86):
http://ungoogled-software.github.io/ungoogled-chromium-binaries/releases/
windows/32bit/
- Brave 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
improved privacy, safety + security and optimized speed:
http://brave.com/
Brave Repository:
http://github.com/brave/brave-browser/
Download [ZIP = full, Portable]:
http://github.com/brave/brave-browser/releases/latest/
- Vivaldi 32-bit + 64-bit web browser for Windows 7/newer 32-bit (x86) + 64-bit 
(x64) based on Chromium code [fork] with
enhanced privacy, safety + security:
http://vivaldi.com/
Download [EXE = Installer ONLY]:
http://vivaldi.com/download/
Vivaldi Portable -> run Installer EXE -> Install standalone:
http://help.vivaldi.com/desktop/install-update/standalone-version-of-vivaldi/
- Thorium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-bit
(x64) based on Chromium code [fork]
hardware 3D, rendering + video playback optimized:
http://thorium.rocks/
Download [ZIP = full, Portable]:
Thorium AVX2 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium AVX 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-Win/releases/latest/
Thorium SS3 64-bit for Windows 10/newer 64-bit (x64):
http://github.com/Alex313031/Thorium-SSE3/releases/latest/
Thorium SSE2 (Win32) 32-bit edition for Windows 7/newer 32-bit (x86) + Thorium 
SSE3, SSE4, AVX + AVX2 64-bit editions for
Windows 7/newer 64-bit (x64):
http://github.com/Alex313031/thorium-win7/releases/latest/
Thorium Requirements:
- Multicore CPU: minimum Intel Core 2nd gen or AMD FX with built-in SSE4 
(Streaming SIMD Extensions 4),
http://en.wikipedia.org/wiki/SSE4
AVX (Advanced Vector EXtensions)
http://en.wikipedia.org/wiki/Advanced_Vector_Extensions
+ AES (Advanced Encryption Standard)
http://en.wikipedia.org/wiki/Advanced_Encryption_Standard
enhancements/multimedia extensions/instructions.
- Graphics video controller with 3D rendering + OpenGL capabilities.
Required Windows 7 64-bit (x64) Updates for Thorium 64-bit web browser enhanced 



hardware + software compatibility/support:
http://thorium.rocks/win7
- Windows 7 SP1/2008 R2 64-bit (x64) Servicing Stack Update 2019 KB4490628:
http://support.microsoft.com/help/4490628/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4490628+x64
- Windows 7 SP1/2008 R2 64-bit (x64) SHA-2 Code Signing Support Update 2019 
KB4474419:
http://support.microsoft.com/help/4474419/
Download:
http://catalog.update.microsoft.com/search.aspx?q=4474419+x64
- Supermium 32-bit + 64-bit web browsers for Windows 7/newer 32-bit (x86) + 64-
bit (x64) based on Chromium code [fork]
optimized for speed + performance:
http://www.win32subsystem.live/supermium.html
Download [EXE = full, Installer +/- ZIP = full, Portable]:
http://github.com/win32ss/supermium/releases/latest/
- X-Chromium (X-Launcher) Portable launcher:
http://www.winpenpack.com/en/download.php?view.1082
Download [EXE = Installer, full]:
http://sourceforge.net/projects/winpenpack/files/X-Chromium/releases/
Either install Chromium precompiled stable releases 32-bit or 64-bit:
http://chromium.woolyss.com/
or extract all files from portable archive [zip or 7z] + copy to the destination
of your choice Chromium portable stable
releases 32-bit or 64-bit to match the Windows NTx [7/newer] operating system(s)
[OS(es)]
build/edition/release/update/version + bit strength [32-bit (x86) or 64-bit 
(x64)] you are using.
All Chromium + Chrome alternatives/derivatives/forks/variants users must have 
these 3 environment variables:
GOOGLE_API_KEY=NO
GOOGLE_DEFAULT_CLIENT_ID=NO
GOOGLE_DEFAULT_CLIENT_SECRET=NO
Right-click CMD shortcut/CMD.EXE -> Run as Administrator -> run these commands -
> press Enter after each line:
SETX.EXE GOOGLE_API_KEY "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_ID "NO" /M
SETX.EXE GOOGLE_DEFAULT_CLIENT_SECRET "NO" /M
Google API Keys:
http://chromium.woolyss.com/#google-api-keys
http://www.chromium.org/developers/how-tos/api-keys/
MDGx "@ Chromium/Chrome/Brave/X-Chromium/Thorium/Vivaldi/Supermium Privacy, 
Safety + Security Settings, Extensions, Guides +
Solutions:" topic in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm#PRV
MDGx collection of essential + useful Chromium/Chrome extensions + tweaks -> 
"CHROMIUM" section in TOOLS.TXT (included):
http://www.mdgx.com/tools.php#:~:text=CHROMIUM%20%5B%2A%5D
http://www.mdgx.com/TOOLS.TXT

* Cloudflare WARP Desktop client 64-bit for Windows 8.1/newer 64-bit (x64) [free
Virtual Private Network (VPN) using public
root Domain Name System (DNS) servers]:
http://1.1.1.1/
Cloudflare WARP for Windows:
http://developers.cloudflare.com/warp-client/get-started/windows/
Cloudflare WARP for Linux:
http://developers.cloudflare.com/warp-client/get-started/linux/
Cloudflare WARP for macOS:
http://developers.cloudflare.com/warp-client/get-started/macos/
Cloudflare WARP for Android:
http://developers.cloudflare.com/warp-client/get-started/android/
Cloudflare WARP for iOS:



http://developers.cloudflare.com/warp-client/get-started/ios/
Use Cloudflare WARP VPN in combination with WireGuard:
http://www.andryou.com/2020/03/28/guide-using-cloudflares-warp-vpn-on-a-
computer-mac-pc-linux/
WireGuard VPN (free, open source):
http://www.wireguard.com/
- BrowserLeaks: DNS (Domain Name System) Leak Test:
http://browserleaks.com/dns/
Wikipedia: Virtual Private Network (VPN):
http://en.wikipedia.org/wiki/Virtual_private_network
Wikipedia: Domain Name System (DNS):
http://en.wikipedia.org/wiki/Domain_Name_System
See MDGx "Digital + Internet/Online Privacy, Safety + Security" chapter ->
"* Web Browsers, Platforms, Computers + Devices Online Protection Guides + Tools
for Privacy, Safety + Security:" section in
WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Digital%20%2B%20Internet%2FOnline%20Privacy%2C
%20Safety%20%2B%20Security%20%3D%20Your%20Top%20Priority
See MDGx "Public Root DNS Servers" chapter in WINDOWS7.TXT (included):
http://www.mdgx.com/7.php#:~:text=Public%20Root%20DNS%20Servers%20%5B%2A%5D

* OpenVPN Cloud, Access Server + Connect client Virtual Private Network (VPN) 
system provides secure point-to-point or
site-to-site concurrent connections using OpenSSL (Secure Sockets Layer) 
encryption + Transport Layer Security (TLS)
protocol, highly customizable:
http://openvpn.net/
Free subscriptions for personal use = limited to:
- OpenVPN Cloud = maximum 3 concurrent connections.
- Access Server = maximum 2 concurrent connections.
Repository:
http://github.com/OpenVPN/openvpn/
OpenVPN Connect client 32-bit + 64-bit for Windows 7/newer 32-bit (x86) + 64-bit
(x64) [MSI Installer]:
http://openvpn.net/client-connect-vpn-for-windows/
OpenVPN FAQs:
http://openvpn.net/vpn-server-resources/#faqs
OpenVPN Online Documentation:
http://openvpn.net/vpn-server-resources/
Wikipedia: Virtual Private Network (VPN):
http://en.wikipedia.org/wiki/Virtual_private_network
Wikipedia: OpenSSL:
http://en.wikipedia.org/wiki/OpenSSL
Wikipedia: Secure Sockets Layer (SSL):
http://en.wikipedia.org/wiki/Transport_Layer_Security#SSL_1.0,_2.0,_and_3.0
Wikipedia: Transport Layer Security (TLS):
http://en.wikipedia.org/wiki/Transport_Layer_Security

* Portmaster Free 64-bit for Windows 7/newer 64-bit (x64) port manager, 
firewall, filter, secure DNS, blocker, network
monitor, highly customizable:
http://safing.io/
File [Setup only!]:
http://updates.safing.io/latest/windows_amd64/packages/portmaster-installer.exe
Windows 7 64-bit (x64) requires Microsoft Security Monthly Quality Rollup (SMQR)
KB4503292:
http://catalog.s.download.windowsupdate.com/d/msdownload/update/software/secu/
2019/06/windows6.1-kb4503292-x64_a35bb4ea16d1d529fde9abfe8a0c16e9061f74cd.msu
More info @ MSKB:
http://support.microsoft.com/help/4503292/
Portmaster Documentation:
http://docs.safing.io/
Community Wiki:
http://wiki.safing.io/



* Pi-hole DOS console command line installer [PH4WSL1.cmd] for Windows 10/newer 
installs Linux Pi-hole DNS sinkhole on
Windows computers, highly customizable:
http://github.com/DesktopECHO/Pi-Hole-for-WSL1/
Download:
http://github.com/DesktopECHO/Pi-Hole-for-WSL1/raw/master/PH4WSL1.cmd
PH4WSL1.cmd install guide step-by-step:
http://www.reddit.com/r/pihole/comments/j39drp/
PH4WSL1.cmd ReadMe guide:
http://github.com/DesktopECHO/Pi-Hole-for-WSL1/#readme
Pi-hole DNS sinkhole for Linux:
http://github.com/pi-hole/pi-hole/
Pi-hole Blocklists:
http://firebog.net/
http://arstech.net/pi-hole-blocking-lists-2023/
http://github.com/topics/pihole-blocklists/
http://github.com/hagezi/dns-blocklists/
http://github.com/jacklul/pihole-updatelists/
DNS sinkhole:
http://en.wikipedia.org/wiki/DNS_sinkhole

* DNSCrypt Proxy clients for Windows NTx 32-bit + 64-bit use encrypted DNS 
protocol to authenticate + anonymize two way
traffic between DNS client and DNSCrypt enabled DNS resolver, prevents DNS 
spoofing, DDoS attacks:
http://dnscrypt.info/
More Info:
http://www.dnscrypt.org/
DNSCrypt Proxy:
http://github.com/DNSCrypt/dnscrypt-proxy/
Download [ZIP -> Installer EXE]:
http://github.com/dnscrypt/dnscrypt-proxy/releases/latest/
DNSCrypt Documentation:
http://github.com/DNSCrypt/dnscrypt-proxy/wiki/
DNSCrypt Clients + DNSCrypt Servers:
http://dnscrypt.info/implementations/
DNSCrypt Clients:
http://www.dnscrypt.org/#dnscrypt-windows
DNSCrypt Public Root DNS Servers:
http://dnscrypt.info/public-servers/
DNSCrypt:
http://en.wikipedia.org/wiki/DNSCrypt

* Unbound 32-bit + 64-bit for Windows 7/newer 32-bit (x86) + 64-bit (x64) 
validating, recursive + caching DNS resolver,
supports IPv6 (Internet Protocol version 6), DNSSEC (Domain Name System Security
Extensions), NSEC (Next Secure Record), DNS
over TLS (DoT) + DNS over HTTPS (DoH) encryption + protocols:
http://nlnetlabs.nl/projects/unbound/
Download [Portable ZIP]:
http://nlnetlabs.nl/projects/unbound/download/
Unbound Repository:
http://github.com/NLnetLabs/unbound/
Unbound Documentation:
http://unbound.docs.nlnetlabs.nl/

* Privoxy GUI interface + DOS console command line non-caching HTTP/web proxy 
with advanced filtering for enhanced privacy +
safety, highly customizable:
http://www.privoxy.org/
Repository:
http://sourceforge.net/projects/ijbswa/
Download:



http://www.privoxy.org/sf-download-mirror/Win32/
http://sourceforge.net/projects/ijbswa/files/Win32/
Privoxy FAQ:
http://www.privoxy.org/faq/
Privoxy Online Manual:
http://www.privoxy.org/user-manual/
Proxy server:
http://en.wikipedia.org/wiki/Proxy_server

* Privaxy 32-bit + 64-bit DOS console command line MITM (Man In The Middle) 
HTTP(S) low level incoming + outgoing tunnel
proxy ad(ware)/malware/spying/surveillance/tracking blocker/filter:
http://github.com/Barre/privaxy/
Download:
http://github.com/Barre/privaxy/releases/latest/
Proxy server:
http://en.wikipedia.org/wiki/Proxy_server

* PeerBlock [ UNMAINTAINED ! ] Portable 32-bit + 64-bit for Windows XP/newer 
personal firewall blocks/filters incoming +
outgoing dangerous/deceptive/insecure/invasive/intrusive/subversive/unsafe IPs +
ports [IPv4 only] from frequently updated +
user customized lists of blacklisted 
ad(ware)/malware/spying/surveillance/tracking hosts/IPs:
http://www.peerblock.com/
Download [Portable ZIP]:
http://code.google.com/archive/p/peerblock/downloads/
PeerBlock 64-bit for Windows Vista/newer 64-bit (x64):
http://storage.googleapis.com/google-code-archive-downloads/v2/code.google.com/
peerblock/PeerBlock_r693__x64_Release_(Vista).zip
PeerBlock 32-bit for Windows Vista/newer 32-bit (x86):
http://storage.googleapis.com/google-code-archive-downloads/v2/code.google.com/
peerblock/PeerBlock_r693__Win32_Release_(Vista).zip
PeerBlock Repository:
http://code.google.com/archive/p/peerblock/
http://sourceforge.net/projects/peerblock/
http://github.com/PeerBlock/peerblock/
I-Blocklist lists of blacklisted IPs [frequently updated]:
http://www.iblocklist.com/lists
Blocklists + Filterlists:
http://github.com/badmojr/1Hosts/
http://filterlists.com/
http://github.com/yokoffing/filterlists/
PeerBlock @ Wikipedia:
http://en.wikipedia.org/wiki/PeerBlock

* Wireshark (formerly Ethereal) 64-bit GUI interface + Tshark DOS console 
command line for Windows 7/newer 64-bit (x64)
network protocols packet analyzer tools for troubleshooting, analysis, software 
+ communications development + education:
http://www.wireshark.org/
Download [EXE Installer + Portable EXE]:
http://www.wireshark.org/download.html
LAST Wireshark version compatible with Windows 7 is 3.2.18:
- Wireshark 3.2.18 64-bit for Windows 7 64-bit (x64):
http://2.na.dl.wireshark.org/win64/all-versions/Wireshark-pdb-win64-3.2.18.zip
- Wireshark 3.2.18 32-bit for Windows 7 32-bit (x86):
http://2.na.dl.wireshark.org/win32/all-versions/Wireshark-pdb-win32-3.2.18.zip
Requires Microsoft Windows 7/newer CRT Updates:
- Universal C Runtime (CRT) Update:
http://support.microsoft.com/help/2999226/
- Universal C Runtime (CRT) Update:
http://support.microsoft.com/help/3118401/
Wireshark installs Npcap link-layer network access Driver + Libraries (DLLs) for



Windows 7/newer:
http://npcap.com/
Download [EXE Installer]:
http://npcap.com/#download
Wireshark User Guide:
http://www.wireshark.org/docs/wsug_html_chunked/ChIntroPlatforms.html
Wireshark Documentation:
http://www.wireshark.org/docs/
Wireshark Wiki:
http://gitlab.com/wireshark/wireshark/-/wikis/

* Winaero Tweaker 32-bit + 64-bit for Windows 7/8/8.1/10/11 [select Portable at 
install time!]:
http://www.winaero.com/winaero-tweaker/
Download:
http://www.winaero.com/download-winaero-tweaker/
Winaero Tweaker Features:
http://www.winaero.com/the-list-of-winaero-tweaker-features/

* UxStyle for Windows 7/8/8.1/10 Preview:
http://www.uxstyle.com/
http://github.com/riverar/uxstyle/
UxStyle for Windows 8/8.1:
http://www.uxstyle.com/builds/UxStyle_sep23_x86_x64_possibly_bugged.zip
UxStyle for Windows 7/7 SP1:
http://www.uxstyle.com/builds/UxStyle_Core_jul13_bits.zip
Aero Theme for Windows 8/8.1:
http://simplexdesignsart.deviantart.com/art/Windows-Aero-536877982/
http://web.archive.org/web/20130402051457/http://xxinightxx.deviantart.com/art/
Windows-7-Vs-REV-D-350491112/
File:
http://drive.google.com/uc?export=download&id=0B883uGPmNY72Sjk3dy1MTzBGVEE
http://web.archive.org/web/20130402051457/http://www.deviantart.com/download/
350491112/windows_7_vs_rev_d_by_xxinightxx-d5so8o8.zip
Windows 8/8.1 Themes:
http://www.winaero.com/category/windows-8-themes/

* UltraUXThemePatcher 32-bit + 64-bit for Windows XP/Vista/7/8/8.1/10/11 patches
UX (User eXperience) Theme system files
[uxtheme.dll, uxinit.dll, themeui.dll] to allow use of 3rd party/custom themes:
http://mhoefs.eu/software_uxtheme.php
UltraUXThemePatcher Guide:
http://setupgamer.info/how-to-install-custom-windows-10-themes-and-visual-
styles-with-ultrauxthemepatcher/
UltraUXThemePatcher Tutorial:
http://www.tenforums.com/customization/76077-ultrauxthemepatcher-recover-black-
grey-screen-windows-8-10-a.html
Windows 7/newer Themes:
http://www.majorgeeks.com/files/categories/themes.html
Windows 11 Themes:
http://www.deviantart.com/tag/windows11themes/
Windows 10 Themes:
http://www.deviantart.com/tag/windows10themes/
http://www.deviantart.com/sagorpirbd/art/Aero-7-Themes-for-Win10-Final-
523979941/
http://www.deviantart.com/niivu/art/Sweetness-for-Windows-10-826122176/
Windows 8/8.1 Themes:
http://www.deviantart.com/tag/windows8themes/
Windows 7 Themes:
http://www.deviantart.com/tag/windows7themes/
View + Remove All built-in Windows 10 Themes:
http://www.majorgeeks.com/content/page/
how_to_view_and_remove_all_windows_10_themes.html



* SecureUxTheme for Windows 8.1/10 patches UX (User eXperience) Theme system 
files [uxtheme.dll, uxinit.dll, themeui.dll] to
allow use of 3rd party/custom themes:
http://github.com/namazso/SecureUxTheme/
Download:
http://github.com/namazso/SecureUxTheme/releases/latest/
SecureUxTheme Install Guide:
http://github.com/namazso/SecureUxTheme/wiki/Help:-Step-by-step-installing-
SecureUxTheme-and-a-custom-theme/
Windows 7/newer Themes:
http://www.majorgeeks.com/files/categories/themes.html
Windows 11 Themes:
http://www.deviantart.com/tag/windows11themes/
Windows 10 Themes:
http://www.deviantart.com/tag/windows10themes/
http://www.deviantart.com/sagorpirbd/art/Aero-7-Themes-for-Win10-Final-
523979941/
http://www.deviantart.com/niivu/art/Sweetness-for-Windows-10-826122176/
Windows 8/8.1 Themes:
http://www.deviantart.com/tag/windows8themes/
View + Remove All built-in Windows 10 Themes:
http://www.majorgeeks.com/content/page/
how_to_view_and_remove_all_windows_10_themes.html

* Classic Task Manager (TM) (TaskMgr.exe) Windows 7 style 32-bit + 64-bit for 
Windows 8/8.1/10/11:
http://www.winaero.com/how-to-restore-the-good-old-task-manager-in-windows-8/
Classic TM for Windows 10/11:
http://win7games.com/download/taskmgr_w10.zip

* K-Lite Codec Pack (KLCP) Mega audio, video + sub(title)s multimedia Codecs + 
Media Player Classic Home Cinema (MPC-HC)
Lite 32-bit + 64-bit:
http://www.codecguide.com/download_k-lite_codec_pack_mega.htm
File [ attempts to install ADWARE/TRIALWARE ! ]:
http://www.majorgeeks.com/files/details/k_lite_mega_codec_pack.html
http://www.videohelp.com/software/K-Lite-Codec-Pack
KLCP Info:
http://en.wikipedia.org/wiki/K-Lite_Codec_Pack
OLD KLCP Versions:
http://www.videohelp.com/software/K-Lite-Codec-Pack/old-versions#download
MPC-HC recommended settings:
1. MPC-HC(64) -> pause -> right-click -> Options (O) -> Playback -> Output -> 
DirectShow Video [H/W] ->
Enhanced Video Renderer (EVR) -> Apply/OK.
http://learn.microsoft.com/windows/win32/directshow/video-mixing-renderer-
filter-9/
2. MPC-HC(64) -> pause -> click RED LAV Video Decoder Taskbar icon -> Hardware 
Acceleration [H/W] ->
DXVA2 (DirectX Video Acceleration 2) (copyback) -> check ALL Resolutions + 
Codecs boxes EXCEPT DVD + VC-1 -> Apply/OK.
http://anime.my/tutorials/watching-h264-videos-using-compute-unified-device-
architecture-cuda/
madVR Tutorial:
http://anime.my/tutorials/madvr/

* Open-Shell [Classic Shell fork] 32-bit + 64-bit Start Menu + 
button/icon/logo/orb, Explorer + IE enhancer, replacer,
supports custom skins, buttons/logos, highly customizable:
http://open-shell.github.io/Open-Shell-Menu/
ReadMe:
http://github.com/Open-Shell/Open-Shell-Menu/
Download:
http://github.com/Open-Shell/Open-Shell-Menu/releases/



Open-Shell Guides:
http://askleo.com/open-shell-regain-your-start-menu-in-windows-and-much-more/
http://www.techrepublic.com/article/how-to-use-open-shell-as-your-windows-10-
start-menu/
Custom Start button/icon/logo/orb Tutorial:
http://coddec.github.io/Classic-Shell/www.classicshell.net/tutorials/
buttontutorial.html
Custom Skin Tutorial:
http://coddec.github.io/Classic-Shell/www.classicshell.net/tutorials/
skintutorial.html
Skins:
http://www.winaero.com/best-skins-for-classic-shells-start-menu/
http://www.classicshell.net/gallery/Start-Menu/skins/
http://www.classicshell.net/forum/viewforum.php?f=17
Start Buttons/Orbs:
http://www.classicshell.net/forum/viewforum.php?f=18
http://www.deviantart.com/w1ck3dmatt/art/Mega-Orb-Pack-150-start-orbs-259940654/
http://www.door2windows.com/customization/start-buttons/
Aero Glass mod [Windows 8/8.1 style UI] for Windows 8/8.1/10/11:
http://www.glass8.eu/
Open-Shell/Classic Shell Free(ware) Alternatives:
http://classicshell.sourceforge.net/alternatives.html
http://classic-shell.en.softonic.com/windows/alternatives/
http://www.alternativeto.net/software/classicshell/
http://www.makeuseof.com/tag/windows-start-menu-alternatives/
http://www.similarindex.com/classic-shell-alternatives/

* 7+ Taskbar Tweaker (7TT) 32-bit + 64-bit (Portable) for Windows 7/newer adds 
hidden + unavailable Taskbar tray settings
beyond Windows capabilities, highly customizable [select Portable at install 
time]:
http://ramensoftware.com/7-taskbar-tweaker/
http://tweaker.ramensoftware.com/
File [Install -> select Portable]:
http://ramensoftware.com/downloads/7tt_setup.exe
7+ Taskbar Tweaker (7TT) Portable:
http://www.portableapps.com/apps/utilitues/7plus-taskbar-tweaker-portable/
7+ Taskbar Tweaker (7TT) Guide:
http://www.winaero.com/get-a-classic-taskbar-in-windows-8-and-windows-7-that-
works-like-xp/
7+ Taskbar Tweaker (7TT) Advanced Settings:
http://tweaker.ramensoftware.com/images/7-taskbar-tweaker.png
7+ Taskbar Tweaker (7TT) Repository:
http://github.com/m417z/7-Taskbar-Tweaker/
7+ Taskbar Tweaker (7TT) Windhawk tweak mods for Windows 11 Taskbar:
http://ramensoftware.com/windhawk-mods-for-the-windows-11-taskbar/
BUG:
7+ Taskbar Tweaker (7TT) does NOT (yet) support NEWer Windows 11 Taskbar:
http://ramensoftware.com/7-taskbar-tweaker-and-a-first-look-at-windows-11/
FIX:
Restore classic Taskbar tray in Windows 11:
http://ramensoftware.com/7-taskbar-tweaker-on-windows-11-with-windows-10s-
taskbar/
http://www.winaero.com/winaero-tweaker-1-20-1-get-back-windows-10-start-menu-
and-taskbar-in-windows-11/
1. Install Winaero Tweaker:
http://www.winaero.com/winaero-tweaker/
2. Open/run/start Winaero Tweaker.
3. Go to: Windows 11 -> Classic Start Menu and Taskbar -> check "Enable Classic 
Taskbar and Start menu" box -> click
"Sign out now" button.
4. Log on/sign in back into Windows 11 under same user name.
5. Open/run/start 7+ Taskbar Tweaker (7TT) -> customize/tweak settings according
to your needs/preferences -> done.



BONUS:
Windhawk customizes/tweaks Windows 10/11 app(lication)s/programs with mods:
http://windhawk.net/
Windhawk Repository:
http://github.com/ramensoftware/windhawk/
Windhawk Mods:
http://windhawk.net/mods/
Windhawk Mods Repository:
http://github.com/ramensoftware/windhawk-mods/
Windhawk Wiki Documentation:
http://github.com/ramensoftware/windhawk/wiki/

* PowerToys 64-bit for Windows 10/11 64-bit (x64): Color Picker, FancyZones, 
File Explorer Add-ons, Image Resizer, Keyboard
Manager, PowerRename, PowerToys Run, Shortcut Guide:
http://github.com/microsoft/PowerToys/
Download:
http://github.com/microsoft/PowerToys/releases/latest/
Require Microsoft .NET Core + Desktop Runtime 3.1.x/newer 32-bit + 64-bit:
http://dotnet.microsoft.com/download/dotnet/3.1/
also here:
http://www.mdgx.com/add.htm#NFR

* UWPSpy Portable UWP (Universal Windows Platform) app(lication)s inspection 
tool for Windows 10/11 views, edits,
experiments, manipulates, modifies + tweaks UI elements + properties in real 
time:
http://ramensoftware.com/uwpspy/
File:
http://ramensoftware.com/downloads/UWPSpy.zip
UWPSpy Repository:
http://github.com/m417z/UWPSpy/

* Restore Desktop Gadgets (Sidebar.exe + *.gadget) in Windows 8/8.1/10/11:
http://www.winaero.com/desktop-gadgets-and-sidebar-for-windows-10/
http://www.winaero.com/blog/get-desktop-gadgets-back-in-windows-8-1-update/
http://win7gadgets.com/blog/how-install-desktop-gadgets-windows-10/
http://windows.gadgethacks.com/how-to/bring-desktop-gadgets-windows-10-0163567/
Desktop Gadgets Installer:
http://gadgetsrevived.com/download-sidebar/
File:
http://gadgetsrevived.com/wp-content/uploads/2013/10/DesktopGadgetsInstaller.zip
Gadgets:
http://gadgetsrevived.com/
http://win10gadgets.com/
http://win7gadgets.com/
http://www.gadgetskit.com/
8GadgetPack for Windows 7/8/8.1/10/11:
http://8gadgetpack.net/
File:
http://8gadgetpack.net/dl_330/8GadgetPackSetup.msi
Run Widgets in Windows 10 using Rainmeter:
http://win10widgets.com/
Rainmeter:
http://www.rainmeter.net/
File:
http://github.com/tjmarkham/win10widgets/releases/latest/
XWidget for Windows 7 SP1/8/8.1/10/11 [OLDer versions freeware]:
http://download.cnet.com/XWidget/3000-12565_4-75609200.html
Neon Clock Widget for XWidget:
http://www.softpedia.com/get/Windows-Widgets/Alarms-Clocks/Neon-Clock-
Widget.shtml

* Missed Feature Installer for Windows 10 (MFI10) ISO optical disc image 



collection of installers, apps, tools + games
removes/disables useless/annoying features, apps + tools and brings 
back/installs/restores useful/favorite features, apps,
tools + games from previous Windows editions: XP, Vista, 7, 8, 8.1, highly 
customizable:
http://www.ghacks.net/2016/01/15/missed-feature-installer-for-windows-10/
http://www.thewindowsclub.com/missed-features-installer-for-windows-10/
Download:
http://www.chip.de/downloads/Missed-Features-Installer-fuer-Windows-
10_88552123.html
MFI10 [1.3 GB, ISO DVD image]:
http://securedl.cdn.chip.de/downloads/40922223/MFI10_1.0.iso
MFI10 requires a dedicated extractor or disc mount/emulator tool to extract 
content from or mount ISO disc image [examples
of free(ware) programs]:
- 7-Zip:
http://www.7-zip.org/
- WinCDEmu:
http://wincdemu.sysprogs.org/
After that: Explorer -> righ-click MFI10.exe -> Run as Administrator -> select +
install desired features/apps/tools/games.

* Windows 7 Games for Windows 8/8.1/10/11:
http://www.winaero.com/blog/get-windows-7-games-for-windows-10/
Download:
http://www.majorgeeks.com/files/details/windows_7_games_for_windows_10.html
File:
http://www.winaero.com/download.php?view.1836

* Windows 7 Games for Windows 10/11:
http://win7games.com/#games
File:
http://win7games.com/download/Win7Games4Win10_8_81_v2.zip

* Microsoft Media Feature Pack (MFP) installs Windows Media Player (WMP) + 
Audio/Video Codecs (AVC) 32-bit + 64-bit for
Windows 10/11 N/KN 32-bit (x86) + 64-bit (x64):
http://support.microsoft.com/help/3145500/
More info:
http://www.codecguide.com/windows_media_codecs.htm
Media Foundation Codecs (MFC) for Windows 10/11 for Live/Metro/Screen/Start/Tile
(Store) UWP (Universal Windows Platform)
apps [.appx format]:
http://www.codecguide.com/media_foundation_codecs.htm
MFP 32-bit + 64-bit (English):
http://www.microsoft.com/en-us/software-download/mediafeaturepack/
Microsoft Media Feature Pack 2015 (MFP 2015) installs Windows Media Player 2015 
(WMP 2015) + Audio/Video Codecs 2015 (AVC
2015) 32-bit + 64-bit for Windows 10 N/KN 2015 32-bit (x86) + 64-bit (x64):
http://support.microsoft.com/help/3099229/
MFP 2015 32-bit + 64-bit (English):
http://www.microsoft.com/download/details.aspx?id=49919
- MFP 2015 64-bit for Windows 10 N/KN 2015 64-bit (x64) [110 MB]:
http://download.microsoft.com/download/B/E/3/BE302763-5BFD-4209-9C98-
02DF5B2DB452/KB3099229_x64.msu
- MFP 2015 32-bit for Windows 10 N/KN 2015 32-bit (x86) [74 MB]:
http://download.microsoft.com/download/B/E/3/BE302763-5BFD-4209-9C98-
02DF5B2DB452/KB3099229_x86.msu

* Microsoft PowerShell 32-bit + 64-bit cross-platform task automation, scripting
language, configuration management
framework (.NET compatible) + interactive shell command line interface for 
Windows XP/newer 32-bit (x86) + 64-bit (x64)
(English, free, open source):



http://github.com/PowerShell/PowerShell/
- PowerShell 32-bit + 64-bit for Windows 7 SP1/newer 32-bit (x86) + 64-bit (x64)
[20-100 MB]:
http://github.com/PowerShell/PowerShell/releases/
Windows 7 SP1/8/8.1/2012 32-bit + 64-bit require Windows 10 Universal C Runtime 
(CRT) 32-bit + 64-bit:
http://support.microsoft.com/help/3118401/
UCRT All in One [ZIP]:
http://download.microsoft.com/download/3/1/1/311C06C1-F162-405C-B538-
D9DC3A4007D1/WindowsUCRT.zip
UCRT Separate Files [MSU Installer]:
http://www.catalog.update.microsoft.com/Search.aspx?q=3118401
PowerShell Documentation:
http://learn.microsoft.com/powershell/

* Microsoft Windows Assessment and Deployment Kit (WADK) 32-bit + 64-bit for 
Windows 10/2016/2019/11/2022 customizes Windows
images (.wim) for Windows installations + deployment by 
adding/removing/customizing components/drivers/apps/add-ons,
includes tools: Windows Performance Toolkit (WPT), Windows Performance Recorder 
(WPR), Windows Performance Analyzer (WPA),
Sysprep:
http://learn.microsoft.com/windows-hardware/get-started/adk-install/
WADK Setup [2.1 MB, Setup only]:
http://download.microsoft.com/download/1/f/d/1fd2291e-c0e9-4ae0-beae-
fbbe0fe41a5a/adk/adksetup.exe
Windows Preinstallation Environment (PE) Add-on:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/winpe-intro/
Windows PE Add-on:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/download-winpe--
windows-pe/
Windows PE Add-on Setup [1.6 MB, Setup only]:
http://download.microsoft.com/download/5/5/e/55e3e34a-5708-46cd-a90d-
92044c29336b/adkwinpeaddons/adkwinpesetup.exe
WADK Setup + Windows PE Add-on Setup require an Internet connection + at least 1
GB of disk space for downloading
components.
WADK Tools:
http://learn.microsoft.com/windows-hardware/get-started/what-s-new-in-kits-and-
tools/
OLDer WADK Editions + Tools for Windows 8/newer:
http://learn.microsoft.com/windows-hardware/get-started/adk-install/#other-adk-
downloads
Windows 8/8.1/2012 require Microsoft .NET Framework Redistributable (NFR) 
4.5/newer:
http://www.mdgx.com/add.htm#NFR
WADK What's New:
http://learn.microsoft.com/windows-hardware/get-started/what-s-new-in-kits-and-
tools/
WADK Documentation:
http://learn.microsoft.com/windows-hardware/test/assessments/
WPT Documentation:
http://learn.microsoft.com/windows-hardware/test/wpt/
WPT Guide:
http://blogs.windows.com/msedgedev/2016/05/11/top-down-analysis-wpt/
WPT Info:
http://www.tenforums.com/tutorials/117625-download-install-windows-performance-
toolkit-windows-10-a.html
WPT Install Guide:
http://social.technet.microsoft.com/wiki/contents/articles/4847.install-the-
windows-performance-toolkit-wpt.aspx
WPR Documentation:
http://learn.microsoft.com/windows-hardware/test/wpt/windows-performance-
recorder/



WPA Documentation:
http://learn.microsoft.com/windows-hardware/test/wpt/windows-performance-
analyzer/
Microsoft Performance Toolkit (MPT) Software Developers Kit (SDK):
http://github.com/microsoft/microsoft-performance-toolkit-sdk/
MPT SDK Documentation:
http://github.com/microsoft/microsoft-performance-toolkit-sdk/blob/main/
documentation/Overview.md
Microsoft Windows SDK 32-bit + 64-bit for Windows 10/2016/2019/11/2022:
http://developer.microsoft.com/windows/downloads/sdk-archive/

* Microsoft SetupDiag [SetupDiag.exe] diagnostic tool for Windows 10 parses 
Windows Setup log files (.etl + .log) and
detects install/setup/update/upgrade/repair errors/failures:
http://learn.microsoft.com/windows/deployment/upgrade/setupdiag/
SetupDiag.exe [572 KB]:
http://download.microsoft.com/download/d/8/1/d8149356-6590-4bec-b1bd-
a2adcf84ace9/SetupDiag.exe
Requires Microsoft .NET Framework Redistributable (NFR) 4.6/newer:
http://www.mdgx.com/add.htm#NFR
Microsoft Windows Setup Log Files and Event Logs:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/windows-setup-
log-files-and-event-logs/
Microsoft Windows 10 Setup [Setup.exe] Command Line Options:
http://learn.microsoft.com/windows-hardware/manufacture/desktop/windows-setup-
command-line-options/

* Microsoft Windows Subsystem for Linux 2 (WSL2) for Windows 
10/2016/2019/11/2022 allows to install + run a modern/recent
Linux distro as guest operating system (OS) in a Windows Virtual Machine (VM) 
Platform like Hyper-V:
http://learn.microsoft.com/windows/wsl/
http://www.makeuseof.com/how-to-install-wsl-2-on-windows-10/
Install a Linux distro in Windows 10/11:
http://learn.microsoft.com/windows/wsl/install/
http://www.windowscentral.com/how-install-wsl2-windows-10/
http://www.freecodecamp.org/news/how-to-install-wsl2-windows-subsystem-for-
linux-2-on-windows-10/
http://pureinfotech.com/install-windows-subsystem-linux-2-windows-10/
WSL2:
http://learn.microsoft.com/windows/wsl/compare-versions/#whats-new-in-wsl-2
WSL:
http://en.wikipedia.org/wiki/Windows_Subsystem_for_Linux
Hyper-V:
http://learn.microsoft.com/virtualization/hyper-v-on-windows/
Enable Hyper-V:
http://learn.microsoft.com/virtualization/hyper-v-on-windows/quick-start/enable-
hyper-v/
Hyper-V:
http://en.wikipedia.org/wiki/Hyper-V
See also "Virtualization: Virtual Machine (VM) Tools + Emulators for Windows" 
section in SOFTWARE.TXT (included):
http://www.mdgx.com/xptoy.htm#VPC
and "Virtualization: Virtual Machine (VM) Tools + Emulators for DOS" section in 
SOFTWARE.TXT (included):
http://www.mdgx.com/dos.htm#VM
Linux distros:
http://www.mdgx.com/linux.htm
______________________________________________________________________________

Tweak, Customize + Repair Tools on the Internet [free(ware)]



* Windows 7/newer tweaking tools [free(ware)]:
http://www.winaero.com/
http://www.wintools.info/
http://www.thewindowsclub.com/category/downloads/
http://www.nirsoft.net/utils/
http://www.sordum.org/
http://www.itsamples.com/software.html
http://www.mitec.cz/Data/XML/data_downloads.xml
http://learn.microsoft.com/sysinternals/
http://www.majorgeeks.com/
http://www.majorgeeks.com/mg/sortdate/windows_10_fixes.html
http://www.majorgeeks.com/mg/sortname/windows_7_8.html
http://www.intowindows.com/15-free-windows-8-1-customization-tweaking-tools/
http://www.nextofwindows.com/a-list-of-windows-8-tweaking-tools/
http://www.thewindowsclub.com/list-freeware-releases-from-the-windows-club/
http://www.softpedia.com/hubs/Tweak-Windows-8/

* Free(ware) Windows 10/11 Anti-Spying, Anti-Tracking, Privacy, Safety + 
Security tools:
http://www.geckoandfly.com/25083/
http://www.ghacks.net/2015/08/14/comparison-of-windows-10-privacy-tools/

* MDGx "Similar Windows 7/newer Anti-Spyware/Privacy Tools" section in 
10_BLOCK.TXT (included):
http://www.mdgx.com/xptoy.htm#10BLK
http://www.mdgx.com/10BLK/10_BLOCK.php
http://www.mdgx.com/10BLK/10_BLOCK.TXT

* MDGx "Free(ware) Windows NTx Extras" section in SOFTWARE.TXT (included):
http://www.mdgx.com/xptoy.htm

* MDGx "1000+ Windows NTx Power Toys + Tweaking Tools [99.9% free(ware)]" 
section in SOFTWARE.TXT (included):
http://www.mdgx.com/toy.htm

* MDGx "List of Useful Windows NTx Tools [99.9% free(ware)]" in TOOLS.TXT 
(included):
http://www.mdgx.com/tools.php
http://www.mdgx.com/TOOLS.TXT

* MDGx "Windows NTx Internet Power Toys" section in SOFTWARE.TXT (included):
http://www.mdgx.com/nettoys.htm

* MDGx "Free(ware) Windows 9x/NTx Firewalls, Anti-Spyware + Internet Monitors" 
section in SOFTWARE.TXT (included):
http://www.mdgx.com/fw.htm

* MDGx "Group Policy Editor (GPE) fixes + tools (free)" topic in SOFTWARE.TXT 
(included):
http://www.mdgx.com/xptoy.htm#GPO

* MDGx "Group Policy Editor (gpedit.msc) Guide" topic in REGISTRY.TXT 
(included):
http://www.mdgx.com/reg.htm#ADM
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